
The Loan Setup Wizard

You can use the Loan Setup Wizard to quickly and automatically create a record of your 
loans that have a regular payment, or amortization, schedule. Before you start, make sure 
you have your loan documents available so you can easily find and enter accurate 
information.
Tip    For help as you work, choose the Question Mark (?) button on the wizard screen.
For each loan you set up, Money automatically calculates the principal and interest 
breakdown of each payment and keeps track of the balance due. From the Loan Setup 
Wizard, you can also schedule a Future Transaction that will remind you when payments are
due and make payment entry nearly automatic.
While setting up the loan, you can leave out one value and Microsoft Money will calculate it 
for you. For example, if you don't know the Principal + Interest amount, leave it blank and 
Money will calculate it automatically.
Note    When you want to keep track of a non-amortized loan, such as an interest-only loan,
a loan to a friend or relative, or a Credit Card advance, you'll need to set up a Liability 
Account, an Asset Account, or a Credit Card Account. For more information, see Introduction
to Loans.
________________
See also

Setting Up a Future Transaction for a Loan
Entering Loan Payments
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The Change Loan Wizard

Since it's common for the terms of a loan to change before the loan is paid off, you can use 
the Change Loan Wizard to quickly and easily update such information as:

The payment amount.
The interest rate (for variable rate loans).
Any other fees associated with your loans, such as property taxes or insurance.
The payee for the loan.

Some elements of the loan cannot change. For example, you can't change the starting date
of the loan or whether the money was borrowed or lent. To make these changes, you'll need
to delete the loan and create a new one.
Note    If you want to change a single payment for a loan, do not do it here. Make the 
change directly to the transaction when you enter it in the Loans window or the Account 
Book. If you have refinanced your mortgage, do not enter the changes here either. Instead, 
pay off your current mortgage and create a new loan with the new rate.
Tip    For help as you work, choose the Question Mark (?) button on the wizard screen.
________________
See also

Setting Up a Loan
Deleting a Loan
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The Loan Calculator

You can use the Loan Calculator to explore loan terms, to compare two loan alternatives, or 
to calculate savings on interest from additional payments.
Note    Doing calculations with the Loan Calculator will not affect your Microsoft Money 
records. The Loan Calculator only lets you calculate terms of a loan. To actually set up a 
loan in Money, see Setting Up a Loan.

The Loan Calculator can help you answer such questions as:
Given the monthly payment I can afford and today's interest rate, how large a loan 

can I take out?
How would a different interest rate change the loan payment amount?
How would a 20-year loan compare with a 30-year loan in terms of monthly payment 

amount and total interest paid?
How much interest will I save by making an extra $1,000 payment this year -- or 

every year?
How much will I owe on my loan in five years?

To use the Loan Calculator, fill in all but one box and choose the Calculate button. Money 
will fill in the blank box for you. 

To compare the terms of two loans
1 Do your initial calculation by filling in all but one of the boxes and choosing the Calculate 

button.
-Or-
Choose the Import button if you would like to use the terms of an existing loan. Then 
choose the loan you want to work with from the Import a Loan dialog box, and choose 
the Import button. This won't affect your existing loan records.

2 Choose the Compare Loans button.
3 In the second calculator, clear the box for the value you want to calculate and change 

one or more of the other terms. Then choose the Calculate button. 
You can then compare the amounts for total interest and last payment date, which are 
displayed below each calculator.

4 Repeat step 3 for each comparison you want to try, for example, to see how changing 
the interest rate or loan length affects the total interest.

To see how extra payments will affect your loans
1 Do your initial calculation by filling in all but one of the boxes and choosing the Calculate 

button.
-Or-
Choose the Import button if you would like to do a calculation with the terms of an 
existing loan. Then choose the loan you want from the Import a Loan dialog box, and 
choose the Import button. This won't affect your existing loan records.

2 Choose the Extra Payments button.
3 In the Extra Amount box, type the amount of your additional payment. For example, if 

your regular payment is $500 and you're considering paying $600, type 100 in the Extra 
Amount box.

4 In the Frequency box, enter Only Once, Monthly, or Annually, depending on how often 
the extra payment would be made. The frequency of the extra payment is not dependent
on the frequency of your regular payments. For example, even if your regular payments 
are made monthly, you can enter an extra payment annually.



5 Choose the Calculate button.
The results will show below the Calculate button.
This calculation is only hypothetical. To actually enter this extra payment in your loan 
payment records, see Making Extra Payments.

In the Loan Calculator, interest on your loan is compounded according to the Payment 
Frequency you've selected. For example, if you choose Monthly as the payment frequency, 
the interest is calculated at the end of each month. While not all loans work this way, the 
Loan Calculator should provide accurate estimates in most cases.
For a mortgage or other loan where interest is tax deductible, keep in mind that the net 
cost of the interest may be less than the interest amount shown in the Loan Calculator. For 
help in tailoring your borrowing to your tax situation, contact your accountant or financial 
advisor.
________________
See also

Using the Financial Wizards
Changing Loan Information
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The Mortgage Planner

The Mortgage Planner comes in handy when comparing mortgage terms or considering 
refinancing your existing mortgage. It enables you to compare initial costs, monthly 
payment amounts, and total costs of each loan option.
For a mortgage loan where interest is tax deductible, keep in mind that the net cost may be
less than the amount shown in the Mortgage Planner. For help in tailoring your borrowing to
your tax situation, contact your accountant or financial advisor.
Note    Choose the Copy button to copy the results to the Windows Clipboard. You can then 
paste the results into another Windows application for printing.
________________
See also

Using the Financial Wizards

User's Guide
Chapter 26



The Savings Calculator

You can use the Savings Calculator to plan for future purchases or for building a cash 
reserve. It can help you answer such questions as:

On what date will I reach my savings goal of $100,000 if I set aside $500 each month 
and receive a 7 percent annual return?

Given my current savings, what return on my investments must I receive to save 
$100,000 by 1998?

Assuming a 3 percent inflation rate, what will $100,000 be worth in 1998?
How much should I save each month to reach my savings goal of $75,000 by the time

my children reach college?
How much will my $20,000 in savings grow in 20 years?

Do your calculation by filling in all but one of the boxes and choosing the Calculate button. 
For example, to see how much you need to save each month in order to reach your savings
goal, fill in all but the Regular Contribution Amount box. When you choose the Calculate 
button, Money will fill in the box for you.
For more accurate planning, choose the Inflation button to see how inflation can affect your
savings plan. To do calculations for different inflation rates, type a different number in the 
Annual Inflation Rate box and choose the Calculate button.
In the Savings Calculator, Annual Return on Savings is compounded according to the 
Frequency of Contribution you've selected. For example, if you choose Monthly as the 
payment frequency, the interest is calculated at the end of each month.
Note    Choose the Copy button to copy the results to the Windows Clipboard. You can then 
paste the results into another Windows application for printing.
________________
See also

Using the Financial Wizards
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The Retirement Planner

You can use the Retirement Planner to estimate the regular contributions you will need to 
make in order to reach your retirement income goal.
The Retirement Planner assumes you'll contribute monthly to your savings plan from now 
until you reach retirement age. It also assumes your savings will be the sole source of your 
monthly retirement income from the time you retire until you reach the life expectancy age
you entered. After you reach the life expectance age you entered, your savings will be zero.
The Retirement Planner assumes you're saving for retirement in a tax-deferred plan such as
an IRA, Canadian RRSP, or 401(k). If your savings plan is taxable, you should enter a more 
conservative estimate for return on savings. The default values for Pre-Retirement Return 
and Post-Retirement Return on savings are typical. You can accept them by choosing Next, 
or change them to more accurately reflect your particular savings situation.
Generally, to be conservative in planning for retirement, you can overestimate your life 
expectancy. This reduces the risk of your savings running out if inflation causes your 
savings to be worth less than originally projected.
Keep in mind that the Retirement Planner's calculations are based only on your current and 
future savings; they don't reflect income you'll have from post-retirement employment, a 
pension fund, or government retirement-security program.
Tip    You can also use the Retirement Planner to estimate the regular contributions you 
need to make to reach your college savings goal. In the Current Age, Retirement Age, and 
Life Expectancy Age fields, just type the students current age, the students age when 
starting college, and the students age at the time of graduation. Then go through the rest 
of the wizard giving information for your college savings instead of retirement savings.
Note    Choose the Copy button to copy the results to the Windows Clipboard. You can then 
paste the results into another Windows application for printing.

________________
See also

Using the Financial Wizards
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The Interest Estimator

You can use the Interest Estimator to calculate the amount of interest a Bank Account has 
earned or the interest you owe on a Credit Card Account.
After you enter the account, the time period, and the interest rate, the wizard will calculate 
an estimated interest amount when you choose the Calculate button. This can be especially
helpful if you rely on interest income for some of your living expenses, or if you want to 
closely manage the cost of credit card interest.
Note    Most accounts will either pay interest (such as most bank accounts) or charge 
interest (such as most credit card accounts). In these cases, you can leave the zero in the 
interest rate field that does not apply.
________________
See also

Using the Financial Wizards
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Using the Financial Wizards

The Microsoft Money Financial Wizards can help you easily accomplish some of the most 
common tasks in financial planning, including:

Setting savings goals.
Planning for retirement.
Estimating interest earned on a bank account or paid on a credit card account.
Calculating loan payments.
Comparing fees and points charged for mortgage loans.

A Financial Wizard asks you questions and then uses the answers to quickly and 
automatically complete the task for you.

To use a Financial Wizard
1 From the Tools menu, choose Financial Wizards. Then choose the wizard you want to use.
2 Follow the instructions and answer the questions provided by the wizard.

Choose Next to move to the next screen.
Choose Cancel to quit the wizard.
Choose Back to move back one screen.

________________
See also

Using the Loan Calculator 
Using the Mortgage Planner
Using the Retirement Planner
Using the Savings Calculator
Using the Interest Estimator
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Using the Mortgage Planner 

You can use the Mortgage Planner to compare two real estate loans or to explore 
refinancing an existing mortgage.
By providing a comparison of total initial costs, regular payment amounts, and total interest
amounts, the Mortgage Planner can help you decide which mortgage is best for you.

To use the Mortgage Planner
1 From the Tools menu, choose Financial Wizards. Then choose Mortgage Planner.
2 In the Mortgage Planners screens, read the information or answer the questions provided

by the wizard. Then, choose the Next button to move to the next screen.
If you want to exit the wizard, choose the Cancel button. To move back one screen, 
choose the Back button.

3 After you finish reviewing the Summary screen, choose the Done button to exit the 
Mortgage Planner.

Note    You can use the Copy button to copy the mortgage comparison information to the 
Clipboard. You can then paste it into other Microsoft Windows applications, such as Notepad
or Word for Windows.
________________
See also

Using the Financial Wizards
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Using the Savings Calculator

You can use the Savings Calculator to plan a savings strategy for a planned purchase or for 
building a cash reserve. 

To use the Savings Calculator
1 From the Tools menu, choose Financial Wizards. Then choose Savings Calculator.
2 In the Savings Calculator screen, type an amount in all the boxes except the one for 

which you want the wizard to calculate a value.
3 Choose the Calculate button.

The wizard calculates the value you want.
4 Choose the Inflation button to see how inflation affects your regular contributions and 

the final savings goal.
5 Choose the Cancel button to exit the Savings Calculator.
Note    You can use the Copy button to copy your savings strategy to the Clipboard. You can
then paste this information into other Microsoft Windows applications, such as Notepad or 
Word for Windows.
________________
See also

Using the Financial Wizards
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Using the Retirement Planner

You can use the Retirement Planner to see exactly how much you'll need to save every 
month in order to meet your retirement income goals.

To use the Retirement Planner
1 From the Tools menu, choose Financial Wizards. Then choose Retirement Planner.
2 In the Retirement Planner screens, answer the questions and then choose the Next 

button to move to the next screen.
If you want to exit the wizard, choose the Cancel button. To move back one screen, 
choose the Back button.

3 When you've answered all the questions, choose the Done button to exit.
Tip    You can also use the Retirement Planner to estimate the regular contributions you 
need to make to reach your college savings goal. In the Current Age, Retirement Age, and 
Life Expectancy Age fields, just type the students current age, the students age when 
starting college, and the students age at the time of graduation. Then go through the rest 
of the wizard giving information for your college savings instead of retirement savings.
Note    You can use the Copy button to copy the summary information for your retirement 
or college savings to the Clipboard. You can then paste it into other Microsoft Windows 
applications, such as Notepad or Word for Windows.
________________
See also

Using the Financial Wizards
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Using the Interest Estimator

You can use the Interest Estimator to estimate the amount of interest a Bank Account has 
earned or the interest you owe on a Credit Card Account.

To use the Interest Estimator
1 From the Tools menu, choose Financial Wizards. Then choose Interest Estimator.
2 Fill in all boxes in the Interest Estimator screen.
3 Choose the Calculate button.

In the blue box in the lower right corner of the screen, Money displays the estimated 
amount of interest for the account you've chosen.

Note    You can use the Copy button to copy the Estimated Interest Amount to the 
Clipboard. You can then paste it into any amount field in Money by positing your cursor in 
the chosen field and choosing Paste from the Edit menu, or pressing SHIFT+INSERT.
________________
See also

Using the Financial Wizards
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Introduction to Money Accounts

Microsoft Money has five basic types of accounts:
Bank Accounts -- for savings or checking accounts
Credit Card Accounts -- for charge accounts
Cash or Other Accounts -- for out-of-pocket expenditures and petty cash
Asset Accounts -- for personal property, or amounts that are owed to you other 

than amortized loans
Liability Accounts -- for amounts you're paying in a few installments (such as with 

insurance premiums), quarterly taxes payable, or other amounts you owe, other than 
amortized loans
In addition to the five basic account types, Money also has:

Loans -- for amortized loans, such as home mortgage loans, car loans, and school 
loans. 

Investment Accounts -- for stocks, bonds, CDs, money markets, mutual funds, and 
T-bills.
________________
See also

Setting Up a Bank Account
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Setting up a Bank Account

Before starting, you'll need your checkbook or savings book and your most recent bank 
statement.

To set up a new Bank Account
1 From the Lists menu, choose Account List.
2 Choose the New button.
3 In the Account Name box, type the name you want for the new account.
4 Choose the Bank button.
5 Choose the OK button.
6 In the Opening Balance box, type the ending balance from the statement, and choose 

the OK button.
You can change the opening balance later, if necessary.

7 If you want, enter the information shown in the table below in the Account List dialog 
box.

8 Choose the Close button, or choose the New button again to add another account.
Once you've set up the account, enter all transactions that have not yet cleared the 
bank.

In this 
box...

You can 
enter...

Shortcut A shortcut 
name for the 
account.

Opening
Balance

A new 
opening 
balance.

Bank 
Name

The name of 
your bank.

Account 
Number

The account 
number.

Minimu
m 
Balance

The minimum
balance for 
this account.

Comme
nt

Any 
additional 
information, 
such as the 
bank's 
address or 
phone 
number.

________________
See also

Changing the Account Opening Balance
Entering a Transaction in the Account Book
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Switching Between Accounts

To switch to another account
From the Account box on the toolbar, choose the account you want to view.

________________
See also

Displaying Multiple Accounts
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Balancing or Reconciling an Account

To balance an account
1 If you're in the Account Book or Account Forms window, click the Balance Account button 

or choose Balance Account from the Tools menu.
2 If you are displaying more than one account, in the Select Account dialog box, choose the

account you want to balance, and then choose the Continue button.
If you are balancing a Cash, Asset, or Liability Account, the Adjust Account Balance dialog
box is displayed. If you want, simply enter an adjustment. Or, if you want to verify each 
transaction, choose the Balance button. 

3 In the Statement Date box, type the ending date for the period covered in your bank 
statement.

4 In the Starting and Ending Balance boxes, type the starting and ending balances from 
your bank statement.

5 Under Service Charge and Interest Earned, boxes, type the amounts from your 
statement. You can also assign a category and subcategory for these transactions.

6 Choose the Continue button. Money will change the view to show only unreconciled 
transactions sorted by number and displayed in Top Line View.
Money compares the opening balance of the account plus all reconciled transactions with
the starting balance you entered when you started balancing. If these balances do not 
match, a warning will display. 

7 Use the ARROW keys to select each transaction that appears on your bank statement, and
then press the SPACEBAR key, or with the mouse, click in the C (Cleared) field. A "C" 
appears in the field. 
You can also clear a range of transactions by choosing the Mark Range as Cleared 
command from the Edit menu, entering dates in the From and To boxes, and choosing the
OK button.

8 When you've marked all transactions that have cleared the bank, choose the Finish 
button.
If there is no difference between the cleared balance and the statement balance, you'll 
see the Balance Account message, and the "C" in the C field for cleared transactions will 
be changed to an "R" to indicate a reconciled transaction. 
If the cleared balance and the statement balance are different, the Account Didn't 
Balance dialog box is displayed. There may be a number of reasons for a difference 
between the two balances. For more information, see Resolving Ending Balance 
Differences.
If the Starting Balance Adjustment dialog box is displayed, see Resolving Starting 
Balance Problems.

________________
See also

Marking a Transaction As Cleared or Reconciled
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Resolving Ending Balance Differences

If your account doesn't balance, you can:
Have Microsoft Money try to find the problem. Money will look for some common 

mistakes, such as transposed digits, a sign error, or a check entered as a deposit. Try this 
approach first.

Try to find the problem yourself by comparing each transaction against your 
statement, confirming that the opening balance is correct, and looking for missing 
transactions.

Make an adjustment to the balance.
Note      If you are using Bank On-Line, make sure that all transactions marked as cleared 
(C) in Money appear on your bank statement. If your statement does not show a 
transaction that is marked as cleared in Money (because it was processed after the 
statement date), you will need to unclear it.

To have Microsoft Money look for the problem
1 In the Account Didn't Balance dialog box, choose the Smart Reconcile option.
2 Choose the OK button.
3 If Money prompts you with possible solutions, choose the Yes or No button.

-Or-
If Money can't find the problem, in the Account Didn't Balance dialog box, choose the OK 
button to go back to reconciling the account.

To try to find the problem yourself
1 In the Account Didn't Balance dialog box, choose the Go Back To Reconciling The Account

option.
2 Choose the OK button.
3 When you have identified the problem and resolved it, choose the Finish button.

To make a balance adjustment
1 In the Account Didn't Balance dialog box, choose the Automatically Adjust the Account 

Balance option. 
Money determines the amount of the adjustment for you.

2 If you want, choose a category and subcategory for the adjustment.
3 Choose the OK button. Money will create a transaction to make the adjustment.
Note    If you don't want to finish balancing, choose the Postpone button.
________________
See also

Resolving Starting Balance Problems
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Resolving Starting Balance Problems

If you are prompted with the Starting Balance Adjustment message after reconciling, your 
Microsoft Money account records don't agree with the opening balance you entered from 
the bank statement. You can correct this by choosing one of the options listed in the 
message:

Go Back to Reconciling the Account
Choose this option if you want to correct the problem now.

Complete Reconciliation Without Correcting the Balance
Choose this option if you want to correct the problem later.

Automatically Adjust the Account Balance
Choose this option and enter a category if you want Money to enter an adjustment 
transaction to correct your records.

To adjust your starting balance
1 In the Starting Balance Adjustment dialog box, choose the Go Back To Reconciling The 

Account option.
2 Choose the OK button.
3 Mark any transaction you change as reconciled by pressing SHIFT as you click in the C 

field, or by pressing CTRL+SHIFT+M. Once a transaction is marked as reconciled, it will 
disappear from the register if the register is currently displaying only unreconciled 
transactions.

4 When you have identified the discrepancy and resolved it, choose the Finish button.
To finish reconciling without adjusting the starting balance

1 In the Starting Balance Adjustment dialog box, choose the Complete Reconciliation 
Without Correcting The Balance option.

2 Choose the OK button.
You'll probably still have the starting balance discrepancy the next time you balance the 
account.

To make a balance adjustment
1 In the Account Didn't Balance dialog box, choose the Automatically Adjust the Account 

Balance option.
2 If you want, choose a category and subcategory for the adjustment.
3 Choose the OK button. Money will create a transaction to make the adjustment.
________________
See also
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Marking a Transaction as Cleared or Reconciled

You can mark transactions as cleared or reconciled while in the Account Book.
Important    These commands are most useful for Liability, Asset, and Cash Accounts. For 
accounts you want to balance against a statement, such as checking, Savings, or Credit 
Card Accounts, it's best to use the Balance Account command. To reconcile your account 
using the Balance Account command, see Balancing or Reconciling an Account.

To mark a transaction as cleared
1 Select the transaction you want.
2 From the Edit menu, choose Mark As Cleared or press CTRL+M. A "C" will appear in the 

field.
To mark a transaction as reconciled

1 Select the transaction you want.
2 Hold down the SHIFT key as you click in the C field, or press CTRL+SHIFT+M. An "R" will 

appear in the field.
________________
See also
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Changing the Account Opening Balance

To change the opening balance in an account
1 If the account you want is not already displayed, choose it from the Account box on the 

toolbar.
2 From the Lists menu, choose Account List.
3 In the Opening Balance box, change the amount to the correct opening balance.
4 Choose the Close button.
Note    The ending balance in this account will be adjusted to reflect the change you made 
to the opening balance.
________________
See also
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Creating a Budget

You can set up or change your budget in two ways:
Automatically

Using AutoBudget, you can have a budget created for you. Microsoft Money averages the
income and expense transactions you've previously entered to create a budget.
When creating a useful budget to help manage your finances, it's best to have at least 
30 days of data entered.

Manually
You can create a budget by entering a constant yearly, monthly, or weekly amount for 
each income and expense category and subcategory. Or, for categories such as utility 
expenses that can vary widely from month to month, you can create a custom budget 
amount for each month.

To have Microsoft Money create a budget for you (AutoBudget)
1 From the Tools menu, choose Budget.
2 Choose the AutoBudget button.
3 In the Date Range box, specify the range of dates you want the data to be based on, or 

enter specific dates in the From/To boxes. Money will average your past transaction 
amounts during the date range you specify.

4 Under Round to Nearest, you can choose to not have the budget amounts rounded or to 
have them rounded to the nearest dollar, ten dollars, or hundred dollars.

5 Specify which categories and subcategories to create a budget for, by choosing one of 
the options described in the table below.

6 Choose the Create button.
To enter a constant budget amount for a category or subcategory

1 From the Tools menu, choose Budget.
2 Choose the category or subcategory you want to assign a budget amount to.

To have subcategories appear in the list indented under categories, choose the Show 
Subcategories option.

3 In the box to the right of the list of categories, choose the Yearly, Monthly, or Weekly 
option.

4 Type the amount you expect to spend or receive each year, month, or week.
5 Choose the Close button, or choose another category or subcategory to assign a budget 

amount to.
To customize a monthly budget amount for a category or subcategory

1 From the Tools menu, choose Budget.
2 Choose the category or subcategory you want to assign a budget amount to.
3 In the box to the right of the list of categories, choose the Custom By Month option.
4 Type the amounts you expect to spend or receive each month.
5 Choose the Close button. 

Choose To create a budget 
for

Only 
Categories
With No 
Budget

All categories and 
subcategories that 
currently have no 
budget assigned to 



them.
All 
Categories

All categories and 
subcategories.

Selected 
Categories

Selected categories 
and subcategories.

Only for... Only the category or 
subcategory that is 
specified in the Budget
dialog box.

________________
See also

Budget Reports
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Calculating Your Net Worth

A Net Worth Report summarizes what you own and what you owe.
If you have any loans or other liabilities, such as for a house, vacation property, rental 
property, car, boat, or other real asset, it's a good idea to include the value of these assets 
in Microsoft Money Asset Accounts. These Asset Accounts will offset your loans and 
liabilities when you figure your net worth.
Usually, you'll want your Asset Accounts (and Net Worth Reports) to reflect your cost basis 
-- your actual investment -- in each asset, rather than the asset's current market value. 
However, you can also make your Net Worth Reports reflect current market values.

To calculate net worth to reflect your cost basis
1 Create a separate Asset Account for each asset or group of assets.

Type 0 as the opening balance.
2 In the Asset Account, enter a transaction for the original cost of the asset. 

Enter the amount in the Increase column.
3 Repeat steps 1 and 2 for each asset you want to include in your net worth.
4 From the Reports menu, choose Net Worth Report.
5 If you want to include only certain accounts or loans, or customize the report in other 

ways, choose the Customize button.
To calculate net worth to reflect the current market value

1 Follow the instructions (above) to calculate net worth on a cost basis.
2 If the value of an asset has changed, enter an adjustment transaction in that Asset 

Account for the amount of the increase or decrease in value.
Or, if you prefer, set up a separate Asset Account for market adjustment transactions. 
This way, each time you do a Net Worth Report, you can decide whether or not you want 
to include the market adjustment account, and your other Asset Accounts will accurately 
reflect the cost basis.

3 From the Reports menu, choose Net Worth Report. 
4 If you want to include only certain accounts or loans, or customize the report in other 

ways, choose the Customize button.
________________
See also

Customizing and Remembering a Report
Net Worth Reports
Setting Up an Asset Account
Displaying Multiple Accounts
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Financial Wizards (overview)

A Financial Wizard is a tool that helps you accomplish some of the most common tasks in 
financial planning. Each wizard is named for what it can do for you. For example, the wizard
that calculates interest on an account is called the Interest Estimator.
To use a Financial Wizard, choose Financial Wizard from the Tools menu, and then choose 
the wizard you want.

Loan Calculator
You can use the Loan Calculator to explore loan alternatives or calculate unknown values,
such as interest, if you know the other values for the loan. For more information, see 
Using the Loan Calculator.

Mortgage Planner
You can use the Mortgage Planner to compare the costs of two real estate loans. You can 
use it when shopping for a mortgage or considering refinancing your existing mortgage. 
It's designed to help you compare two different mortgage loans of the same amount to 
decide which is best for you. For more information, see Using the Mortgage Planner.

Savings Calculator
You can use the Savings Calculator to plan for future purchases or building a cash 
reserve. For more information, see Using the Savings Calculator.

Retirement Planner
You can use the Retirement Planner to estimate your retirement income or see how much
you'll need to save now to reach your retirement goal. For more information, see Using 
the Retirement Planner.

Interest Estimator
You can use the Interest Estimator to estimate the amount of interest a bank account has
earned or the interest you owe on a credit card account. For more information, see Using 
the Interest Estimator.

________________
See also

Using the Financial Wizards
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Using the Windows Calculator

You can use the Windows Calculator in Microsoft Money and copy the results to an amount 
field.

To use the Windows Calculator
1 Click the Calculator button on the toolbar near the top of the window.

-Or-
From the Tools menu, choose Calculator.
-Or-
Press CTRL+K. This is the only way to bring up the calculator if the split transaction window
is open.

2 Enter the first number in the calculation.
3 Choose the operator you want to use in the calculation.

For example, if you are trying to add numbers, choose the plus sign (+) button.
4 Enter the next number in the calculation.

If you make a mistake, choose the Back button (or press the BACKSPACE key) to correct a 
few digits, or choose the Clear Entry (CE) button (or press DEL) to clear the entire 
number.

5 Enter any remaining numbers and operators.
6 Choose the equal sign (=) button.

-Or-
Press = (equal sign) or ENTER.
The result appears in the calculator display area.

To copy a value from the calculator's display area and paste it into Money
1 Press CTRL+C to copy the value.
2 Place the insertion point in the Money field, and press CTRL+V to paste the value.
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Using Your Own Calculator Program

You can run any program you want in place of the Windows Calculator by making a 
modification to the MSMONEY.INI file. This is the Microsoft Money initialization file that 
stores all your Microsoft Money settings.

To use a different program in place of the Windows Calculator
1 Quit Money by choosing Exit from the File menu.
2 Open your MSMONEY.INI file in a text editor such as Notepad. For information on using 

Notepad, see your Microsoft Windows documentation.
You will find MSMONEY.INI in the directory you installed Money in. Typically, the directory 
is named MSMONEY.

3 At the end of the MSMONEY.INI file, type: Calculator=
4 After the equal sign (=), add the path and file name of the program you want to run.

For example, if you want to run EXCEL, your entry might look like this:
Calculator=C:\EXCEL\EXCEL.EXE
Depending on the calculator program's features, you can type additional parameters to 
the right of the file name.

5 Once you've typed the path and file name, save the MSMONEY.INI file and start Money.
6 Click the Calculator button on the toolbar near the top of the window.

-Or-
From the Tools menu, choose Calculator.

To go back to using the Windows Calculator in Money
Delete the line, "CALCULATOR=" from the MSMONEY.INI file.
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Cash, Asset, and Liability Accounts

Cash Accounts

Setting Up a Cash or Other Account
Updating a Cash Account Balance
Recording Cash Withdrawals from Bank and Credit Card Accounts

Asset and Liability Accounts

Setting Up an Asset Account
Setting Up a Liability Account
Updating an Asset or Liability Account



Setting Up a Cash or Other Account

You can record your cash transactions in a checking or savings account, or, if you want to 
keep more detailed records of how you spend your cash, you can set up a Cash Account.

To set up a new Cash or Other Account
1 From the Lists menu, choose Account List.
2 Choose the New button.
3 In the Account Name box, type the name of the new account.
4 Choose the Cash or Other Account option.
5 Choose the OK button.
6 In the Opening Balance dialog box, type the amount of cash you have on hand.
7 Choose the OK button.
8 If you want, enter the information shown in the table below.
9 Choose the Close button.

Box Contents
Shortcut A shortcut 

name for 
the 
account.

Comment Any 
additional 
informatio
n about 
the 
account.

________________
See also

Entering a Transaction in the Account Book
Updating a Cash Account Balance
Recording Cash Withdrawals from Bank and Credit Card Accounts
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Updating a Cash Account Balance

It is not necessary to record every cash transaction. If you prefer, simply record the 
transactions you want to track, and assign them to categories or classification items. To 
account for the remaining cash transactions, make a periodic adjustment to the account 
balance.

To update your Cash Account balance
1 If you are displaying more than one account, switch to your Cash Account.
2 From the Tools menu, choose Balance Account.
3 In the New Ending Balance box, type the present balance.
4 In the As Of Date box, either accept the proposed date or type a different date.
5 If you want, choose a category for the adjustment.
6 Choose the OK button.

An adjustment transaction is created to balance the account.
Note    If you want to clear individual transactions and balance the account as you do a 
checking account, you can choose the Balance Account button.
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Recording Cash Withdrawals from Bank and Credit Card Accounts

Once you've set up a Cash Account, you can record a cash withdrawal from a bank or credit
card as a transfer to your Cash Account.

To transfer cash from another account
1 From the Account box on the toolbar, choose the account you've made the withdrawal 

from.
2 In the Number and Date fields, type the information as you would for any other 

transaction.
3 In the Payee field, enter Cash, or whatever you normally call a cash withdrawal.

If you always enter the same payee name for a cash withdrawal, you can create a 
register view to display all your cash withdrawal transactions.

4 In the Payment or Charge field, type the amount of the cash withdrawal.
5 In the Category field, type or choose Transfer.
6 In the Subcategory field, enter the name of the account you are transferring money into.
7 Press ENTER to complete the transfer.
________________
See also

Transferring Money Between Accounts
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Setting Up an Asset Account

You can use Asset Accounts to track changes in the value of your personal assets. For 
example, you might want to keep records of improvements that increase the value of your 
house. After you've created the Asset Account, enter each increase or decrease in value as 
a separate transaction.

Personal assets should not be confused with investment assets. For investment assets such
as stocks, bonds, CDs, T-Bills, Money Market Funds, and IRAs, you should create Investment
Accounts.

Use an Asset Account for:
 Antiques  Homes
 Cars  Stamp collections
 Boats

To set up an Asset Account
1 From the Lists menu, choose Account List.
2 Choose the New button.
3 In the Account Name box, type a name for the new account that describes the kind of 

assets or investments you plan to keep a record of.
4 Choose the Asset Account option.
5 Choose the OK button.
6 In the Opening Balance dialog box, enter the cost of the item(s). For example, if you 

purchased a house for $50,000, enter that amount as your opening balance.
7 Choose the OK button.
8 If you want, enter the information shown in the table below.
9 Choose the Close button.

Box Contents
Shortcut A shortcut 

name for the 
account.

Bank 
Name

The name of 
the bank 
managing 
the account, 
if any, or the 
brokerage 
company 
holding your 
stocks.

Account 
Number

The account 
number.

Comment Any 
additional 
information 
about the 
account, 
such as the 



name of the 
appraiser, or 
stock broker.

Minimum
Balance

A minimum 
balance for 
this asset, if 
applicable.

________________
See also

Updating an Asset or Liability Account
Introduction to Investments
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Setting Up a Liability Account

Use a Liability Account to track money you owe that you don't want to track in Loans. For 
example, money that you owe to a friend. Use Loans for tracking loans with a regular 
payment schedule, such as home mortgage loans.
After you've created the Liability Account, enter each increase or decrease as a separate 
transaction. 

To set up a Liability Account
1 From the Lists menu, choose Account List.
2 Choose the New button.
3 In the Account Name box, type a name that describes the liability you plan to keep a 

record of.
4 Choose the Liability Account option.
5 Choose the OK button.
6 In the Opening Balance dialog box, enter an opening balance. 

This is typically the amount you still owe and should be entered as a positive number.
7 Choose the OK button.
8 If you want, enter the information shown in the table below.
9 Choose the Close button.

Box Contents
Shortcut A shortcut name for 

the account.
Bank 
Name

The name of the 
bank providing the 
loan.

Account 
Number

The account number.

Minimum 
Balance

A minimum balance 
for this liability, if 
applicable.

Comment Any additional 
information about 
the account, such as
the name of the loan
officer.

________________
See also

Updating an Asset or Liability Account
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Updating an Asset or Liability Account

You can update an Asset or Liability Account in two ways.
Transfer funds to the Asset or Liability Account

For instance, to make a payment on a debt, you might enter a transaction and categorize
it as a transfer from checking to your Liability Account. This transfer would decrease your
Liability Account balance.

Directly enter a transaction in the Asset or Liability Account
For instance, to track an improvement to your home, you might enter a transaction 
directly into your Asset Account for the cost of the improvement.

To enter a change in the value of an asset
1 If you are viewing more than one account in Account Book or Account Forms, switch to 

your Asset Account.
2 Enter a new transaction with the change in value of the asset in the Increase or Decrease

field.
Don't change the amount of the original transaction. You might need a record of the 
original transaction for tax purposes.

3 In the Category field, type Market Adjustment.
4 Press the ENTER key.

To enter a change in the value of a liability
1 If you are viewing more than one account in Account Book or Account Forms, switch to 

your Liability Account.
2 Enter a new transaction with the increase in the amount you owe in the Increase field, or 

the decrease in the amount you owe in the Decrease field.
3 Press ENTER.

To update an account balance
1 If you are displaying more than one account, from the Account box on the toolbar choose

the account you want to update.
2 Click the Balance Account button on the toolbar, or from the Tools menu, choose Balance

Account.
3 In the New Ending Balance box, type the present value.
4 In the As Of Date box, accept the proposed date or type another.

You can assign a category and subcategory to the adjustment transaction.
5 Choose the OK button.

An adjustment transaction is created to balance the account.
If you receive a statement for the liability or asset, and you want to verify each 
transaction and balance the account against your statement, choose the Balance button 
instead of the OK button.

________________
See also
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Using Categories

Introduction

Introduction to Categories
Standard Income and Expense Categories

Using Categories and Subcategories

Creating a New Category or Subcategory
Assigning Categories to Transactions
Category List Reports
Using Categories to Track Tax Information

Managing Categories and Subcategories

Adding Information to Categories and Subcategories
Changing a Category's Type
Combining or Dividing Categories
Deleting Categories and Subcategories
Renaming Categories and Subcategories



Introduction to Categories and Subcategories

Income and expense categories are the key to organizing your finances, and subcategories 
help further refine your record keeping.

With categories and subcategories, you can:
See where your money is coming from and where it's going.
Budget income and expenses and compare budgeted amounts with actual amounts.
Track tax-related income and expenses.

Working with Categories

When you set up Microsoft Money, you probably chose to start with Money's standard set of
categories. You can add, delete, and modify these built-in categories to meet your needs, or
you can start from scratch and create your own custom list of categories.
When entering a transaction, you can enter an existing category, or type in a new one for 
that transaction.

Working with Subcategories

Subcategories can be used together with categories to further refine the way you track 
income and expenses. For example, in the Automobile category you may want to use 
subcategories to track expenses such as gasoline, maintenance, and car payments.

Making Transfers, Splits, and Loan Payments

The Category and Subcategory fields are also used to make transfers, split transactions, 
and loan payments.
________________
See also

Creating a New Category or Subcategory
Assigning Categories to Transactions
Creating a New File
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Assigning Categories to Transactions

You can assign a category to a transaction as you enter it, or later. It's best to do it right 
away because then you can always get detailed reports and charts.

To assign a category to a transaction
1 Move to the Category field by pressing TAB or clicking the field.
2 Type a category name, or choose one from the list.
3 If you want to assign a subcategory, move to the Subcategory field and type a name or 

choose one from the list.
4 Press ENTER.
________________
See also

Adding Information to Categories and Subcategories
Creating a New Category or Subcategory
Deleting Categories and Subcategories
Renaming Categories and Subcategories

User's Guide
Chapters 1 & 3



Splitting a Transaction

You can split a transaction to assign an amount to more than one category. A split 
transaction can include transfers to another account.

For example, you can split a transaction for:
Depositing part of a check and taking some of it in cash.
Purchasing several items that you want to describe and keep track of separately.
Itemizing a credit card payment.
Itemizing your paycheck.
To split a transaction

1 Enter the number, date, payee, and amount as usual.
2 Click the Split Transaction button or choose Split Transaction from the Edit menu.
3 In the first line of the Split Transaction dialog box, enter the category, subcategory, 

description, and amount for the first portion of the split.
4 To move down one line, press TAB, or double-click the next line.
5 Repeat steps 3 and 4 to itemize each part of the split transaction. 
6 When you're finished, choose the Done button or press ALT+D.
7 If the unassigned amount is not zero, you're prompted to make an optional adjustment. 

Follow the instructions in the Adjust Split Amount dialog box. If you don't know what to 
do, choose the Help button.
Choose the option for how you want to resolve the unassigned amount. Then choose the 
OK button or press ENTER.

8 Press ENTER.
"Split" is displayed in the Category field.

Tip    If you have an unassigned amount you want to apportion between all the parts of a 
split transaction, press the F6 key. For example, if you have purchased several items and 
categorized them in a split transaction, you can apportion the sales tax between all of them
by pressing F6.
________________
See also

Entering a Deposit Less Cash
Itemizing a Paycheck Deposit
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Creating a New Category or Subcategory

You can create a category or subcategory while entering a transaction, or by choosing the 
Category List command from the Lists Menu. 

To create a new category or subcategory while entering a transaction
1 In the Category or Subcategory field, type a name for the new category. To create a 

subcategory, the Category field must be filled in.
2 Press TAB.

The Create New Category/Subcategory dialog box is displayed. You can change the name
or type of category or subcategory, and indicate whether you want it to be included on 
tax reports.

3 Choose the OK button.
To create a new category or subcategory using the Category List command

1 From the Lists menu, choose Category List.
2 If you're creating a subcategory, first choose the category to which it will belong in the 

Category List box.
3 Choose the New button below the Category List for a new category, or choose the New 

button below the Subcategory List for a new subcategory.
4 In the Name box, type a name.
5 For a new category, under Type, choose Income or Expense.

If you are creating a new subcategory, you can't choose a Type. However, you can 
change the category it belongs to in the Subcategory For box.

6 Choose the Include on Tax Reports check box if you want the category to be included on 
tax reports.

7 Choose the OK button to create the new category or subcategory.
8 In the boxes to the right of the Category List, enter the information you want. See the 

table below for more details about these options.

Choose If you want 
to

Shortcut Type a 
shortcut name
for the 
category or 
subcategory. 
This will allow 
you to type 
the shortcut, 
instead of the 
complete 
category 
name.

Comment Type 
additional 
information 
you want to 
remember 
about the 
category.



Include On Tax 
Reports

Include (x), or 
not include 
(blank), the 
category on 
tax reports.

Tax Form Associate the 
category or 
subcategory 
with a specific 
tax form.

Tax Form Line Associate the 
category or 
subcategory 
with a specific 
line of the tax 
form.

Tax Form Copy Associate the 
category with 
multiple 
copies of the 
same tax 
form. Then 
type the 
number of 
copies.

Budget button Create a 
budget based 
on your 
categories.

Investments 
button

Change the 
category or 
subcategory 
assigned to 
each type of 
investment 
activity.

________________
See also

Assigning Categories to Transactions
Adding Information to Categories and Subcategories
Creating a Budget

User's Guide
Chapter 12



Adding Information to Categories and Subcategories

To add information to a category or subcategory
1 From the Lists menu, choose Category List.
2 In the Category List box or Subcategory List box, choose the category or subcategory.
3 In the boxes to the right of the Category List, enter your changes. See the table below for

more information about these options.
4 Choose the Close button, or choose another category to customize.

Choose If you want 
to

Shortcut Type a 
shortcut name
for the 
category or 
subcategory. 
This will allow 
you to type 
the shortcut, 
instead of the 
complete 
category 
name.

Comment Type 
additional 
information 
you want to 
remember 
about the 
category.

Amount Assign a 
budget 
amount to the
category or 
subcategory.

Include On 
Tax Reports

Include (x) or 
not include 
(blank) the 
category on 
tax reports.

Tax Form Associate this 
category or 
subcategory 
with a specific
tax form.

Tax Form 
Line

Associate this 
category or 
subcategory 
with a specific
line of the tax 
form.



Budget Include this 
category in 
your budget.

Investments Change the 
category or 
subcategory 
assigned to an
investment 
activity.

________________
See also

Renaming Categories and Subcategories
Using Shortcuts
Creating a Budget
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Using Categories to Track Tax Information

You can specify which categories or subcategories are included in Tax Reports, and then 
create a Tax Report that includes only those categories.
To make exporting tax information into a tax software package easier, you can also 
associate a category or subcategory with a particular line on a Federal Income Tax form. 
This enables you to generate a Tax Form Report and export your Microsoft Money tax 
records directly into the correct lines in leading tax software packages. Or, you can simply 
print the Tax Form Report and use it to help you manually complete your tax forms.

To include or exclude a category from a Tax Report
1 From the Lists menu, choose Category List.
2 In the Category List box or the Subcategory List box, choose the category or subcategory.
3 Choose the Include On Tax Reports check box to include the category or subcategory in 

the Tax Report. Clear the check box to exclude it from a Tax Report.
4 Choose the Close button.

To associate a category or subcategory with a particular line on a federal 
income tax form (to include on a Tax Form Report)
1 From the Lists menu, choose Category List.
2 In the Category List box or the Subcategory List box, choose the category or subcategory.
3 Under Tax Form, choose the tax form you want to associate with the category or 

subcategory, or accept the tax form that Money proposes.
4 Under Tax Form Line, choose the name of the tax line that you want to associate with the

category or subcategory, or accept the tax form line that Money proposes.
5 In the Tax Form Copy box, if you need more than one copy of the selected tax form, type 

the copy number you want to associate with the selected category.
For example, if you and your spouse work and keep your records in the same Money file, 
you'll want separate categories for Wages and Salary.

________________
See also

Preparing for Taxes
Tax Reports
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Renaming Categories and Subcategories

When you rename a category or subcategory, the name will change in all transactions 
using that category or subcategory.

To rename a category or subcategory
1 From the Lists menu, choose Category List.
2 In the Category List box or the Subcategory List box, choose the category or subcategory.
3 Choose the Modify button.
4 In the New Name box, type the new name for the category or subcategory.
5 Choose the OK button.
6 Choose the Close button.
________________
See also

Combining or Dividing Categories
Deleting Categories and Subcategories
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Combining or Dividing Categories

If you find you have two categories used for the same thing, you can combine them. In 
order to more specifically track income and expenses you've been assigning to one 
category, you can also divide a category into two categories or subcategories.

To combine two categories into one
Note    When you combine two categories, you'll delete one and reassign its transactions 
to the other.

1 From the Lists menu, choose Category List.
2 In the Category List box, choose the category you want to delete.
3 Choose the Delete button.
4 If the category has any subcategories, choose the OK button to confirm the deletion.

If any transactions use the category, Microsoft Money will ask if you want to reassign the 
transactions to another category or subcategory.

5 Choose the category or subcategory to which you want to reassign the transactions.
6 Choose the OK button.

To divide a category
Note    When you divide a category, you'll first display all transactions that have been 
assigned to that category, and then reassign the transactions you want to a new 
category.

1 In the View box, choose A Category.
2 In the Category List, choose the category you want to divide.
3 Choose the OK button.
4 Move to the Category field in the first transaction where you want the new category.
5 Type a name for the new category, or choose an existing one from the list and press TAB.

If you are creating a new category, choose the OK button in the Create New Category 
dialog box.

6 Move to the next transaction that you want to assign to the new category and highlight 
the Category field.

7 Press SHIFT+ QUOTATION MARK ( " ) to copy the new category name into the transaction.
8 Repeat steps 6 and 7 for each transaction you want to assign to the new category.

Each transaction you reassign will disappear from the view.
________________
See also

Deleting Categories and Subcategories
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Deleting Categories and Subcategories

To delete a category or subcategory
1 From the Lists menu, choose Category List.
2 In the Category List box, choose the category or subcategory you want to delete.
3 Choose the Delete button.
4 If the category has a subcategory, choose the OK button to confirm the deletion.

If any transactions were assigned to the deleted category or subcategory, Microsoft 
Money asks you to choose a new category or subcategory to reassign the transactions 
to. You don't have to reassign the transactions to a new category or subcategory. 
However, if you want to include the transactions in Budgets, Views, or Reports, it's best 
to reassign the transactions.

5 Choose the OK button.
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Preparing for Taxes

Categories and subcategories simplify preparation of your taxes. If you assign all your 
transactions to categories and subcategories throughout the year, and mark those that 
relate to taxes to be included on tax reports, you can print a report with all your tax-related
income and expenses. This Tax Report can help you prepare your taxes.
You can also create a Tax Form Report in Microsoft Money. This report associates categories 
and subcategories with specific Federal Income Tax forms and tax form lines. You can print 
the report to help you complete your tax forms. 
If you plan to use a tax preparation package, you can export your Tax Form Report directly 
into it. If it uses standard Federal Income Tax forms and line numbers, and is compatible 
with Money, your Money tax records will be automatically assigned to the right lines in the 
tax preparation package.
________________
See also

Creating New Categories and Subcategories
Using Categories to Track Tax Information
Tax Reports
Exporting Reports
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Changing a Category's Type

If you accidentally created an income category that should be an expense category -- or an 
expense category that should be an income category -- you can change the category's 
type.

To change a category's type
Note    When you change a category's type, its subcategories automatically change to 
the new type.

1 From the Lists menu, choose Category List.
2 In the Category List box, highlight the category whose type you want to change.
3 Choose the Modify button.

Microsoft Money displays the Modify Category dialog box.
4 Under Type in the Modify Category dialog box, choose the category type you want.

If the Modify Category dialog box doesn't display the options for category type, you may 
have chosen a subcategory name instead of a category name. You should return to step 
2 and choose the category again.

5 Choose the OK button.
6 Choose the Close button.
________________
See also

Introduction to Categories and Subcategories
Assigning Categories to Transactions
Adding Information to Categories and Subcategories
Renaming Categories and Subcategories
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Standard Income and Expense Categories

This is a standard set of categories you can choose from when first starting Money or 
creating a new file. For a list of the tax form information assigned to these standard 
categories, see the topics below. You can print these files for easy reference by choosing 
Print Topic from the File menu in the Help screen.
________________
See also

Income Categories
Expense Categories

User's Guide
Chapters 1 & 3



Income Categories

Category/Su
b

Tax
Fla
g

Tax Form Tax-Form 
Line

Investment 
Income

Dividend T Schedule B Dividend 
income

Interest T Schedule B Interest 
income

Long-Term 
Capital Gain

T

Short-Term 
Capital Gain

T

Tax-Exempt 
Interest

Other Income T 1040 Other 
income-misc.

Alimony 
Received

T 1040 Alimony 
received

Gifts 
Received
Loan 
Principal 
Received
Lotteries T 1040 Prizes, 

awards, 
gambling

State & 
Local Tax 
Refund

T 1040 State and 
local refunds

Unemploym
ent 
Compensati
on

T 1040 Unemployme
nt 
compensation

Retirement 
Income

T

IRA 
Distribution
s

T 1099R IRA total 
distribution - 
taxable

Pensions & 
Annuities

T 1099R Pension total 
distribution - 
taxable

Social 
Security 
Benefits

T 1040 Soc. Sec. 
Income

Wages & T W-2 Salary



Salary
Bonus T W-2 Salary
Commission T W-2 Salary
Gross Pay T W-2 Salary
Overtime T W-2 Salary

________________
See also

Assigning Categories to Transactions
Introduction to Categories
Using Categories to Track Tax Information
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Expense Categories

Category/Su
b

Tax
Fla
g

Tax Form Tax-Form 
Line

Automobile
Gasoline
Maintenance

Bank Charges
Charitable 
Donations

T Schedule A Cash charity 
contributions

Child care T 2441 Child care - 
day care

Clothing
Education

Books
Fees
Tuition

Food
Dining Out
Groceries

Furnishings
Repairs

Gifts
Health care T Schedule A Medicine and

drugs
Dental T Schedule A Medicine and

drugs
Eye care T Schedule A Medicine and

drugs
Hospital T Schedule A Medicine and

drugs
Physician T Schedule A Medicine and

drugs
Prescriptions T Schedule A Medicine and

drugs
Housing

Maintenance
Mortgage 
Interest

T Schedule A Home 
mortgage 
interest

Mortgage 
Principal
Rent

Insurance



Automobile
Health Schedule A Medicine and

drugs
Homeowner'
s/Renter's
Life

Interest 
Expense

T

Job Expense T
Non-
Reimbursed

T

Reimbursed T
Leisure

Cable 
Television
Toys & 
Games

Loan Principal
Miscellaneous
Personal Care
Taxes T Schedule A Other taxes

Federal 
Income Tax

T W-2 Federal 
Withholdings

Local Income
Tax

T W-2 Local 
Withholdings

Other Taxes T Schedule A Other taxes
Real Estate 
Taxes

T Schedule A Real estate 
tax

Social 
Security Tax

T W-2 Soc Sec Tax 
Withholdings

State & Local
Taxes

T Schedule A State and 
local taxes

State Income
Tax

T W-2 State 
Withholdings

Utilities
Electricity
Heating 
Oil/Gas
Telephone
Water/
Sewer/
Garbage

Vacation
Lodging
Travel

________________
See also



Assigning Categories to Transactions
Introduction to Categories
Using Categories to Track Tax Information

User's Guide
Chapters 1 & 3





Making Changes to a Transaction

You can modify any of the transaction fields. If you change the amount of a transfer 
transaction in one account, the amount of the corresponding transaction in the account you
are transferring to or from will also change.

To make changes to a transaction
1 Move to the transaction you want to change.
2 Click the field you want to change or press TAB to move to the field.
3 Make the change you want.

If you change the amount of a reconciled transaction, your account may not balance the 
next time you reconcile it.
If you want Microsoft Money to warn you if you try to change a reconciled transaction, 
choose Options from the Tools menu, then choose General. Choose the Protect 
Reconciled Transactions check box.

4 Repeat steps 2 and 3 until the transaction is correct.
5 Press ENTER.

Depending on which field you change, the position of that transaction in the Account 
Book may move up or down to maintain the current sort order.

To undo changes to a transaction before pressing ENTER
Press ESC.

________________
See also

Entering a Transaction in the Account Book
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Voiding a Transaction

When you void a transaction, a record of the transaction is maintained, but the transaction 
amount is not included in the account balance.

To void a transaction
1 Select the transaction.
2 From the Edit menu, choose Void Transaction.

In a voided transaction, **VOID** is displayed in the Amount field, and "R" for Reconciled 
is placed in the C (Cleared) field.

To reinstate a transaction
1 Select the voided transaction.
2 From the Edit menu, choose Unvoid Transaction.
Note    If you void a transfer in one account, the corresponding transaction in the account 
you transferred to or from is also voided. Voiding any part of a split will void all parts of that
split. Unvoiding a transfer transaction or any of the items in a split transaction unvoids all 
related transactions.
________________
See also

Deleting or Removing a Transaction
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Deleting or Removing a Transaction

To delete a transaction
1 Select the transaction you want to delete.
2 Press DEL.

-Or-
From the Edit menu, choose Delete Transaction.

3 Choose the Yes button to confirm the deletion.
Note    Pressing DEL while you are making changes to a transaction will not delete it. Before 
deleting the transaction, you need to press ESC to cancel your edit.
If you delete one side of a transfer, the other side will also be deleted.
Tip    If you want to delete a transaction without getting a confirmation message, press 
CTRL+DEL.
________________
See also

Voiding a Transaction
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Copying or Moving Information

You can copy or move all or part of the information in a field from one transaction to 
another. Copying makes a duplicate without changing the original; moving removes the 
original information so you can insert it in a new place. 

To copy or move information from one field to another
1 Move to the transaction you want to copy or cut information from.
2 Click the field you want to copy or move, or press TAB to move to the field.
3 From the Edit menu, choose Copy to copy the information.

-Or-
From the Edit menu, choose Cut to move the information.

4 Move to the transaction you want to insert the information into.
5 Click the field where you want to insert the information, or press TAB to move to the field.
6 From the Edit menu, choose Paste.

To copy information from the last transaction you entered
1 Move to the field you want to copy information into.
2 Press SHIFT+QUOTATION MARK ( " ) to copy the contents from the same field in the last 

transaction you entered to this transaction.
For example, if you want to copy a memo from the last transaction you entered, move to 
the Memo field and press SHIFT+QUOTATION MARK ( " ).

User's Guide
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Creating Charts from Reports

Introduction

Introduction to Charts

Creating Charts

Creating a Chart
Choosing a Chart Type

Formatting Charts

Changing the Fonts on a Chart
Formatting a Chart

Copying and Printing Charts

Copying a Chart
Printing Charts



Introduction to Charts

A chart is a graphical representation of a report. In Microsoft Money you can create and 
customize three types of charts:

Bar charts
Line charts
Pie charts

A chart is based on the information in a report. To get the chart you want, you may first 
want to customize your report.
You can create charts from these kinds of reports: Summary, Tax, Budget, Net Worth, 
Income and Expense, Market Value, Performance, Price History, and some Transaction 
Reports. You cannot create charts from these kinds of reports: List Reports, Loan Reports, 
Capital Gains Reports, and some Transaction Reports.
Tip    Concentrate first on what information you want in your report, then on how you want 
to show that data in a chart.
________________
See also

Creating a Chart
Customizing and Remembering a Report
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Creating a Chart

Charts are based on Microsoft Money reports and make it easy to see relationships between
your income and expenses.

To create a chart
1 From the Reports menu, choose the report you want. The following reports can be 

charted: Summary, Tax, Budget, Cash Flow, Net Worth, Income and Expense, Market 
Value, Performance, Price History, and some Transaction Reports.
If the information in the report is not exactly what you want, choose the Customize 
button and customize the report.

2 From the row of buttons at the top of the report, choose the Chart button.
If you want to change the chart's type or layout, choose the Format button, then choose 
the options for the changes you want. If you want to change the chart's contents, choose
the Format button then the Customize Report button. You must customize the report to 
change the chart's contents.

________________
See also

Customizing and Remembering a Report
Formatting a Chart
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Choosing a Chart Type

Some types of charts are better than others at showing the meaning of the information in a
report.

Bar chart
Shows a variation over a period of time or draws comparisons between items.

Line chart
Shows trends or changes in data over a period of time.

Pie chart
Shows the relationship or proportions of parts to a whole. Good for highlighting a 
significant element.

To change a chart type
1 From the buttons at the top of the Chart, choose the Format button.
2 Under Chart Type, choose Bar, Line, or Pie.
3 Choose the OK button.
________________
See also

Formatting a Chart
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Changing the Fonts on a Chart

You can change the style and size of the lettering in a chart title and in the chart labels by 
changing the font.

To change the font on a chart
1 From the buttons at the top of the chart, choose Format.
2 In the Format Chart dialog box, choose the Fonts button.
3 In the Font box, choose the name of a font.
4 In the Size box, choose the size you want.

In the Sample box, you can see what the letters look like.
5 Choose the OK button.
Note    When you change the font, both the chart title and chart label are affected.
________________
See also

Formatting a Chart

User's Guide
Chapter 6



Formatting a Chart

Often, you can get a clearer picture of the meaning of a report by creating a formatted 
chart.
The formatting options vary with the kind of report.

To format a chart
1 From the buttons at the top of the chart, choose the Format button.
2 Under Chart Type, choose Bar, Line, or Pie.

If you chose a Pie chart, choose the type of Pie Labels you want: Percents or Dollar 
Amounts. These options are described in the table below.
If you chose a Bar chart for a Budget Report, choose the type of Bar Option you want: 
Clustered or Stacked. These options are described in the table below.

3 Choose from the other Format Chart options described in the table below.
The available choices will vary depending on the type of report you start with and which 
kind of chart you're formatting -- Bar, Pie, or Line.

4 After choosing all the Format Chart options you want, choose the OK button to view the 
chart.

5 If the chart is not exactly what you want, choose the Format button again and make the 
changes you want. If you're still unable to format the chart to show what you want, you 
may need to choose the Customize Report button and modify the report.

Format 
Chart 
Option

Descriptio
n

Show 
Legend

Displays a 
key or 
legend for 
the colors or
patterns on 
the chart.

Show 
Gridlines

Displays 
gridlines on 
the chart to 
make it 
easier to 
see the 
height of 
bars and 
lines.

Display 
Patterns 
Instead 
of Colors

Replaces 
chart colors 
displayed 
on-screen 
with 
patterns.

Print 
Patterns 
Instead 
of Colors

Uses black 
and white 
patterns 
instead of 



colors on 
printed 
charts.

Bar 
Chart 
Options 
(budget 
reports 
only)

Descriptio
n

Clustered Places 
related bars
next to each
other for 
easy 
comparison.

Stacked Stacks 
related bars
on top of 
each other. 

Pie Chart
Label 
Options

Descriptio
n

Percents Shows the 
labels for 
the sections
of the pie 
chart in 
percentages
.

Dollar 
Amounts

Shows the 
labels for a 
pie chart in 
dollar 
amounts.

________________
See also

Changing Fonts on a Chart
Customizing and Remembering a Report
Introduction to Charts
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Copying a Chart

You can copy a chart to the Clipboard to paste into another Windows application, such as a 
word processor.

To copy a chart to the Clipboard
1 Create the chart.
2 From the buttons at the top of the chart window, choose the Copy button.

The chart is copied to the Clipboard. You can now open another Windows application, 
such as Microsoft Word for Windows, and paste the chart into a document.

________________
See also

Creating a Chart
Printing Charts
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Using Classifications

Introduction

Introduction to Classifications

Setting Up Classifications

Creating a Classification
Creating Classification Items and Sub-items

Entering Classifications

Classifying a Transaction

Managing Classifications

Adding Information about Classification Items and Sub-items
Classification List Reports
Renaming a Classification and Classification Items
Deleting a Classification and Classification Items



Introduction to Classifications

If you own rental property, run a charity, or have separate projects, you might want to 
organize your records by more than just income and expense categories. Classifications let 
you do this.

Examples of classifications are:
Customers, clients, or projects
Properties
Type of expense -- business or personal

You can create up to two classifications. Each classification can contain both items and sub-
items -- a structure similar to categories and subcategories.
For example, if you own rental property, you might set up a Property classification with: 
Rental Property 1 as an item, and Apartments A, B, and C as sub-items; Rental Property 2 
as another item, and Apartments 1, 2, 3, and 4 as sub-items.
You can also use classifications as keywords to help organize your records based on 
particular events, or for specialized reports. For example, you could create a classification 
called "Vacations" for tracking all your vacation-related expenses.
Note    When you create a new classification, an extra line for entering classification items 
and sub-items is added to every transaction.
________________
See also

Creating a Classification
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Creating a Classification

You can create new classification items as you enter transactions, or by adding items to the
classification list available from the Lists menu.
When you create a classification, additional fields are added below the Category and 
Subcategory field in each transaction.

To create a custom classification
1 From the Lists menu, choose Other Classification.
2 In the Classification 1 box, choose the New button.

If you've already created one classification, choose the New button in the Classification 2
box.

3 In the New Classification dialog box, choose a name for the classification, or type a new 
one.

4 If you want to use sub-items in the classification, choose the Allow Sub-items check box.
5 Choose the OK button.

A Classification List dialog box is displayed, so you can create classification items and 
sub-items.

6 Choose the New button to create each item you want.
7 Choose the Close button.
________________
See also

Creating Classification Items and Sub-items
Classifying a Transaction
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Creating Classification Items and Sub-items

There are two ways to create a classification item or sub-item.
While entering a transaction

This is fastest; however, you can't add shortcuts or comments to your classification item.
From the Lists menu

This way you can add a shortcut and a comment to your classification item.
To create a new item or sub-item while entering a transaction

1 In the classification item or sub-item field, type the name you want for the new item or 
sub-item. Before creating a sub-item, you must enter an item name in the item field.

2 Press TAB to move to the next field.
Microsoft Money displays the Create New Classification dialog box.

3 Choose the OK button to add the new item or sub-item.
To create a new item or sub-item from the Lists menu

1 From the Lists menu, choose the List command for your classification, for example, 
Property List or Client List.

2 Choose the New button under the list of items or sub-items.
3 In the Name box, type a name.
4 If you are creating a sub-item, choose who or what it is a sub-item for, from the list of 

existing items.
5 Choose the OK button to create the new item or sub-item.

In the box to the right of the Item List, you can type a shortcut for quick entry, or a 
comment.

6 Choose the Close button.
________________
See also

Classifying a Transaction
Adding Information About Classification Items and Sub-items
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Classifying a Transaction

Once you have created a classification, a line is added to each transaction. You can classify 
a transaction as you enter transaction details, or you can do it later.

To classify a transaction
1 Move to the Item field below the Category  field that is labeled with the name of your 

classification.
2 In your Classification field, type an item name or choose one from the list.
3 If your classification includes sub-items, and you want to use one for this transaction, 

type a name in the Sub-item field or choose one from the list.
4 Press ENTER.
________________
See also

Creating a Classification
Creating Classification Items and Sub-items
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Adding Information About Classification Items and Sub-items

You can give items or sub-items shortcut names for quick entry in transactions or add a 
comment for reference. Shortcuts are useful if you have several items with similar names.

To add information for an item or sub-item
1 From the Lists menu, choose the List command for your classification.
2 In either list box, choose the item or sub-item.
3 In the box to the right of the list box, type a shortcut or comment.
4 Choose the Close button, or choose another item to customize.

User's Guide
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Renaming Classifications and Classification Items

To rename a classification
1 From the Lists menu, choose Other Classification.
2 In the Classification 1 or Classification 2 box, choose the Modify button.
3 In the New Name box, type a name.

You can also change whether the classification can have sub-items by choosing or 
clearing the Allow Sub-items box. If you clear this box, any existing sub-items will be 
deleted.

4 Choose the OK button.
5 Choose the Close button.

To rename an item or sub-item
1 From the Lists menu, choose the command for your classification -- for example, Project 

List.
2 In the Item or Sub-item list, choose the item or sub-item.
3 Choose the Modify button.
4 In the New Name box, type the name.
5 Choose the OK button.
6 Choose the Close button.

User's Guide
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Deleting Classifications and Classification Items

When you remove a classification, the item and sub-item information is deleted from each 
transaction. The classification list is also deleted. This does not affect the remainder of the 
transaction. You can also delete items and sub-items that you no longer need.

To delete a classification
1 From the Lists menu, choose Other Classification.
2 Choose the Delete button under the classification you want to delete.

Microsoft Money will ask you to confirm the deletion.
3 Choose the Close button.

To delete an item or sub-item
1 From the Lists menu, choose the List command for your classification.
2 In the Item or Sub-item list, choose the item or sub-item you want to delete.
3 Choose the Delete button.

If any transactions were assigned to the deleted item or sub-item, Money asks you to 
choose the item or sub-item you want to reassign the transactions to. You can leave this 
blank if you don't want to classify those transactions.

4 Choose the Close button.
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Credit Card and Charge Accounts

Introduction

Introduction to Tracking Credit Card Transactions

Setting Up

Setting Up a Credit Card Account

Making Payments and Reconciling

Making Credit Card Payments
Balancing or Reconciling Your Credit Card Account
Handling a Credit Card Through Your Checking Account



Introduction to Tracking Credit Card Transactions

A Credit Card Account can help you:
Keep an up-to-date record with a running balance by entering transactions from 

credit card receipts.
Balance your records against your credit card statement each month.
Track a large number of payees through your credit card charges.

You can enter new charges as you make them, or enter them all at once when you get a 
new statement. In either case, you'll pay your credit card bill from a Bank Account, such as 
checking, not from the Credit Card Account.
If you generally pay your credit card bill in full and you're not concerned about tracking any
unpaid balance, or to whom you made charges, you don't need to set up an account. You 
can track your credit card transactions using split transactions in your checking account.
________________
See also

Handling a Credit Card Through a Checking Account
Making Credit Card Payments
Setting Up a Credit Card Account
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Setting Up a Credit Card Account

Before starting, you'll need your most recent credit card statement.
To set up a new Credit Card Account

1 From the Lists menu, choose Account List.
2 Choose the New button.
3 In the Account Name box, type the name of the new account.
4 Choose the Credit Card option button.
5 Choose the OK button.
6 In the Opening Balance box, type the ending balance from your last credit card 

statement.
7 Choose the OK button.
8 If you want, enter the information shown in the table below.
9 Choose the Close button.

Once you've set up the account, enter all transactions that have not yet appeared on the
statement.

Box Contents
Shortcut A shortcut 

name for the 
account to 
speed entry.

Bank Name The name of 
the bank that 
administers 
your credit 
card.

Account 
Number

The account 
number for the 
credit card.

Credit Limit The amount of 
your credit 
limit.

Comment Any additional 
information 
about the 
account, such 
as the bank's 
address.

________________
See also

Handling a Credit Card Through Your Checking Account
Making Credit Card Payments
Balancing or Reconciling Your Credit Card Account
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Handling a Credit Card Through Your Checking Account

If you generally pay your credit card bill in full and you're not concerned about tracking any
unpaid balance, or tracking by payee, you can track your credit card transactions using 
split transactions in your checking account.

To track credit card payments and charges in your checking account
1 In the checking account from which you want to pay the bill, enter the check number, 

date, payee, and the amount of the payment.
To ensure that you use the same payee name consistently, choose the payee from the 
transaction's payee list.

2 Choose the Split Transaction button from the toolbar, or press CTRL+S.
3 For each item on your credit card statement, assign a category, type a description, and 

type the amount for that item.
If you've set up additional classifications, each split item will display an additional line 
that allows you to assign the split item to your classification as well as to a category.
If you don't want to itemize every expenditure, assign the remaining amount to a 
Miscellaneous category.

4 Choose the Done button.
5 Press ENTER.
Note    If you decide not to pay your entire credit card bill, you could enter the amounts 
from your statement as a split transaction and enter the remaining negative amount as a 
transfer to a Credit Card Account. When you pay back this amount, include it as a part of 
the split -- categorized as a transfer from the Credit Card Account.
________________
See also

Making Credit Card Payments
Splitting a Transaction
Printing Checks
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Making Credit Card Payments

You'll generally make credit card payments from a Microsoft Money Bank Account, such as a
checking account.

To make a payment when you have a separate Credit Card Account
1 In the Account Box, choose the Bank Account from which you want to pay (typically 

checking), and move to the blank transaction at the end of the register.
2 Begin entering a transaction as you would for any check, including the check number, 

date, payee, and the amount of the payment.
3 In the Category field, type transfer or choose it from the list.
4 In the Subcategory field, type the name of the account for this credit card or choose it 

from the list.
5 Press ENTER.
________________
See also

Printing Checks
Handling a Credit Card Through Your Checking Account
Setting Up a Credit Card Account
Splitting a Transaction
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Balancing or Reconciling Your Credit Card Account

To reconcile your statement with your records
1 Choose your Credit Card Account.
2 Enter transactions for any charges you have not previously entered.
3 From the Tools menu, choose Balance Account. Or, click the Balance Account button on 

the toolbar.
4 Enter the previous balance from your statement in the Starting Balance box, and enter 

the new balance from your statement in the Ending Balance box.
If the previous balance from your statement does not agree with the proposed starting 
balance, you may have forgotten to balance your account one month. You should go 
back and reconcile the previous month's statement before proceeding.

5 In the Statement Date box, type the closing date of your statement.
6 In the Service Charge and Interest Charged boxes, type the amounts from your 

statement. If you want, assign a category and subcategory for these expenses.
7 Choose the Continue button. This will change the view in the register to display only 

unreconciled transactions.
Microsoft Money will switch to Top Line View so you can see more transactions at one 
time. New transactions will automatically be added for any service charges or interest 
you entered.

8 Select each transaction that appears on your statement and press the SPACEBAR key to 
mark it as cleared; or with the mouse, click the C (Cleared) field.
You can also clear a range of transaction numbers by choosing the Mark Range As 
Cleared command from the Edit menu and entering the transaction numbers you want to
clear.
A "C" is displayed in the C field.

9 When you have cleared all the transactions that appear on your statement, choose the 
Finish button.
If the cleared balance and the statement balance are different, the Account Didn't 
Balance dialog box is displayed. There may be a number of reasons for a difference 
between the two balances. For more information, see Resolving Ending Balance 
Differences.

________________
See also

Introduction to Tracking Credit Card Transactions
Making Credit Card Payments
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Exit Microsoft Money

Closes Microsoft Money. Your work has automatically been saved. You will be prompted to 
save a backup copy of your work on a different disk as you exit Money, if you chose the 
Remind to Back Up on Close option.



Undo

Reverses last change in the current field in the transaction.



Cut

Removes the highlighted text from a field and places it on the Clipboard.



Copy

Copies the highlighted text or numbers from a field and places it on the Clipboard.



Paste

Pastes text or numbers from the Clipboard into the highlighted field.



Delete Transaction

Deletes the selected transaction. You will be asked to confirm that you want to delete the 
highlighted transaction. When deleted, the information will not be placed on the Clipboard.



Void/Unvoid Transaction

Marks the transaction as void and does not include the amount in the running balance. If 
the Transaction is already voided, Unvoid Transaction will be displayed in the Edit menu. 
Choosing Unvoid Transaction will then reinstate the transaction. This menu item is not 
available in the Future Transactions window.



Mark as Cleared/Uncleared or Reconciled/Unreconciled

Mark as Cleared/Uncleared

Marks a transaction that has appeared on a bank or loan statement as cleared or 
uncleared.

Mark as Reconciled/Unreconciled

Marks a reconciled transaction as unreconciled or marks a cleared or uncleared transaction 
as reconciled. This menu item is available when the SHIFT key is held down as the menu is 
chosen.



Mark Range as Cleared

Marks a range of account transactions as cleared. For example, if you are reviewing your 
bank statement and want to mark several checks as cleared, you can specify a range of 
check numbers to mark as cleared.



Go To Last Edited/Go To

In the Investment Summary and Future Transactions windows, the Go To Last Edited menu 
item takes you to the last transaction you edited. If there are no transactions to go to, the 
option will be unavailable. Microsoft Money only remembers the transactions you edit in 
that session.
In the Account Book, Account Forms, Loans, and Investment Summary windows, the Go To 
menu item goes to either the last transaction you edited, to the other side of a transfer, or 
to the main transaction for a split transaction. If there are no transactions to go to, the 
option will be unavailable.



Calculator

Brings up the Windows Calculator. You can bring up your own program by modifying your 
MSMONEY.INI file.
________________
See also

Using the Windows Calculator
What's In Your MSMONEY.INI File

User's Guide
Chapter 16



Loan Calculator

Brings up the Loan Calculator, which can be used to compare interest rates and other loan 
terms.
________________
See also

Using the Loan Calculator
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Postpone Balance

Available when balancing. Postpones balancing of an account. You can resume balancing at 
any time.



Finish Balance

Finishes balancing an account. If your account does not balance, Microsoft Money will 
suggest reasons for the problem and help you find the error.



Entire Transaction View/Top Line View

In the Account Book window
Entire Transaction View displays all the information for each transaction (memo, 

account, category, and classifications). 
Top Line View displays only the top line of each transaction. In this view, you see 

more transactions on the screen at one time, and you can scroll through them faster.

In the Loans window
Entire Transaction View displays all the information for each loan (memo, payee, and 

account). 
Top Line View displays the top line of each loan.



Cascade

Arranges all open windows in an overlapping pattern so that the title bar of each is visible.



Account Book

Switches to the Account Book window and brings it to the front.



Account Forms

Switches to the Account Forms window and brings it to the front.



Loans

Switches to the Loans window and brings it to the front.



Future Transactions

Switches to the Future Transactions window and brings it to the front.



Investment Details

Switches to the Investment Details window and brings it to the front.



Investment Summary

Switches to the Investment Summary window and brings it to the front.



Contents

Displays the index of online Help topics.



Keyboard Shortcuts

Provides a reference for all keyboard shortcuts in Microsoft Money.



Search

Lets you search through Help for an individual topic or subject area.



How To Use Help

Displays introductory information about how to access and use online Help.



Money Preview

Choose from a list of short demonstrations that introduce ways to organize your finances in 
Microsoft Money.



Transaction Cue Cards

The Transaction Cue Cards help you get started entering your checking or savings account 
records by providing guidance and useful tips as you enter your first few transactions.



Ordering Checks

Describes how to order check forms if you want to print checks from Microsoft Money. 
For more information on ordering checks, see the order form in the Microsoft Money 
package.



About Microsoft Money

Displays the product version number, copyright notice, and serial number.



Loan Payment Report

A Loan Payment Report displays the payment schedule for the life of the loan. It includes 
the transactions you've already paid (listed in the Loans window), and those you haven't 
yet paid (from the Loan Amortization Schedule).

To create a Loan Payment Report
1 In the Loans window, from the Loan box, choose the loan for which you want to create a 

report.
2 From the Reports menu, choose Loan Payment Report. The report is displayed in its own 

window.
3 If you want, you can choose from the buttons at the top of the Loan Payment Report 

window to Customize, Remember, Print, Export, or Close the window.
________________
See also

User's Guide
Chapter 25



Remembered Reports

Displays a list of any reports you have remembered (saved). From the list of remembered 
reports, you can choose the one you want to view, rename, or delete.
If this menu item is unavailable, you have not remembered any reports.

To remember a report
1 First create the report you want.

If you want, customize the report.
2 From the buttons at the top of the report, choose the Remember button.
3 In the Remember [Report Name] dialog box, accept or change the proposed name.
4 Choose the OK button. The report name is added to the list of Remembered Reports, 

under the Reports menu.
________________
See also

User's Guide
Chapter 6
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Converting Foreign Currencies

If you are converting foreign currencies in the Investment Details window, see the second 
of the two following procedures.

To convert foreign currency amounts to local currency
1 In a window or dialog box, type the amount you spent or received in foreign currency in 

the amount field.
For example, if you reside in the United States but made a purchase in Canada, you 
would type the amount you spent in Canadian dollars.

2 Make sure the insertion point is in the amount field, then press the F8 key to bring up the 
Currency Converter dialog box.

3 The Foreign Amount box will display the number you typed in the amount field. If this 
field is blank, type the foreign currency amount you want to convert to local currency.

4 In the Foreign Currency list box, choose the currency you are converting from.
In the example of making a purchase in Canada, you would choose Canadian Dollar.

5 Depending on which exchange rate you know, choose Local Units For Each Foreign Unit 
or Foreign Units For Each Local Unit.
For example, if you know that $.8425 in the U.S. is equal to $1.00 in Canada, then 
choose Local Units For Each Foreign Unit. That is, .8425 local units for each foreign unit.

6 In the Exchange Rate box, type the exchange rate at the time you made the purchase, or
exchanged cash at the bank.
In our example, you would type 0.8425.

7 Choose the OK button.
The number in the amount field will convert to the local currency based on the 
information you supplied.

Note    If you made a purchase with a credit card, you can wait until you get your statement
to make an adjustment. Make an adjustment in the Account Book for the exact amount 
shown in the statement.

To convert foreign currencies in the Investment Details window
1 Enter your investment activity, leaving the Price field blank.
2 In the Total field, type the amount you spent or received in foreign currency.

For example, if you reside in Australia, but purchased stock in the U.S., you would type 
the amount you spent in U.S. dollars.

3 Press the F8 key to bring up the Currency Converter dialog box.
The Foreign Amount box will display the number you typed in the amount field.

4 In the Foreign Currency list box, choose the currency you are converting from.
In the example of making a purchase in the U.S. you would choose the US Dollar.

5 Depending on which exchange rate you know, choose Local Units For Each Foreign Unit 
or Foreign Units For Each Local Unit.
For example, if you know that $1.5 in Australia is equal to $1.00 in the U.S. then choose 
Local Units For Each Foreign Unit.

6 In the Exchange Rate box, type the exchange rate at the time the transaction took place.
In our example, you would type 1.5.

7 Choose the OK button.
The number in the Total field will convert to the local currency, and the amount in the 
Price field will automatically be entered when you complete the transaction.



________________
See also

Updating Currency Exchange Rates

User's Guide
Chapter 16



 Updating Currency Exchange Rates

You can view and update all your currency exchange rates at once in the Currency List. You 
can also add new currencies to the list or delete ones you don't need.

To update a currency's exchange rate
1 From the Lists menu, choose Currency List.
2 In the Currency List box, highlight the currency whose exchange rate you want to 

change.
3 In the Display Exchange Rate As box, choose an option depending on which one you 

know.
For example, if you know that there are .80 local units for each foreign unit, choose Local
Units For Each Foreign Unit; however, if you know that there are 1.25 foreign units for 
each local unit, then choose Foreign Units For Each Local Unit. Either way, the exchange 
rate will produce the same result.

4 In the Exchange Rate box, type the new exchange rate.
5 Continue steps 2 through 4 until you have updated all the exchange rates you want.
6 Choose the Close button.
________________
See also

Converting Foreign Currencies

User's Guide
Chapter 16





Glossary

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

401(k) Plan
A
Account box
amortization
annotation
Annual Percentage Rate
annual return
annuity



application
archive
asset
Associated Cash Account
ATM
B
balance
Balance Account button
balloon payment
Bank On-Line
bond
bookmarks
broker
brokerage account
C
Calculator button
capital gain
capital gains distribution
capital loss
category
CD (Certificate of Deposit)
choose
classification
cleared transaction
Clipboard
commission
Control menu
cost basis
D
dialog box
discount bond
disk
dividend
drag
drive
E
enter
Enter Due Transactions button
Entire Transaction View button
export
F
face value
field
FIFO (First In, First Out)
Financial Wizard



Find button
frequency
Future Transaction
G
Ginnie Mae
H
highlight
I
icon
import
inflation
interest
interest rate
investment
Investment Account
IRA (Individual Retirement Account)
item
K
Keogh
L
liability
load
loan
lot
M
market value
maturity date
Maximize button
menu bar
Minimize button
modem
money market fund
municipal bond
mutual fund
N
net asset value (NAV)
net worth
O
offer price
On-Line Services
opening balance
opportunity cost
options
P
par value



Pay On-Line
payee
percentage unrealized gain or loss
postdated check
preferred stock
principal
Q
Quotes On-Line
R
realized gain or loss
reconcile
reconciled transaction
record transaction
Remind When Due button
reminder
RRSP (Registered Retirement Savings Plan)
S
savings bond
scroll
scroll arrow
scroll bar
scroll box
security
shortcut
Simplified Employee Pension (SEP)
SmartFill
Split Transaction button
split
stock dividend
stock split
stock symbol
stock
sub-item
subcategory
SuperSmartFill
T
tax-exempt
title bar
Toolbar buttons
Top Line View button
transaction
transfer
transfer account
treasury bill (T-bill)
treasury bond



treasury note
U
unrealized gain or loss
V
view
void



Account box      
Located in the toolbar under the menu bar. Click the Account box arrow or press ALT+A to 
see the Account box list.



archive
To copy a file into an archive file and remove specified transactions from the current file. 
Everything related to those records is copied into this file, including reconciled transactions,
account, category, classification, payee, and budget information.



balance
The sum of all transactions in an account, as of a particular date. The running total of an 
account.



Balance Account button      
Located in the toolbar under the menu bar. Click this button to reconcile a Microsoft Money 
Account or Loan against a statement.



Bank On-Line
Lets you electronically update your bank or credit card records, transfer funds between 
accounts, check your current balances, send inquiries, and order new checks -- just like 
working with a bank teller.



Calculator button      
Located in the toolbar under the menu bar. Click this button when you want to use the 
Windows calculator.



category
An income or expense label that you assign to organize transactions, for example, Housing 
or Insurance. You can create a category of your own, or use one of the standard Microsoft 
Money categories.



choose
To choose an option or item.

    With the mouse, point and click.

    With the keyboard, press ALT and the underlined letter, or use the ARROW KEYS until 
the item is highlighted and then press ENTER. Within a dialog box, press TAB to move to an 
option and press the SPACEBAR to choose it.



classification
Use in addition to income and expense categories to further organize transactions. For 
example, transactions can be organized by client, project, or any other classification.



cleared transaction
A transaction that is listed on a bank, credit card, or loan statement. In Money, the letter 
"C" in the C (Cleared) field indicates a cleared transaction. Credit Card Accounts use the 
letter "R" (reconciled) to signify cleared transactions.



disk
A place for permanently storing information such as the files needed to run an application 
or the files that contain your work. This term, unless specified, can refer to your computer's
internal hard disk or to a floppy disk that can be inserted into your computer's A or B drive.



drive
A storage place for information for operating applications and the contents of the files you 
create. Usually, your computer's hard drive is drive C. If you have one or two slots for 
inserting floppy disks, the first slot is usually considered drive A and the second drive B. 
This may vary depending on the type of computer you have and the way it's set up.



enter
To choose an item from a list or type your own selection in a dialog box or Microsoft Money 
Window.
To create a record of an activity or transaction.



Enter Due Transactions button      
Located in the toolbar under the menu bar. Click this button to enter the selected Future 
Transaction into the Account Book.



Entire Transaction View button    
Located in the toolbar under the menu bar. Click this button to display all lines of 
information for each transaction.



export
To copy the information or data from a report into a file. You can then import the file into a 
tax preparation program, a word processor, or a spreadsheet.



field
A single area in a transaction where you enter information, for example, a date or a payee 
name.



Financial Wizard
A Microsoft Money tool that helps you accomplish some of the most common tasks in 
financial planning. Each wizard is named for what it can do for you. For example, the wizard
that calculates interest on an account is called the Interest Estimator.
To use a Financial Wizard, choose Financial Wizard from the Tools menu, and then choose 
the wizard you want.



Find button      
Located in the toolbar under the menu bar. Click this button when you need to search for a 
specific transaction.



frequency
The rate at which recurring transactions take place, for example, weekly or quarterly.



Future Transaction
A feature that lets you get a reminder when a transaction is due and then have it entered 
automatically into the appropriate account, after you've made any changes.



highlight
To select an item by pointing and clicking with the mouse, or by pressing the UP ARROW key 
or the DOWN ARROW key.



import
To insert a file or piece of data from another application, such as Quicken. You can import a 
file by using the Import command on the File menu.



item
Part of a classification. For example, if you set up a property classification, an item could be
116 Almenar Drive (the address of the property).



modem
Short for modulator/demodulator, a communications device that enables a computer to 
send or receive information over a standard telephone line, typically at speeds ranging 
from 300 to 9600 bits per second (bps).



Pay On-Line
Lets you pay bills electronically to anyone in the U.S. (with limited exceptions).



payee
The individual or business a check is written to or from.



postdated check
A check written using a future date.



Quotes On-Line
Lets you electronically download the most recent closing prices for stocks and mutual 
funds.



reconcile
The process used to verify that all transactions that have cleared the bank (shown on your 
statement) are properly recorded in Money.



reconciled transaction
A transaction that is listed on a bank statement and has been checked by Microsoft Money 
against your records. In Money, the letter R in the C (Cleared) field indicates a reconciled 
transaction.



record transaction
To record a Future Transaction into the Account Book.



Remind When Due button      
Located in the toolbar under the menu bar. Choose this button to copy the selected 
transaction into the Future Transactions window. You will then get a reminder the next time 
the bill is due.



reminder
A message telling you that transactions you entered in Future Transactions are nearly due.



schedule
To assign a transaction to a specific date in the future.



scroll arrow       
An arrow at either end of a scroll bar that is used to move the contents of a window or list 
box. 



scroll bar      
A bar that appears at the right and/or bottom edge of a window or list box. Each scroll bar 
contains two scroll arrows and a scroll box, which you click in order to scroll within the 
window or list box.



scroll box      
A box in a scroll bar. The scroll box shows the position of what's currently in the window or 
list box relative to the contents of the entire window or box. When you scroll up or down the
window using the scroll box, information about the current transaction is displayed on the 
message bar.



shortcut
A shorter name you can assign to categories, classes, accounts, and payees for quick entry.



SmartFill
The automatic filling in -- after three or more letters have been typed -- of a payee, 
category, classification item, or account name you have used before.



split 
To divide a transaction into two or more parts. You can split a transaction according to 
existing categories or classifications, or you can give each part its own description. 
This is the Split Transaction button:      



Split Transaction button    
Located in the toolbar under the menu bar. Choose this button to divide a transaction into 
two or more parts according to existing categories or classifications or to give each part its 
own description.



sub-item
A subset of an item in a classification. For example, a sub-project in a project classification.



subcategory
A subset of an income or expense category (a label you assign to organize transactions). 
For example, for a category called Utilities, you could have a Water subcategory and an 
Electric subcategory.



SuperSmartFill
When you enter a payee name you have used before, the amount, memo, category, 
classification item, and account fields from the last transaction using that payee are 
automatically filled in.



toolbar buttons
These are located under the menu bar and provide quick access to Microsoft Money 
commands.

Balance Account button
Click this button to reconcile a Money Account or 
Loan against a statement.
Calculator button
Click this button when you want to use the 
Windows Calculator.
Entire Transaction View button
Click this button to display all lines of information 
for each transaction.
Enter Due Transactions button
Click this button to enter the selected Future 
Transaction into the Account Book.
Find button
Click this button when you need to search for a 
specific transaction.

 Remind When Due button
Choose this button to copy the selected transaction
into the Future Transactions window. You will then 
get a reminder the next time the bill is due.
Split Transaction button
Choose this button to divide a transaction into two 
or more parts according to existing categories or 
classifications or to give each part its own 
description.
Top Line View button
Click this button to display only one line of 
information for each transaction.

Top Line View button     
Located in the toolbar under the menu bar. Click this button to display only one line of 
information for each transaction.



transfer
A movement of money between accounts. You can enter a transfer transaction in an 
account by entering the word "Transfer" in the Category field and then entering the name 
of the other account in the Subcategory field.



transfer account
The account specified in the Transfer From/To field of the Investment Details window that 
provides or receives funds from investment revenues and expenses.



view
The set of transactions you're displaying, and the order in which they're displayed.



View box      
Located in the toolbar under the menu bar. Click the View box arrow or press ALT+V to see 
the View box list.



dialog box
A window that displays options for you to review or change things that are specific to what 
you are currently doing in Microsoft Money. A dialog box is your way of "conversing" with 
Money.



scroll
Sometimes you need to scroll to see all the information in your register, the Help window, 
or a window containing another application. The vertical scroll bar is always available, and 
the horizontal scroll bar appears when the information is wider than the window. To scroll, 
click on one of the arrows at either end of the scroll bar. 
If you use the scroll box in the vertical scroll bar to scroll up or down Microsoft Money 
windows, the message bar displays the information about the current transaction.



icon
A graphical representation of various elements in Microsoft Money, such as tools on the 
toolbar. The Microsoft Windows(TM) operating system also uses icons to represent 
applications.



application
Software designed to help you perform specific tasks. For example, Microsoft Money is a 
personal finance application which helps you manage your accounts and print checks. 
There are hundreds of different applications that help you do everything from creating 
spreadsheets to drawing pictures.



annotation
A note or comment you can add to a Help topic by choosing Annotate from the Edit menu 
of Help.



bookmark
Just as you can place bookmarks in a book to mark specific places, you can place 
bookmarks in Help topics you use frequently. Help puts the titles of those topics in a special
list you can read by choosing the Bookmark menu.



drag
You may need to drag the mouse to complete a procedure in Microsoft Money.

    To drag the mouse
1 Position the mouse pointer at the location specified by the procedure.
2 Hold down the appropriate mouse button as you move the mouse.

You should always hold down the left mouse button unless the right mouse button is 
specified for the procedure.

3 Release the mouse button when you're finished moving the mouse.



Control menu      
The menu appearing on every application that runs in a window. The Microsoft Money 
Control menu is located in the upper left corner of the window and has commands that 
move, change the size of, and close the window, and switch to applications running in other
windows.



title bar
The horizontal bar at the top of the window above the menu that contains the title of the 
application or dialog box. On many windows the title bar also contains the Control menu 
box in the left corner and the Maximize and Minimize buttons in the right corner.



Maximize button      
If you do not need to see other windows, you can maximize the one you are currently 
working in by clicking on the Maximize button in the upper-right corner of the window. The 
maximize arrow is pointing up. The window expands to fill the entire screen. To minimize 
the window, click the down arrow.



Minimize button      
It is possible to have more than one Windows application open at the same time. To work in
another application, you can minimize the application in which you are currently working by
clicking on the Minimize button in the upper-right corner of the window. The minimize arrow
is pointing down. The window shrinks into an icon that represents the application. To work 
in an application that you have minimized, double-click the icon.



Transaction
Any deposit, transfer, purchase, withdrawal, or other action you take in an account or loan.



menu bar
The horizontal bar at the top of the window containing the names of all of the Microsoft 
Money menus. The menu bar appears below the title bar.



Clipboard
A temporary, invisible storage area for cut or copied information. You can paste the 
contents of the Clipboard into another account or into another Windows application. The 
Clipboard will hold only one item at a time.



Opening balance
The beginning balance for a Microsoft Money account. Usually, you type a positive number 
for the opening balance -- even for a Credit Card or Liability Account.

Bank Account
Ending balance from most recent statement.
Credit Card Account
Ending balance from most recent statement.
Cash or other Account
Amount of cash on hand.
Asset Account
Original purchase cost of asset, or zero if you want to record its purchase as an expense.
Liability Account
Amount you currently owe, or zero if you want to record the amount owed as income.
Investment Associated Cash Account
Zero if you plan to enter a transfer transaction for the original cash deposit; otherwise, the 
amount of the original cash deposit.



Associated Cash Account
A Microsoft Money term for the cash portion (usually a money market) of a brokerage 
account. You use the cash in this account to buy your investments. You can also deposit 
cash from investment sales and profits into this account.
For example, your Investment Account may consist of stock, some CDs, a T-bill, and $5,000 
in the Associated Cash Account.
Associated Cash Accounts allow check writing and are listed as Bank Accounts that are 
linked to an Investment Account.

Investment Accounts that typically have an Associated Cash Account
    Brokerage accounts and other 

institutional accounts

Investment Accounts that typically don't have an Associated Cash Account
    401(k)s     SEPs
    Keoghs     Other retirement 

accounts
    IRAs     Personally held 

investments
Note    As with other Cash Accounts, you can view an Investment Account's Associate Cash 
Account in the Account Book by choosing it from the Account box on the toolbar.



Investment Account
A Microsoft Money account type specifically tailored for investment record keeping. 
Generally, you'll set up one Investment Account for each account from which you receive a 
periodic statement. You'll then add individual Investments to this Investment Account.



void
To keep a record of a transaction but not include the transaction amount in the account 
balance. You can void a transaction when, for example, you stop payment on a check. 





401(k) Plan
A retirement plan to which contributions are made by employees and (sometimes) 
employers. Money an employee contributes to or earns from a 401(k) isn't taxed, but any 
money taken out of a 401(k) is.



amortization
The process of repaying a loan. An amortization schedule shows the division of principal 
and interest for each payment and the principal balance after each payment.



Annual Percentage Rate
The simple interest rate plus fees or finance charges associated with a loan. The Annual 
Percentage Rate reflects the true cost of a loan.



annual return
Your annual profit on an investment as a percentage of the amount invested. For example, 
a $1,000 investment that pays $100 in profits over the year has an annual return of 10 
percent. This is a tool for comparing the performance of different investments over the 
same time period. For example, if you want to compare the performance of a six-month CD 
to a one-year bond, you would calculate (annualize) what the same CD would have earned 
if it were held for one year.



annuity
A contract in which you make a payment or series of payments now and receive a payment
or series of payments later. Money invested in an annuity grows tax free.



asset
Something you own, such as cash, real estate, stocks, bonds, automobiles, and other items 
that have measurable value.



ATM
Automated Teller Machine.



balloon payment
The loan principal you still need to pay after the last regular payment. Balloon payments 
occur because a loan's regular payments didn't fully amortize the loan.



bond
An agreement to borrow money, pay interest, and later repay money. Bonds are issued by 
the government and many businesses.



broker
Typically a salesperson who makes a commission by helping execute purchases and sales 
of stocks, bonds, and other investments.



brokerage account
The collection of investments a brokerage company holds for you. Each of your brokerage 
accounts should be set up as a separate Investment Account in Microsoft Money.



capital gain
The profit you get by selling a stock, bond, or mutual fund for more than you paid.



capital gains distribution
A mutual fund shareholder's portion of the fund's capital gains. Generally, these are paid 
once a year.



capital loss
The loss you incur by selling a stock, bond, or mutual fund for less than you paid for it.



CD (Certificate of Deposit)
An investment purchased from a bank. CDs pay interest and can usually be purchased in 
any denomination greater than $100.



commission
A fee charged by brokers for buying or selling investments.



cost basis
The total purchase price you paid for an investment. The difference between what you sell 
an investment for and its cost basis determines your capital gain or loss.



discounted bond
A bond sold for less than its par (or face) value. If you buy a $50 savings bond, the face 
value is $50. However, because savings bonds are sold at a discount, you will pay less than
$50 for it. All savings bonds and T-Bills are sold at a discount, as these investments do not 
make interest payments to investors. Investors are compensated by the increased value of 
the bonds over time. When redeemed or sold, the profit is treated as interest income.



dividend
The portion of corporate earnings distributed to shareholders. Dividends are taxable, and 
are usually distributed quarterly.



face value
The redemption value of a bond at maturity.



fractional shares
A partial portion of an individual share of a stock, bond, or mutual fund.



FIFO (First In, First Out)
An assumption that investments are sold in the same order they're purchased. Microsoft 
Money assumes all investments are sold on a FIFO basis.



Ginnie Mae
The nickname for the Government National Mortgage Association, which is a federal 
agency that borrows money from investors and then lends it to homeowners for mortgages.



inflation
An increase in the price of goods and services.



interest
The cost of borrowed money. Interest payments do not reduce principal.



interest rate
The cost of money, expressed as an annual percentage.



investment
An asset that produces profits. Microsoft Money supports six main types of investments:

Mutual Funds (except those invested in money market securities)
Money Market Funds (a special type of mutual fund that invests in money market 

instruments)
Certificates of Deposit (CDs)
Stocks (including foreign currency investments and options on stocks or 

commodities)
Bonds (including corporate and municipal bonds)
Discounted Bonds (including government savings bonds, zero-coupon bonds, and 

other investments traded at a discount)



IRA (Individual Retirement Account)
A retirement plan to which employees contribute. Contributions may be tax deductible, but 
earnings and contributions are taxed when they're withdrawn from the IRA.



Keogh
A retirement plan for the self-employed. Money invested in a Keogh is tax deductible and 
earnings from the plan are tax-deferred, but withdrawals are taxed.



liability
Debts you owe, such as a mortgage or home-equity loan, credit card balance, car loan, 
student loan, or any other personal loan or obligation. Microsoft Money can track credit 
card balances with a Credit Card Account and all other liabilities with Loans and Liability 
Accounts.



loan
Money borrowed or lent, usually in exchange for interest. In Microsoft Money you may want 
to set up Loan Accounts to track major debts on which you make regular payments. For 
tracking debts that you'll pay off in the near future or with a single payment, you may want
to use Liability Accounts.



load
A sales commission charged when buying or selling shares in a mutual fund. Some mutual 
funds don't charge a sales commission. These are referred to as no-load mutual funds.



lot
A block of stock or mutual fund shares purchased at the same time. For example, if you 
purchase 100 shares of Litware, Inc. on Jan. 10, and 50 shares of Litware, Inc. on Jan. 11, 
you would own two lots of Litware, Inc. When securities are sold, Microsoft Money will 
assume a FIFO sale flow. Therefore, if you later sold 50 shares of Litware, Inc. Money will 
assume half the first lot has been sold.



market value
The price a buyer is willing to pay for an asset. Market prices are readily available for most 
stocks, bonds, and mutual funds.



maturity date
The date at which a bond, note, CD, or loan principal must be repaid.



money market fund
A type of mutual fund that invests in short-term securities, such as T-bills, and earns 
interest. The fund's share value is usually $1.



municipal bond
State or local government-issued debt. Municipal bonds are generally exempt from federal 
income taxes and most state and local taxes, particularly in the state of issue.



mutual fund
A collection of stocks, bonds, and other securities managed by investment professionals 
but owned by the mutual fund's shareholders. When you buy shares in a mutual fund, your 
money is combined with other investor's money.



net asset value (NAV)
The market value of an asset less liabilities.



net worth
What you own minus what you owe.



offer price
The price at which a security is offered to buyers.



On-Line Services

Allow you to do common banking tasks from your computer. 
There are three types of On-Line Services:

Pay On-Line    Lets you pay bills electronically to anyone in the U.S. (with limited 
exceptions).

Bank On-Line    Lets you electronically update your bank or credit card records, 
transfer funds between accounts, check your current balances, send inquiries, and order 
new checks, just like working with a bank teller.

Quotes On-Line    Lets you electronically download the most recent closing price for 
stocks and mutual funds.



opportunity cost
The amount you could have earned on an alternative investment. For example, if you could 
earn 8 percent on a CD, the opportunity cost of investing in stock or something else is 8 
percent.



options
The right to purchase or sell something, such as a stock, at a predetermined price at some 
time in the future.



par value
The value of a bond at maturity. Bonds are usually issued with a $1,000 par value.



percentage unrealized gain or loss
The potential profit or loss on an investment at a point in time stated as a percentage.



preferred stock
Preferred stock receives dividends prior to common stock and has preference over common
stock in case of bankruptcy.



principal
What you still owe or are owed on a loan.



RRSP (Registered Retirement Savings Plan)
A Canadian retirement plan that allows you to save on a tax-deferred basis. Amounts 
contributed to an RRSP are tax deductible, and income earned is tax-exempt as long as the 
funds remain in place. Capital and income from the plan are fully taxable once funds are 
withdrawn from the plan.



realized gain or loss
The actual profit or loss on an investment you sell. (The value of investments can go up or 
down, but the gain or loss is unrealized until the investment is sold.)



reinvestment
Using interest or dividend payments from an investment to purchase more shares of that 
investment. Retirement plans such as 401(k) plans are frequently set up to automatically 
reinvest dividends and interest.



savings bond
U.S. government bonds issued at a discount with face value denominations ranging from 
$50 to $10,000. When savings bonds are redeemed, the difference between purchase price
and redemption value is considered interest income. Interest from savings bonds is exempt 
from state and local taxation, and generally no federal tax is due until the bonds are sold.



security
Microsoft Money uses this term to describe an investment that has a unit value that can 
change. Typical securities include stocks, bonds, and mutual funds.



Simplified Employee Pension Plan (SEP)
A pension plan for owners of small businesses and the self-employed. Money invested in an
SEP is tax deductible and earnings from the plan are tax-deferred.



stock
Shares of ownership in a corporation's earnings, assets, and liabilities. Stockholders may 
receive dividends and can generally sell their interest at any time.



stock dividend
A dividend paid with shares of the issuing company's stock rather than cash. Stock 
dividends are generally not taxable.



stock split
A transaction where a corporation gives existing shareholders new shares resulting in 
stockholders owning more shares at a lower price. For example, if a company initiates a 
two-for-one split, it doubles the number of shares each shareholder owns and drops the 
price by half.



stock symbol
The abbreviation for a corporation's stock that is used by brokers when trading stock.



tax-exempt
Investment income that isn't taxed.



treasury bill (T-Bill)
Money the U. S. government borrows and pays back within one year. T-Bills sell at a 
discount because they do not make interest payments.



treasury bond
Money the U. S. government borrows for more than ten years. Bonds pay interest on a 
semi-annual basis. 



treasury note
Money the U. S. government borrows for two to ten years. Treasury notes pay interest on a 
semi-annual basis.



unrealized gain or loss
The profit or loss on an investment if it were to be sold at its current price.





Finding, Viewing, and Sorting

Finding

Finding a Specific Transaction

Viewing

Creating a Custom View
Displaying Only Specific Transactions
Displaying Multiple Accounts
Switching Between Entire Transaction and Top Line Views

Sorting

Sorting Transactions by Date, Check Number, or Entry Order



Switching Between Entire Transaction and Top Line Views

You can display all the information about a transaction, or you can display only the top line 
of each transaction. 

Use Entire Transaction View when entering transactions so that you can enter 
categories, classifications, and memos. 

Use Top Line View to display more transactions at once and to scroll more quickly 
through the transactions.

To view all lines of each transaction
Click the Entire Transaction View button from the toolbar; or from the Tools menu, 

choose Entire Transaction View.
To view only the top line of each transaction
Click the Top Line View button, from the toolbar; or from the Tools menu, choose Top 

Line View.



Finding a Specific Transaction 

The Find command is an effective way to move to the last modified transaction, the other 
side of a transfer transaction, the main transaction of a split, or to a transaction that 
contains specific words or numbers.

To find a transaction containing specific text
1 From the Edit menu, choose Find.
2 In the Find What box, type what you want to find.
3 If you want to limit your search to a single field, choose a field from the Look In list.
4 In the Direction box, choose a direction for the search.
5 Choose the Find Next button.

Microsoft Money displays the next transaction, if any, that meets your specification. If 
you want to continue searching, choose the Find Next button again.

6 When you have finished the search, choose the Cancel button.
To go to the last transaction edited, the other side of a transfer, or the main

transaction of a split
1 From the Edit menu, choose Go To.
2 If you want to go to the last transaction you entered or made a change to, choose Last 

Transaction Edited.
If the current transaction is a transfer, you can use the Go To command to go to the other
side of the transfer by choosing Other Side of Transfer.
If the current transaction is a Split Transaction that includes transfers, you can use the 
Go To command to move to the Main Transaction for this Split.

3 Choose the OK button.

User's Guide
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Sorting Transactions by Date, Check Number, or Entry Order

Microsoft Money initially sorts your transactions by date. You can choose to sort them by 
date, number, or in the order you entered them.
Displaying by Entry Order is useful when entering a variety of kinds of transactions because
you can always see the last transaction you entered.

To sort transactions by check number
In the View box, choose All (by Num).

Transactions without check numbers will be displayed above transactions with check 
numbers.

To sort transactions by date
In the View box, choose All (by Date).
To sort transactions by entry order
In the View box, choose All (by Entry Order).

Note    You can't use Entry Order in the Other View dialog box.
________________
See also

Displaying Only Specific Transactions
Creating a Custom View



Displaying Only Specific Transactions

If you want to view only certain transactions, you can limit the display to:
Unprinted checks.
Unreconciled transactions.
Transactions for a specific payee.
Transactions for a specific category or subcategory.
Transactions for a specific classification item or sub-item.

If you want to display a more specific group of transactions than the View box allows, you 
can create a custom view.

To display a single group of transactions
In the View box, choose the type of transaction you want to display.

Note    When you display only certain transactions and make a change to a transaction, it 
may no longer appear. For example, if you are displaying only unreconciled transactions, 
and mark a transaction as reconciled, it will no longer be visible.
________________
See also

Sorting Transactions by Date, Check Number, or Entry Order
Creating a Custom View
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Displaying Multiple Accounts

When displaying multiple accounts, the account name for each transaction appears below 
the Number field.

To display more than one account at once
1 In the Account box or the Inv Acct box, choose Multiple Accounts or Multiple Investment 

Accounts.
2 In the Select Accounts box or the Select Investment Account box, highlight each account 

you want to display.
3 To select all accounts, choose the Select All button.

-Or-
To clear all selections, choose the Select None button.

4 Choose the OK button.
To display all your accounts at once
In the Account box or the Inv Acct box, choose All Accounts or All Investment 

Accounts.
________________
See also

Switching Between Accounts
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Creating a Custom View 

If you want to view a more specific group of transactions than the View box allows, you can 
create a custom view. 
For example, you can sort by date, number, account, payee, or category. You can also 
choose to limit the displayed transactions according to category, payee, or type and see 
the total for those transactions at the bottom of the window.

To create a custom view
1 In the View box, choose Other.
2 In the Sort By box, choose the order in which your transactions are displayed.
3 To determine which transactions are displayed, choose from the lists or enter the settings

you want in the fields you're interested in. If you leave a field blank, it will not filter 
transactions in the view.

4 Choose the OK button.
Note    When you display only certain transactions and make a change to a transaction, it 
may no longer appear. For example, if you are displaying only unreconciled transactions 
and mark a transaction as reconciled, it will no longer be visible.
________________
See also

Switching Between Entire Transaction and Top Line Views
Displaying Only Specific Transactions
Sorting Transactions by Date, Check Number, or Entry Order





Account List

In the Account List, you can set up a new account, delete or modify an existing account, 
enter and change information about your accounts, and select accounts to use with On-Line
Services. The information to the right of the account list relates to the account highlighted 
in the Account List.

Dialog Box Options
Account List
Lists all accounts in the Account Book and displays the type (Bank, Cash, Credit, Asset, 
Liability).
New button
Creates a new account.
Delete button
Deletes the selected account.
Modify button
Modifies the selected account by changing the type of account and/or its name.
Report button
Displays the Account List Report. You can print this list for reference. You can also include 
bank information such as bank name, account number, shortcut, account limit, and current
balance.
Money On-Line Services button
Choose this button to enable or disable the selected account for On-Line Services. On-Line 
Services lets you pay bills electronically from your computer, download bank information 
into your Money records, transfer funds between bank accounts, send inquiries about your 
transactions, and download stock and mutual fund closing prices. Accounts that are 
enabled for On-Line Services will have a lightning bolt next to their name in the Account 
List.
Shortcut
You can type a shortcut for the selected account using six characters or less. It's best to 
use a shortcut that's easy to remember. Shortcuts are useful when you have several 
accounts with similar names.
Opening Balance
You can enter or change the opening balance.
Bank Name
You can type the name of the bank for the selected account.
Account Number
You can type the account number for the selected account so that it's readily available for 
reference.
Minimum Balance
If your account requires a minimum balance, you can enter that amount here.
Comment
You can type a comment about the selected account. For example, the bank's address or 
phone number may be included as a comment.
________________
See also

Setting Up a Bank Account
Setting Up a Cash or Other Account
Setting Up a Credit Card Account
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Create New Account

Dialog Box Options
Account Name
Type a name for the account.
Bank
Choose the Bank Account option as the account type if the account will be used to keep 
track of transactions involving checking, savings, or money market accounts.
Credit Card
Choose the Credit Card Account option as the account type if the account will be used to 
keep track of credit card transactions and the money owed on such accounts.
Cash or Other
Choose the Cash or Other Account option as the account type if the account will be used to
keep track of cash expenditures, petty cash balances, or other income and expenses not 
included in Bank or Credit Card Accounts.
Asset
Choose the Asset Account option as the account type if the account will be used to track 
the value of personal assets owned by you or money owed to you. This does not include 
financial investments such as stocks, bonds, CDs, Canadian RRSPs, and IRAs. These should
be tracked in Investment Accounts.
Liability
Choose the Liability Account option as the account type if the account will be used to keep 
track of money you owe, such as a one-time payment to a friend. This does not include 
amortized loans such as those you may have for college, your house, or your car. These 
should be tracked in Loans.
________________
See also
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Opening Balance

Dialog Box Options
Bank Account
Type the ending balance from your most recent bank statement in order to accurately 
balance your account. Once the account is created, enter all transactions that have not yet
appeared on your bank statement.
Credit Card Account
Type the amount you owe on the credit card from your last statement. Once the account is 
created, enter only those transactions which occurred after your last statement.
Cash or Other Account
Type the amount of cash you have on the day you create this account.
Asset Account
Start with the value of the asset on the day you create this account.
Liability Account
Start with the amount of money owed on the day you create this account.



Modify Account

Dialog Box Options
Old Name
Displays the current name for the account.
New Name
Type a new name for the account.
Bank Account
Choose the Bank Account option as the account type if the account will be used to keep 
track of transactions involving checking, savings, or money market accounts.
Credit Card Account
Choose the Credit Card Account option as the account type if the account will be used to 
keep track of credit card transactions and the money owed on such accounts.
Cash or Other Account
Choose the Cash or Other Account option as the account type if the account will be used to
keep track of cash expenditures, petty cash balances, or other income and expenses not 
included in Bank or Credit Card accounts.
Asset Account
Choose the Asset Account option as the account type if the account will be used to track 
the value of personal assets owned by you or money owed to you. This does not include 
financial investments such as stocks, bonds, CDs, Canadian RRSPs, and IRAs. These should
be tracked in Investment Accounts.
Liability Account
Choose the Liability Account option as the account type if the account will be used to keep 
track of money you owe, such as accounts payable.



Category List

In the Category List you can set up a new category or subcategory, delete or modify 
existing ones, and enter and change information about a category or subcategory. The 
information to the right of the category list relates to the highlighted category or 
subcategory.

Dialog Box Options
Category List
Lists all your categories, divided by Income and Expense.
Subcategory List for
Displays the subcategories for the selected category.
New button
Creates a new category or subcategory.
Delete button
Deletes the selected category or subcategory. If the category being deleted has 
subcategories, you will be alerted that deleting the category will cause all of its 
subcategories to be deleted. If you prefer, you can reassign the transactions to a new 
account.
Modify button
Modifies the selected category or subcategory.
Report button
Displays the Category List Report. You can print this list for reference. You can also include 
additional information such as shortcuts, as well as budget and tax report information.
Shortcut
You can type a shortcut for the selected category using six characters or less. It's best to 
use a shortcut that's easy to remember. Shortcuts are most useful if you have several 
categories with similar names.
Comment
You can type additional information about the selected category. For example, if you have 
an Automobile Maintenance category, you may include a comment about when the oil 
change or tire rotation should occur. 
Include on Tax Reports
Choose this option if the transactions assigned to the category or subcategory should be 
included as part of a Tax Report. For example, if the transactions assigned to the category 
or subcategory are tax deductible or tax related, it would be useful to include them on a 
Tax Report.
Tax Form
Choose the type of tax form from a list that includes Form 1040, Schedule A, Schedule B, 
Schedule C, and W-2.
Tax Form Line
Choose the tax line from the list.
Tax Form Copy
Enter the copy of the tax form you are using. Most often the number will be 1; however, if 
you are using multiple forms, such as W-2 or Schedule C, this number will be greater.
Budget button
Choose this button to set up a budget based on your categories.
Investments button
Choose this to change the category or subcategory assigned to each type of investment 
activity.



If you choose a category or subcategory that is used to track investment activities, you will 
see a sentence below the category information saying "This category is used to record 
investment activities." If you want to change the categories or subcategories your 
investment activities are assigned to, choose the Investments button. 
________________
See also

Creating New Categories and Subcategories
Deleting Categories and Subcategories
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Create New Category

Dialog Box Options
Name
Type a name for the new category or subcategory.
Income Category
If the category will be used for transactions that deposit money into an account, choose 
Income Category.
Expense Category
If the category will be used for transactions that withdraw money from the account, choose
Expense Category.
Include on Tax Reports
Choose this option if the transactions assigned to the category or subcategory should be 
included as part of a Tax Report. If the transactions assigned to the category or 
subcategory are tax deductible or tax related, it would be useful to include them on a Tax 
Report.



Delete Category or Classification Item

Delete Category Dialog Box

The Delete Category dialog box appears if the category or subcategory you're deleting has 
transactions assigned to it or is used for reporting investment transations. The transactions
assigned to the category or subcategory to be deleted can be reassigned. Otherwise, the 
transactions would not be assigned to a category or subcategory.

Dialog Box Options (Delete Category)
Category List
Choose a replacement category from the list.
Subcategory List
Choose a replacement subcategory from the list.

Delete Classification Item Dialog Box

The Delete Classification Item dialog box appears if the item or sub-item you're deleting 
has transactions assigned to it. The transactions assigned to the item or sub-item to be 
deleted can then be reassigned. Otherwise they will not be assigned to an item or sub-item.

Dialog Box Options (Delete Classification Item)
Item List
Choose a replacement item from the list.
Sub-item List
Choose a replacement sub-item from the list.



Modify Category or Classification Item

Dialog Box Options
Old Name
Displays the current name for the category or classification item.
New Name
Type a new name for the category or classification item.
Type
If you want, choose a different type.



Modify Subcategory or Sub-item

Dialog Box Options
Old Name
Displays the current name for the subcategory or sub-item.
New Name
Type a new name for the subcategory or sub-item.



Classification Item List

Displays the items and sub-items for the custom classification you have created. You can 
add, delete, or rename items and sub-items and enter shortcuts and comments for them. 
The name you've given your classification will appear on the Lists menu as well as at the 
top of this dialog box. The information to the right of the list is related to the highlighted 
item or sub-item.

Dialog Box Options
Item List
Lists the names of all your classification items. The names you have given your items will 
be displayed. For example, if you have a Property Classification, items could be 8034 Jones
Street, 17 Lichen Lane, and 119 Alameda Avenue.
Sub-item List
Lists the names of sub-items for the selected item. This list is only displayed if you have 
specified that your classification can have sub-items. For example, if 8034 Jones Street is 
the item, sub-items could be Apt. A and Apt. B.
New button
Creates a new item or sub-item.
Delete button
Deletes the selected item or sub-item.
Modify button
Renames the selected item or sub-item.
Report button
Displays a Classification Report. You can print this list for reference. Examples of such a 
report may include a Property List Report or a Job List Report.
Shortcut
You can type a shortcut for the selected item or sub-item using six characters or less. It's 
best to choose a shortcut that's easy to remember. Shortcuts are useful when you have 
several items that have similar names.
Comment
You can type additional information about the selected item or sub-item. For example, if 
you have a Property Classification, you may want to include the tenant's name and phone 
number as a comment.
________________
See also

Creating Classification Items and Sub-items
Deleting a Classification and Classification Items
Renaming a Classification and Classification Items
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Create New Classification Item

Dialog Box Options
Name
Type a name for the new classification item.



Create New Subcategory and Classification Sub-item

Dialog Box Options (New Subcategory)
Name
Type a name for the new subcategory.
Subcategory For
Choose a category from the list that you want to create the subcategory for.
Include on Tax Reports
Choose this option if the transactions assigned to the subcategory should be included as 
part of a Tax Report. If the transactions assigned to the subcategory are tax-deductible 
expenses or taxable income, it would be useful to include them on a Tax Report.

Dialog Box Options (New Classification Sub-item)
Name
Type a name for the new classification sub-item.
Sub-item For
Choose a classification item from the list that you want to create the sub-item for.



Other Classification

In addition to the built-in income and expense categories, you can create up to two custom 
classifications. A classification is a way of cataloging each transaction as more than merely 
an income or expense category. You can also modify and delete existing classifications.

Dialog Box Options
Classification 1 and Classification 2
In the Classification 1 and Classification 2 boxes, you can create a new classification, for 
example, by property, by client, or by job.
New button
Creates a new classification.
Modify button
The Modify button only appears if you have already created a classification. It renames the
classification and allows you to determine whether the classification items can have sub-
items.
Delete button
The Delete button only appears if you have already created a classification. It deletes the 
selected classification. If you choose to delete a classification, all transactions assigned to 
that classification will be updated.
________________
See also

Creating a Classification



Modify Classification

Dialog Box Options
Old Name
Displays the current name of the selected classification.
New Name
Type a new name for the classification.
Allow Sub-items
Choose the Allow Sub-items option to specify that your classification items can have sub-
items. If this option is not chosen, you will not be able to use sub-items. If you decide later 
that you need sub-items, you can modify your classification. If you clear the Allow Sub-
Items option, all sub-items will be deleted and all transactions will be reassigned to its 
parent item.



New Classification

Dialog Box Options
Type
Choose Client, Department, Job, Project, Property, or Family Member, or type any name 
you want for the new classification.
Allow Sub-items
Choose the Allow Sub-items option to specify that your classification items can have sub-
items. If this option is not chosen, you will not be able to use sub-items. If you decide later 
that you need sub-items, you can modify your classification to add them.
________________
See also

Creating a Classification
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Payee List

In the Payee List, you can rename, delete, or change information about an existing payee, 
or create a new payee. The information displayed to the right of the list relates to the 
payee selected in the Payee List.

Dialog Box Options
Payee List
Lists the names of all payees, as well as the last date of a payment to or from that payee.
Last Date
Displays the last entered date for each payee.
New button
Creates a new payee and adds it to the Payee List.
Delete button
Deletes the selected payee from the Payee List. However, transactions containing that 
payee are unaffected.
Rename button
Renames the selected payee in all transactions containing that payee.
Report button
Displays the Payee List Report. You can print this list for reference. You can also include in 
the report additional information such as a shortcut name and the last date a payment was
made to each payee.
Shortcut
You can add or change a shortcut. It's best to use a shortcut that's easy to remember. 
Shortcuts are useful when you have payees with similar names or that share the same first
word in their name.
Phone
You can type the phone number of the payee for easy access.
Acct #
You can type the account number for reference.
Address
You can type a payee's address for reference or when printing checks.
Street, City, State/Prov, Zip (For On-Line Services)
Type the street, post office box, or route number, city, state or province, and zip code in 
the fields provided.
This information must be correct and complete if you pay a payee through Pay On-Line.
Comment
You can type additional information about the selected payee. For example, if the selected 
payee is a bank, it may be useful to include the name of the loan officer or branch 
manager with whom you do business.
Pay On-Line Info button
You can view the payee's mailing address and the number of days Pay On-Line needs to 
pay the payee. Pay On-Line may later inform you that the payee's address has been 
replaced with a merchant number. The merchant number is an electronic address that 
allows the payee to be paid more quickly.
________________
See also

Renaming an Item on A List



Deleting an Item from the List
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Create New Payee

Dialog Box Options
Name
Type a name for the new payee as you want it to appear on checks and reports. Any 
information contained in curly brackets {    } is not printed on checks. Such information 
could refer to the billing date, for example.



Rename Payee

Dialog Box Options
Old Name
Displays the current name for the payee.
New Name
Type a new payee name to replace the old.
When a payee is renamed, the change is reflected in all transactions using that payee 
name.



Select Payee

In the Select Payee dialog box, you can choose to view transactions for a single payee and 
get a quick total of all transactions assigned to that payee.

Dialog Box Options
Payee List
Choose the payee whose transactions you want to view. Only one payee may be selected.
OK button
When you choose the OK button, the selected name is displayed in the View box and 
transactions related to that payee are displayed in the Account Book.



Select Category or Select Classification Item

Select Category

In the Select Category dialog box, you can display transactions for single or multiple 
categories and subcategories, enabling you to get a quick total of all transactions assigned 
to those categories.

Dialog Box Options (Select Category)
Category List
Displays Income and Expense categories in separate sections. You can choose the 
categories or subcategories you want to view.
To choose more than one category or subcategory with the keyboard, press ALT+L to 
activate the Category List, then press the UP or DOWN ARROW keys to move to the categories
or subcategories you want, and press the SPACEBAR to choose them.
Show Subcategory
Displays subcategories indented under each category.

Select Classification

The Select Classification dialog box is titled with the name you chose for the classification. 
You can view transactions for single or multiple classification items or sub-items and get a 
quick total of all transactions assigned to them.

Dialog Box Options (Select Classification)
Classification Item List
Displays items in the classification. You can choose the items or sub-items you want to 
view.
To choose more than one classification item or sub-item with the keyboard, press ALT+L to 
activate the Classification List, then press the UP or DOWN ARROW keys to move to the items 
or sub-items you want, and press the SPACEBAR to choose them.
Show Sub-item
Displays sub-items indented under each item.



Select Multiple Categories or Classification Items

Select Multiple Categories

In the Select Multiple Categories dialog box, you can display transactions for multiple 
categories and subcategories, enabling you to get a quick total of all transactions assigned 
to those categories.

Dialog Box Options
Category List
Displays Income and Expense categories in separate sections. You can choose the 
categories or subcategories you want to view.
To choose more than one category or subcategory with the keyboard, press ALT+L to 
activate the Category List, then press the UP or DOWN ARROW keys to move to the categories
or subcategories you want, and press the SPACEBAR to choose them.
Select None button
Choose Select None if you don't want categories or subcategories highlighted.
Select All button
Choose Select All to highlight all the categories and subcategories.
Show Subcategory
Displays subcategories indented under each category.

Select Multiple Classification Items

The Select Multiple Classification Items dialog box is titled with the name you choose for 
the classification. You can view transactions for multiple classification items or sub-items 
and get a quick total of all transactions assigned to them.

Dialog Box Options
Classification List
Displays items in the classification. You can choose the items or sub-items you want to 
include in the report.
To choose more than one classification item or sub-item with the keyboard, press ALT+L to 
activate the Classification List, then press the UP or DOWN ARROW key to move to the items 
or sub-items you want, and press the SPACEBAR to choose them.
Select None button
Choose Select None if you don't want items or sub-items highlighted.
Select All button
Choose Select All to highlight all the items and sub-items.
Show Sub-item
Displays sub-items indented under each item.



Other View (Select Transactions)

In the Other View dialog box, you can specify which transactions are displayed in the active
window.

Dialog Box Options
Sort By
Choose Date, Number, Account, Payee, Category, or Classification to specify how 
transactions are grouped. The other options determine which transactions are displayed.
Type
Choose Payments, Deposits, Unprinted Checks, Transfers, or No Amount as the type of 
transactions you want to display. If you choose All Types, or leave the field blank, all 
transactions are displayed.
Payee
Choose transactions for a single payee, All Payees, or a Blank Payee. Choosing the Blank 
Payee option will display only those transactions that currently do not have a payee name.
Status
Choose whether you want to display reconciled or unreconciled transactions, or both. If 
you leave this field as Reconciled & Unreconciled, it will have no effect on which 
transactions are displayed in the Account Book.
Category
Choose transactions for a single category, multiple categories, all categories, or blank 
categories; or choose a specific type of category, for example, tax categories. If you 
choose the blank category option, only those transactions without a category assigned to 
them will be displayed.
Classification Item 1 and 2
A box is displayed for each classification and labeled with the name you chose. Choose 
transactions for a single classification item, multiple items, blank items, or all items within 
the classification. If you choose the blank item option, only those transactions without an 
item assigned to them will be displayed.
Date From/To
Limits the view to transactions with dates within the range of dates you specify. If the From
box is blank, all transactions with dates up to and including the date in the To box are 
included. If the To box is blank, all transactions dated the same as or later than the date in 
the From box are included. 
Number From/To
Limits the view to transactions with check numbers in the range you specify. If the From 
box is blank, all transactions with numbers equal to or lower than the number in the To box
are included. If the To box is blank, all transactions with numbers equal to or higher than 
the number in the From box are included.
Amount From/To
Limits the view to transactions with an absolute value equal to or between the amounts in 
the From and To boxes. If the From box is blank, the view includes all transactions with a 
value up to the amount in the To box. If the To box is blank, the view includes all 
transactions with a value equal to or greater than the amount in the From box. 

 



Select Multiple Accounts

In the Select Account dialog box you can choose a custom view that enables you to display 
all transactions for selected accounts.

Dialog Box Options
Account List
Lists the names of all accounts. Choose the accounts you want to view. To choose more 
than one account, click each account you want, or move to each account with the UP or 
DOWN ARROW key and press the SPACEBAR to choose them.
Select None button
Choose Select None if you do not want to select any of the accounts.
Select All button
Choose Select All if you want to select all of the accounts.



Choose a Specific Payee

The Choose a Specific Payee dialog box is displayed when you type a payee name that 
matches more than one payee in the list.

Dialog Box Options
Payee List
Choose the payee you want from the list.
Last Date
Displays the last date the payee was used in a transaction.
Shortcut
Displays the payee's shortcut name.
Address
Displays the payee's address.
Phone
Displays the payee's phone number.
Account Number
Displays the account number for the selected payee.
Comment
Displays additional information about the selected payee.





About Microsoft Money

Displays the product version number, the copyright notice, and the serial number.



Options: General

By turning options on or off in the Settings dialog boxes, you can customize Microsoft 
Money to fit your needs.

Display Options
Font Size
Specifies the size of the numbers and letters displayed in your transactions.
Background Color
Shows the name of the current background color as displayed in checks and in the register.
If you prefer, you may choose a different color.
Scenic Checks
Displays a scenic background in your Money checks.
Message Bar
Displays informative messages at the bottom of the Money window.

Confirmation Options
Confirm Transaction Changes
Displays a confirmation message before a transaction is entered so you can accept or 
cancel the entry.
Beep on Transaction Entry
Produces a beep every time a transaction is entered.
Confirm New Payee Names
Displays a message when you use a new payee, asking if you want to add it to the payee 
list
Remind to Back Up on Close
Displays a message when you close Money, asking if you want to create a backup file.
Require Category in Each Transaction
Displays a message when you enter a transaction without a category assigned to it, 
confirming that the category is missing and asking if you want to add one.
Require Correct Category Type
Displays a message if you mistakenly enter an Income category for an expense or an 
Expense category for income, confirming the error and asking if you want to make a 
correction.
Protect Reconciled Transactions
Displays a message when you try to edit a transaction that is already reconciled, 
confirming you really want to make the changes.

Future Transactions Options
Remind When Transactions Due
Displays a reminder when you open Money for Future Transactions that are due.
Days in Advance to Remind
Allows you to choose the number of days in advance you want to be reminded of pending 
Future Transactions.
Count Only Business Days
Reminds you of Future Transactions a specified number of business days in advance.

Entry Options
Use SmartFill
Automatically fills in previously entered transaction information after you have typed three
or more characters.
Automatically Drop Lists



Automatically displays the list of choices for a transaction field, for example, a list of 
category or classification item names.
Auto Decimal Point in Amounts
Automatically adds the decimal point when you type a transaction amount.
Use Enter Key to Move in Register
Choose this if you want to use the ENTER key -- instead of the TAB key -- to move from field 
to field.

Print Options
Prompt If Checks Are Postdated
Displays a message when you choose Print Check, notifying you that there are checks to 
be printed that have future dates attached to them. You have the option to proceed with 
printing them using today's date or to use the original date.
Print Payee in Check Address
Choose this if you want the payee name printed on checks as the first line in the address 
field. This option is only available for printing checks.



Split Transaction

Divides the amount of a transaction into two or more parts. You can assign a category, 
classification item, description, and amount to each part.

Dialog Box Options
Category
You can assign a category and subcategory to each part of the split. You can also assign 
items or sub-items if you are using classifications.
Description
You can type a description for each part of the split transaction, for example, specific 
details about a purchase.
Amount
Type the amount for each part of the split transaction.
Total
If you split the transaction before entering an amount for the whole transaction, this 
displays the sum of the parts, as you enter the amount for each part.
Unassigned
If you split the transaction after entering an amount for the transaction, this displays the 
amount not yet assigned to the parts of the split transaction. For accurate record keeping, 
you should see that this amount is zero before closing the dialog box.
Done
Choose this button to enter the split transaction.
Delete All
Choose this button to remove the parts of this split.
________________
See also

Splitting a Transaction
Itemizing a Paycheck Deposit
Entering a Deposit Less Cash

User's Guide
Chapter 5



Enter Due Transactions

Copies the selected transaction from the Future Transactions window into the Account 
Book, and reschedules a Future Transaction based on the frequency assigned in the Future 
Transactions window.

Dialog Box Options
Enter in Account
Type or choose the account you want the transaction paid from.
Remaining Balance
Displays the remaining balance for the account the transaction is being recorded in.
Number
You can assign a number (for example, a check number) to the highlighted transaction 
before it is recorded in the Account Book. You can also type Print if you want to print the 
highlighted transaction.
Date
Accept the proposed date, or type the date you want.
Spend or Receive (for non-investment transactions only)
Displays the amount you want to subtract (spend) or add (receive). You can accept the 
proposed amount, or type the amount you want.
Quantity, Price, Commission, and Amount (for investment transactions only)
Accept these figures, or type the amounts you want.
Splits button
Choose this button to enter a split transaction into the Account Book or to see or change 
the parts of a split transaction already entered.
Enter button
Enters the transaction into the specified account.
Don't Enter Now button (when available)
The transaction is not recorded or rescheduled. The date in the Future Transaction window 
remains the same.
Reschedule button
The transaction is not recorded, but is rescheduled. For example, if your Future Transaction
is paid monthly and is due today -- March 1 -- choosing Reschedule will postpone it until 
April 1.



Remind When Due

Places a copy of the transaction into the Future Transactions window and schedules it as a 
Future Transaction.

Dialog Box Options
Frequency
From the list, choose how often the transaction takes place.
Next Due Date
Type the date on which the next transaction should take place.



Specify Date Range

The Specify Date Range dialog box is displayed when you choose Enter Due Transactions, 
or if you choose to enter Future Transactions when you are reminded.

Dialog Box Options
Date
Accept the proposed date or type another date for the Future Transactions you want to 
record. The proposed date is determined by the Remind When Transactions Due setting in 
the Settings dialog box.
OK button
Opens the Enter Due Transactions dialog box, where you can choose to enter, ignore, or 
reschedule each due transaction on a case-by-case basis.
________________
See also

Changing When the Pay Bills Reminder is Displayed



Select Account

The Select Account dialog box is displayed if you are viewing more than one account in the 
Account Book when you choose Balance Account. You can balance only one account at a 
time.

Dialog Box Options
Account List
From this list, choose the account you want to balance.
Continue button
Opens the Balance Account dialog box.



Adjust Account Balance

In the Adjust Account Balance dialog box, you can make adjustments to anything but Bank 
or Credit Card Accounts. You can also balance the individual transactions in the Account 
Book.

Dialog Box Options
New Ending Balance
Displays the current ending balance for the account. Accept the proposed amount or type 
a new amount.
As Of Date
Displays today's date. If you want, type another date.
Category for Adjustment
You can choose a category and subcategory for the adjustment transaction. The amount of
the adjustment transaction will be equal to the difference between the existing account 
balance and the New Ending Balance.
OK button
Choose the OK button to confirm an adjustment to the account's balance.
Balance button
Choose the Balance button to begin balancing your account with your bank statement.
________________
See also

Balancing or Reconciling a Bank Account



Account Didn't Balance

Presents ways you can adjust for any differences between Microsoft Money's account 
balance and the balance you entered from your bank statement.

Dialog Box Options
Go Back to Reconciling the Account
Choose this option to return to the Account Book to find and fix the problem yourself. You 
can modify existing transactions, mark them as cleared, or add any previously omitted 
transactions.
Use SmartReconcile to Help Find the Error
Choose this option to have Money try to find the transaction that could be causing the 
problem.
Automatically Adjust the Account Balance
Choose this option to have Money automatically add an adjustment transaction to make 
your account balance.
Adjustment Amount
Displays the amount of the adjustment that is the difference between Money's account 
balance and the balance you entered from your bank statement.
Category
You can assign a category or subcategory to the adjustment transaction.



Balance Account

Begins balancing your account with your bank statement. If you resume balancing an 
account, the previous balances and date you entered are displayed.

Dialog Box Options
Statement Date
Type the end date of the period covered in the bank statement.
Starting Balance
Type the beginning balance from your statement.
Ending Balance
Type the ending balance from your statement.
Have Microsoft Money Create Transactions For
If your bank statement lists a service charge, you can type the amount into the Service 
Charge box. You can also enter a category and subcategory for the charges.
If your bank statement lists interest earned, you can type the amount into the Interest 
Earned box. You can also enter a category and subcategory for the amount.
Continue button
Opens the Account Book so you can clear individual transactions and finish balancing the 
account.



Starting Balance Adjustment

If you finish reconciliation and are prompted with the Starting Balance Adjustment dialog 
box, it is because the starting balance you entered from your bank statement is not the 
same as the one calculated in Microsoft Money. This difference may be the result of omitted
transactions or transaction amounts that are not accurate.

Dialog Box Options
Go Back to Reconciling the Account
Choose this option to return to the Account Book to adjust the starting balance yourself. 
You can modify existing transactions, mark them as reconciled, or add transactions.
Complete Reconciliation Without Correcting the Balance
Choose this option if you do not want an adjustment made for the difference between the 
two balances. You will probably still have the problem next time you balance.
Have Microsoft Money Automatically Adjust the Balance
Choose this option if you want to correct the problem by adding a starting balance 
adjustment transaction.
Adjustment Amount
Displays the difference between the starting balance from Money and the starting balance 
entered from your bank statement.
Category
You can assign a category and a subcategory to the adjustment transaction.



Starting Balance Warning

The Starting Balance Warning is displayed if the amount you entered from your statement 
does not match the starting balance from Microsoft Money.
Make sure you haven't skipped reconciling a statement and that you aren't reconciling an 
old statement. Also, make sure there are no transactions from earlier statements missing 
from the Account Book.

To enter missing transactions during reconciliation
1 In the Starting Balance Warning dialog box, choose the Continue button.
2 Enter the missing transactions in the Account Book.
3 To mark the transaction as reconciled, hold down the SHIFT key as you click with the 

mouse in the C field, or press SHIFT+CTRL+M to mark the transaction. An "R" will appear in 
the field.
When you have entered all the missing transactions, the Starting Balance Difference 
displayed will be zero.

Note    You may want to switch views from Unreconciled to All, so you can see transactions 
that may have been erroneously marked as reconciled.



Possible Error

Microsoft Money has detected a transaction that may have created an error. The error may 
be in the amount, the type of transaction, or the status of the transaction.

Transaction Options
Payee
Displays the payee for the transaction.
Amount
Displays the amount of the transaction in error. Make sure you haven't incorrectly entered 
the amount or misplaced the decimals.
Type
Displays the type of the transaction, for example, Deposit or Payment. Make sure the 
transaction is of the correct type.
Status
Displays the status of the transaction. Verify whether the transaction is shown as cleared 
or uncleared on the statement.
Date
Displays the date the transaction was entered.
Category
Displays the category assigned to the transaction.

Dialog Box Options
Yes button
Choose the Yes button to fix the problem with the transaction and finish balancing the 
account.
No button
Choose the No button if you don't want to change the transaction. SmartReconcile will 
continue to look for errors, but you may still need to make an adjustment to this 
transaction.
Cancel button
Choose the Cancel button if you don't want to continue using SmartReconcile to help find 
errors.



Possible Balance Error

Microsoft Money has detected a transaction that may have created an error in the ending 
balance.

Dialog Box Options
Yes button
Choose the Yes button to have Money change the amount entered on the ending balance 
statement and finish balancing the account.
No button
Choose the No button if you don't want to change the transaction.
Cancel button
Choose the Cancel button if you don't want to continue using SmartReconcile to help find 
errors.



Find

Looks through the transactions in the current view for the text or numbers you type.
Dialog Box Options

Find What
Type the information you want to find. You can use letters, numbers, spaces, and symbols.
Search
Choose a direction for the search.
Look In
Choose which fields you want included in the search.
Also Look in Split Transactions
Choose this option to have split transaction information included in the search.
Find Next button
Starts the search. Selects the next transaction that contains the information you typed in 
the Find What box. You can continue to choose the Find Next button until you find the 
transaction you're looking for.
Cancel button
Closes the Find dialog box and moves to the last transaction found. If no transactions were 
found, it returns to the last selected transaction.



Spend or Receive

If you split a transaction without entering a total amount for the transaction, the Spend or 
Receive dialog box is displayed.

Dialog Box Options
Spend button
Choose Spend if you spent the displayed amount. Spend will subtract the amount from 
your account balance.
Receive button
Choose Receive if you received the displayed amount. Receive will add the amount to the 
account balance.



Create First Account

Microsoft Money guides you through creating your first account.

OK button
Choose the OK button to continue. You will have a chance to change the name of the 
account or create another type of account if you prefer.



Reschedule Transaction

When rescheduling a Future Transaction with a frequency of Only Once, you must enter a 
date.

Dialog Box Options
Date
Enter a date using a slash ( / ) to separate the month, day, and year. For example, for May 
18, 1991, enter 5/18/91.
OK button
Choose the OK button to reschedule the transaction.



Split Transaction

Divides a transaction or part of a transaction into two or more parts. You can assign a 
category, description, and amount to each part.
Depending on what you are doing, Microsoft Money will display slight variations of the Split 
window. There are three variations.

If you are balancing a loan, setting up a loan, or changing loan information, you 
will have these options:

Dialog Box Options
Category
You can assign a category and subcategory for each fee. For example, insurance or 
taxes.
Description
You can type a description for each fee. For example, the type of insurance may be 
included as part of the description.
Do not enter a description when balancing a loan. It can't be used.
Amount
Type the amount for each fee.
Total Other Fees
This displays the sum of the fees as you enter each amount.
Done
Choose this button to accept these Other Fees.

If you are entering or changing a loan payment, you will have these options:
Dialog Box Options

Category
The categories and subcategories for principal, interest, and other fees are listed here. 
Do not change the content of this field. It is used to help track your loan payments. To 
change the category for a loan payment see Changing Loan Information.
Description
You can type a description for the principal, interest, and other fees. For example, you 
may want to highlight the principal and interest parts of the loan payment by entering 
"principal" and "interest" in the respective Description fields.
Amount
Type the amount for each part of the loan payment.
Unassigned
This displays the uncategorized part of the loan payment as you enter each amount. For
accurate record keeping, you should see that this amount is zero before you close the 
Split window.
Done
Choose this button to accept the split parts of this loan payment.
Delete All
Choose this button to remove the parts of this split.

If you are entering or changing a Future Transaction for a loan payment, you will 
have these options:



Dialog Box Options
Category
The categories and subcategories for principal, interest, and other fees are listed in 
here.
You cannot make changes to this field. To change the category for a Future Transaction, 
see Changing Loan Information.
Description
The description for the principal, interest, and other fees are listed here.
You cannot make changes to this field.
Amount
The principal and interest amounts are calculated and cannot be changed.
Unassigned
This displays the sum of the Future Transaction as you enter each amount. For accurate 
record keeping, you should see that this amount is zero before you close the Split 
window.
Done
Choose this button to accept the split parts of this Future Transaction.





Opening Balance 

In the Opening Balance dialog box, the amount you enter is determined by the type of 
account you create.

Dialog Box Options
Opening Balance (Bank Account)
Enter the ending balance from your bank statement.
Opening Balance (Credit Card Account)
Enter the amount you owe on the credit card from your last statement. Once the account 
is created, enter only those transactions that occurred after your last statement.
Opening Balance (Cash or Other Account)
Enter the amount of cash you have on the day you create this account.



Opening Balance 

The amount you enter in the Opening Balance box is determined by the type of account 
you are creating.

Dialog Box Options
Opening Balance (Asset Account)
Type the balance as determined by the cost of the asset on the day you create this 
account. Type 0 as the opening balance if you plan to enter a transaction for the purchase 
of this asset.
Opening Balance (Liability Account)
Type the amount you owe on the day you create this account. Leave the Opening Balance 
box blank if you plan to enter the liability as a transaction.





AutoBudget

AutoBudget automatically creates a budget by averaging the income and expense 
transactions you've already entered. It's best to have at least 30 days of data entered 
before using this feature.

Dialog Box Options
Date Range box
Choose a date range from the list, or enter specific dates in the From and To boxes. 
Microsoft Money will average your past transaction amounts during the date range you 
specify.
Round to Nearest
Choose how strictly you want to round your budget amounts. 
Create Budget For
Choose from the options to specify which categories and subcategories to include in the 
budget.
Create button
Choose this button when you've made your selections and are ready to create a budget.

Cho
ose

To create a 
budget for

Only 
Cate
gorie
s 
With 
No 
Budg
et

All categories 
and 
subcategories 
that currently 
have no budget 
assigned to 
them.

All 
Cate
gorie
s

All categories 
and 
subcategories.

Selec
ted 
Cate
gorie
s

Specified 
categories and 
subcategories.

Only 
for 
Divid
ends

Investment 
dividend 
income.

________________
See also

Budget Reports
Creating a Budget
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Budget List

In the Budget List dialog box, you can assign a yearly, monthly, weekly, or customized 
budget amount to income and expense categories and subcategories. Customizing a 
monthly budget is useful when you know you'll spend different amounts from month to 
month. For example, you could assign a higher budget to your Gift category for the month 
of December if you know you'll spend extra money for holiday gifts.

Dialog Box Options
Budget List
You can select an Income or Expense category for which you'll create a budget. On the 
right side of the dialog box, you can assign budget amounts to the selected category.
Budget/Yr
Shows the total yearly budget amount assigned to the selected category or subcategory.
Show Subcategories
You can select Show Subcategories to have subcategories appear indented under each 
Income and Expense category. Select a subcategory to create a budget for, then assign 
budget amounts to it.
Yearly
Shows the yearly total of the amounts you assigned for each month. You can change the 
budgeted yearly amount for the selected category or subcategory by entering a different 
amount in this box.
Monthly 
Shows the monthly budget amount. You can change the monthly amount for the selected 
category or subcategory by entering a different amount in this box.
Weekly
You can enter a weekly budget amount for the selected category or subcategory.
Customize by Month
You can enter a different amount for each month.
Categories
Choose the Categories option to go to the Category List dialog box. You will be able to 
create, delete, or modify your categories.
AutoBudget
Choose this option to have Microsoft Money create a budget for you based on your past 
records.
________________
See also

Creating a Budget

User's Guide
Chapter 34



Report

Dialog Box Options
Customize button
Choose to change what is included and how the report is displayed.
Remember button
Choose to have Microsoft Money remember your report customizations and chart 
formatting.
Print button
Choose to print the report displayed in the dialog box.
Export button
Choose to export the displayed report to a file for use in another computer application, 
such as a word processor or spreadsheet.
Chart button
Choose to display a chart based on the report.
________________
See also

Printing Reports
Exporting Reports
Adjusting the Report Column Width
Changing the Font Used in a Report

User's Guide
Chapter 6



Set Report Column Widths

If there is too much space between columns, or if the information doesn't fit in the columns,
you can choose a different column width, which will affect both display and printing.

Dialog Box Option
Width
Choose Automatic, Narrow, Standard, Wide, or Extra Wide. The Automatic width option 
adjusts each column to fit the information it contains on the page. The other options allow 
you to create narrower columns, or wider columns using a landscape orientation.
________________
See also

Printing Reports



Customize Summary Report

Summary Reports show a detailed breakdown of your income and expenses. You can 
change the report and how it is organized by specifying what is displayed in the rows and 
columns.

Dialog Box Options
Title
Type a descriptive title for the report and chart. You can use up to 64 characters.
Rows
Choose what you want listed down the left side of your report, for example, categories or 
payees.
Columns
Choose what you want listed as column headings across the top of your report. For 
example, you can choose a column for every account or every month.
Combine All Values Under
Use this to combine all small amounts for cleaner looking charts.
Sort By Amount
Choose this to sort rows in descending order according to the amount. Otherwise, your 
reports will be sorted alphabetically.
Include Shortcuts
Choose this to display shortcuts in parentheses.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Transactions - From Account
Use this to specify which accounts you want included in the report.
All Transactions
Choose this if you want to include all transactions in the report.
Select Transactions
Choose this to include only certain transactions in the report, for example, only reconciled 
transactions.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
Chapter 6



Customize Income and Expense Report

The Income and Expense Report totals transactions by what you earned and what you 
spent and compares the difference. You can change the report and how it is organized by 
specifying what is displayed in the rows and columns.

Dialog Box Options
Title
Type a descriptive title for the report and chart. You can use up to 64 characters.
Rows
Choose what you want listed down the left side of your report.
Columns
Choose what you want listed as column headings across the top of your report.
Combine All Values Under
Use this to combine all small amounts for cleaner looking charts.
Sort By Amount
Choose this to sort rows in descending order according to the amount. Otherwise, your 
reports will be sorted alphabetically.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Transactions - From Account
Use this to specify which accounts you want included in the report.
All Transactions
Choose this if you want to include all transactions in the report.
Select Transactions
Choose this to include only certain transactions in the report, for example, only reconciled 
transactions.
Report Transfers By
Choose Don't Include Transfers if you don't want transfers reflected in this report. Choose 
Include Transfers To or From Asset or Liability Accounts if you want these transfers 
reflected in a separate section of the report and reflected in net income. Choose Include 
Transfers To or From Accounts that Aren't in the Report to see cash inflows and outflows to 
or from accounts that aren't included in the report.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
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Customize Tax Report

Tax Reports display information about transactions in categories marked to be included on 
Tax Reports.

Dialog Box Options
Title
Type a descriptive title for the report and chart. You can use up to 64 characters.
Report Type - Tax Summary
Choose this to include only subtotals and no individual transactions.
Report Type - Tax Transactions
Choose this to show individual transactions.
Rows (Tax Summary Only)
Choose what you want listed down the left side of your report. For example, you can 
choose a row for every category or subcategory.
Columns (Tax Summary Only)
Choose what you want listed as column headings across the top of your report. For 
example, you can choose a column for every account or payee.
Subtotal by (Tax Transactions Only)
Use this to choose how your transactions are grouped.
Include Shortcuts (Summary Only)
Choose this to display shortcuts.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Transactions - From Account
Use this to specify which accounts you want included in the report.
All Transactions
Choose this if you want to include all transactions in the report.
Select Transactions
Choose this to include only certain transactions in the report, for example, only reconciled 
transactions.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
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Customize Budget Report

Budget Reports compare actual amounts spent with budgeted amounts. You can change 
the information in the report and how it is organized by specifying what is displayed in the 
rows and columns.

Dialog Box Options
Title
Type a descriptive title for the report and chart. You can use up to 64 characters.
Rows
Choose what you want listed down the left side of your report.
Columns
Choose what you want listed as column headings across the top of your report.
Combine All Values Under
Use this to combine all small amounts for cleaner looking charts.
Sort By Amount
Choose this to sort rows in descending order according to the amount. Then choose to sort
transactions based on Actual, Budget, or Difference. Otherwise, your reports will be sorted 
alphabetically.
Show Empty Categories
Choose this to include categories that have budgeted amounts but have not been used in 
any transactions.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Transactions - From Account
Use this to specify which accounts you want included in the report.
All Transactions
Choose this if you want to include all transactions in the report.
Select Transactions
You can choose which transactions are included in the report, for example, only expense 
transactions.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also
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Customize Net Worth Report

Net worth is determined by subtracting liabilities from assets.
Dialog Box Options

Title
Type a descriptive title for the report and chart. You can use up to 64 characters.
Show Balances as of
The report will show the balances as of the date you type.
Include Accounts
Choose which accounts you want included in your report.
Include Loans
Choose which loans you want to include in your report.
Include Investment Accounts
Choose which Investment Accounts you want to include in your report.
Combine All Values Under
Use this to combine all small amounts for cleaner looking charts.
Sort By Amount
Choose this to sort rows in descending order according to the amount. Otherwise, your 
reports will be sorted alphabetically.
Level of Detail
Choosing Accounts will display the greatest amount of detail; choosing Asset/Liabilities will
display the least.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
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Customize Transaction Report

Transaction Reports display all transactions from the Account Book or Account Forms.
Dialog Box Options

Title
Type a descriptive title for the report. You can use up to 64 characters.
Include Fields
Choose which fields you want to include in your report. These will display as column 
headings across the top of your report.
Subtotal by
Use this to group transactions and have a subtotal for each group. For example, you can 
group transactions by category or account.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Transactions - From Account
Choose which accounts you want included in the report.
All Transactions
Choose this if you want to include all transactions in the report.
Select Transactions
Choose this to include only certain transactions in the report, for example, only reconciled 
transactions.
Show Splits
Choose this to include all parts of split transactions.
Running Balance
Choose the Display a Running Balance/Total Starting With option to include a running 
balance in your report. Then choose what you want the opening balance to start with.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
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Customize Future Transaction Report

Future Transaction Reports display all information from your Future Transactions window. 
You can change the information in the report and how it is organized.

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Include Fields
Choose which fields you want to include. These will display as column headings across the 
top of your report.
Show Splits
Choose this to include all parts of split transactions.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Transactions
Choose which transactions you want included in the report.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
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Customize Account List Report

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Shortcut
Choose this to display shortcuts.
Account Balances
Choose this to display each account's opening and current balance.
Bank Information
Choose this to display the bank name and account number.
Account Limit
Choose this to display a minimum balance or credit limit amount.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
Chapter 17



Customize Payee List Report

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Shortcut
Choose this to display shortcuts.
Phone Number
Choose this to display phone numbers for the payees.
Last Date Used
Choose this to display the last date each payee was used in a transaction.
Account Number
Choose this to display the account number for each payee.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
Chapter 14



Customize Category List Report

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Shortcut
Choose this to display shortcuts.
Tax Information
Choose this to display which categories are included on Tax Reports as well as the Tax 
Form and Tax Form Line for the category.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
Chapter 12



Customize Budget List Report

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Summary
Choose this to display Income and Expense categories and subcategories with annual 
budgets assigned to each.
Subcategory Budgets
Choose this option to have subcategories included in the report. The subcategories will 
appear indented under each Income and Expense category.
Budget Details
Choose this to display a greater level of detail that includes budget information, such as 
budget amounts and length of the budget period, as well as a monthly breakdown of the 
budget amounts.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
Chapter 34



Customize Classification List Report

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Include Shortcut
Choose this to display each classification item's shortcut.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
Chapter 13





Charts

You can create a chart to graphically display the information from Summary Reports, 
Income and Expense Reports, Tax Reports, Budget Reports, Net Worth Reports, Market 
Value Reports, Performance Reports, or Price History Reports. Charts are useful in 
comparing amounts and tracking your finances. Once the chart is displayed, you can 
change its content and layout as you see fit.

Dialog Box Options
Format button
Choose this option to change the content and layout of the chart. You can change the type 
(bar, pie, or line), as well as make other formatting changes.
Print button
Choose this option to print the chart.
Copy button
Choose this option to copy the chart to the Windows Clipboard. You can then paste it into 
another application, such as a word processor.
________________
See also

Introduction to Charts
Choosing a Chart Type
Formatting a Chart

User's Guide
Chapters 6 & 30



Format Chart 

Once a chart is created you can change its content and how it's displayed.
Dialog Box Options

Chart Type
You can choose Bar Chart, Line Chart, or Pie Chart for the type. The type you choose 
determines which other options are available.
Include From Report
You can choose which sections of the report you want to chart.
Bar Options
In a Bar Chart, if you are working with a Budget Report, you can choose to view either 
Stacked or Clustered bars if your report has multiple amount columns.
Pie Labels
In a Pie Chart, you can choose to label the slices by percentage or by dollar amounts.
Show Legend
Depending on the type of chart you're creating, you can display a legend containing a list 
of symbols and what they represent to use as a reference. You can choose or clear this 
option.
Show Gridlines
Depending on the type of chart you're creating, you can include a gridline as part of the 
chart to use as a reference. You can choose or clear this option.
Display Patterns Instead of Colors
You can replace the colors in the on-screen chart with patterns.
Print Patterns Instead of Colors
You can replace the colors on the printed image of the chart with patterns.
Chart Budget Amounts for (Budgets Reports only)
You can choose to have your Budget Report charts display Actual, Budget, Difference, or 
any combination of the three. If you choose only one check box, you can create a Pie Chart
for the corresponding amounts.
Fonts button
Choose this button to change the typeface of the chart you're creating.
Customize Report button
Choose this option to switch back to the report and make the customizations you prefer. 
The revisions you make in the report will then be included in the chart.
________________
See also

User's Guide
Chapter 6



Print Chart

Prints the displayed chart.
Dialog Box Options

Copies
Choose the number of copies you want to print.
Print Quality
You can specify the print quality, which will affect the resolution of the chart you're 
printing. The print quality is either described in dots per inch (dpi) or as High, Medium, or 
Low. The more dots per inch, the higher the resolution.
Setup
Displays the Print Setup dialog box, where you can change the printer you're using or 
change the printer settings to better suit your needs.
________________
See also

Setting Up to Print Checks and Reports
Printing Reports

User's Guide
Chapter 6





Currency List

In the Currency List dialog box, a standard set of built-in currencies is displayed. You can 
add or delete items from the list, rename a currency, make modifications to the currency's 
last exchange rate, or create a Currency List Report. The information to the right of the list 
relates to the highlighted Currency.

Dialog Box Options
Currency List
Highlight the currency here that you want to work with.
Exchange Rate
Displays the last exchange rate used for each currency.
New button
Creates a new currency that will be added to the list.
Delete button
Deletes the highlighted currency from the list.
Rename button
Renames the highlighted currency.
Display Exchange Rate As
Choose the option that describes the exchange rate you know.
Exchange Rate
You can change a currency's exchange rate by typing a new rate here.
Report button
Displays the Currency List Report. You can customize, remember, print, or export the 
Currency List Report.
________________
See also

User's Guide
Chapter 16



Rename Currency

Dialog Box Options
Old Name
Displays the current name for the currency.
New Name
Type a new currency name to replace the old.
________________
See also

User's Guide
Chapter 16



Create New Currency

Dialog Box Options
Name
In the Currency List box, type the currency's name and choose the OK button. The name 
will be added to the Currency List.
________________
See also

User's Guide
Chapter 16



Customize Currency Exchange Rate Report

Dialog Box Options
Show Local Units for Each Foreign Unit
Choose this if you want to see the value of the local units for each foreign unit. That is, 
if .84 local units equals one foreign unit, .84 will be displayed.
Show Foreign Units for Each Local Unit
Choose this if you want to see the value of the foreign units for each local unit. That is, if 
1.19 foreign units equals one local unit, 1.19 will be displayed.
________________
See also

User's Guide
Chapter 16



Currency Converter

In the Currency Converter dialog box, you can convert the amount you spent in a foreign 
currency to your local currency. To convert foreign currency amounts to local currency, 
enter the amount you spent or received in foreign currency. While in the amount field, press
the F8 key to display the Currency Converter dialog box.

Dialog Box Options
Foreign Amount
The number you entered in the amount field will be displayed here. If the foreign amount 
field is blank, type the amount that is being converted to local currency.
Foreign Currency
From the list, choose the foreign currency you want to convert from.
Display Exchange Rate As
Choose either Foreign Units for Each Local Unit or Local Units for Each Foreign Unit. In 
determining which option to choose, select the option that describes the exchange rate 
you know. 
Exchange Rate
You can change the listed exchange rate of a currency by typing a new rate here.
________________
See also

User's Guide
Chapter 16





Open

You can open any existing file, but you can have only one Microsoft Money file open at a 
time. Whenever you start Money, the last file you worked with is opened automatically. If 
you open a different file, your previous file is saved and closed.

Dialog Box Options
File Name
Type the name of the file you want to open, or choose from the list.
List Files of Type
Choose the type of file you want to open. The file types are identified by their file name 
extensions, for example, Money files (.MNY), backup files (.BAK), or All Files (*.*).
Directories
Displays the current directory. You can choose a different one.
Drives
Displays the current drive. You can choose a different one.
New button
Displays the New File dialog box, where you can create a new Money file.
Network button (displays only if connected to network)
Lets you connect to a shared directory.
________________
See also

Opening a File



Password

Dialog Box Options
Password
Type the password assigned to this Microsoft Money file.
________________
See also

Assigning, Changing, or Deleting a Password



New Password

You can change, remove, or assign a new password to your Microsoft Money file.

To Change or Assign a Password
Type a password of up to 16 characters, and choose the OK button. You will then be 
prompted to re-enter the password.
To Remove a Password 
If you want to remove password protection from the file, leave the Password box blank and
choose the OK button. Repeat this process when prompted to re-enter the password.
________________
See also

Assigning, Changing, or Deleting a Password



New

You can create a new Microsoft Money file with a new set of categories and accounts. You 
might create a new file if you want to keep individual project accounts separate from 
personal and home accounts.

Dialog Box Options
File Name
Type a name for the new file.
Directories
Displays the current directory. You can choose a different one.
Drives
Displays the current drive. You can choose a different one.
________________
See also

Creating a New File



Set Up Category List

Dialog Box Options
Standard Categories
Choose this if you would like to start with Microsoft Money's default set of income and 
expenses categories.
No Standard Categories
Choose this if you want to create all of your own categories.
________________
See also

Income Categories
Expense Categories
Introduction to Categories
Creating a New Category or Subcategory

User's Guide
Chapters 1 & 12



Backup

Use to create a backup copy of your file. Microsoft Money saves your work automatically. 
Creating a backup file is an extra precaution against data loss.

Dialog Box Options
Back Up File To
Proposes a name and location for your backup file or displays the name and location of the
last backup file you made. You can accept the suggestion or type a different name and 
location.
Remind to Back Up on Close
You can choose this option to be reminded to create a backup file as you close Money.
________________
See also

Backing Up Your File
Changing the Backup Option

User's Guide
Chapter 37



Backup Reminder

This dialog box is displayed every time you quit Microsoft Money if you have chosen the 
Remind To Back Up on Close option. Money saves your work automatically. Creating a 
backup file of your work on a different disk is an extra precaution against data loss.

Dialog Box Options
Back Up File To
Proposes a name and location for your backup file or displays the name and location of the
last backup file you made. You can accept the suggestion or type a different name and 
location.
Remind to Back Up on Close
You can choose or clear this option to be reminded to create a backup file as you close 
Money.
________________
See also

Backing Up Your File
Changing the Backup Option

User's Guide
Chapter 37



Archive

Microsoft Money creates a copy of all transactions for an archive file, then deletes the type 
of transactions you specify for each account.

Dialog Box Options
Remove Transactions that are Dated Before
Enter the date up to which you want transactions deleted from the current file. 
Transactions dated the same as, or after, the date you enter will not be removed.
________________
See also

Archiving Your Records

User's Guide
Chapter 37



Backup

Dialog Box Options
File Name
Proposes a name for the archive file. You can type a new name.
Directories
Displays the current directory. You can choose a different one.
Drives
Displays the current drive. You can choose a different one.
________________
See also

Archiving Your Records

User's Guide
Chapter 37



Export (Report)

Exports the displayed report to tab-delimited text format (with the extension .TXT) so you 
can open it in another application, such as a spreadsheet or word processing program. 
When you open the report in a word processor, each row of the report will constitute a 
separate paragraph, and the columns in each row will be separated by tabs.

Dialog Box Options
File Name
Proposes a name for the exported report file. You can type a new name.
Directories
Displays the current directory. You can choose a different one. You may want to use the 
directory where the application you plan to use is located.
Drives
Displays the current drive. You can choose a different one.
________________
See also

Exporting Reports

User's Guide
Chapter 6



Import

Imports the selected files into the current Microsoft Money account.
Dialog Box Options

File Name
Choose the files you want to import from the list. Files with the extension .QIF (Quicken 
Interchange Format) are displayed for you.
Select All button
Choose this button to select all the files listed in the File Name box.
Select None button
Choose this button to remove the highlight from all file names in the File Name box.
List Files of Type
Choose the type of file you want to display. The file types are identified by their file name 
extensions, for example, Quicken Files (*.QIF) or All Files (*.*).
Directories
Displays the directory of your import files. You can choose a different one.
Drives
Displays the current drive. You can choose a different one.
________________
See also

Importing Information from a Quicken File

User's Guide
Appendix A



Select Import Account

The Select Import Account dialog box is displayed so you can specify the Money accounts 
into which these transactions will be placed. 

Dialog Box Options
Account List
From this list, choose which Money account the imported transactions will be added to.
Create button
Choose this button to create a new Money account.
Cancel button
Choose this button to stop importing this file and move to the next one.



Select Import Investment Account

The Select Import Investment dialog box is displayed so you can specify the Money 
Investment Accounts into which these investment transactions will be placed.

Dialog Box Options
Investment Account List
From this list, choose which Money Investment Account the imported transactions will be 
added to.
Create button
Choose this button to create a new Investment Account.
Cancel button
Choose this button to stop importing this file and move to the next one.



Select Import Investment

The Select Import Investment dialog box is displayed so you can specify the Money 
investment into which these investment transactions will be placed.

Dialog Box Options
Investment List
From the list, choose which investment you want to use for the import investment 
displayed above.
OK button
Choose this button to import the highlighted investment and move to the next.
Create button
Choose this button if you have not yet created the investment in Money to which you want
to add the import investment.
Cancel button
Choose this button to stop importing this file and move to the next one.



Assign Import Account

The Select Import Account dialog box is displayed so you can specify the Microsoft Money 
accounts into which these account transactions will be placed.

Dialog Box Options
Account List
From the list, choose which Money account you want to use for the import account 
displayed above.
Assign
Choose this button to assign the imported account to the highlighted account in the 
Account List.
Create button
Choose this button if you have not yet created the Money account into which you want to 
add the import account.
Cancel button
Choose this button to stop importing the file and move to the next one.



Select Font

In the Select Font dialog box, you can change the typeface and type size that will print on 
your report or chart.

Dialog Box Options
Font
Choose the font you want to print on your report.
Size
Choose the size of type you want to print on your report.
Sample
Displays a sample of each font and type size you select.

Note    Only the fonts that are available on your printer are listed.



Export

Exports the selected account to a .QIF (Quicken Interchange Format) file. 
If you want to export information to a spreadsheet or word processor, such as Microsoft 
Excel or Microsoft Word, you should export from a Microsoft Money report instead of using 
File Export.

Dialog Box Options
Loose QIF
Choose this option if you are going to be using the file with a spreadsheet or word 
processor.
Strict QIF
Choose this option if you will be opening the exported file in Quicken. This option will 
shorten the category names in your export file to 13 characters to make them compatible.
________________
See also

Exporting Reports



Export

The Export dialog box is used to choose a file name and directory for your exported files. 
Dialog Box Options

File Name
Type a name for the file you are going to export. Be sure to give the file name a QIF 
extension, for example, export.qif.
Directories
Displays the directory where your exported account will go. You can choose to export your 
account to a different directory.
Drives
Displays the current drive. You can choose to export your account to a different drive.



Export

The Export dialog box is displayed so you can specify what type of Microsoft Money 
accounts you want to export.

Dialog Box Options
Regular
Choose this button if the account you want to export is a non-Investment Account.
Investment
Choose this button if the account you want to export is an Investment Account.



Select Export Account

The Select Export Account dialog box is displayed so you can specify which Microsoft 
Money Investment Accounts you want to export. 

Dialog Box Options
Investment Account List
From the list, choose which Money Investment Account you want to export.
Continue button
Choose this button to export the highlighted Investment Account and move to the next.



Select Export Account

The Select Export Account dialog box is displayed so you can specify which Microsoft 
Money accounts you want to export. 

Dialog Box Options
Account List
From the list, choose which Money account you want to export.
Continue button
Choose this button to export the highlighted account and move to the next.



Adjust Split Amount

The Adjust Split Amount dialog box is displayed if there is an unassigned amount in the split
transaction or if the sum of the split transaction exceeds the total amount originally 
entered.

Dialog Box Options
Edit Splits
Choose to return to the Split Transaction dialog box and change amounts.
Adjust Total
Choose to adjust the total amount to be the sum of the split transaction amounts.
Reallocate Unassigned Amount
Choose to change each split proportionally to account for the unassigned amount. Then 
return to the Split Transaction dialog box.
Continue With Unassigned Amount
Choose if you want to leave some amounts in the split transaction unassigned.





New Investment Account

In the New Investment Account dialog box, you can enter information about your broker or 
bank. The information will appear in the Investment Account List and can be helpful when 
making a trade. All information except Name, Shortcut, and Status is listed solely for your 
reference and is not used by Money.

Dialog Box Options
Name
Type a name for the new account. 
Shortcut
You can type a shortcut for the account using six characters or less. It's best to use a 
shortcut that's easy to remember. Shortcuts are used to save time when entering 
transactions and can be useful when you have several accounts with similar names.
Status
Choose the Tax Deferred box if the investments in this account are tax deferred. If you 
choose this option, transactions in this account will not be included in Tax Reports.
Account Number
Type the number of the Investment Account. You can get this number from your brokerage 
statement.
Institution
Type the name and address of the financial institution with which you have this account.
Contact
Type the name of the person you work with at the financial institution.
Voice Phone
Type your contact's telephone number.
Fax Phone
Type your contact's fax telephone number.
Continue button
Choose the Continue button after you have entered your new account information.
________________
See also

Recording Your Current Investment Holdings



Associated Cash Account

In the Associated Cash Account dialog box, specify whether your Investment Account has a 
companion account that contains uninvested cash you've deposited with the broker or 
institution that manages your account. This account is often a money market fund that lets 
you withdraw or deposit funds for investment purchases and sales.

When you buy an investment, the purchase funds are typically drawn from this cash 
account, and when you sell an investment, the proceeds are typically added to it. The cash 
account may also provide check-writing privileges.

Dialog Box Options
Yes
Choose the Yes button if you want to set up an Associated Cash Account for this 
Investment Account.
No
Choose the No button if your account does not contain a companion account used to store 
uninvested cash. Money will let you set one up later, if you want.

________________
See also

Viewing Transactions in the Associated Cash Account



Opening Cash Account Balance

Dialog Box Options
Opening Balance
If you plan to record all previous transactions for this account, enter zero now and later 
record the original transfer of cash into the account.
If you want to start your investment record keeping on a certain date, enter the account 
balance from that date. You'll be able to change this balance at any time.



Create New Investment

Dialog Box Options
Investment Name
Type the name of the investment. To avoid confusion later, it's best to use the proper name
under which the security is traded.
Type
Choose your new investment's type from the six listed. The investment activities available 
and the way they're reflected in reports vary according to the investment type.



New (Investment)

In the New investment dialog box, you can enter additional information about your 
investments. The information you enter here will appear in the Investment List.

Dialog Box Options
Symbol
Type the symbol of the security as it would be listed in a market index or in a newspaper 
stock report. This also serves as a shortcut for this investment. Shortcuts are used to save 
time when entering transactions and can be useful when you have several investments 
with similar names.
Status
Choose if your investment is tax exempt. Choosing tax exempt determines how Money will 
handle transactions involving this investment in Tax Reports.
Comment
Type any comments you want to accompany your investment listing.
Face Value (only for discounted bonds)
Type the face or redemption value of the bond. This is the amount you will be paid when 
the bond matures.
Par Value (only for bonds)
Type the par or redemption value of the bond. (Bonds are commonly issued with a par 
value of $1,000.)
Maturity Date (only for bonds or discounted bonds)
Type the date the bond achieves par value. This is only for your reference. Money does not
use this information.



Investment Account List

The Investment Account List dialog box displays all your Investment Accounts and their 
account values. You can rename, delete, or change information about an existing 
Investment Account, or create a new one. The information displayed to the right of the list 
relates to the account chosen in the Investment Account List.

Dialog Box Options
New button
Choose this to set up a new Investment Account.
Delete button
Choose this to delete the highlighted Investment Account and all transactions within that 
account.
Modify button
Choose this to change the name of the highlighted account or to enable or disable the 
Associated Cash Account.

________________
See also

Entering Purchases and Sales



Modify Investment Account

Dialog Box Options
New Name
Type a new name for this account.
Cash Account Enabled
Choose the check box to the left to enable the Associated Cash Account. To disable the 
Associated Cash Account, clear the check box by choosing it again. If you disable the 
Associated Cash Account, the account will be removed and the transfer field for all 
transfers to or from it will be left blank.

Note    Most other Investment Account details can be changed directly in the Investment 
Account List dialog box.



Investment List

The Investment List dialog box lists all your investments and their type. You can rename, 
delete, or change information about an existing Investment, or create a new one. The 
information displayed to the right of the list relates to the investment chosen in the list.

Dialog Box Options
New button
Choose this to add a new investment to the list. To enter an investment purchase, you 
must also enter a Buy transaction in the Investment Details window.
Delete button
Choose this to delete the highlighted investment. If you are currently holding this 
investment, it cannot be deleted.
Rename button
Choose this to change the name of the highlighted investment.
Update Price button
Choose this any time you want to update the market price of your investments to keep 
your records current. These changes will be reflected in the Investment Summary window.
Stock Split button
Choose this to record a stock split. Money will then adjust the price and quantity to reflect 
the split. These changes will also be reflected in the Investment Summary and Details 
windows and the Update Price dialog box. 

________________
See also

Setting Up an Investment Account



Update Price

The Update Price dialog box allows you to update the market price of any Investment and 
to see a price history.
Note    You can change the date and price of any previous entry by choosing it in the list, 
and then updating the Date or Price field under Update Market Price.

Dialog Box Options
Investment
Choose the investment whose price history you want to view or change.
Date
Type the date of the new price. If you enter a date for which there is already a price, the 
new price will overwrite the existing one.
Price
Type the new price as of the date specified.
Update button
Choose this button to enter the new date and price. The update information is added to 
the list box and the changes are reflected in reports and in the Investment Summary 
window.
Delete button
Choose this button to delete the entry that is chosen in the list.
Report button
Choose this button to view a price history of the chosen investment. From there you can 
create a chart of the investment's performance.

________________
See also

Performance Report
Price History Report

User's Guide
Chapter 28



Disable Cash Account

The Disable Cash Account dialog box is used to verify that you want to remove the cash 
account from this Investment Account.

Dialog Box Options
OK button
Choose this button to confirm that you want to disable the Associated Cash Account.
If you disable the Associated Cash Account, the transfer field for all transfers to or from it 
will be left blank. You can set up another cash account later, if necessary.
Cancel button
Choose this button if you want to keep the Associated Cash Account.



Other Investment View

In the Other Investment View dialog box, you can specify which transactions are displayed 
in the Investment Details window.

Dialog Box Options
Sort by
Choose Date, Account, Investment, or Activity to specify in what order your transactions 
are displayed.
Activity
You can choose to view All Activities, Multiple Activities, or an individual investment 
activity.
Investment
You can choose All Investments, an individual investment, or an investment type. All your 
investments are listed alphabetically in the list, followed by Money's six investment types. 
Reconciled Status
Choose whether you want to display reconciled transactions, unreconciled transactions, or 
both. If you leave this field as Reconciled & Unreconciled, it will have no effect on which 
transactions are displayed.
Date
Choose the range of transaction dates you want to include. If you leave the fields blank, all
dates will be included.
Amount
Choose the range of transaction amounts you want to include. If you leave the fields blank,
all amounts will be included.
OK button
Choose this to display your transactions according to your criteria.



Investment Categories

Microsoft Money assigns categories to Investment transactions based on the investment 
activity. You can change or blank these categories at any time. If a Category field is left 
blank in the Investment Categories dialog box, transactions for that activity will be marked 
as "unassigned" in reports.
________________
See also

Changing the Categories Assigned to Investment Activities
Introduction to Categories and Subcategories



Delete Category

Microsoft Money uses this category for reporting Investment transactions. If you are going 
to delete it, you must first choose a replacement category and subcategory.

Dialog Box Options
Category
Choose a replacement category and subcategory from the lists.

________________
See also

Introduction to Categories and Subcategories



Buy Investment

If you have set up an Investment Account, you can enter purchases from non-Investment 
Accounts, such as checking accounts. A Buy activity will be entered in your Investment 
Account, using the non-investment account as the transfer account. If you have not yet set 
up an Investment Account, see Setting Up an Investment Account.

Dialog Box Options
Purchase Date
Type the date you actually purchased or sold the Investment. This may not be the same 
date you record or initiate the transaction.
Inv Account
Enter the account to which this investment belongs. If this is a new Investment Account, 
Microsoft Money will prompt you for more details and set up the new account.
Investment
Enter the name of the Investment. If this is a new investment, Money will prompt you to 
enter the investment type and other details.
Number of Shares
Type the number of shares you have purchased.
Price per Share
Type the price per share at which you bought the investment. 
Commission
Type the amount of commission you paid your broker for this purchase.
Total Amount Paid
Money will automatically calculate the total for this transaction.
Memo
Type any memos you find useful.
Check Number
Type the number of the check you used to purchase this investment.
Payee
If you have typed the name of the payee in the Account Book, it appears here. You can 
accept the one displayed or change it.
Transfer Account
Enter the account that provided the funds for this purchase.
Frequency (Future Transactions window only)
Enter the frequency of this periodic Buy Investment.
OK button
Choose this button when you are done, and Money will enter the transaction and return to 
the Account Book.

________________
See also

Entering Purchases and Sales



Buy Investment Split

If you have set up an Investment Account, you can enter Investment purchases from the 
Split Transaction dialog box. A Buy activity will be entered in your Investment Account, 
using the non-investment account as the transfer account. If you have not yet set up an 
Investment Account, see Setting Up an Investment Account.

Dialog Box Options
Inv Account
Enter the account to which this investment belongs. If this is a new Investment Account, 
Microsoft Money will prompt you for more details and set up the new account.
Investment
Enter the name of the investment. If this is a new investment, Money will prompt you to 
enter the investment type and other details.
Number of Shares
Type the number of shares you have purchased.
Price per Share
Type the price per share at which you bought the investment.
Commission
Type the amount of commission you paid your broker for this purchase.
Total Amount Paid
Money will automatically calculate the total for this transaction.
Memo
Type any memos you find useful.
Frequency (Future Transactions window only)
Enter the frequency of this periodic Buy Investment.
OK button
Choose this button when you are done, and Money will enter the transaction and return to 
the Split Transaction dialog box.

________________
See also

Entering Purchases and Sales



Customize Investment Transaction Report

Investment Transaction Reports display Investment transactions much like they appear in 
the Investment Details window. You can change the information in the report and how it is 
organized by specifying what is displayed in the columns and which transactions are 
included.

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Include Fields
Choose which optional fields you want to include in your report. These will display as 
column headings across the top of your report.
Date Range - Dates From/To
Use this to limit the report to the dates you specify.
Group by
Use this to group transactions and have a subtotal for each group. For example, you can 
group transactions by investment type, quarter, or account.
Include Transactions - From Account
Choose which Investment Accounts you want included in the report.
All Transactions
Choose this if you want to include all investment transactions in the report.
Select Transactions
Choose this to include only certain investment transactions in the report, for example, only
those involving a specified investment activity.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use Landscape Orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
View button
Choose this to view your customized Investment Transaction Report.



Customize Capital Gains Report

Capital Gains Reports show gains and losses from Investment sales. You can change the 
information in the report and how it is organized by specifying what is displayed in the rows
and columns.

Dialog Box Options
Title
Type a descriptive title for the report and chart. You can use up to 64 characters.
Subtotal By
Use this to group transactions and have a subtotal for each group. For example, you can 
group transactions by quarter, investment type, or account. These will be listed down the 
left side of your report.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Investment Accounts
Choose the All option if you want to include all of your Investment Accounts in this report. 
Choose the Select option if you want the report to reflect only specified accounts. Another 
dialog box will prompt you to choose which you want to include.
Include Investments
Choose the All option if you want to include transactions from all your investments in the 
report.
Choose An Investment if you want the report to reflect the transactions from an individual 
investment. Another dialog box will prompt you to choose which investment.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use Landscape Orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
View button
Choose this to view your customized Capital Gains Report.



Customize Market Value Report

Market Value Reports show the quantity, latest prices, and value of your Investments. You 
can change the information in the report and how it is organized by specifying what is 
displayed in the rows and columns.

Dialog Box Options
Title
Type a descriptive title for the report and chart. You can use up to 64 characters.
Subtotal By
Use this to group transactions by Investment Account or investment type and have a 
subtotal for each. These will be listed down the left side of your report.
Show Value As Of
Type a previous date if you want to see your market value at some point in the past.
Combine All Values Under
Use this to combine all small amounts for cleaner looking charts.
Include Investment Accounts
Choose the All option if you want to include all of your Investment Accounts in this report. 
Choose the Select option if you want the report to reflect only specified accounts. Another 
dialog box will prompt you to choose which you want to include.
Include Investments
Choose the All option if you want to include transactions from all your investments in the 
report.
Choose An Investment if you want the report to reflect the transactions from an individual 
investment. Another dialog box will prompt you to choose which investment.
Sort By Amount
Choose this to sort rows in descending order according to the amount. Otherwise, your 
reports will be sorted alphabetically.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use Landscape Orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
View button
Choose this to view your customized Market Value Report.



Customize Investment Performance Report

Investment Performance Reports can be used to summarize gains (realized and unrealized),
income, and Investment return percentages. You can change the report and how it is 
organized by specifying what investments and Investment Accounts are included and what 
is displayed in the report's rows.

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Subtotal By
Use this to group transactions by Investment Account or investment type and have a 
subtotal for each. These will be listed down the left side of your report.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Show Calculation Details
Choose this option if you want to see additional columns for Cost Basis, Realized Gains, 
Unrealized Gains, and Income & Expenses.
Do Not Show Performance Based On Data Of Less Than X Days
Type the minimum number of days needed to show accurate annualized return figures. 
This is important in making accurate projections because calculating investment 
performance on too short of a period can result in unreliable data.
Include Investment Accounts
Choose the All option if you want to include all of your Investment Accounts in this report. 
Choose the Select option if you want the report to reflect only specified accounts. Another 
dialog box will prompt you to choose which you want to include.
Include Investments
Choose the All option if you want to include transactions from all your investments in the 
report.
Choose An Investment if you want the report to reflect the transactions from an individual 
investment. Another dialog box will prompt you to choose which investment.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use Landscape Orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
View button
Choose this to view your customized Investment Performance Report.



Customize Price History Report

Price History Reports show past market prices of your Investments. It's useful to create a 
line chart from this showing upward or downward trends. You can change the report and 
how it is organized by specifying what dates and what Investment Accounts are included.

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Investments
Choose the All option if you want to include transactions from all your investments in the 
report.
Choose An Investment if you want the report to reflect the transactions from an individual 
investment. Another dialog box will prompt you to choose which investment.
Include Fields
Choose the Source option if you want to show the origin of each price update.
Widths button
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use Landscape Orientation.
Fonts button
Choose this to specify the size and style of the typeface in the report.
View button
Choose this to view your customized Price History Report.



Stock Split

When you enter a stock split, Money automatically adjusts the price and quantity of 
transactions involving the stock that have a date prior to the split date. Money also adds 
the letter "s" to the Price field of all transactions it adjusts. The Total of each transaction 
isn't affected by a split.

Dialog Box Options
Stock
Enter the name of the stock that has split.
Date
Type the date of the stock split. This may be different than today's date.
Split the stock 
Type the ratio of the stock split. For example, if you are entering a two-for-one split, type 2 
in the first box and 1 in the second, so it reads: "2 share(s) for every 1 share(s)."

________________
See also

Tracking Stock Splits



Fractional Shares

If a stock split results in a non-whole balance of shares, (for example, 37 3/4 shares) you 
can record the fractional shares, or you can replace them with cash. Call your broker if 
you're not sure if your account allows fractional shares.

Dialog Box Options
Keep the Fractional Shares
Choose this option is you have a stock plan, such as a 401(k), that permits fractional 
shares.
Replace the Fractional Shares with Cash
Choose this option if you want to track only whole shares.
If you choose this option, Money will prompt you to enter the per-unit price of the stock 
after the split.
Deposit Cash Into Account
If you chose to replace the fractional shares with cash, you can choose the account into 
which the cash is deposited.



Price After Split

Money needs to know the new stock price in order to convert the fractional shares to cash. 
If you don't know the per-unit price after the split, call your broker.

Dialog Box Options
Price
Type the per-unit price of the Investment after the split.



(** No Context ID yet - this deals with Transfer and buy**) Details 
for Buy Investment

If you don't know the exact figures for this Buy Investment, enter estimates. You can 
change them when you receive a detailed statement from your broker.

Dialog Box Options
Quantity
Accept the proposed quantity or type a new one.
Price
Accept the proposed per-unit price or type a new one. This is the price at the time of the 
purchase.
Commission
Accept the proposed commission price or type a new one.
Amount
Accept the proposed total amount or type a new one.

Note    You can enter amounts in any three of these fields, and Money will calculate the 
fourth.
________________
See also

Making Changes to an Investment Transaction
Entering Purchases and Sales



Rename Investment

Dialog Box Options
Old Name
Displays the current name for the Investment.
New Name
Type a new investment name to replace the old.
When an investment is renamed, the change is reflected in all transactions involving that 
investment.



Select Investment

In the Select Investment dialog box, you can specify that only selected investments are 
displayed.

Dialog Box Options
Investment List
Lists the names of all your investments. Choose the investment you want to view by 
clicking the investment with the mouse, or moving to the investment with the UP or DOWN 
ARROW keys and pressing the SPACEBAR.



Investment Options

Dialog Box Options
Require Transfer Account in Each Transaction
Choose this if you want Microsoft Money to give you a warning when the transfer field is 
left blank. Money recommends that when an Investment transaction requires or produces 
cash, you transfer the cash from or to another Money account.
Treat Bond Prices as Percentage of Par Value
Choose this if you want Money to display bond prices as percentages of their par value; 
otherwise, they will display as dollar amounts. Bond prices are commonly quoted as 
percentages.
Categorize Short Term and Long Term Capital Gains
Use this to change the criteria Microsoft Money uses to categorize investment gains or 
losses as short or long term. This can have an impact on your tax records.



Select Investment Accounts

In the Select Investment Accounts dialog box you can choose a custom view that enables 
you to display all transactions for selected Investment Accounts.

Dialog Box Options
Account List
Lists all your Investment Accounts. Choose the accounts you want to view. To choose more 
than one account, click each account you want, or move to each account with the UP or 
DOWN ARROW key and press the SPACEBAR to choose them.
Select All button
Choose Select All if you want to select all of the accounts.
Select None button
Choose Select None if you do not want to select any of the accounts.





Set Up On-Line Services

Dialog Box Options
Continue
Choose this to enter your personal information and address after you've received your 
start-up kit.
Cancel
Choose this if you don't want to see the Pay On-Line or Bank On-Line previews and have 
not yet received a start-up kit from On-Line Services.
Preview
Choose this button to learn more about On-Line Services.
________________
See also

Introduction to Money On-Line Services
Applying for On-Line Services



Personal Information

On-Line Services needs this information about you or your company in order to match it 
with the information on file at your bank. Except for the social security number (or Tax 
Identification Number), you can change this information at any time, as long as you notify 
On-Line Services. If you change the social security number after you've sent the 
application, you must print and mail another application form to On-Line Services.

Dialog Box Options
First Name
Type your first name as it is listed on your bank statement.
Last Name (or Company Name)
Type your last name or company name as it is listed on your bank statement.
SS Number (or TIN)
Type your Social Security Number or TIN (for businesses). If you change this later, you will 
have to reapply to On-Line Services.
Street
Type your street or post office box number. This is the address On-Line Services uses to 
send any correspondence.
City
Type the full name of your city. Do not use abbreviations.
State
Type the two-letter U.S. Postal Service abbreviation for your state, or choose it from the 
list.
Zip
Type your zip code, using five or nine digits.
Phone
Type your home area code and telephone number. On-Line Services uses this number to 
determine the local phone number it will send you for use in connecting to On-Line 
Services.



Money On-Line Services

Before you enable any accounts for On-Line Services, you must first receive your start-up 
kit. For more information, see Applying for On-Line Services.

Dialog Box Options
Account Number
Type the account number exactly as it appears in your start-up kit.
Pay On-Line
Choose this check box if this account has been approved for Pay On-Line in your start-up 
kit.
Bank On-Line
Choose this check box if this account has been approved for for Bank On-Line in your start-
up kit.
When you choose this check box, the following options will become available.
Account Designation
Choose the account type as specified in the start-up kit.
Financial Institution
Choose the button for your bank, or choose the Other button if your bank is not listed here.
Bank Routing Number
If this number does not fill in automatically, type the Bank Routing Number from your 
start-up kit. On-Line Services needs this number to identify your bank.
________________
See also

Introduction to Money On-Line Services

User's Guide
Chapters 31 and 32



On-Line Payee Address

Pay On-Line needs a complete address in the format displayed in order to send your 
payment.

Dialog Box Options
Street
Type the street address or post office number of the payee for this Electronic Payment.
City
Type the full name of the city. Do not use abbreviations.
State
Type the two-letter U.S. Postal Service abbreviation for the state, or choose it from the list.
Zip
Type the zip code, using five or nine digits.
Account Number
Type the account number from your billing statement from this payee. If you don't know 
the account number, or if this is a personal check, type your name.



Set Up Automatic Payment

Once you set up Automatic Payments in Microsoft Money, Pay On-Line pays bills when they 
are due by automatically withdrawing the necessary funds from your bank account. This 
happens whether or not you connect to Pay On-Line. It's important that you keep enough 
money in your account to cover these automatic deductions.

Dialog Box Options
Frequency
Verify that this Automatic Payment frequency is correct, or choose a new frequency. Also, 
verify that the due dates for the first and second payments are correct.
Number of Payments
If you know it, type the number of Automatic Payments you want Pay On-Line to make. 
Money will automatically calculate the Date Final Payment Is Due.
Date Final Payment is Due
Either accept the date proposed, or type a different final payment date.

Note    You can leave blank both the Number of Payments and the Date Final Payment Is 
Due fields, and Pay On-Line will make Automatic Payments until you cancel them.



Pay On-Line

The Pay On-Line dialog box lists all your instructions that are ready to be sent to Pay On-
Line. Once they are sent, a record of all transactions will be entered in your Account Book 
automatically.

Dialog Box Options
Instructions For Pay On-Line
All the instructions you want to send should have an X in the box to the left. 
Choose or clear instructions by clicking the instruction or highlighting it with an ARROW key 
and then pressing the SPACEBAR key.
Call button
Choose this button to initiate the phone call that sends your instructions to Pay On-Line.
Inquiry button
Choose this button to get an immediate payment status of a particular payment or to write
a letter to Pay On-Line.
Also choose the Inquiry button to review or change the contents of a previously written 
letter.
Close button
Choose this button if you want to exit this dialog box without connecting to Pay On-Line.
________________
See also

Creating a List of Instructions for On-Line Services

User's Guide
Chapter 31



Inquiry

In the Inquiry dialog box, you can request a Quick Status on a payment or write a letter to 
Pay On-Line.
Note    For a simple and immediate payment status, choose the Get Quick Status Of A 
Specific Payment option.

Dialog Box Options
Get Quick Status of a Specific Payment
Choose this option to get immediate feedback about any Electronic Payments made within 
the last 60 days. You can use this to find out, for example, if a payment has been made or 
the date when a payment will be made.
Write a Letter
Choose this option to send Pay On-Line general-purpose questions or comments. You can 
also send a payment investigation letter if, for example, a merchant didn't receive a sent 
payment and you want Pay On-Line to initiate an investigation by contacting the payee.



Get Status

From the list, choose the payments from which you want to get a Quick Status. You will 
receive a response during this connection.



Payment Investigation

From the list, choose the payment from which you want to send a payment investigation 
letter. You will receive a response within the next two days. Remember that you will later 
have to initiate another phone call in order to receive the response.



Letter (Pay On-Line)

You can send letters electronically to Pay On-Line for general-purpose inquiries, or to start a
payment investigation. Pay On-Line will generally respond within two business days. 
Remember, you will have to call Pay On-Line to retrieve the response to your letter.

Dialog Box Options
General Purpose Letter
Choose this option if you want to order new checks, get copies of processed checks, or 
send a general-purpose inquiry.
Payment Investigation Letter
Choose this option if, for example, a merchant didn't receive a sent payment.
Att'n
If you want, type the name of the person or department to whom you want to direct your 
letter, or just type Customer Service.
Subject
Type a short title or subject for your letter.
Dear Pay On-Line Service
Type a brief description of your problem or question, and choose the OK button. Your letter 
will be added to the list of instructions in the Pay On-Line dialog box. You can write a 
maximum of 18 lines.



Personal Identification Number

Just like with an ATM, On-Line Services uses a Personal Identification Number (PIN) to 
secure your On-Line Services. You can change your PIN at any time.
Note    Be sure to keep your PIN confidential, and keep a record of it in a safe, secure place.
Only those you've authorized to use your bank account should know your PIN. When 
making a connection, your PIN is checked by On-Line Services. If you lose or forget your 
PIN, call the number for On-Line Services Customer Support listed in your start-up kit.

Dialog Box Options
Please Type Your PIN
Type your four-digit Personal Identification Number. For security reasons, Money will 
display it as ****.
Change PIN
Choose this button if you want to change your PIN.
OK button
Choose this button when you are done. Money will then connect you to On-Line Services.



Change PIN

You can change your Personal Identification Number (PIN) at any time. For added security, 
the first time you use On-Line Services, you are required to change the PIN you were 
assigned in the start-up kit you received from On-Line Services.

Dialog Box Options
Old PIN
Type your old PIN or the PIN you were assigned, if this is your first time using the service.
For security reasons, Microsoft Money will display your number as ****.
New PIN
Type your new PIN.
Verify New PIN
Type your new PIN exactly as you typed it the first time.
OK button
Choose this button when you are done.
Cancel button
Choose this button if you don't want to change your PIN.



Bank On-Line

The Bank On-Line dialog box lists all your instructions that are ready to be sent to Bank On-
Line. Instructions to Get Transaction Details are automatically added to the list of 
instructions for all accounts you enabled for Bank On-Line.

Dialog Box Options
Instructions For Bank On-Line
All the instructions you want to send should have an X in the box to the left.
Choose or clear instructions by clicking the instruction or highlighting it with an ARROW key 
and then pressing the SPACEBAR key.
Get Status/Balance For All Accounts
Choose this check box to receive a current balance of all your accounts, information on 
available balances for credit card accounts, payment due dates, and interest payment 
totals.
Call button
Choose this button to make the phone call that sends your instructions to Bank On-Line.
Inquiry button
Choose this button to get an immediate payment status of a particular payment or to write
a letter to Bank On-Line.
Also choose the Inquiry button to review or change the contents of a previously written 
letter.
Options button
Choose this button to specify how you want Microsoft Money to download transactions 
from Bank On-Line.
Close button
Choose this button to exit without sending instructions to Bank On-Line.
________________
See also

Enabling Accounts for Pay On-Line or Bank On-Line

User's Guide
Chapter 32



Letter (Bank On-Line)

You can send letters electronically to Bank On-Line to order new checks, get copies of 
processed checks, dispute transactions, or send general-purpose inquiries. Bank On-Line 
will generally respond within two business days. Remember, you will have to call Bank On-
Line to retrieve the response to your letter.

Dialog Box Options
General Purpose Letter
Choose this option to send any general-purpose inquiries.
Request a Copy of a Check
Choose this option to receive a copy of a processed check. Be sure to complete the 
information needed when choosing this option.
Order New Checks
Choose this option to order new checks. Be sure to complete the information needed when
choosing this option.
Att'n
Type the name of the bank, person, or department to whom you want to direct your letter.
Subject
Type a short title or subject for your letter.
Dear Bank On-Line Service
Type the content of your letter. You can write a maximum of 18 lines.
OK button
Choose this button when you're done.



Bank On-Line Options

These options determine when Money asks for confirmation when matching your bank's 
downloaded transactions with your Money transactions.

Dialog Box Options
Look for Matching Transactions Within a xxx Day Range
Use this to specify the range of dates Money will search through when matching the bank's
transaction records with your Money transaction records. For example, if you type one as 
the number of days, Money will automatically match transactions that have cleared the 
bank within one day of the date you recorded for the transaction in Money.
Ask Me to Confirm Every Transaction
Choose this option to have Money confirm every transaction it downloads. This method 
takes a little longer to get the bank records into Money, but gives you more control and 
enables you to add memos and to categorize each transaction.
Never; Enter All Transactions Without Asking For Confirmation
Choose this option if you don't want Money to confirm any transaction matches. This is the
fastest option because all transactions are added to Money automatically. Later, you can 
review all transactions and add memos or categories, if necessary.
Attach the Bank's Transaction Description to the Memos in Money
Choose this option if you want the bank or credit card company's transaction details 
entered into the Memos field in your Money records. If you already have an entry in the 
Memo field, it will not be deleted.
These details can include the posting date at your bank, the address of the ATM, or a 
description of a bank fee, whatever the bank chooses to tell you about this transaction.
OK button
Choose this button after you have chosen your options.



Complete Address

Pay On-Line needs a complete address in the format displayed on the right of the dialog 
box in order to send your payment.

Dialog Box Options
Old Payee
This is the payee's address in the old format.
Street
Type the street address or post office number of the payee for this Electronic Payment.
City
Type the full name of the city. Do not use abbreviations.
State
Type the two-letter U.S. Postal Service abbreviation for the state, or choose it from the list.
Zip
Type the zip code, using five or nine digits.
Account Number
Type the account number from your billing statement from this payee. If you don't know 
the account number, or if this is a personal check, type your name.



Confirm Transaction

If Bank On-Line downloads a transaction that Microsoft Money cannot find in its records, 
Money will add it into the Account Book. If you want these transactions to be entered 
automatically without your confirmation, choose the Options button, and then choose the 
other confirmation option. 
You can add additional information to the transaction in the Confirm Transaction dialog box,
or you can add the information in the Account Book later.

Dialog Box Options
Your Bank's Records Show This Transaction
This is the information your bank has about this transaction. You can add additional 
information in the Memo and Category fields.
Continue button
Choose this button to enter the transaction and move to the next.
Options button
Choose this button if you want to view or change your Bank On-Line confirmation options.
________________
See also

Changing Your Bank On-Line Options

User's Guide
Chapter 32



Confirm Match

The Confirm Match dialog box verifies transactions that seem to match, based on amount, 
check number, and date. To change when you want Money to ask you for confirmation, 
change your Bank On-Line options. For more information, see Changing Your Bank On-Line 
Options.

Dialog Box Options
Your Bank's Records Show This Transaction
This is the transaction that was downloaded from Bank On-Line.
Your Money Records Show This Transaction
This is the transaction taken from your Microsoft Money records.
Yes, They Are The Same
Choose this option to confirm that they represent the same transaction.
No, They Represent Different Transactions
Choose this option if -- although they have the same amount -- they are not the same 
transaction.
Continue button
Choose this button to go to the next transaction confirmation.



Amount Doesn't Match

Microsoft Money found transactions with the same check number, but with different 
amounts. This is most often caused by an incorrect amount or check number entered in the
Account Book.
Important    If you think the bank made a mistake, don't delete the bank transaction 
entered in Money. Call your bank. If they made the error, they will correct it and issue an 
adjustment transaction that will be downloaded into your Account Book and compensate 
the error.

Dialog Box Options
Change the Amount in My Money Records; The Bank is Correct
Choose this option to replace the amount in the Account Book with the bank's amount.
Add The Bank's Transaction To Money, But Don't Change My Existing Money 
Records
Choose this option to add the bank's transaction to your Money records without altering 
the amount of the check in your Money records.
Continue button
Choose this button to go to the next transaction.



Money On-Line Services

On-Line Services allow you to do common banking tasks from your computer. You can 
enable accounts for Pay On-Line, Quotes On-Line, Bank On-Line, or any combination of the 
three.
You should not enable your accounts for On-Line Services until after you've received the 
start-up kit. The start-up kit will list the accounts that have been approved for On-Line 
Services and will give you instructions on how to enable your accounts. For information on 
completing the application for On-Line Services, see Applying for On-Line Services.

Dialog Box Options
Pay On-Line
Choose this option if the start-up kit sent to you by On-Line Services notifies you to enable 
this account for Pay On-Line.
Pay On-Line lets you pay bills electronically to anyone in the U.S. (with limited exceptions).
Bank On-Line
Choose this option if the start-up kit notifies you to enable this account for Bank On-Line.
Bank On-Line lets you electronically update your bank or credit card records, transfer 
funds between your accounts (if both are enabled for Bank On-Line), check your current 
balances, send inquiries, and order new checks -- just like working with a bank teller.
Purpose of the Bank Account
If you are enabling Bank On-Line, choose the purpose of this account from the list. The 
start-up kit will give you this information.
Bank On-Line Routing Number
Type the online routing number that came in your On-Line Services start-up kit.
Your start-up kit is mailed to you after your On-Line Services application is approved.
OK button
Choose this button when you are done and want to enable a different account listed in the 
start-up kit.



Pay On-Line Info

In the Pay On-Line Info dialog box, you can view the mailing address of your Pay On-Line 
payees, and see the number of business days it takes to send them payments. This is only 
for your information. You do not need to calculate when to send a payment; Pay On-Line 
does it for you.

Dialog Box Options
Add On-Line Payees
Choose this button to display the list of regional and national payees that Pay On-Line is 
able to transmit payments to electronically at a centralized address. From there you can 
enable more On-Line payees. Using On-Line Payees saves time and helps avoid errors. 
Payments sent to On-Line Payees, can be made in one day, but non-Pay On-Line payees 
require up to four business days to process because On-Line Services needs time to print 
the check and send it through the mail.
Close button
Choose this button when you are finished.



Add On-Line Payees

Payments sent to On-Line Payees can be made in one day because they are sent 
electronically to a centralized address. (Payments that are not sent to a centralized address
take four business days to process because On-Line Services needs time to print a check 
and send it through the mail.) Using On-Line Payees also helps avoid errors.

Dialog Box Options
List of On-Line Payees
Highlight the payees you use or might use in the future.
Add button
Choose this to add the highlighted payee to your Payee List.



Modem Options

Dialog Box Options
Serial Port
Choose the serial communications port your modem uses. If you are unsure, call your 
computer dealer.
Most PCs use COM1 or COM2 for modem connections. If your mouse is using COM2, try 
COM1 for your modem.
Modem Speed
Choose the speed of the modem you will be using for On-Line Services. If you don't know 
the speed of your modem, check the modem box or call the dealer. 
On-Line Access Phone #
Type the local On-Line Services phone number that came with your start-up kit. This is the 
number you use when connecting to On-Line Services.
Dialing
Choose whether your phone service is Tone or Pulse dialing. Rotary phones use Pulse 
dialing, and most push-button phones use Tone dialing.



Quotes On-Line

The Quotes On-Line dialog box lists all your instructions that are ready to be sent to Quotes
On-Line. Once they are sent, the most recent closing prices of the stocks and mutual funds 
chosen in the list will be electronically downloaded, and a record will be entered in the 
Update Price dialog box.

Dialog Box Options
Instructions For Quotes On-Line
All the instructions you want to send should have an "X" in the box to the left. 
Choose or clear instructions by clicking the instruction or highlighting it with an ARROW key 
and then pressing the SPACEBAR key.
Call button
Choose this button to initiate the phone call that sends your instructions to Quotes On-
Line.
Close button
Choose this button if you do not want Microsoft Money to connect to Quotes On-Line.
________________
See also

Creating a List of Instructions for On-Line Services



Call Summary

The Call Summary dialog box acknowledges all instructions sent during this call and gives 
information about any errors that might have occurred.
The Call Summary also includes any informational notes from On-Line Services or 
information you've requested, such as transaction details or responses to previously sent 
letters.

Dialog Box Options
Continue button
When you choose this button, the information in the Call Summary window will be 
automatically downloaded into your Money records.
Copy to Clipboard Button
Choose this button to copy the information in the Call Summary window to the Clipboard 
for use in another application.
Save as button
Choose this button to save your call summary information in a TXT file.



Save As

Use the Save As dialog box to save your call summary information in a TXT file.
Dialog Box Options

File Name
Type a name for the TXT file.
Directories
Displays the current directory. You can choose a different one.
Drives
Displays the current drive. You can choose a different one.
Network button (displays only if connected to network)
Lets you connect to a shared directory.
________________
See also

User's Guide
Chapters 28, 31 & 32





Loan List

In the Loan List dialog box, you can create a new loan, delete or rename an existing loan, 
and enter and change information about a loan. The information displayed to the right of 
the Loan List box relates to the highlighted loan.

Dialog Box Options
Loan List
Lists the names of all loans in the Loans window and displays the current balance for each.
Create button
Creates a new loan.
Delete button
Deletes the selected loan.
Rename button
Renames the selected loan.
Change Loan Information button
Changes information for the selected loan, such as other fees, interest rate, loan length, 
and payment frequency.
Report button
Displays the Loan List Report. You can print a list of your loans for reference. You can 
include the loan number, shortcut, other fees, and loan type as additional information.
Calculator button
You can use the Loan Calculator to answer "what if" questions like, "How would my 
payment change given a change in the interest rate?" by typing the information you know 
and leaving one unknown value to be calculated.
Shortcut
You can type a shortcut for the selected loan using six characters or less. It's best to use a 
shortcut that's easy to remember. Shortcuts are useful when you have several loans with 
similar names.
Loan Number
You can type the loan number for the selected loan so that it's readily available for 
reference. This number will display in the Memo field of your loan payment transactions 
and will print on the Memo line if you decide to print checks.
Comment
You can type a comment about the selected loan. For example, the lender's address or 
phone number may be included as a comment.
Loan Amount, Interest Rate, Length, and Payment
You can see a brief summary of the loan terms for the selected loan.
________________
See also

Introduction to Loans
Using the Loan Calculator
Setting Up a Loan
Changing Loan Information
Deleting a Loan
Renaming an Item on a List
Printing a List





(**dlgidLoanCalc - This topic is no longer in use **)
Loan Calculator

You can use the Loan Calculator to help answer questions about existing loans or loans you 
are considering by typing the information you know and leaving one unknown value blank.
Tip    Microsoft Money will continue to calculate the same value if you change other values 
and choose the Calculate button. If you are calculating the same value, you don't have to 
clear it each time.

Dialog Box Options
Loan Amount
Type the loan amount.
Interest Rate
Type the Simple Interest Rate for the loan you are calculating.
Length of Loan
Type the length of the loan in months, years, or number of payments.
Frequency
Choose how often loan payments are made.
Principal + Interest
Type the principal + interest amount of the loan payment. This does not include other 
fees--such as insurance and tax reserves--associated with the payment.
Balloon Amount
Type the balloon amount, if there is one, due at the end of the loan.
If you have a balloon before the end of the loan, leave the field 0.00. Money can only 
calculate balloon payments due at the end.
Calculate button
Calculates the unknown value based on the information supplied.
Clear button
Clears all entries and sets Frequency to Monthly.
Report button
Displays a Loan Amortization Schedule report based on the values in the Loan Calculator. 
You can print this report for reference. You can also customize it to suit your needs.
________________
See also

Using the Loan Calculator



Customize Loan Report

Loan Reports display information on past and future loan payments and show how 
payments are broken into principal and interest.

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Include Fields
Choose which fields you want to include in your report. These will be displayed as column 
headings across the top of your report.
Subtotal By (None)
Choose this if you don't want your loan payments subtotaled.
Subtotal By (Quarter)
Choose this to group your loan payments quarterly and have a subtotal for each.
Subtotal By (Year)
Choose this to group your loan payments annually and have a subtotal for each.
Show Opening Balance
Choose this to show the principal balance as of the beginning date specified for this report.
To display the original loan amount, choose this box and choose "All Dates" in the Dates 
box.
Show Splits
Choose this to show each part of your loan payment: principal, interest, and other fees.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Transactions - From Loan
Choose which loans you want to include in the report.
All Transactions
Choose this to include all transactions in your report. This includes paid transactions in the 
Loans window, and unpaid loan payments listed in the Loan Amortization Schedule.
From Loan Register
Choose this to include only those transactions listed in the Loans window. This does not 
include unpaid loan payments in the Loan Amortization Schedule.
From Amortization Schedule
Choose this to include only unpaid loan payments in the Loan Amortization Schedule. This 
does not include paid transactions listed in the Loans window.
Widths
Choose this to set the column width. If you are having trouble fitting your report on one 
page, try Narrow width and Landscape orientation.
Fonts
Choose this to specify the size and style of the typeface in the report.
________________
See also

Loan Reports

User's Guide
Chapter 25





Customize Loan Amortization Schedule

The Loan Amortization Schedule is a hypothetical report used to see how future loan 
payments will be broken into principal and interest.

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Subtotal By (None)
Choose this if you don't want your loan payments subtotaled.
Subtotal By (Quarter)
Choose this to group your loan payments quarterly and have a subtotal for each group.
Subtotal By (Year)
Choose this to group your loan payments annually and have a subtotal for each group.
Show Opening Balance
Choose this to display the principal balance as of the beginning date specified for this 
report. To display the original loan amount, choose this box and choose "All Dates" in the 
Dates box.
Include Date
Choose this to display a column for each scheduled payment.
Include Payment Amount
Choose this to display a column for the payment amount (principal + interest + other 
fees).
Include Principal Amount
Choose this to display a column for the principal amount of the loan payment.
Include Interest Amount
Choose this to display a column for the interest amount of the loan payment.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Widths
Choose this to set the column width. If you are having trouble fitting your report on one 
page, try Narrow width and Landscape orientation.
Fonts
Choose this to specify the size and style of the typeface in the report.
________________
See also

Loan Payment Reports



Customize Loan List Report

Loan List Reports display a summary of each loan and its terms.
Dialog Box Options

Title
Type a descriptive title for the report. You can use up to 64 characters.
Loan Terms
Choose this to display columns for the loan amount, interest rate, length of loan, principal 
and interest, frequency of payments, and balloon amount.
Payment Details
Choose this to display columns for the payee, payment amount, and amount for other 
fees.
Categories
Choose this to display columns for the principal and interest categories.
Loan Number
Choose this to display a column for the loan number. This is the number the lender 
assigns.
Shortcut
Choose this to display a column for shortcuts you assigned to your loans.
Payment Splits
Choose this to display the parts of your loan payment: principal, interest, and other fees.
Loan Balance
Choose this to display a column for the remaining balance of your loan. If it is a loan you 
are borrowing, this is the amount you owe. If it is a loan you are lending, this is the amount
owed to you.
Loan Type
Choose this to display a column specifying whether the loan was borrowed or lent and a 
column indicating if the interest is calculated based on the date the payment is due or the 
date the payment is received.
Widths
Choose this to set the column width. If you are having trouble fitting your report on one 
page, try Narrow width and Landscape orientation.
Fonts
Choose this to specify the size and style of the typeface in the report.
________________
See also

Loan Payment Reports
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Balance Loan

In order to reconcile any differences between your records in Microsoft Money and the 
interest, principal, and other fees shown on your loan statement you'll probably want to 
balance your loan after receiving a statement from your lender.

Dialog Box Options
Statement Starting Date
Accept or change the statement starting date. You must enter a date on or after the start 
date of the loan.
Statement Ending Date
Enter the ending date on your loan statement.
Continue button
Advances to the next screen so you can enter the principal and interest paid on your loan 
statement.
________________
See also

Balancing a Loan
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Chapter 24



Balance Loan

Because lenders use many different methods to calculate interest, it may be necessary to 
periodically update your principal, interest, and other fee amounts in Microsoft Money to 
match the loan statement.

Dialog Box Options
Principal Paid
Accept the principal amount if it matches the principal on your loan statement. If it differs, 
change it so it equals the amount on your statement.
Interest Paid
Accept the interest amount if it matches the interest on your loan statement. If it differs, 
change it.
Other Fees button
Opens a split window where you can change the amounts for other fees. If any fees differ, 
make the appropriate changes in the Other Fees screen.
________________
See also

Balancing a Loan
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Rename Loan

You can rename your loan and the new name will appear everywhere the old name did.
Dialog Box Options

Old Name
Displays the current name for the loan.
New Name
Type a new loan name to replace the old one.



Adjust Loan Payment Amount

Your total loan payment is not equal to the sum of the loan split amounts. The difference 
between the loan payment and the sum of the splits is summarized in the top box. To 
resolve the unassigned amount, choose one of the options.

Dialog Box Options
Apply All of the Unassigned Amount to Principal
Choose this option if the total loan payment is correct, but the split amount assigned to 
principal is incorrect. Typically, you should choose this option if you're adding extra 
principal to a regular loan payment.
Apply the Entire Loan Payment to Principal
Choose this option if the total loan payment is correct, and you want the entire payment to
go toward principal. Typically, you should choose this option when you are making an extra
payment. Microsoft Money will remove any other split amounts and assign the total loan 
payment to principal.
Manually Change the Split Amounts in the Split Dialog Box
Choose this option if the total loan payment is correct, but the split amounts are incorrect. 
Money will bring up the split dialog box for you to edit the principal, interest, and other fee 
amounts.
Change the Loan Payment Amount to be the Sum of the Loan Split Amounts
Choose this option if the total loan payment is incorrect, but the split amounts are correct. 
Money will update the total loan payment to equal the sum of the split amounts.
Cancel Changes, Revert to the Regular Loan Payment and Split Amounts
Choose this option if you want to delete any changes you made to the loan payment and 
revert to the regular loan payment. Typically, you should choose this option if you've made
unintended changes. Money will replace your changes with the regular loan payment 
amount and regular split amounts.
Leave the Amount Unassigned (not recommended)
Choose this option if the total loan payment is correct and the split amounts should not be 
adjusted. Money will continue with an unassigned amount. Unassigned amounts can 
adversely affect your balances in reports.
________________
See also

User's Guide
Chapter 24



Select Loans

You can choose which loan or loans you want included in the customized report.
Dialog Box Options

Loan List
Highlight the loans you want included in the customized report by clicking on the ones you
want, or by using the ARROW keys to move to the loans you want and pressing the SPACEBAR.
Select All button
Choose this button to select all of the loans.
Select None button
Choose this button to select none of the loans.



Adjust Loan Interest

You have changed the date on the loan payment, so the interest calculated as being due on
this date is different than the interest in this loan payment.

Dialog Box Options
Correct the Interest and Adjust the Principal Amount
Choose this option to change the principal and interest amounts so they still equal the 
total amount of the loan payment, which will not change. This is the most common option.
Correct the Interest and Adjust the Payment Total
Choose this option to increase or decrease the interest so that it equals the interest 
calculated as being due on this date. The total amount of the loan payment is adjusted to 
reflect the change in interest.
Ignore the Discrepancy (not recommended)
Choose this option if you don't want to adjust any part of your loan payment.
________________
See also

User's Guide
Chapter 24



Update Default Loan Payments

You have made changes to a Future Transaction that matched the default loan payment for 
a loan. You can choose how you want this change to affect your other Future Transactions 
for this loan.

Dialog Box Options
Change the Default Loan Payment and Matching Future Transactions
Choose this option if you want the changes you made to become the new default loan 
payment for this loan. Other Future Transactions that match the default loan payment will 
also be updated with the changes.
Change Only the Default Loan Payment
Choose this option if you want the changes you made to become the new default loan 
payment for this loan, without updating other Future Transactions.
Change Only This Payment
Choose this option if you don't want your changes to affect the currently selected Future 
Transaction.
________________
See also

User's Guide
Chapter 24



Change Loan Information

You can update your loans in Microsoft Money so they match your lender's records and 
have your future payments reflect the change. You can also make adjustments to the loan 
balance.

Dialog Box Options
Change Other Fees (such as insurance or tax reserves)
If the entire loan payment goes toward principal and interest, you do not have other fees.
Change Interest Rate
Typically, you will change the interest rate if you have an adjustable rate loan, such as an 
Adjustable Rate Mortgage (ARM).
Adjust Loan Balance
Choose this option if you want to reconcile any differences between your records in Money 
and the interest, principal, and any other fees on your loan statement.
Change Other Loan Information
Choose this option if other loan information is changing, for example, if you are refinancing
your loan.
If you want to change the payee, frequency of payments, length of the loan, categories, 
other fees, or other loan information, choose this option.

User's Guide
Chapter 24





Print Setup (Reports and Charts)

Dialog Box Options
Printer
Choose the default printer or one from the list of currently installed printers. For 
information on installing a printer, see your Microsoft Windows(TM) documentation.
Orientation
Under Orientation, choose Portrait, if you want to print reports vertically, or Landscape, if 
you want to print horizontally.
Paper: Size
Choose the size of paper you are using.
Paper: Source
Choose how the paper will be fed into the printer, for example, from the upper or lower 
tray, by manual feed, or automatically.
Options button
Displays a dialog box that allows you to make additional printing adjustments to take full 
advantage of the specific printer you are using.
Network button (displays only if connected to a network)
Choose this to browse through and connect to a network printer.
________________
See also

Printing Charts
Printing Reports
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Print Setup

Use the Print Setup command to choose or change the printer, or to set up and change the 
printer's settings.

Dialog Box Options
Setup For: Report and Chart Printing
Choose to print reports and charts.
Setup For: Check Printing
Choose to print checks.
Printer
Choose either the default printer or one from the list of currently installed printers. For 
information on installing a printer, see your Microsoft WindowsTM documentation.
Orientation (Reports only)
Under Orientation, choose Portrait, if you want to print reports vertically, or Landscape, if 
you want to print reports horizontally.
Check Type (Checks only)
Choose the type of check you want from the list.
Paper: Size (Reports only)
Choose the size of paper you want.
Paper: Source
Choose how the paper will be fed into the printer, for example, from the upper or lower 
tray, by manual feed, or automatically.
Options button
Displays a dialog box that allows you to make additional printing adjustments to take full 
advantage of the specific printer you are using.
________________
See also

Setting Up to Print Checks and Reports
Printing Checks
Printing Reports
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Confirm Printing

Dialog Box Options
Continue button
Choose this option if the test check was printed correctly and you want to continue 
printing the checks.
Reprint button
Choose this option if the printing was unsatisfactory, and you would like to reprint the 
checks using different printer settings.
________________
See also

Setting Up to Print Checks and Reports
Printing Checks



Print Checks

Prints checks marked "Print" in the Number field. If you are using a dot-matrix printer, you 
must make sure the printer is set up to print 10 characters per inch horizontally and six 
lines per inch vertically.

Dialog Box Options
Print Range
Choose Print All if you want to print checks for all transactions marked with "Print" in the 
Number field of the account you're displaying. Choose Select Checks if you want to choose
specific transactions to print checks for.
Print Test button
Choose the Print Test button if you want to print a test check to make sure that the 
information will print in the right location on the check.

Note    When you are ready to print, in the box at the bottom of the Print Checks dialog box,
type the number of the first check loaded in your printer. Then choose the OK button.
________________
See also

Setting Up to Print Checks and Reports
Printing a Sample Check
Printing Checks
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Print Checks

Prints checks marked with "Print" in the Number field. Make sure you leave the strip of 
paper attached at the bottom of the check while printing a partial sheet.

Dialog Box Options
Print Range
Choose Print All if you want to print checks for all transactions marked with "Print" in the 
Number field of the account you're displaying. Choose Select Checks if you want to choose
specific transactions to print checks for. Be sure to type the number of the first check 
loaded in the printer in the box to the right of step 2.
Print Test button
Choose the Print Test button if you want to print a test check to make sure that the 
information will print in the right location on the check.

Options for Laser Standard and Laser Wallet Checks
Number of Checks Remaining
Load the partial sheet of checks in the envelope feeder on your paper tray, and then 
choose the number of checks remaining on the sheet.
Feeder
Choose the In The Center of Feeder option if the envelope feeder is located in the center of
the paper tray, or choose the Along the Side of Feeder option if you load the checks from 
one side of the paper tray.
Paper
Choose the Right Edge First option if your printer requires that you feed partial sheets with
the right edge of the check first. Choose the Left Edge First option if your printer requires 
that you feed partial sheets with the left edge of the check first.
________________
See also

Setting Up to Print Checks and Reports
Printing a Sample Check
Printing Checks
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Select Checks

In the Select Checks dialog box you can choose the transactions you want to print checks 
for.

Dialog Box Options
Select All button
Choose Select All to select all transactions with "Print" in the Number field.
Select None button
Choose Select None to select no transactions. For example, you might choose the Select 
None button if you had selected some transactions by mistake and wanted to start over.



Select Check Type

In the Select Check Type dialog box, verify before printing that the correct check type has 
been selected.

Dialog Box Options
OK button
Choose the OK button once you have verified that the correct check type has been 
selected.



Print Report

Prints the displayed report. You can choose how much of your report you want to print and 
whether you want it to print vertically or horizontally. You can also change printer settings.

Dialog Box Options
Print Range
Choose the All button to print every page in the report, or choose the Pages button to 
specify a range of pages to print.
Print Quality
Choose a print quality (for example, High, Medium, Low, Draft) from the list.
Copies
Choose the number of copies you want to print.
Collate Copies
Choose if you want several copies of a report to be printed in sequence. For example, if 
you wanted to print two copies of a three-page report, the copies would be printed in the 
following order: 1-2-3, 1-2-3. Turning this option off may result in faster printing of multiple 
copies of multi-page reports, but you will have to collate the pages manually after printing.
Setup button
Displays the Print Setup dialog box, where you can change the printer you want to use, or 
set up and change the printer settings for your printer. Under Orientation, choose Portrait if
you want to print reports vertically, or choose Landscape if you want to print reports 
horizontally.
________________
See also

Setting Up to Print Checks and Reports
Printing Reports
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Select Account to Print Checks

The Select Account dialog box is displayed if you are viewing more than one account in the 
Account Book when you choose Print Checks. Checks can only be printed from one account 
at a time.

Dialog Box Options
Account List
From this list, choose the account from which you want to print checks 
Continue button
Opens the Print Checks dialog box.





Remembered Reports

You can save a report -- and its most recent chart -- by having Microsoft Money remember 
it. Once a report is remembered, you can display it again by choosing Remembered Report 
from the Reports menu. You can then view, delete, or rename it. If you customize a report 
to include one of the standard date range options -- such as Last 30 Days -- Money re-
creates the report for the date range specified each time you display the report.

Dialog Box Options
Report Name
Displays a list of remembered reports. You can choose the report you want to display.
Report Type
Displays the report type of the remembered report.
View
Choose to view the remembered report.
Delete
Choose to delete the remembered report. You will be asked to confirm the deletion.
Rename
Choose to rename a remembered report.
________________
See also

User's Guide
Chapter 6



Remember Report

You can save a report for future use by having Microsoft Money remember your report 
customizations.

Dialog Box Options
Report Name
Type a descriptive name for the report, using up to 32 characters.
________________
See also
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Rename Remembered Report

Dialog Box Options
Old Name
Displays the current name for the report.
New Name
Type a new name for the report.
________________
See also

User's Guide
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Customize Tax Form Report

Tax Form Reports are a good starting point for preparing your taxes or preparing your 
records for export to a tax-preparation program.

Dialog Box Options
Title
Type a descriptive title for the report. You can use up to 64 characters.
Report Type - Tax Summary
Choose this to display only tax form lines and amounts in the report.
Report Type - Tax Transactions
Choose this to display columns for number, date, payee, memo, category, job, client, and 
amount.
Date Range - Dates From/To
Use this to limit the report to the dates specified.
Include Transactions - From Account
Choose which accounts you want included in the report.
All Transactions
Choose this to include all transactions in the report.
Select Transactions
Use this to choose which transactions are included in the report. For example, you could 
include only transactions assigned to several specific categories.
Widths
Choose this to set the column width. If you have trouble fitting your report on one page, 
try choosing the Narrow option, or set your printer to use landscape orientation.
Fonts
Choose this to specify the size and style of the typeface in the report.
________________
See also

User's Guide
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Export Tax Form Report

Instead of typing your tax-related information in a tax-preparation program, you can export
-- or transfer -- the Tax Form Report electronically to a tax preparation-program. By 
specifying another file format, you can also export the Tax Form Report to a spreadsheet or 
word processor.

Dialog Box Options
File Name
Accept the proposed file name, or type a new one for the exported report.
Create File of Type
To export the report to a tax-preparation program, choose Tax Exchange Format as the 
type. If you want to export the report to a spreadsheet or word processor, choose Tab-
Delimited Text as the file type.
Directories
Displays the current directory. You can choose to export your report to a different directory.
Drives
Displays the current drive. You can choose to export your report to a different drive.
Network button (displays only if connected to a network)
Choose this to browse through and connect to a network printer.
________________
See also

User's Guide
Chapter 36





Mark Transaction Range as Cleared

Dialog Box Options
From / To Boxes
Type the range of numbers of the transactions you want to clear.
________________
See also

User's Guide
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Go To a Specific Transaction

Dialog Box Options
Last Transaction Edited
Choose this option to return to the transaction you just entered.
Other Side of This Transfer
Choose this option if you're displaying a transfer transaction and you want to go to the 
other side of the transfer.
Other Side of Investment Transaction
Choose this option if you want to switch to the window where the investment transaction 
was recorded.
Main Transaction for this Split
Choose this option if you're displaying a transaction that is part of a split and you want to 
display the main transaction for that split.



Archive Account

In the Archive Account dialog box, you can choose which type of transactions you want 
Microsoft Money to remove.

Dialog Box Options
Remove all Transactions
Choose this option if you want Money to remove all transactions before the specified date.
Remove Only Cleared and Reconciled Transactions 
Choose this option if you want Money to remove only transactions that are considered 
cleared and reconciled. Money considers cleared transactions to be those with a letter "C" 
in the Cleared field; reconciled transactions have an "R" in the Cleared field.
Remove Only Reconciled Transactions 
Choose this option to have Money remove only the transactions that have been reconciled.
Don't Remove Any Transactions
Choose this option if you don't want Money to remove any transactions.



Microsoft Money 1.0 and 2.0 File Conversion

If you are about to open a file created in Microsoft Money version 1.0 or 2.0, it will need to 
be converted to the 3.0 file format. It may be useful to save a copy of the old file as a 
precautionary measure.

Dialog Box Options
Yes button
Choose this button to save an extra copy of the file in its original version format. Money 
will add the .MNY extension to the file.
No button
Choose this button to convert the file to version 3.0 format without saving an earlier-
version copy.
Cancel button
Choose this button to cancel the conversion.
________________
See also
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Archive Loan

In the Archive Loan dialog box, you can choose how you would like Microsoft Money to 
adjust each Loan Account to compensate for the removed transactions.

Dialog Box Options
Adjust Loan Balance For the Transactions Removed
Choose this option if you want Money to compensate for the removed transactions by 
adjusting the opening balance of the loan.
Record Removed Transactions as a Single Transaction For Each Year
Choose this option if you want Money to compensate for the removed transactions by 
entering a summary transaction for each year.
Record Removed Transactions as a Single Transaction
Choose this option if you want Money to compensate for the removed transactions by 
entering one summary transaction.
Don't Remove Any Transactions
Choose this option if you prefer that Money not remove any transactions from the loan 
specified in the dialog box.



Archive Investment Account

In the Archive Investment Account dialog box, you can choose which type of investment 
transactions you want Microsoft Money to remove.

Dialog Box Options
Remove all Transactions
Choose this option if you want Money to remove all investment transactions before the 
specified date.
Remove Only Cleared and Reconciled Transactions 
Choose this option if you want Money to remove only investment transactions that are 
considered cleared and reconciled. Money considers cleared transactions to be those with 
a letter "C" in the Cleared field; reconciled transactions have an "R" in the Cleared field.
Remove Only Reconciled Transactions 
Choose this option to have Money remove only the investment transactions that have 
been reconciled.
Don't Remove Any Transactions
Choose this option if you don't want Money to remove any investment transactions.



Entering Transactions

Introduction

Introduction to Entering Transactions

Entering Transactions

Choosing a Check or Other Form
Entering a Transaction in Account Forms
Entering a Transaction in the Account Book
Converting Foreign Currencies
Entering Information You Don't Want Printed on Checks
Itemizing a Paycheck Deposit
Quick Ways to Enter Transactions
Speeding Up Date Entry
Working With SmartFill

Managing Transactions

Copying or Moving Information
Deleting or Removing a Transaction
Making Changes to a Transaction
Marking a Transaction as Cleared or Reconciled
Moving Transactions from One Account to Another
Quickly Deleting a Transaction
Voiding a Transaction



Introduction to Entering Transactions

You'll enter transaction information into individual areas or boxes, called fields.
Entering transactions in the Account Book window is much like working in your checkbook 
register. Entering transactions in the Account Forms window is like using typical paper 
forms, such as checks and withdrawal slips.
You can use either the Account Book or Account Forms to enter transactions. Which one you
use is mostly a matter of personal preference.
Since you'll probably start by entering transactions from your checkbook register into 
Microsoft Money, you may want to begin entering transactions in the Account Book, where 
you can see many transactions on the screen at the same time. In the Account Forms 
window, you can see only one transaction at a time.
If you're using Microsoft Windows for Pen Computing, you may find it easier to use a pen in 
the Account Forms window.
If you enter a payee that was used in a previous transaction, when you move to the next 
field, Money will fill in the information from the last transaction that involved that payee. If 
you want to change what was filled in, just type over it.
Note    You can use the Payee field to see your last five transactions for the current payee 
by clicking the right mouse button (or pressing SHIFT+F10) in the Payee field. To close the 
list, click either mouse button (or press any number or letter key).
Each transaction you enter is automatically saved for you, so you don't have to save files or
accounts when quitting Money. For this reason, Money has no Save command.
________________
See also

Entering a Transaction in the Account Book
Entering a Transaction in Account Forms
Quick Ways to Enter Transactions
Working with SmartFill
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Entering a Transaction in the Account Book

To enter a transaction in the Account Book
1 If you're not already in the Account Book window, double-click the Account Book icon, or, 

from the Window menu, choose Account Book.
2 From the Account box on the toolbar, choose the account you want.
3 Press TAB to start entering information.
4 Enter the information you want In each field, or accept the proposed entry.

See the table below for additional information about some fields.
5 Press TAB to move to the next field, or press SHIFT+TAB to move to the previous field. Use 

the ARROW keys to move up and down.
6 To complete the transaction, press ENTER.

When you enter a transaction, it is automatically saved for you.
Note    To cancel a transaction you've started, press ESC.

Field Additional 
information

Number If you are going to 
print the check, type
the word "Print" 
instead of a number.
Leave the Number 
field blank for 
transactions such as
deposits and cash 
machine 
withdrawals.

Date Use a slash ( / ) or a 
hyphen (-) as a 
separator between 
month, day, and 
year.

Payee You can choose from
a list of previously 
entered payees, or 
type what you want 
in the field. After 
you enter a payee, 
you can click the 
right mouse button 
in the Payee field to 
see a list of the last 
five transactions for 
that payee.

C This field is used to 
indicate whether or 
not the transaction 
has cleared the 
bank or been 
reconciled against 



your account 
statement.

Payment Use this field if the 
amount of the 
transaction 
decreases the 
account balance. 
This column heading
will vary depending 
on the account type.

Deposit Use this field when 
the transaction 
increases the 
account balance, 
such as for deposits 
and credits. This 
column heading will 
vary depending on 
the account type. 

Memo Type a memo to 
help you remember 
details about a 
transaction. It will 
print on the check. 
Do not use this field 
to identify the 
transaction as a 
type of income or 
expense; use the 
Category and 
Subcategory fields 
instead.

Category You can choose from
a list of existing 
categories, or type a
new one. You will 
also use this field to 
indicate transfers, 
loan payments, and 
split transactions.

Subcategory You can choose from
a list of existing 
subcategories, or 
type a new 
subcategory. The 
Subcategory field is 
also used to identify 
the destination 
account for a 
transfer, loan 
payment, or split 
transaction.



Classification
Items

If you've created a 
new classification, 
fields for 
classification items 
and sub-items are 
added below the 
Category and 
Subcategory fields.

Account If more than one 
account is included 
in the View, an 
Account field is 
added below the 
Number field so you 
can choose the 
account you want to
enter the 
transaction in. 
Choose from the list 
of existing accounts,
or type the name of 
a new account.

Note    Unless you have turned off the setting to use SmartFill, Microsoft Money will 
automatically fill in some fields and finish entering known information for you. If you want 
to change what was filled in, just type over it. For more information, see Working with 
SmartFill.
________________
See also

Quick Ways to Enter Transactions
Entering a Transaction in Account Forms

User's Guide
Chapter 3



Entering a Transaction in Account Forms

To enter a transaction in Account Forms
1 If you're not already working in the Account Forms window, switch to it by double-clicking

the Account Forms icon or, from the Window menu, choose Account Forms.
2 From the Account box on the toolbar, choose the account you want.
3 If the form you want is not already displayed, choose it from the set of buttons above the

forms.
4 Press TAB or click the form to begin entering information.
5 In each field, enter the information you want.

See the table below for additional information about some fields.
6 Press TAB to move to the next field, SHIFT+TAB to move to the previous field, or the ARROW 

keys to move up or down.
7 To complete the transaction, press ENTER.

When you enter a transaction, it is automatically saved for you.
Note    To cancel a transaction you've started, press ESC.

Field Additional information
Number If you are going to print 

the check, type Print 
instead of a number. 
Leave the Number field 
blank for transactions 
such as deposits and 
cash machine 
withdrawals.

Date Use a slash ( / ) or a 
hyphen (-) as a separator
between month, day, and
year.

Pay To For check payments, 
choose from a list of 
previously entered 
payees, or type what you
want in the field. After 
you enter a payee, you 
can click the right mouse
button in the Pay To field 
to see a list of the last 
five transactions for that 
payee.

Received From For deposits, choose 
from a list of previously 
entered payees, or type 
what you want in the 
field.

$ (Amount) Enter the amount of the 
transaction.

Memo Type a memo to help you



remember details about 
a transaction. It will print 
on the check. Do not use 
this field to identify the 
transaction as a type of 
income or expense; use 
the Category and 
Subcategory fields 
instead.

Address Enter the payee's name 
and address. To quickly 
enter the payee name, 
press the CTRL key and 
the QUOTATION MARK (") 
key. The contents of this 
field will print on the 
check. This field is only 
available in the Account 
Forms window.

Category You can choose from a 
list of existing categories 
or type of new one. You 
will also use this field to 
indicate transfers, loan 
payments, and split 
transactions.

Subcategory You can choose from a 
list of existing 
subcategories, or type a 
new one. The 
Subcategory field is also 
used to identify the 
destination account for a 
transfer, loan payment, 
or split transaction.

Classification 
items

If you've created a new 
classification, fields for 
classification items and 
sub-items are added 
below the Category and 
Subcategory fields.

Account If more than one account
is included in the view, 
an Account field is added
near the top of the form 
so you can choose which 
account you want the 
transaction entered in. 
Choose from a list of 
existing accounts, or 
type a new one.

Transfers The Account Forms 



window has a special 
Transfer Form with From 
and To fields to make it 
easier to enter a transfer 
transaction.

Note    Unless you have turned off the setting to use SmartFill, Microsoft Money will 
automatically fill in some fields and finish entering known information for you. If you want 
to change what was filled in, just type over it. For more information, see Working with 
SmartFill.
________________
See also

Entering a Transaction in the Account Book
Quick Ways to Enter Transactions

User's Guide
Chapter 3



Quick Ways to Enter Transactions

Using the quotation mark ('') key to fill in single fields

You can fill in a field with the contents of the same field of the most recently entered or 
changed transaction by pressing the QUOTATION MARK (") key in the field.
Also, to enter the payee name in the address field on a check form, you can hold down the 
CTRL key and press the QUOTATION MARK (") key.

Using the plus sign (+) and minus sign (-) keys

You can increase or decrease the transaction number or date by moving to that field and 
pressing the plus or minus sign key. You don't need to use the SHIFT key with the PLUS or 
MINUS key for this to work.

Using shortcuts 

If you frequently enter payees, categories, classification items, or accounts with long, 
similar names, assigning shortcut names makes them easier to enter. The full name will be 
filled in when you move to the next field.

Using SmartFill

Leaving the setting for SmartFill on makes entering information quicker because Microsoft 
Money can often complete the entry for you.
________________
See also

Using Shortcuts
Working With SmartFill



Using Shortcuts

If you use names that are similar, such as Washington Electric, Washington Electrical 
Supplies, and Washington Elementary School, you may want to use shortcut names. 
Microsoft Money will replace the shortcut with the full name when you move to the next 
field or enter the transaction.
SmartFill works with shortcuts, but even if you've turned SmartFill off, you can still use 
shortcuts.

To assign a shortcut
1 From the Lists menu, choose Account List, Payee List, Category List, or Investment 

Account List.
2 From the list, choose the item to which you want to assign a shortcut.
3 In the Shortcut box to the right of the list, type a shortcut name that is six characters or 

less. Use a name that is easy to remember.
4 Repeat steps 2 and 3 until all the shortcuts you want are entered.
5 Choose the Close button.

To use shortcuts while entering transactions
1 In the current transaction, move to the field you want.
2 Type the shortcut.
3 Click another field or press TAB to move to the next field.

Money automatically replaces the shortcut you type with the full name from the list.
________________
See also

Working with SmartFill
Quick Ways to Enter Transactions



Working with SmartFill

SmartFill helps you quickly type text into a single transaction field. It completes the entry of
an item as soon as you type enough characters for it to be identified. If you prefer not using
SmartFill, you can turn it off.
For example, if you have two names that begin with the same letters (such as two 
categories that start with "Automobile"), SmartFill will not complete the entry until you 
have typed enough letters for the name to be uniquely identified. For this reason, it's good 
to think about how you name categories, payees, and accounts in Microsoft Money.
If you enter a payee that was used in a previous transaction, Money will enter the 
information from the last transaction that involved that payee. If you want to change the 
information, just type over it.

To turn SmartFill on or off
1 From the Tools menu, choose Options, and then choose General.
2 Under Entry, choose or clear the Use SmartFill check box.
3 Choose the OK button.
________________
See also

An Account Naming Strategy
Using Shortcuts

User's Guide
Chapters 3 & 15



Adding a Transaction from a Previous Month's Statement

If you've already reconciled your account in Microsoft Money, you can still enter 
transactions from an earlier date. 
For example, If you started using Money in February, and later decided that you'd like to 
track the entire year, you can enter the transactions from the January bank statement. 

To add a transaction from a previous month
Follow the procedure for entering a transaction, then hold down the SHIFT key as you 

click the C (cleared) field, or press SHIFT+CTRL+M to mark the transaction as reconciled.
An "R" for "reconciled" appears in the C (cleared) field.
Note    Adjust your account's starting balance so that the balance includes the earliest 
transaction you entered. Using the previous example, you would want to enter the 
beginning balance from your January statement.

To change the opening balance
1 From the Lists menu, choose Account List.
2 Choose the account you want to change.
3 In the Opening Balance box, type the new amount.
4 Choose the Close button.
________________
See also

Entering a Transaction in the Account Book



Entering a Deposit Less Cash

If you deposit a check and take part of it in cash, you can use a split transaction to track 
how much you deposit and how much you take in cash.

To enter a deposit less cash
1 Enter information in the Number, Date, and Payee fields as you would for any other 

transaction. 
2 In the Deposit field, enter the net deposit (the total amount minus the cash).
3 Choose the Split button, or choose Split Transaction from the Edit menu.

The Amount field in the first part of the Split Transaction box shows the amount of the 
actual deposit.

4 Enter the category, subcategory, and description, and change the amount to equal the 
total amount of the check.

5 Press TAB to move to the second line of the split transaction.
The Amount field of the second line of the split transaction will contain a negative 
amount equal to the cash amount you withdrew from the check. 

6 In the Category field of the second line, enter the name of the category you use for 
miscellaneous cash. Use another category name if you plan to use the cash for a specific 
purpose, or choose Transfer if you use a Cash Account.

7 Press TAB several times to move to the third line. At the bottom of the Split Transaction 
box, the Unassigned Amount should be $0.

8 When the parts of the split transaction contain what you want, choose the Done button 
to return to the transaction in the register.

Note    The amount you enter in the Deposit field before you split a transaction is 
unaffected by changes you make in the Split Transaction dialog box.
________________
See also

Splitting a Transaction

User's Guide
Chapter 3



Transferring Money Between Accounts

When you transfer money between accounts, you can update both accounts at once by 
entering a single transfer transaction in one of the accounts.

To enter a transfer in the Account Book
1 From the Account box on the toolbar, choose the account you want to transfer money 

from.
2 In the Number, Date, Payee, and Memo fields, enter the information as you would for any

other transaction.
3 In the Amount field, enter the amount of the transfer in the column that will decrease the

account balance (in the Payment, Decrease, Spend, or Charge column).
4 In the Category field, type Transfer, or choose it from the list.
5 In the Subcategory field, enter the name of the account you want to transfer to, or 

choose it from the list.
6 To complete the transfer, press ENTER.
Note    The word "Transfer" will change to "Transfer To." The transaction will also be entered
in the account you transferred money to.

To enter a transfer in Account Forms
1 Switch to the Account Forms window.
2 From the Account box on the toolbar, choose the account you want to transfer money 

from.
3 Click the Transfer button, or press ALT+T.
4 In the To box, enter the account you want to transfer money to.

If you want to transfer money from a different account than the one you're working in, 
you can choose the account you want from the list in the From box on the transfer form. 
When you enter the transfer transaction, this will also cause the register account to 
change to All Accounts.

5 In the Amount field, enter the amount you want to transfer.
6 In the other fields, enter the information you want.
7 To enter the transfer, press ENTER.
Note    To cancel a transfer transaction you've started entering, press ESC.
________________
See also

Finding a Specific Transaction
Switching Between Accounts

User's Guide
Chapter 18





Help for the Message:

A communication error occurred. Please try your call again, and if this message 
repeats, call On-Line Services Customer Support.

If you are using a Telebit QBlazer modem, add the following lines to your WIN.INI file:
[MNYESRV]
InitModem=S58=0S180=0S190=0



Help for the Message:

Your modem is turned off, improperly configured, or in use by another 
application.

To ensure your modem is set up correctly, do the following:
Make sure your modem is plugged in and turned on.
Ensure all cables are attached correctly and securely
Make sure the modem cable is connected to the right COM port.
Make sure the correct COM port is selected in Money by choosing Options from the 

Tools menu and then choosing Modem.
Close any applications that might be accessing your modem.
Check that your modem is Hayes-compatible.



Help for the Message:

To use Quotes On-Line, one or more stocks, mutual funds, or money market 
mutual funds must have a valid symbol in the Symbol field of your Investment 
List. Please review your Investment List and add symbols if necessary.

To add investment symbols, choose Investment List from the Lists menu. Then highlight a 
stock or mutual fund in the Investment List and type a symbol in the Symbol box.



Help for the Message:

This payment cannot be made by the date you have specified. The earliest this 
payment can be made is X. You can enter this date or a later date, and Pay On-
Line will make sure it gets paid on time. Do you want to use this new date?

In the Date field, you should enter the date you want the payee to receive this payment 
from Pay On-Line.
Money accepts or rejects the date you enter depending on how many days are needed to 
pay this business or individual. Some payees can be paid in one day, but others will take up
to four business days.



Help for the Message:

Do you want to cancel this scheduled Automatic Payment? If you choose Yes, 
Money will cancel this one payment during your next connection. To permanently
cancel this Automatic Payment, you must void it in the Future Transactions 
window.

To permanently cancel Automatic Payments
1 In the Future Transactions window, choose the recurring payment you want to cancel.
2 From the Edit menu, choose Void Transaction. Money displays **VOID** and a lightning 

bolt indicating this is a pending instruction to cancel the Automatic Payment. This will 
cancel all future payments to this payee. Be sure to send this instruction to Pay On-Line 
before exiting Money.
Note    This will NOT cancel any individual Automatic Payments that have already been 
scheduled in your Account Book.



Help for the Message:

Do you want to permanently cancel this Automatic Payment? If you choose Yes, 
Money will cancel it during your next connection. If this payment is already 
scheduled in the Account Book, you can prevent it from being paid by voiding it 
there.

To cancel an individual Automatic Payment that has already been scheduled
1 In the Account Book, select the transaction you want to cancel. You can identify a 

scheduled Automatic Payment in the Account Book by the letter "A" preceding the check 
number in the Number field.

2 From the Edit menu, choose Void Transaction. Money displays **VOID** and a lightning 
bolt indicating that this is a pending instruction to cancel this scheduled Automatic 
Payment. Be sure to send this instruction to Pay On-Line before exiting Money.
Note    This will cancel only this payment. Other Automatic Payments will continue to be 
paid unless you permanently cancel them.



Help for the Message:

No carrier was detected. Please check your modem settings by choosing Options 
from the Tools menu and then choosing Modem.
Under On-Line Access Phone # In the Modem Options dialog box, be sure you have typed 
the local On-Line Services phone number that came with your start-up kit. This is the 
number that is dialed when you call On-Line Services.
Then, under Modem Speed, Choose the speed of the modem you will be using for On-Line 
Services. If you don't know the speed of your modem, check the modem box or call the 
dealer.



Help for the Message:

You should enter the date when you want this payment to be made, usually the 
bill's due date. The earliest this payment can be made is X. You can enter this 
date or a later date, and Pay On-Line will make sure it gets paid on time. Do you 
want to use this date?

In the Date field, you should enter the date you want the payee to receive this payment 
from Pay On-Line.
Money accepts or rejects the date you enter depending on how many days needed to pay 
this business or individual. Some payees can be paid in one day, but others will take up to 
four business days.



Help for the Message:

To use Pay On-Line or Bank On-Line, you need to enable the appropriate account 
in the Account List. To use Quotes On-Line, you need to add symbols to 
investments in the Investment List.

To enable your account(s) for Pay On-Line or Bank On-Line
1 From the Lists menu, choose Account List.
2 In the Account List dialog box, highlight an account you want to enable, and choose the 

Money On-Line Services button.
3 In the Money On-Line Services dialog box, choose Pay On-Line(sm), Bank On-Line(sm), or 

both.
If you're enabling the account for Pay On-Line, type an account number in the Account 
Number box and choose the Pay On-Line check box.
If you're enabling the account for Bank On-Line, choose the Bank On-Line check box, 
choose a financial institution and enter information in the Account Number, Account 
Designation, and Bank Routing Number fields.

4 Repeat steps 2 and 3 for each account approved for On-Line Services in your start-up kit.
Money will display a lightning bolt next to each account that has been enabled for On-
Line Services.

5 Choose the Close button.
To enable your investments for Quotes On-Line

1 From the Lists menu, choose Investment List.
2 Highlight a stock or mutual fund in the Investment List and type the market-approved 

symbol for the investment in the Symbol box.
3 Choose the Close button.



Help for the Message:

Bank On-Line will only process transfers with today's date. Do you want to use 
today's date?

All transfers are processed by Bank On-Line at the end of the day. On business days, if you 
send a transfer before the bank's evening cut-off time, it will be processed that day. If you 
send it after the cut-off time, it will be processed at the end of the following business day. 
Transfers to and from credit card accounts have an additional one-day delay.
Transactions sent on holidays or weekends will be processed at the end of the following 
business day.



Help for the Message:

There are no instructions ready to send. Do you still want to make the phone 
connection?

Occasionally you will need to connect to On-Line Services even when there are no 
instructions to send, so that you can receive responses to letters you've previously sent to 
On-Line Services or download any scheduled Automatic Payments from Pay On-Line.
Choose the Yes button if you still want to connect to On-Line Services. 

Choose the No button if you first want to create instructions to send. All instructions have a 
check box to the left. Only those with an "X" in the box will be sent when you call On-Line 
Services. You can choose or clear instructions by clicking the instruction or highlighting it 
with an ARROW key and then pressing the SPACEBAR key.
________________
See also

Creating a List of Instructions for On-Line Services



Help for the Message:

The payment cannot be made on the date you specifed. The earliest this 
payment can be made is X. You can enter this date or a later date, and Pay On-
Line will make sure it gets paid on time. Do you want to use this date?

In the Date field, you should enter the date you want the payee to receive this payment 
from Pay On-Line.
Money accepts or rejects the date you enter depending on how many days are needed to 
pay this business or individual. Some payees can be paid in one day, but others will take up
to four business days.



Help for the Message:

The payment cannot be made on the date you specifed. The latest this payment 
can be made is X. You can enter this date or an earlier date, and Pay On-Line will 
make sure it gets paid on time. Do you want to use this date?

In the Date field, you should enter the date you want the payee to receive this payment 
from Pay On-Line. The date must be within two months of today's date.



Help for the Message:

Please enter the On-Line access phone number and the modem speed.

Type the local telephone number you'll use to access On-Line Services in the On-Line 
Access Phone # box. This number can be found in your start-up kit. If you can't find this 
number, or if your modem speed has changed, call CompuServe(R) at 1-800-848-8980.
In the Modem Speed box, choose the speed of the modem you will be using for On-Line 
Services. If you don't know the speed of your modem, check the modem box or call the 
dealer.





There isn't a specific Help topic about this message. 

To find information about the general content area, try the Search command in Help, 
explore the Help Contents (Index), or check the Microsoft Money User's Guide.

To use Search in Help
1 From the Help menu, choose Contents.
2 In the Microsoft Money Help window, choose the Search button.
3 Type or choose the topic you want, and choose the Show Topics button. 
4 From the list below, choose the topic you want to see.
5 Choose the Go To button.
________________
See also

Getting Help



Help for the Message:

Please choose the type for your new account.

You must choose a type for each account you create. The description below each account 
type gives examples for when you might use it. To choose an account type, click the option 
button, or press ALT and the underlined letter of the type of account you want.
________________
See also

Setting Up a Bank Account
Getting Help



Help for the Message:

Please choose one of the predefined classification names, or enter a name of 
your choice for the classification.

To choose an existing classification
Click an option button or press ALT and the underlined letter of the option button you 

want.
To type your own name for the classification
Type the name you want in the empty box at the bottom of the list or in the New 

Name box.
________________
See also

Creating a Classification
Getting Help



Help for the Message:

You must enter a date using '/' to separate the month, day, and year.

Microsoft Money recognizes the date format you specify in the Microsoft Windows(TM) 
Control Panel. To change your date format settings, see the Windows documentation. You 
cannot leave the Date field blank.
________________
See also

Getting Help



Help for the Message:

Please enter an account. Choose an account from the list or type the name of a 
new account you would like to create.

If you are displaying more than one account in the Account Book, you must specify which 
account you want this transaction assigned to by choosing an account in the Account Field.
________________
See also

Getting Help



Help for the Message:

There was an error finding or running the calculator application.

CALC.EXE is the Microsoft Windows(TM) Calculator. If you have moved CALC.EXE out of your 
Windows directory, Microsoft Money will be unable to run it. You can use File Manager to 
search for the file. Or, you can reinstall Windows so the calculator file will be reinstalled. If 
you set your own calculator application, make sure you put the correct path in 
MSMONEY.INI.
________________
See also

Using Your Own Calculator Program.
Getting Help



Help for the Message:

The Transaction Cue Cards or Previews cannot be run at this time. Your computer
may be low on memory or missing one or more of the required files. Close other 
applications or run Microsoft Money Setup again.

You can continue to work without making these installations if you want. Money can run 
without the Transaction Cue Cards or Previews.

To reinstall Microsoft Money with the Setup program
1 Insert your Money disk in drive A.
2 In Program Manager or File Manager choose Run from the File menu.
3 In the Command Line box, type a:\setup.
4 Choose the OK button, and follow the instructions on your screen.
Note    To print these instructions, choose Print Topic from the File menu in this Help 
window.
________________
See also

Getting Help

User's Guide
Chapter 1



Help for the Message:

Not enough memory is available.

If you have several applications open at the same time, you might need to close one of 
them before you run Microsoft Money. If you still can't run Money, try closing and then 
restarting Microsoft Windows(TM).
________________
See also

Getting Help



Help for the Message:

You cannot split this transaction because it is already part of another split 
transaction.

You are performing a split in the Split Transaction dialog box.
Choose a category or leave the Category field blank. You cannot enter "split" in this field.
________________
See also

Splitting a Transaction
Getting Help



Help for the Message:

This file is corrupted or is not a Microsoft Money data file.

Make sure you are opening a file with an MNY or a BAK extension. If you have chosen the 
correct file and it could not be accessed, you will need to open your most recent backup to 
access your data.

To open your most recent backup
1 From the File menu, choose Open.

You can open BAK files like any other file.
2 In the List Files Of Type box, choose Backup Files (*BAK).

If the file is not listed in the current directory, either type its directory name in front of 
the file name in the File Name box, or choose the directory in the Directories box.

3 Choose the OK button.
After you have restored your most recent backup, you'll need to re-enter any 
transactions that have occurred since you last backed up your file.

Tip    You can rename your restored BAK file to a MNY file in the Windows File Manager. 
Upon start up, Money will still try to open the BAK file. All you must do is open your MNY file
from Money once. Money will remember this and open the MNY file from then on.
________________
See also

Getting Help
Backing Up Your File
Opening a File



Help for the Message:

If you want to transfer money to or from another account, you must enter the 
account name. If you do not want a transfer, choose a category other than 
Transfer.

In the Account Book, you must enter an account name in the Subcategory field to transfer 
money to or from another account.
In the Account Forms window, you must enter an account name in the To box under 
Transfer to specify which account you're transferring to.
________________
See also

Transferring Money Between Accounts
Getting Help

User's Guide
Chapter 18



Help for the Message:

Overwrite existing file?

If you choose the Yes button when you back up or export your file, the current file version is
copied over the older version. If you don't want to overwrite the older file, choose No. Then 
type a different name or directory for this copy.
________________
See also

Backing Up Your File
Exporting an Account
Getting Help

User's Guide
Chapter 37



Help for the Message:

A payee with this name already exists. The information for these payees will not 
be combined. Do you still want to create another payee with that name?

By creating more than one payee with the same name, you can have different addresses 
for the same payee. Choose the Yes button to create another payee with the same name, 
or choose the No button to return to the Create New Payee dialog box, and type a different 
name.
________________
See also

Creating Multiple Payees with the Same Name
Getting Help



Help for the Message:

This command is not available while balancing an account. Would you like to 
postpone balancing so that the command will be available?

When balancing, some commands are unavailable. You can choose to postpone balancing 
and continue with the command you selected, or you can cancel the command and 
continue balancing your account. When you want to finish balancing your account, click the
Balance Account button, or choose Finish Balancing from the Options menu.
________________
See also

Balancing or Reconciling an Account
Getting Help



Help for the Message:

Please reinsert the correct floppy disk to continue reading this file.

The Microsoft Money file which you are using is stored on a floppy disk different from the 
one in the current disk drive. In order to continue working in this file, you must insert the 
disk with the current file on it.
________________
See also

Getting Help



Help for the Message:

You have reached the maximum number of accounts. In order to create 
additional accounts, you need to delete some existing ones.

You have reached the limit of 63 accounts. If you don't want to delete any accounts, you 
can create a new file where you can create another 63 accounts. Before you delete an 
account, you should make a backup of your file.

To delete an account and all of its transactions
1 From the List menu, choose Account List.
2 Select the account you want to delete.
3 Choose the Delete button.
4  If you are prompted to confirm the deletion, choose the OK button.
________________
See also

Backing Up Your File
Creating a New File
Getting Help



Help for the Message:

You have reached the category or classification item limit, so a new one cannot 
be created. In order to create a new one, you must first delete an existing one.

You have reached the limit of 253 categories, or 255 classification items. To delete some 
categories or classification items, you will first want to determine which ones you don't use.
________________
See also

Creating a New File
Deleting a Classification and Classification Items
Getting Help



Help for the Message:

You have reached the maximum number of payees. Archiving this file will remove
payees that are no longer needed, allowing you to create new ones. Or, you can 
delete one or more payees from the Payee List dialog box.

You have reached the limit of 32,765 payees, which includes the payees you have deleted. 
If you want to create another payee, you'll need to delete payees that you don't frequently 
use, and then archive your file.
________________
See also

Archiving Your Records
Getting Help



Help for the Message:

You cannot transfer money from an account to itself. Please check that you are 
entering the transfer in the correct account.

To transfer money between accounts, enter Transfer in the Category field, and in the 
Subcategory field, choose an account other than the account the transaction is in. If you 
don't want to create a transfer transaction, choose a different category, or leave the 
Category field blank.
________________
See also

Transferring Money Between Accounts
Getting Help



Help for the Message:

This transaction is part of a split transaction. Unvoiding it will unvoid all parts of 
the split transaction. Do you want to unvoid it?

Unvoiding a transaction means its amount will then be included in the running balance.
________________
See also

Splitting a Transaction
Voiding a Transaction
Getting Help



Help for the Message:

This transaction is part of a split transaction. Voiding it will void all parts of the 
split transaction. Do you still want to void the transaction?

Example
You originally wrote a check to purchase a car, and entered the transaction in your 
checking account as a split transaction containing the following two parts:

Transfer To: Car (an Asset 
Account)

$4500 (The price of the car)

Sales Tax $500
If you void the transaction in your Car account, the entire transaction in your checking 
account will also be voided. Voided transactions are not included in the running balance.
________________
See also

Splitting a Transaction
Voiding a Transaction
Deleting or Removing a Transaction
Getting Help



Help for the Message:

Microsoft Money needs to make some minor repairs to this file before opening, 
or you can open a different file. Do you want Microsoft Money to repair this file?

When you exit Money, the file needs to be closed properly. If your machine was turned off, 
or there was a problem while Money was running, then Money needs to make some minor 
repairs to the file. Always be sure to exit Money before turning off your computer.
It's a good idea to back up your file regularly. You may want to back up this file after it is 
repaired.
________________
See also

Backing Up Your File
Getting Help



Help for the Message:

Would you like to continue searching from the beginning or end of the register?

Microsoft Money has not been able to locate any more transactions with the requested text 
or numbers in the direction it is searching. To continue searching from the beginning (or 
end) of the register, choose the OK button.
________________
See also

Finding a Specific Transaction
Getting Help



Help for the Message:

One part of this split transaction is a transfer to or from the current account. 
Please make sure you are entering the transaction in the correct account.

You cannot transfer money from an account to itself. Open the Split Transaction dialog box 
and make sure the transaction is being entered in the correct account and that the 
category shows a transfer to or from the correct account.
________________
See also

Splitting a Transaction
Transferring Money Between Accounts
Getting Help





Help for the Message:

The name you entered is already being used for an existing account.

Please enter a different name. Each account that you create in Microsoft Money must have 
a unique name and shortcut name.
________________
See also

Getting Help



Help for the Message:

The subcategory you entered is ambiguous. Please enter a category before 
entering the subcategory.

If there is more than one subcategory with the same name, you must specify the category 
first.
Example    If you have two subcategories called Maintenance, one for your Housing 
category and another for your Automobile category, you will need to choose the Housing or
Automobile category before you can choose the Maintenance subcategory.
________________
See also

Assigning Categories to Transactions
Getting Help



Help for the Message:

Your entry is ambiguous. Please enter a classification name before entering a 
sub-item.

If there is more than one classification sub-item with the same name, you must choose the 
classification item first.
Example    If you had two sub-items called Apartment 1, one for your 363 Sandhill Way 
item and another for your 89 Ross St. item, you will need to choose the Sandhill Way or 
Ross St. item before you can choose the Apartment 1 sub-item.
________________
See also

Creating Classification Items and Sub-items
Renaming a Classification and Classification Items
Getting Help



Help for the Message:

The file MSMONEY.EXE is corrupted. Please delete MSMONEY.EXE and run 
Microsoft Money Setup again.

You will not lose any of your data if you reinstall Microsoft Money.
To reinstall Microsoft Money with the Setup program

1 Insert your Money disk in drive A.
2 In Program Manager or File Manager, choose Run from the File menu.
3 In the Command Line box, type: a:setup
4 Choose the OK button.
5 Follow the instructions on your screen.
________________
See also

Getting Help

User's Guide
Chapter 1



Help for the Message:

The password you entered was incorrect. Please enter the correct password.

You may have made a typing error or typed the password for a different file.
________________
See also

Assigning, Changing, and Deleting a Password
Getting Help

User's Guide
Chapter 37



Help for the Message:

The new file cannot be created.

Please make sure that the new file is being created on a disk that is not write-protected and
has sufficient capacity to store the new file. Either delete some files from the disk and try 
again, or create the file on a different disk.
________________
See also

Getting Help
Creating a New File
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Help for the Message:

No more matching transactions can be found.

Microsoft Money has found all of the transactions that fit the description you've provided.
________________
See also

Getting Help
Finding a Specific Transaction



Help for the Message:

Microsoft Money cannot locate your file or cannot open it, possibly because it is 
a read-only file.

You can change the read-only attribute in the Windows(TM) File Manager. If you have chosen
the correct file and it cannot be accessed, you will need to open your most recent backup.

To change the read-only attribute for a file
1 Switch to the Windows File Manager.
2 Select the file you want to change.
3 From the File menu, choose Change Attributes.
4 Turn off the Read Only option.
5 Choose the OK button.

To open your most recent backup
1 From the File menu, choose Open.
2 In the List Files Of Type box, choose Backup Files (*.BAK).
3 In the File Name box, type the name of your backup file (it should have a .BAK extension)

or choose it from the list of files.
If the file is not listed in the current directory, either type another directory name in front 
of the file name in the File Name box, or choose the directory in the Directories box.

4 Choose the OK button.
Once you open your most recent backup, you'll need to re-enter any transactions that 
you entered since the backup was made. You can also rename your backup file from the 
BAK extension to a MNY standard extension.

________________
See also

Backing Up Your File
Getting Help

User's Guide
Chapter 37



Help for the Message:

The category or classification item does not exist. Please choose an existing one.

You can either choose an existing one, or exit what you are doing and create a new 
category or classification item.
________________
See also

Creating a New Category or Subcategory
Creating Classification Items and Sub-items
Getting Help

User's Guide
Chapters 12 & 13



Help for the Message:

That name is already being used for an existing category or classification item or
shortcut. Please enter a different name.

Each category and category shortcut you create must have a unique name.
________________
See also

Creating a New Category or Subcategory
Getting Help



Help for the Message:

Do you want to delete this part of the current split transaction?

If you choose the Yes button, the amount will be left unassigned.
________________
See also

Getting Help
Splitting a Transaction



Help for the Message

Reassigning this split transaction to this category or subcategory will delete all 
of the split transaction information.

If you don't want to reassign the transaction to a single category, cancel the changes by 
pressing the ESC key. Before you decide to reassign a split transaction to a single category, 
it's a good idea to view the split information and make sure you no longer need it.

To cancel changes while entering or making changes to a transaction
Press the ESC key.
To view split transaction information
In the toolbar, click the Split Transaction button, or press CTRL+S.

________________
See also

Splitting a Transaction
Getting Help

User's Guide
Chapter 3



Help for the Message:

The file has been repaired; however, some of your data may have been lost.

You may want to open your most recent backup, but first look at the current file to see if 
you've lost any data. If not, continue to use the file. If you have lost data, open your most 
recent backup and re-enter transactions you have entered since you made the backup.

To open your most recent backup
1 From the File menu, choose Open.
2 In the List Files Of Type box, choose Backup Files (*.BAK).
3 In the File Name box, type the name of your backup file (it should have a BAK extension) 

or choose it from the list.
If the file is not listed in the current directory, either type the directory name in front of 
the file name in the File Name box, or choose the directory in the Directories box.

4 Choose the OK button.
Microsoft Money displays a dialog box reminding you to back up the file you currently 
have open before restoring the .BAK file.

5 Choose Yes if you want to make a backup copy of the file currently open. Make sure you 
don't use the same name as the backup file you are opening. 
Choose No if you don't want to back up the file currently open.

Note    If you plan to use a backup file as a working file and want to change the file 
extension to MNY, use File Manager in Windows.
________________
See also

Getting Help
Backing Up Your File

User's Guide
Chapter 37



Help for the Message:

Deleting the classification will remove classification information from all 
transactions, and the classification item list will be deleted. Do you want to 
delete this classification?

Before deleting a classification, it's a good idea to make a backup copy of your file in case 
you ever need the classification information again.
________________
See also

Backing Up Your File
Getting Help



Help for the Message:

There are transactions in the account. Deleting the account will delete those 
transactions. Are you sure you want to delete the account?

Before deleting your account, it's a good idea to make a backup copy of your file in case 
you ever need information from that account. When you delete an account, your payee, 
category, and classification lists will remain.
________________
See also

Backing Up Your File
Getting Help



Help for the Message:

Are you sure you want to delete this payee from the Payee List?

The payee will continue to exist in your previous transactions, but it will be removed from 
the Payee List. You will not be able to set a custom view for that payee if it's deleted.
________________
See also

Deleting an Item from the List
Getting Help



Help for the Message:

This category or classification has at least one subcategory or sub-item and 
deletion will remove all of them.

When you delete a category or a classification item, all of the subcategories or sub-items 
are also deleted. You may want to make sure you don't need the subcategories or sub-
items before deleting them.
________________
See also

Deleting Categories and Subcategories
Deleting a Classification and Classification Items
Getting Help



Help for the Message:

The disk where this file is being stored is full.

You need to exit Microsoft Money and move your Money data file to a disk with free space. 
You can make more room on your disk by moving files no longer needed to a floppy disk. 
Or, you can make your Money file smaller by archiving old transactions to a floppy disk for 
storage.
________________
See also

Getting Help
Archiving Your Records

User's Guide
Chapter 37



Help for the Message:

This check number has already been used as a check number in this account. Do 
you want to reuse it?

Most banks don't allow you to use the same check number twice for a single account. If you
are viewing more than one account, make sure you are entering the transaction in the 
correct account.
________________
See also

Getting Help



Help for the Message:

Error reading or writing this file.

Microsoft Money cannot use the file. You can try to open a backup file or you can exit 
Money, restart your computer, and try to open the file again.
________________
See also

Backing Up Your File
Getting Help



Help for the Message:

This is an invalid account.

You must enter the name of an existing account.
________________
See also

Getting Help



Help for the Message:

This is an invalid date. Please enter the date with a valid format using '/' to 
separate the month, day, and year. Microsoft Money will not accept years earlier 
than 1948 or later than 2075.

Microsoft Money recognizes dates separated by slashes (/) or hyphens (-), and only accepts 
dates between January 1, 1948 and December 31, 2075. Make sure you enter a date within 
that range.
________________
See also

Getting Help



Help for the Message:

This is an invalid frequency. Please choose from the list of frequencies.

Check your typing and try again, or choose one of the frequencies provided by Microsoft 
Money.
________________
See also

Getting Help



Help for the Message:

This field in a Future Transaction contains either Print or Epay, or it can be left 
blank. You will be able to enter a number later when you enter the Future 
Transaction into the Account Book or Loans window.

You cannot enter a check number in the Future Transactions window, because the number 
must be assigned at the time you record the transaction in the Account Book or enter it in 
the Loans window.
________________
See also

Setting Up Future Transactions
Getting Help



Help for the Message:

You must choose one item from the list.

Before you can continue, you need to first select an account name from the list. With the 
mouse, click the account name, or press the ARROW keys to select an account.
________________
See also

Getting Help



Help for the Message

There is a problem with the currently selected printer driver. Please use the 
Microsoft Windows Control Panel to reinstall your printer driver, then try printing
again.

To correct the problem, you must install, or reinstall, your printer driver from the Microsoft 
Windows Control Panel. See your Windows documentation for instructions.
________________
See also

Getting Help



Help for the Message:

Canceling the Split Transaction dialog box will cancel the changes you just made.
Do you still want to cancel the dialog box?

If you choose Yes, the dialog box will be closed, and any changes you made to the split 
transaction will be lost.
If you choose No, the dialog box will remain open so you can continue working on parts of 
the split transaction.
________________
See also

Splitting a Transaction
Getting Help





Help for the Message:

Microsoft Money requires Microsoft Windows version 3.1 or later.

Since Money is a Microsoft Windows(TM) application, you must run it under Microsoft 
Windows.

To see which version of Windows you're running
1 In Windows Program Manager, choose the Help menu.
2 Choose About Program Manager.

The Windows version number is listed near the top of the dialog box.
________________
See also

Getting Help



Help for the Message:

You have reached the maximum number of transactions. You must archive this 
file in order to enter new transactions.

The maximum number of transactions per file is 32,765. You've been busy! You need to 
archive your records to remove older transactions.
________________
See also

Archiving Your Records
Getting Help



Help for the Message:

You previously postponed balancing this account. If you entered a service charge
or interest amount last time, you can't change them here. You can change them 
later in the Account Book.

It's important to finish balancing with the same statement you were using when you 
postponed balancing.
Any information you previously entered in the Balance dialog box will still be entered, and 
any transactions you previously marked as cleared will still have a "C" in the cleared field.
________________
See also

Balancing or Reconciling an Account
Getting Help



Help for the Message:

AutoBudget will enter new budget amounts for all categories and subcategories. 
Any existing budget amounts will be replaced.

AutoBudget enters amounts based on previously entered transactions. If you haven't 
assigned any transactions to a particular category or subcategory during the date range 
that you have specified, Microsoft Money will clear any amount budgeted for that category 
or subcategory, and the budget amount will be set to zero.
________________
See also

Creating a Budget
Getting Help



Help for the Message:

The file you are about to open was created with a previous version of Microsoft 
Money. Before you can use this file, Money must convert the file to version 3.0 
format. Do you want to save a copy of it in its current format?

Because your financial records are so important, it's a good idea to save a copy of the 
earlier file in case something goes wrong -- such as a power failure -- during the conversion 
to Money 3.0. The copy in the previous format will have a .MNX extension. Once a previous 
version's file is converted to 3.0, you can no longer use it in the previous version of Money.
________________
See also

Opening Previous Versions of Money
Getting Help



Help for the Message:

The QIF file contains a section of data that Microsoft Money does not support. Do
you want to continue importing the rest of the file?

Money does not import the following:
Loan terms (loan payments are imported)
Budgets
Memorized transactions

________________
See also

Importing Information from a Quicken File
Getting Help

User's Guide
Appendix A



Help for the Message:

You have reached the maximum number of remembered reports. In order to 
remember additional reports, you need to delete some existing ones.

Microsoft Money can Remember (save) up to 50 reports and lets you delete or rename 
them.
________________
See also

Deleting or Renaming a Remembered Report
Getting Help



Help for the Message:

Please enter a different name for the backup file. You cannot back up the current
file to the file you are trying to open.

You're probably using the same file name for both files and need to change one. To change 
the name of the file, exit Microsoft Money, rename the file, and then restart Money. You can 
then open the file with its new file name.
________________
See also

Backing Up Your File
Getting Help



Help for the Message:

The unassigned amount cannot be reapportioned because either the splits sum 
to zero so there's nothing to reapportion, or changing them will result in one of 
the splits being too large.

If the sum of the splits is zero, you have no unassigned amount to reapportion. The 
overflow problem will only happen if the amount of one of the splits is in the millions.
________________
See also

Splitting a Transaction
Getting Help



Help for the Message:

The other half of this transfer is part of a split transaction. Changing this 
transaction will produce an unassigned amount in the split transaction. Do you 
still want to make the changes?

You may want to examine the other side of the transfer before you decide what to do. You 
can press ESC to cancel the changes.

To go to the other side of a transfer transaction
1 From the Edit Menu, choose Go To.
2 Choose Other Side of This Transfer.
3 Choose the OK button.
________________
See also

Splitting a Transaction
Getting Help



Help for the Error Message:

Deleting this transaction will produce an unassigned amount in the split 
transaction. Do you still want to delete it?

The transaction you are about to delete was created by a transfer from a split transaction. 
If you delete the transaction, the amount in the split transaction will become part of the 
unassigned amount.
You may want to examine the other side of the transfer before you decide what you want to
do. You can press ESC to cancel the changes.

To go to the other side of a transfer transaction
1 From the Edit Menu, choose Go To.
2 Choose Other Side of This Transfer.
3 Choose the OK button.
________________
See also

Splitting a Transaction
Getting Help





Help for the Message:

There was an error changing the existing payments for your loan. Not all of the 
payments have been updated.

Your computer was probably low on disk space or available memory while you were trying 
to change your loan.
You should free up some memory or disk space, and choose Change Loan Information 
again.
For more information about how to free up more memory or disk space, see your Microsoft 
Windows(TM) documentation.
________________
See also

Getting Help



Help for the Message:

You have entered an income category for an expense, or an expense category for
income. Do you want to change it?

For example, in your Bank Account you may have entered an amount in the Payment field, 
but chosen an income category. If you choose Yes, you can change the category. If you 
choose No, Microsoft Money will accept the entry and enter the transaction.

To turn off the error message warning
1 From the Tools menu, choose Options, then General.
2 In the Confirmation box, clear the Require Correct Category Type check box.
3 Choose the OK button.
________________
See also

Getting Help



Help for the Message:

You have entered an income category for an expense, or an expense category for
income. Do you want to change it?

For example, when reconciling your account you may have entered an amount in the 
Service Charge field, but chosen an income category. If you choose Yes, you can change the
category. If you choose No, Microsoft Money will accept the entry.

To turn off the error message warning
1 From the Tools menu, choose Options, then General.
2 In the Confirmation box, clear the Require Correct Category Type check box.
3 Choose the OK button.
________________
See also

Getting Help



Help for the Message:

The other side of this transfer has been reconciled. Do you really want to change
it?

If you choose Yes, you can change the transaction and the other side of the transfer will 
automatically reflect the changes. Changing the Amount field in a reconciled transaction 
can cause its account not to balance. Changes to other fields, such as Payee, Memo, and 
Category do not affect the reconciling procedure.
If you choose No, you cannot change the transaction.

To turn off the error message warning
1 From the Tools menu, choose Options, then General.
2 In the Confirmation box, clear the Protect Reconciled Transactions check box.
3 Choose the OK button.
________________
See also

Getting Help

User's Guide
Chapter 18



Help for the Message:

Some of the checks to be printed have dates after today. Do you want to print 
today's date on them instead? (Loan payments will be printed with today's date, 
but their dates will not be changed in the Account Book.)

If you choose Yes, loan payments will be printed with today's date, but the transaction date 
will not be changed in the Account Book.
If you choose No, Microsoft Money will continue printing the postdated checks.

To turn off the error message warning
1 From the Tools menu, choose Options, then General.
2 In the Print box, clear the Prompt If Checks Are Postdated check box.
3 Choose the OK button.
________________
See also

Getting Help

User's Guide
Chapter 9



Help for the Message:

Do you want to add this payee to the Payee List?

Choose Yes to add the name to the Payee List and enter the transaction.
Choose No to enter the transaction without adding the name to the Payee List. The payee 
name you entered will still appear in the transaction; however, it will not appear in any 
Payee Lists and you will not be able to create a view for this payee.
Choose the Cancel button to continue entering the transaction.

To turn off the error message warning
1 From the Tools menu, choose Options, then General.
2 In the Confirmation box, clear the Confirm New Payee Names check box.
3 Choose the OK button.
________________
See also

Getting Help

User's Guide
Chapter 14



Help for the Message:

You have reached the maximum number of loans. In order to create additional 
loans, you need to delete some existing ones.

You can have up to 63 loans in a file. To create additional loans, delete some existing ones 
or create a new file. If you create loans in a new file, you will not be able to share data 
between the two files or generate reports that combine information from both.

To delete existing loans
1 From the Lists menu, choose Loan List.
2 In the Loan List box, select the loan you want to delete.
3 Choose the Delete button.
If any transactions -- or Future Transactions -- are assigned to the loan, Microsoft Money will
prompt you to confirm the deletion.
________________
See also

Deleting a Loan
Creating a New File
Getting Help

User's Guide
Chapter 24



Help for the Message:

You have entered a payment frequency and loan length that do not allow 
Microsoft Money to calculate the exact number of payments. Please enter the 
length of the loan as a number of payments.

For example, in setting up your loan you may have entries similar to the following:
Paid how often Annually 
What is the 
scheduled length 
of the loan?

2 Months

These choices do not allow Money to calculate the exact number of payments.
Choose the OK button, and enter the length of the loan as a number of payments, for 
example:

What is the 
scheduled length 
of the loan?

2 Payments

________________
See also

Getting Help

User's Guide
Chapters 24 & 26



Help for the Message:

You have left more than one loan value blank. Microsoft Money can compute only
one. Please fill in all but one value.

You must enter at least four of the five following values:
Loan Amount
Interest Rate
Length of Loan
Principal + Interest
Balloon Amount

The Frequency field must have a value.
________________
See also

Getting Help

User's Guide
Chapter 26



Help for the Message:

You have entered loan values that do not work together. Please go back and 
correct the numbers, or leave one value blank to have Microsoft Money calculate 
it for you.

Some reasons why your loan may not calculate:
You entered a principal and interest amount that included other fees.
You entered the Annual Percentage Rate, not the Simple Interest Rate.
You entered a balloon amount before the end of the loan.
You entered a loan amount that included the down payment.

If you answered all the questions and the loan values did not calculate, you may want to let
Money calculate a value for you.
________________
See also

Setting Up a Loan
Using the Loan Calculator
Getting Help

User's Guide
Chapters 24 & 26



Help for the Message:

Microsoft Money has calculated the loan value as the amount displayed.

Accept the value or change the loan information, and have Money recalculate the loan.
________________
See also

Setting Up a Loan
Using the Loan Calculator
Getting Help

User's Guide
Chapters 24 & 26



Help for the Message:

You have entered a loan name that does not exist. Choose a loan from the list or 
press ESC to cancel this transaction and use the Loan List dialog box to create the
loan.

You can do one of the following:
Choose an existing loan from the list in the Subcategory field. This must be a loan 

you've already set up in Microsoft Money.
Press ESC to cancel the transaction and create the loan, if it is not already set up in 

Money.
To create a loan

1 From the Lists menu, choose Loan List.
2 In the Loan List, choose the Create button.
3 Follow the instructions on screen.
4 When you reach the loan summary screen, choose the Create button if the information is

correct.
________________
See also

Entering Loan Payments
Setting Up a Loan
Getting Help

User's Guide
Chapter 24



Help for the Message:

Before you can work in Loans, you must first create a loan. If you want to create 
a loan, choose Create Loan from the Loan box on the toolbar.

Another way to create a loan
1 From the Lists menu, choose Loan List.
2 In the Loan List, choose the Create button.
3 Follow the instructions on screen.
4 When you reach the loan summary screen, choose the Create button if the information is

correct.
________________
See also

Setting Up a Loan
Getting Help

User's Guide
Chapter 24



Help for the Message:

You cannot change the transaction for Principal or Interest.

You cannot change the transaction for principal or interest because they are calculated 
each time the transaction is recorded.
To change the categories for principal or interest, choose the Change Loan Information 
button from the Loan List. You can also change the categories at the time the transaction is
entered.
________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

You cannot delete the transaction for Principal or Interest.

Each loan payment needs both principal and interest for those values to be calculated.
To enter a Future Transaction for principal only, enter an amount that's different from your 
regular payment. When you enter the transaction, choose the option: Apply The Entire Loan
Payment To Principal in the Adjust Loan Payment Amount dialog box.
________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

You must enter categories for both the principal and interest portions of a loan.

Choose from the list or enter categories and subcategories for principal and interest.
You can see how much was spent or received in interest and principal when you create 
reports or customized views based on these categories and subcategories.
If you are entering a loan for your house, you may want to enter the following categories 
and subcategories:

Principal
Categor
y:

Housin
g

Principal 
Subcateg
ory:

Mortga
ge 
Princip
al

Interest 
Categor
y:

Interes
t 
Expens
e

Interest 
Subcateg
ory:

Mortga
ge 
Interest

If the category or subcategory you want is not in the list, you can type it, and Microsoft 
Money will add it to the list.
________________
See also

Getting Help

User's Guide
Chapter 24



Help for the Message:

The categories for principal and interest must not be the same. Please change 
one or the other.

The principal and interest must be assigned to different categories and subcategories.
For example, you cannot enter these matching categories:

Principal 
Category:

Housing

Interest 
Category:

Housing

Instead, you may want to enter the following categories and subcategories:
Princi
pal 
Categ
ory:

Housin
g

Principal 
Subcateg
ory:

Mortgag
e 
Principal

Intere
st 
Categ
ory:

Interes
t 
Expens
e

Interest 
Subcateg
ory:

Mortgag
e 
Interest

If the category or subcategory you want is not in the list, you can type it, and Microsoft 
Money will add it.
________________
See also

Getting Help

User's Guide
Chapter 24



Help for the Message:

Reassigning this loan payment to a single category, classification, or transfer will
delete all the loan payment information.

You are replacing a loan payment with a category, classification, or transfer.
Choose the OK button to delete all the loan payment information and remove the 
corresponding transaction from Loans.
Choose the Cancel button to revert back to the original loan payment.
________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

This category is the principal or interest category for a loan. If it is deleted, it 
must be replaced. Please specify another category to replace it.

Loans must have categories for principal and interest to figure out which portion of the 
payment goes to principal and which goes to interest.
You can choose a category from the list, or type a new one.
________________
See also

Getting Help

User's Guide
Chapter 24



Help for the Message:

Replacing this category would cause a loan to have the same category for 
principal and interest payments. Please specify a different category to replace it.

You cannot use the same category names to categorize principal and interest, because 
categories are used to figure out which portion of the payment goes to principal and which 
goes to interest.
Choose a replacement category from the list, or type a new one.
________________
See also

Getting Help

User's Guide
Chapter 24



Help for the Message:

This category is the Principal or Interest category for a loan; This category is a 
category for Other Fees in that loan's payments. In order for Microsoft Money to 
correctly track your loan amounts, you must specify a different replacement 
category.

The category name you have entered is being used to categorize other fees for your loan. 
You cannot use the same category names to categorize principal, interest, and other fees 
because they are used to figure out which portion of the payment goes to principal and 
which goes to interest.
Choose a replacement category from the list, or type a new one.
________________
See also

Getting Help

User's Guide
Chapter 24



Help for the Message:

You have chosen a category for Principal or Interest that is already a category 
for Other Fees in existing loan payments. Please change your categories to ones 
not already used.

You cannot use the same category names to categorize principal, interest, and other fees 
because they are used to figure out which portion of the payment goes to principal and 
which goes to interest.
Choose a replacement category from the list, or type a new one.
________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

In this loan there are loan payments following the one you are changing. Do you 
want Microsoft Money to recalculate the Principal and Interest distribution for 
these payments?

Choose Yes to have Money recalculate the principal and interest distribution for the loan 
payments in Loans that have a date equal to or later than the transaction you are 
changing.
For example, if you made payments on Jan. 1, Feb. 1, and March 1 and later changed the 
March 1 payment's date to January 15, the amount of interest owed on that day would 
probably be different, so the principal and interest breakdown of following payments would 
need to change.
Choose No to keep the existing principal and interest distribution for loan payments in 
Loans that have a date equal to or later than the transaction you are changing. The loan 
payment you are modifying will reflect the changes you make.
________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

Changing this transaction will delete all information linking this transaction to 
the loan.

You are about to replace all your loan payment information with a split transaction. The 
categories and amounts in the loan payment will remain the same in the split; however, the
transaction will no longer appear in Loans. This will change the outstanding balance in 
Loans.
________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

Reassigning this loan payment will delete all parts of the payment referring to 
the current loan.

You are about to move the loan payment from the current loan to the loan you are entering.
The splits for the old loan will be replaced with the splits for the new loan. This will change 
the outstanding balance for both loans, increasing the current loan balance and decreasing 
the balance of the loan you are entering.
________________
See also

Getting Help

User's Guide
Chapter 24



Help for the Message:

There are too many past loan payments for Microsoft Money to update. Please 
enter a more recent date for the change to take effect.

Money can enter up to 360 loan payments for you.
________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

The total principal plus interest you entered does not agree with the loan 
payments you entered in Microsoft Money during the period. The loan 
adjustment transaction may change the remaining amount owed on the loan. 
Would you like to continue anyway?

Choose Yes if you are balancing your loan against your loan statement and need to make 
an adjustment transaction to make your loan records accurate.
Choose No if you want to change the principal and interest amounts again before you enter
them.
________________
See also

Balancing a Loan
Getting Help

User's Guide
Chapter 24



Help for the Message:

Microsoft Money cannot tell which parts of this transaction represent a regular 
loan payment, and so will not be able to calculate the principal and interest 
distribution when the Future Transaction is used.

Check the splits for your Future Transaction to ensure only one part of the split is assigned 
to the interest category, and the other parts are assigned to principal.
________________
See also

Setting Up a Future Transaction for a Loan
Getting Help

User's Guide
Chapter 24



Help for the Message:

There is no interest split in this loan payment. Microsoft Money cannot make this
transaction into a regular loan payment, and so will not be able to calculate the 
principal and interest distribution when the Future Transaction is used.

Make sure you have an interest payment in the split portion of the loan payment.
If the entire payment goes toward principal, choose the OK button. You will not need to 
have interest calculated on this payment.
________________
See also

Setting Up a Future Transaction for a Loan
Getting Help

User's Guide
Chapter 24



Help for the Message:

One of the splits of this loan payment is a transfer to or from an account. In 
order to enter this loan payment, you must enter an account.

If you are entering a Future Transaction, enter an account name in the Pay From Account 
box.
If you are entering a loan payment in the Loans window, enter an account name in the 
Account field. Otherwise, change the split so there are no transfers.
________________
See also

Entering Loan Payments
Getting Help

User's Guide
Chapter 24



Help for the Message:

You have changed the date of the loan payment, but Microsoft Money cannot 
recalculate the principal and interest amounts for this transaction.

You cannot change the date for part of a loan payment.
Your view is set so that parts of your loan payment are displayed as individual transactions.
For instance, the principal portion of a loan payment is displayed as its own transaction, 
and you are trying to change its date.

Press ESC to cancel any changes.
Change the view to All (by Date).
Make your changes to the dates.

________________
See also

Entering Loan Payments
Getting Help

User's Guide
Chapter 24



Help for the Message:

This Future Transaction doesn't match the default loan payment, so changes you 
make here won't affect the default payment. Use the Change Loan Information 
button in the Loan List dialog box to change the default payment.

If you want to make changes that only affect this loan payment, continue by entering the 
transaction.
If you want to make changes that affect loan payments from now on, such as changes to 
the interest rate, other fees, or the payee for the loan, use the Change Loan Information 
button in the Loan List.

To change a Future Transaction for a Loan Payment
1 From the Lists menu, choose Loan List.
2 Highlight the loan you want to change, then choose the Change Loan Information button.
3 Choose the option you want.
4 Choose the OK button.
5 Make the changes you want in each Change Loan dialog box, choosing the Next button to

move forward.
6 If the information is correct in the summary screen, choose the Done button. Otherwise, 

choose the Back button to change the loan information.
Money displays a message that your Future Transactions have been updated.

________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

The Future Transaction you changed matches the default loan payment. Do you 
want Microsoft Money to use the changes you have made as the new default 
payment for the loan?

Choose the Yes button if you want these changes to become the regular loan payment for 
this loan.
Choose the No button if you want changes to affect only this Future Transaction.
________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

The loan values you entered don't work together. Please go back and change the 
numbers, or leave one value blank and have Microsoft Money calculate it for you.

You must enter at least four of the five following values:
Loan Amount
Interest Rate
Length of Loan
Principal + Interest
Balloon Amount

To change any of these values, choose the Back button until you return to the screen you 
want to modify.
________________
See also

Setting Up a Loan
Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

Because you have transfers as part of your other fees, Microsoft Money will not 
be able to enter or change past loan payments for you. Would you like to go back
and change your other fees?

A transfer requires two accounts: an account the money is coming from and an account the
money is going to.

If you are creating a loan

Money automatically enters past loan payments in the Loans window. Those payments are 
not assigned to any account. Because Money does not have a second account name for the
other side of the transfer, those past loan payments cannot be created with a transfer as 
part of the other fees.

If you are changing a loan

Microsoft Money automatically changes past loan payments that have a date on or after 
the date of the change.
There may be past payments in the Loans window that are not assigned to an account. 
Because Money does not have a second account name for the other side of the transfer, 
those loan payments cannot be changed to include a transfer as part of the other fees.
Choose No to manually enter or change your past loan payments in the Loans window.
Choose Yes to return to the other fees screen to remove the transfer.
________________
See also

Setting Up a Loan
Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

Your other fees contain a transfer to the account you specified for the Future 
Transaction. You can go back and change your other fees, or you can change or 
delete the account for the Future Transaction.

The account you chose in the Make Payments From Account box is the same account you 
are transferring the other fees to. You have two options:

Change your other fees so that you are not transferring fees to the same account as 
you entered in the Future Transaction.

Do not specify an account in the loan's Future Transaction.
________________
See also

Setting Up a Future Transaction for a Loan
Changing Loan Information
Getting Help

User's Guide
Chapters 11 & 24



Help for the Message:

You have reached the maximum number of currencies, so a new one cannot be 
created. In order to create additional currencies, you need to delete some 
existing ones.

You can have up to approximately 45 currencies in the Currency List.
To delete a currency item

1 From the Lists menu, choose Currency List.
2 In the Currency List box, highlight the currency name you want to remove.
3 Choose the Delete button.
4 When you're prompted, choose the OK button to confirm the deletion.
5 Choose the Close button.
________________
See also

Deleting an Item From a List
Updating Currency Exchange Rates
Getting Help

User's Guide
Chapter 16



Help for the Message:

You cannot make this transaction into a loan payment because it is already part 
of a split transaction.

While in a Split window, Loan Payment is not an option in the Category field. To enter a loan
payment, you must be in the Account Book, Account Forms, Loans, or Future Transactions 
window.
________________
See also

Entering Loan Payments
Getting Help





Help for the Message:

Do you want to replace the current split transactions with the default splits for 
the loan payment?

If you're attempting to convert a Liability Account to a Loan you've set up in Microsoft 
Money, it's best to choose the No button. Then your records of past payments and your 
account balances won't be affected.
________________
See also

Changing Loan Information
Getting Help

User's Guide
Chapter 24



Help for the Message:

The first payment date and frequency you have entered result in an invalid 
starting date or Future Transaction date for the loan. Please change the first 
payment date or the frequency.

You've entered information outside the date limitations for a Microsoft Money Loan. 
The start and end dates for your loan must fall between: January 1, 1948 and December 31,
2075.
________________
See also

Getting Help



Help for the Message:

The format of the tax table file is incorrect.

Your tax table file has somehow been changed so that Microsoft Money cannot read it 
correctly.
You should either set up Microsoft Money again, or use the TAX.TBL file supplied with the 
tax program you're using.
The TAX.TBL file can be found in the directory you installed Money in; consequently, if you 
are using a TAX.TBL file supplied with another tax program, copy it to the directory you 
installed Money in.
________________
See also

Getting Help



Help for the Message:

You have not yet assigned any budget amounts to your categories. If you want 
Microsoft Money to help set up your budget, choose the AutoBudget button.

AutoBudget generates a budget using previously entered transactions. Because of this, you
should enter at least one month's worth of transactions before using AutoBudget.
The budget is based on the average daily amounts of categorized transactions. Once the 
budget is set up, you'll want to manually review it and probably adjust some amounts.
________________
See also

Creating a Budget
Getting Help

User's Guide
Chapter 34



Help for the Message:

There is a Future Transaction for this loan that did not match the default loan 
payment. It has not been updated with your loan changes. You can update the 
transaction in the Future Transactions window.

In some cases you will not want to make changes to the Future Transaction.
For example, if you entered an extra principal payment as a one-time exception, the Future 
Transaction won't need to be updated.
________________
See also

Entering Loan Payments
Setting Up Future Transactions
Getting Help

User's Guide
Chapter 24



Help for the Message:

The amount of this loan payment does not match the sum of the splits. In order 
to reflect these changes in the default loan payment, Microsoft Money must use 
the sum of the splits as the loan payment amount. Do you want to change the 
transaction?

Unless you have very strong reasons for an unassigned amount, it's best to choose the Yes 
button. Then change the transaction so you no longer have an unassigned amount. 
Otherwise, the amount of your default loan payment will differ from the amount of your 
Future Transaction loan payment. 
________________
See also

Getting Help



Help for the Message:

The report customization you have chosen does not support charts. Do you want 
to close the chart window?

After creating a chart, you customized your report in a way that can't be charted. Microsoft 
Money doesn't support charts of Tax Detail Reports.
Choose the OK button to close the Chart window.
Choose Cancel to change the customization.
________________
See also

Introduction to Charts
Getting Help



Help for the Message:

Microsoft Money believes that your loan was paid off on the date you have given.
Please choose a date when the loan was still active.

You've entered a date where the amount due on the loan was zero, or entered a date past 
the last payment date Money calculated for your loan.
________________
See also

Changing Loan Information
Getting Help



Help for the Message:

The category for this transaction is missing, or there is an income category on an
expense or an expense category on income. Do you want to enter the transaction
anyway?

Choose No if you don't want to enter this transaction in the Account Book. Cancel the Pay 
Bills command and add a category to the Future Transaction.
Choose Yes if you want to enter this transaction into the Account Book. You can go to the 
account later and add category information.
You can change the setting, Require Category in Each Transaction, that affects whether or 
not you're reminded about a missing category.

To change the setting
1 From the Options menu, choose Settings.
2 In the Settings dialog box, under Confirmation, choose or clear the Require Category in 

Each Transaction check box.
3 Choose the OK button.
________________
See also

Requiring Categories in Each Transaction
Getting Help

User's Guide
Chapter 12



Help for the Message:

Changing the type of this transaction will leave an income category assigned to 
an expense or an expense category assigned to income. Do you want to change 
the type anyway?

Since Microsoft Money found a potential balancing problem, you probably want to choose 
the Yes button, then go to the transaction and change the category type.
You can also change the setting for reminders about transactions with incorrect category 
types.

To change the setting
1 From the Options menu, choose Settings.
2 In the Settings dialog box, choose or clear the Require Correct Category Type check box.
3 Choose the OK button.
________________
See also

Requiring Categories in Each Transaction
Getting Help

User's Guide
Chapter 12



Help for the Message:

You have entered a date after today, so Microsoft Money will make the loan 
changes effective immediately. Any loan payments you enter from now on will 
use the new loan information. Do you want to change the date you entered?

You can't change a Money Loan based on a future date, because the changes might result 
in inaccurate loan payment records between now and the future date.
Choose the Yes button, to enter a date before today.
Choose the No button to have today's date used as the date for the loan changes.
If you don't want the loan changes to take effect immediately, choose the No button. Then 
choose Cancel, and make changes to your loan at the time the changes actually take 
effect.
________________
See also

Changing Loan Information
Getting Help



Help for the Message:

The category to be budgeted has subcategories. Do you want Microsoft Money to
assign budget amounts to the subcategories also?

If you choose the No button, any existing budget amounts on the subcategories are 
preserved, and any subcategory amounts are added to the budget amount for the category.
If you choose the Yes button, individual subcategories will be assigned new budget 
amounts.
________________
See also

Creating a Budget
Getting Help

User's Guide
Chapter 34



Help for the Message:

If you want to transfer money to or from another account, you must enter the 
account name. If you do not want a transfer, press ESC to close the list and press 
ESC again to cancel changing the transaction.

If you do want to complete the transfer, enter the other account in the Subcategory field. If 
the account doesn't exist, type the name of the account you want to create.
________________
See also

Transferring Money Between Accounts
Getting Help

User's Guide
Chapter 18





Help for the Message:

Are you sure you want to delete your custom budget information?

You have set up a Custom By Month budget for this category. Choosing the Weekly, 
Monthly, or Yearly option will delete all of the custom budget information.
To see your custom budget entries before deleting them, choose the Custom By Month 
button, then look at each month.
________________
See also

Creating a Budget
Getting Help

User's Guide
Chapter 34



Help for the Message:

An error occurred while printing.

Check the Microsoft Windows(TM) Control Panel and your printer before trying to print again.
________________
See also

Setting Up to Print Checks or Reports
Getting Help

User's Guide
Chapters 9 & 10



Help for the Message:

Microsoft Money can only print checks from Bank Accounts. The current account 
is not a Bank Account.

Make sure you are viewing a Bank Account before you choose the Print Checks command. If
you have a Credit Card Account that allows check writing, you will need to create a Bank 
Account before you can print checks for it.
________________
See also

Getting Help



Help for the Message:

The number you entered is an invalid check number.

You need to type a number for the first check loaded in your printer. Microsoft Money does 
not recognize a non-numeric value for this option.
________________
See also

Setting Up to Print Checks or Reports
Getting Help

User's Guide
Chapter 9



Help for the Message:

There are no checks to print in this account.

Microsoft Money will only print checks for transactions that have "Print" in the Number field.
Make sure you have chosen the correct account to print checks from.
________________
See also

Setting Up to Print Checks or Reports
Getting Help

User's Guide
Chapter 9



Help for the Message:

Based on the Print Test results, please adjust your printer as needed.

Line up your paper until the check prints correctly. When you're satisfied with the way the 
test check prints, you may want to make a mark -- or place a piece of tape -- on your 
printer to help you properly align checks the next time you print. If you are using a dot 
matrix printer, you need to make sure the printer is set to print 10 characters per inch 
horizontally and six lines per inch vertically.
________________
See also

Setting Up to Print Checks or Reports
Using Laser Standard and Laser Wallet Checks
Getting Help

User's Guide
Chapter 9



Help for the Message:

The row and column types you chose cannot be used together in this report. 
Please change one.

You cannot choose related items for both the rows and columns in your report. For example,
you can't choose a subcategory for row and category for column. Choose a different item in
either the Row box or the Column box.
________________
See also

Getting Help



Help for the Message:

Microsoft Money could not load all of the transactions from the import file.

Your computer ran out of memory while importing, or your disk is full. Part of the import file
was loaded, but some was lost. Check your computer memory and disk space, then try to 
import the file again. Before trying again, start with an empty account, or you'll get a 
duplicate of what was imported the first time.
________________
See also

Importing Information from a Quicken File
Getting Help

User's Guide
Appendix A



Help for the Message:

Microsoft Money could not create all categories, classification items, or accounts 
from the data in the import file. Some transactions may have blank categories or 
classifications.

Your computer may have run out of memory or disk space while importing, or your Quicken 
and Microsoft Money files had more than 253 categories combined. You can display the 
uncategorized or unclassified transactions and assign categories or classifications to them.
If you try to import again, you should import the account into a new Microsoft Money file 
created without the default categories.

To display uncategorized/unclassified transactions
1 In the View box, choose Other.
2 In the Category or Classification box, choose Blank Category, or Blank Classification.
3 Choose the OK button.

Microsoft Money will display all uncategorized/unclassified transactions.
4 If you want, assign categories or classifications to the displayed transactions.
Note    If you have reached the 253-category limit, you need to delete or combine some 
existing categories in the Category List.
________________
See also

Assigning Categories to Transactions
Classifying a Transaction
Deleting Categories and Subcategories
Getting Help



Help for the Message:

This file does not appear to be a Quicken Interchange Format (QIF) file. Do you 
want to try to import it anyway?

Make sure you have chosen the correct file in the Import dialog box. You can only 
import .QIF (Quicken Interchange Format) files into Microsoft Money. You cannot import an 
exported Quicken report. You can quickly re-create the report in Microsoft Money once you 
have imported your Quicken accounts.
________________
See also

Importing Information from a Quicken File
Getting Help

User's Guide
Appendix A



Help for the Message:

No default printer is installed; please use the Microsoft Windows Control Panel to
install a default printer.

To install a printer, you need to switch to the Microsoft Windows(TM) Program Manager. Start
the Control Panel and choose the Printers icon. For more information about installing 
printers in Windows, see your Microsoft Windows documentation.
________________
See also

Getting Help



Help for the Message:

The number of checks remaining on the sheet must be one or two. Leave this 
field blank if you are loading a full sheet of blank checks.

There are only three checks to a page. So, when you are printing on a partial sheet of 
checks, you must type either 1 or 2 for the number of checks remaining on the sheet. If 
you are printing on a full sheet of checks, leave the field blank.
________________
See also

Setting Up to Print Checks or Reports
Getting Help

User's Guide
Chapter 9



Help for the Message:

The new amount will produce an unassigned amount in the overall split 
transaction. Do you want to continue with the changes?

You are viewing split transactions in the Account Book as separate transactions. For 
example, you're viewing by category, or sorting by category. By editing the amount of this 
transaction, you are changing the unassigned amount for the parent transaction. You can 
press ESC to stop making these changes, then go back to View All (by Date) and make the 
changes as you normally would. Or, you can choose No, then press CTRL+S to see the splits 
you're about to change.
________________
See also

Splitting a Transaction
Getting Help



Help for the Message:

To change the contents of a split transaction, the main transaction must be 
selected. The currently selected transaction is just one part of a split 
transaction.

To make changes to an existing split transaction
1 Make sure you are viewing the account you originally entered the transaction into, and 

are viewing all its transactions.
From the View box, choose All, then -- from the Account box -- switch to the account you 
originally entered the transaction into.

2 Select the original split transaction that you want to change.
3 Choose the Split button, or choose Split Transaction from the Edit menu.

Make the changes you want in the Split Transaction dialog box.
________________
See also

Splitting a Transaction
Getting Help



Help for the Message:

You have some Future Transactions due within the next [#] days. Would you like 
to enter these transactions now? (If not, you can choose Enter Due Transactions 
from the Tools menu at any time to enter these transactions.)

You may have scheduled bills to pay, or deposits to make. If you choose Yes, you'll have a 
chance to review the transactions before entering them in the Account Book. You can also 
reschedule the transactions, or cancel the process after choosing Yes.
If you prefer to take care of the transactions at another time, choose No. You'll be reminded
again of these pending transactions the next time you start Microsoft Money.
________________
See also

Entering Future Transactions That are Due
Getting Help

User's Guide
Chapter 11



Help for the Message:

This is an invalid amount.

Microsoft Money does not recognize too large of a value or a non-numeric value for this 
field. Please type a number that uses no more than nine digits (including those after the 
decimal, even if they're zero).





Help for the Message:

There were no pages to print because this report is only [#] page(s) long.

In the Print Report dialog box, you have entered a range of pages to print that does not 
exist. Choose the All option in the Print Report dialog box.
________________
See also

Printing Reports
Getting Help



Help for the Message:

This payee named already exists. Would you like to change all transactions with 
this payee to use that payee instead? Choosing No will create a second payee 
with the same name.

If you choose the Yes button, the payees will be combined. 
If you choose the No button, a new payee with the same name will be created. Later, when 
entering transactions assigned to this payee name, you will be prompted to specify which 
of the two payees with the same name you are referring to.
Choose the Cancel button to enter a new payee name.
________________
See also

Creating Multiple Payees with the Same Name
Getting Help

User's Guide
Chapter 14



Help for the Message:

The QIF file contains transactions for an account that is not the same type as the
account you are loading it into. Do you want to continue importing the file?

For example, you may be trying to import a Credit Card Account into a checking account, or
be attempting to import an investment account into a different type of Microsoft Money 
account. Choose an account of the same type to load into, or create a new account of the 
same type.
________________
See also

Importing Information from a Quicken File
Getting Help

User's Guide
Appendix A





Help for the Message:

You have reached the maximum number of investments. Archiving this file will 
remove investments that are no longer needed, allowing you to create new ones.

The maximum number of investments for each file is 32,765. You need to free up some 
space if you want to create new investments.
You may want to delete investments you've sold or no longer need and then archive your 
file.
________________
See also

Archiving Your Records
Deleting or Removing a Transaction

User's Guide
Chapter 37



Help for the Message:

This quantity is invalid.

In this field, Money cannot recognize values using more than ten digits, non-numeric 
values, or negative values. Please type a positive number that uses no more than ten digits
(including those after the decimal, even if they're zero).



Help for the Message:

This price is invalid.

In this field, Money cannot recognize values using more than nine digits, non-numeric 
values, or negative values. Please type a positive number that uses no more than nine 
digits (including those after the decimal, even if they're zero).



Help for the Message:

This file has more investments than the Investment List can hold. You can 
continue, but some investments will not appear in the list. You can delete 
unused investments in the Investment List dialog box.

The maximum number of investments Money can display in the Investment List is 8,000. To
make room in the Investment List, you can delete investments you no longer need.

To delete an investment from the Investment List
1 From the Lists menu, choose Investment List.
2 In the Investment List dialog box, highlight the investment you want to delete.
3 Choose the Delete button.

Money asks if you want to delete the investment specified.
4 Choose the Yes button to delete the investment.
5 Choose the Close button to return to the window in which you were working.
________________
See also

User's Guide
Chapter 27



Help for the Message:

You have left blank more than one of the Price, Quantity, Comm, and Total fields. 
Microsoft Money can calculate only one amount for you. Please enter all the 
amounts or leave only one blank.

For the Quantity, Price, Comm, and Total fields, you can type numbers for any three, and 
Money will calculate the fourth when you enter the transaction. 
You have left more than one field blank. You either need to type an amount in each of the 
fields or leave only one blank.
________________
See also

Entering Purchases and Sales



Help for the Message:

For this activity, the amount in the Commission field may not be larger than the 
amount in the Total field.

The commission you've typed is larger than the total amount of the investment purchase. 
Money cannot calculate what the quantity or price should be from this information.
Please increase the total or enter a commission that is less than the total.
________________
See also

Entering Purchases and Sales
 



Help for the Message:

This investment was previously deleted but is still used in some transactions. Do 
you want to reuse it?

You've previously deleted this investment from the Investment List, but Money remembers 
that you used it in some transactions.
Choose the OK button to add the investment back to the Investment List.



Help for the Message:

This transaction can only be changed in the Investment Details window. Would 
you like to go there now?

You can look at all of your investment activities in the Account Book and Account Forms 
windows. However, the only activity you can make changes to in these windows is a Buy 
activity. To make changes to other investment activities, you must be in the Investment 
Details window.
Choose the Yes button to go to the Investment Details window now.
________________
See also

Using the Investment Details Window
Making Changes to an Investment Transaction



Help for the Message:

This category is the main category for more than one of Principal, Interest, and 
Other Fees for a loan; you need to reassign the subcategories used before 
deleting this category.

You've tried to delete a category you're currently using for loan payments. Before you can 
delete this category, you need to reassign its subcategories so that Money knows which 
portion of your loan payment goes to Principal, Interest, and Other Fees.
________________
See also

Deleting Categories and Subcategories
Creating a New Category or Subcategory
Assigning Categories to Transactions

User's Guide
Chapter 12



Help for the Message:

Some unknown QIF fields were ignored.

The Quicken file you are importing has some information Money does not recognize. This 
information will not be added to your Money file.
Choose the OK button to continue.
________________
See also

Importing Information from a Quicken File

User's Guide
Appendix A



Help for the Message:

To make this transaction into a transfer, choose the account you are transferring 
to or from in the Transfer from/to field.

You typed "transfer" in the Category field for this Other Income or Other Expense activity. 
You need to use the Transfer from/to field to transfer the amount to or from another 
account.

To make this transaction into a transfer
1 Delete the word "transfer" from the Category field.
2 Move to the Transfer from/to field.
3 Enter the account you want to transfer money from or to.
________________
See also

Transferring Money Between Accounts

User's Guide
Chapter 18



Help for the Message:

Microsoft Money cannot create an Associated Cash Account for this Investment 
Account because there is already an account with this name.

The name of one of your accounts begins with the word "Cash:" and is followed by the 
proposed Investment Account name. 
When you create an Associated Cash Account for an Investment Account, Money 
automatically names it by adding the word "Cash:" to the beginning of the Investment 
Account name, for example, Cash: Jack and Sons.
Please rename the other account with this name.

To rename your account
1 Cancel the creation of this Investment Account.
2 From the Lists menu, choose Account List.
3 Highlight the account you want to rename.
4 Choose the Modify button.
5 In the New Name box, type a new name for your account.
6 Choose the OK button.

You can now create the Investment Account and its Associated Cash Account.
________________
See also

User's Guide
Chapter 27



Help for the Message:

Money is unable to load this file. You may need to run Setup again.

When you run the Setup program to install Money, all the files Money needs are 
automatically copied to your hard disk. You may have accidentally moved or deleted a file 
that Money needs to complete a task. Depending on the problem, Money may be able to 
indicate which file it needs.

To run Money Setup
1 Exit Money.
2 Put the Money Setup disk in drive A or B and close the drive door.
3 In the Windows Program Manager, choose Run from the File menu.
4 In the Command Line box, type the letter of the drive that contains the Money Setup disk

followed by a colon, a backslash, and the word "setup." For example, type a:\setup if the
disk is in drive A.

5 Press ENTER.
6 Follow the instructions on the screen.

User's Guide
Chapter 1



Help for the Message:

You've already sold the shares of this investment purchased with the transaction
you are replacing. You must delete some Sell activities before you can replace 
this transaction.

You are trying to change a Buy activity for an investment that you've already sold. If you 
want to make changes to this transaction, you must first delete the Sell activity (or 
activities).
________________
See also

Making Changes to a Transaction
Deleting or Removing a Transaction

User's Guide
Chapter 4



Help for the Message:

If you replace this transaction, the first transaction for this investment in this 
account will not be a Buy. Do you really want to replace this transaction?

You are trying to make changes to your initial purchase of this investment. In general, the 
first transaction you'll enter for an investment should be a Buy activity. This indicates that 
you've purchased the investment. Any other transactions you enter in Money are based on 
this initial transaction.
________________
See also

Making Changes to a Transaction

User's Guide
Chapter 4



Help for the Message:

If you make these changes your first transaction for this investment in this 
account will not be a Buy activity. Are you sure you want to do this?

In general, the first activity you'll enter for an investment should be a Buy activity. This 
indicates that you've purchased the investment. Any other activities that you enter in 
Money are based on this initial activity.
You can choose the Yes button to continue, but this could cause problems later on in your 
investment reports. Money recommends that you choose the No button and not replace the
purchase.



Help for the Message:

You've already sold the shares of this investment purchased with this 
transaction. You must delete some Sell Activities before you can delete this 
transaction.

You are trying to delete a Buy activity for an investment you've already sold. If you want to 
delete this transaction, you must first delete the Sell activity (or activities).
________________
See also

Deleting or Removing a Transaction

User's Guide
Chapter 4



Help for the Message:

If you delete this transaction, the first transaction for this investment in this 
account will not be a Buy activity. Do you really want to delete this transaction?

In general, the first activity you'll enter for an investment should be a Buy activity. This 
indicates that you've purchased the investment. Any other activities that you enter in 
Money are based on this initial activity.
You've just tried to delete the Buy activity for this investment. You can choose the Yes 
button to continue, but this could cause problems later on in your investment reports. 
Money recommends that you choose the No button and not delete the purchase.
________________
See also

Deleting or Removing a Transaction

User's Guide
Chapter 4



Help for the Message:

You are currently holding some of this investment, so it cannot be deleted.

You cannot delete an investment that you still own. If you want to delete it, you must first 
enter a Sell activity so you no longer own it.
________________
See also

Entering Purchases and Sales

User's Guide
Chapter 28



Help for the Message:

Microsoft Money found this Financial Wizard already loaded. Please close 
Windows and try again.

You were using a Financial Wizard when Money closed down. Before you can use a wizard 
again, you need to exit Windows. Then, start Windows and open Money again.



Help for the Message:

The par value you entered for this bond is too large. Money would not be able to 
adjust some of the totals in this bond's transactions. Please make sure you have 
the right figures and enter a smaller number.

Money allows nine digits (including those after the decimal, even if they're zero) in the Total
field of the Investment Details window. The number you typed for the par value of your 
bond will cause this limit to be exceeded.
Please type a smaller number.
________________
See also

Displaying Bond Prices as Dollar Amounts



Help for the Message:

You've already sold the shares of this investment purchased with the transaction
you are voiding. You must delete some Sell Activities before you can void this 
transaction.

You are trying to void a Buy activity for an investment you've already sold. If you want to 
void this transaction, you must first delete the Sell activity.
________________
See also

Deleting or Removing a Transaction
Voiding a Transaction

User's Guide
Chapter 4



Help for the Message:

If you void this transaction, the first transaction for this investment in this 
Investment Account will not be a Buy activity. Do you really want to void this 
transaction?

In general, the first activity you'll enter for an investment should be a Buy activity. This 
indicates that you've purchased the investment. Any other activities you enter in Money 
are based on this initial activity.
You've just tried to void the Buy activity for this investment. You can choose the Yes button 
to continue, but this could cause problems later on in your investment reports. Money 
recommends that you choose the No button and not void the purchase.
________________
See also

Voiding a Transaction
Deleting or Removing a Transaction



Help for the Message:

This stock split cannot be deleted because it would cause the share balance to 
become negative in one or more of your Investment Accounts, or because it 
would generate an invalid price.

You can fix the balance error by doing one of the following:
Deleting or changing one or more of your Sell activities.
Entering a new stock split with the same date as the one you entered previously (to 

replace a split that was entered incorrectly).
Adding a new stock split and then deleting the old one (if the date of the original 

stock split was incorrect).





The Category Field

Income and expense categories are the key to organizing your finances. 
When entering a transaction, you can choose a category from the list, or type a new one.
You can also make the transaction a Transfer, Split, or Loan Payment by choosing those 
words from the category list.

You can use categories to:
See where your money is coming from and where it's going.
Budget income and expenses and compare budgeted amounts with actual amounts.
Track tax-related income and expenses.

________________
See also

Assigning Categories to Transactions
Introduction to Entering Transactions
Keyboard Shortcuts for Entering Information

User's Guide
Chapter 3



The Num (Number) Field

In the Number field, you can enter a number for check transactions, or mark transactions 
for printing, Electronic Payment, or electronic transfer of funds. The Number field can 
contain up to eight characters.

When you are entering several check transactions, Microsoft Money will automatically
enter the next sequential check number for you.

If you are preparing to print a check, type Print instead of the check number.
If you want to send this payment electronically through Pay On-Line, type Epay. In 

order to do this, you must have set up On-Line Services and enabled the account. For more 
information, see Applying for On-Line Services and Enabling Accounts for On-Line Services.

If you want to electronically transfer funds between accounts (for example, from 
savings to checking), type Xfer. In order to do this, both accounts must be enabled for Bank 
On-Line. For more information, see Applying for On-Line Services and Transferring Money 
Electronically Between Accounts.

For transactions such as deposits and automatic teller machine withdrawals, leave 
the Number field blank, or enter a notation such as "deposit" or "ATM."
________________
See also

Introduction to Entering Transactions
Quick Ways to Enter Transactions
Keyboard Shortcuts for Entering Information



The Number Field (Future Transactions)

In Future Transactions, the Number field can be used to mark checks for printing or 
Electronic Payment or can be left blank.

If you want to send this payment electronically through Pay On-Line, type Epay. In 
order to do this, you must have set up On-Line Services and enabled the account. For more 
information, see Applying for On-Line Services and Enabling Accounts for Pay On-Line or 
Bank On-Line.

If you want to send this payment automatically through Pay On-Line, type Apay. For 
more information, see Using Automatic Payments.

If you are preparing to print a check, type Print in the Number field. Otherwise, this 
field should be empty. You can give the transaction a check number when it is entered into 
an account.
________________
See also

Setting Up Future Transactions
Entering Future Transactions That Are Due
Keyboard Shortcuts for Entering Information



The Date Field

The current date, or the date of the last transaction you entered, is automatically entered 
when you begin entering information. You can change it if you want.

To change only the day, enter the number for the day and press TAB to move to the 
next field. Microsoft Money will fill in the month and year for you.

To increase or decrease the date by one day, press the PLUS SIGN (+) or MINUS SIGN (-) 
key.

When typing in a date, use a slash ( / ) as a separator between month, day, and year. 
For example, enter May 18, 1994 as 5/18/94.
Note    If you want to change the way dates are displayed, you can change the Short Date 
Format in the International dialog box of the Microsoft Windows Control Panel. For more 
information, see the Microsoft Windows documentation.
________________
See also

Quick Ways to Enter Transactions
Keyboard Shortcuts for Entering Information
Speeding Up Date Entry



The Payee Field

You can choose from a list of previously entered payees, or type a new one. When you 
leave the Payee field, the values from the last transaction with this payee are entered 
automatically.

To open the payee list, click the arrow to the right of the Payee field, or press ALT+ 
DOWN ARROW. Then choose the name you want from the list.

If you type a new payee and enter the transaction, that name is added to the payee 
list.
Note    You can click the right mouse button (or press shift+f10) in the Payee field to see the 
last five transactions for the current payee. To close the list, click either mouse button (or 
press a number or letter key or the esc key).
________________
See also

Deleting an Item from the List



The Payee Field List

You can choose from the list of previously entered payees, or type a new one in the field.
Click the name you want, or use the Down arrow key to highlight the name. Then press 

TAB to move to the next field.
If you type a new payee name and enter the transaction, that name is added to the 

payee list.
________________
See also

Renaming an Item on a List
Deleting an Item from the List



Entering a Transaction Amount

You can enter the transaction amount in one of two columns depending on whether it 
increases or decreases the account balance.
For example, in a checking or savings account, enter the amount in:

The Payment column if it's a check or withdrawal.
The Deposit column if it's a deposit.

The column headings for the transaction amount vary for each type of account.

Account 
Type

Fields

Bank 
Accounts

Payment or
Deposit

Cash or 
Other

Spend or 
Receive

Credit Card Charge or 
Credit

Asset 
Accounts

Decrease 
or Increase

Liability 
Accounts

Increase or
Decrease

Multiple 
Accounts

Spend or 
Receive

In Account Forms, enter the transaction amount in the box labeled with a dollar sign.
________________
See also

Automatically Inserting the Decimal Point
Quick Ways to Enter Transactions
Keyboard Shortcuts for Entering Information



The Account Field

The Account field is displayed when you're viewing more than one account in the Account 
Book or Account Forms window, when you're working in the Loans window, or when you're 
working in the Future Transactions window.

Account Book or Account Forms window

The Account field displays the name of the account where the transaction will be entered. 
To enter the transaction in a different account, choose the account name you want from the
list, or type the name of the new account in the Account field.

Loans window

In the Loans window -- for a borrowed loan -- the Account field displays the account from 
where the loan payment was made. For a loan that was lent, the Account field displays 
where the payment was deposited.

Future Transactions window

In the Future Transactions window, the Account field displays the account in which you'll 
make the deposit, or from which you'll make the payment. If you're not sure which account 
you'll ultimately use, you can leave the Account field blank for now.
________________
See also

Introduction to Entering Transactions
Quick Ways to Enter Transactions
Keyboard Shortcuts for Entering Information



The Memo Field

You can use the Memo field to help you remember details about a transaction. However, it's
best to use the Category field to keep track of income and expenses for reports, budgets, 
and tax purposes.

The memo will print on the check. However, anything you enter between curly 
brackets {    } will not be printed, so you can include information for your own use.
________________
See also

Entering a Transaction in Account Forms
Entering Information You Don't Want Printed on Checks



The Category Field for a Split Transaction

When the Category field contains the word "Split," the transaction is a split transaction.
You can create a split transaction by typing the word split in the Category field, or by

clicking the Split Transaction button in the toolbar.
You can view a split transaction by clicking the Split Transaction button, by choosing 

Split Transaction from the Edit menu, or by typing CTRL+S.
________________
See also

Splitting a Transaction



The Category Field in a Transfer Transaction

The word "Transfer" in the Category field means the transaction is a transfer between 
Microsoft Money accounts.

Enter the name of the account you're transferring to or from in the Subcategory field.
If you use the Transfer form in Account Forms, enter the accounts you are transferring from 
and to in the fields labeled From and To.
________________
See also

Transferring Money Between Accounts
The Category Field
Quick Ways to Enter Transactions
Keyboard Shortcuts for Entering Information



The Subcategory Field

Subcategories can be used together with categories to further refine the way you track 
income and expenses.
For example, for the Automobile category, you may want to choose a subcategory from 
Gasoline, Maintenance, or Payments. Or you may want to create your own subcategory.
________________
See also

Creating a New Category or Subcategory
Assigning Categories to Transactions



The Frequency Field (Future Transactions)

When you schedule transactions in the future, you also specify the frequency of the 
transactions.
For example, if you pay rent on the first day of every month, you'd choose Monthly for the 
frequency.
Click the DOWN ARROW in the Frequency field to see what frequencies are available.
________________
See also

Setting Up Future Transactions



The Address Field on a Check Form

Use the Address field in Account Forms to enter a mailing address for the payee. The next 
time you enter a check using this payee, Microsoft Money will enter the address for you.
To begin a new line in the Address field, press ENTER. If you print the check, the address is 
printed, except for anything between curly brackets {    }.
________________
See also

Entering a Transaction in Account Forms
Quick Ways to Enter Transactions
Keyboard Shortcuts for Entering Information



The Subcategory Field for a Loan Payment

You've entered "Loan Payment" in the Category field. The Subcategory field now displays 
the list of loans you've set up in Money.

To continue entering the loan payment 
From the list of loan names in the Subcategory field, choose the name of the loan.

Note    When you enter a loan payment in a Money Bank Account, a payment transaction is 
also entered in Loans.
________________
See also

Introduction to Loans
Setting Up a Loan
Entering Loan Payments



 The Category Field for a Loan Payment

If you're making a loan payment, you must enter the following information in the Category 
and Subcategory fields:

Field Enter the 
following

Category Loan Payment
Subcatego
ry

The name of the 
loan

Note    When you enter a loan payment in a Money Bank Account, a payment transaction is 
also entered in Loans.
________________
See also

Entering Loan Payments
Introduction to Loans



 The Loan List in the Subcategory Field

If you choose Loan Payment in the Category field, the Subcategory field list contains the 
names of the loans you've set up in Money.

To continue entering the loan payment
From the list of loan names in the Subcategory field, choose the loan for which you're 

making a payment.
If you do not want to enter a loan payment, move back to the Category field and choose 
a category other than Loan Payment, or press ESC to cancel the transaction.

Note    When you enter a loan payment in a Money Bank Account, a payment transaction is 
also entered in Loans.
________________
See also

Entering Loan Payments
Introduction to Loans



 The Loan Payment Number

The Loan Payment Number (Pmt Num) field indicates how many loan payments have been 
entered in Loans (including any prior payments you chose to have entered when you set up
the loan in Money). The loan payment number may be used for coupon numbers if the loan 
has a payment coupon book. It is not the same as the check number or Bank Account 
transaction number.
The loan payment number does not always indicate the actual number of loan payments 
you've made over the life of the loan. For example, if you set up an existing loan to enter 
previous payments back only to the first of the year, the payment number will not include 
any payments you made before the first of that year.

To change the loan payment number in the Loans window
1 In the Loans window, choose the loan you want.
2 Highlight the payment number you want to change.
3 Type a new payment number.
Note    If you change the payment number of the last payment entered in Loans, your next 
payment is assigned the next highest number.
________________
See also

Entering Loan Payments
Introduction to Loans



Keyboard Shortcuts for Entering Information

Here are some keyboard shortcuts to speed up entering information. A complete list of 
keyboard shortcuts is also printed on the back of the Microsoft Money User's Guide. 

Moving Within a Transaction

Press To
TAB or 
ENTER

Start entering 
transaction 
information

TAB Move ahead 
one field

SHIFT+TAB Move back one 
field

UP ARROW Move up one 
field

DOWN 
ARROW

Move down one
field

ENTER Complete a 
transaction 
(press twice if a
list is open)

ESC Cancel 
transaction 
changes

Making Changes in a Field

Press To
ALT+BACKSP
ACE
or CTRL+Z 

Undo last 
typing

SHIFT+ARRO
W keys

Extend 
selection

DEL Delete 
selection

CTRL+X or 
SHIFT+DEL

Cut to 
Clipboard

CTRL+C or 
CTRL+INS

Copy to 
Clipboard

CTRL+V or 
SHIFT+INS

Paste from 
Clipboard

Entering Transactions

Press To
CTRL+S Split a 

transaction
F4, or 
ALT+DOWN 

Open a list in a
field with an 



ARROW arrow
CTRL+D Insert the 

current date in 
Date field

PLUS SIGN Increase 
number or 
date by one

MINUS SIGN Decrease 
number or 
date by one

SHIFT+QUO
TATION 
MARKS (")

Copy 
information 
from same 
field in 
previous 
transaction

CTRL+M Mark 
transaction as 
cleared

SHIFT+CTRL
+M

Mark 
transaction as 
reconciled

ESC Cancel 
changes

F8 Display the 
Currency 
Converter

Note:    For a more complete list of keyboard methods, choose Keyboard Shortcuts from the
Microsoft Money Help menu.



The Investment Field (Investment Details)

You can choose from a list of previously entered investments or type a new one. If you type 
a new one, Microsoft Money will prompt you to create a new investment. 

To open the investment list, click the arrow to the right of the Investment field, or 
press ALT+DOWN ARROW. Then choose the investment you want from the list.

If you set up a new investment, it will be added automatically to the investment list.
________________
See also

Introduction to Investments
Deleting an Item from the List



The Activity Field (Investment Details)

The Activity field is where you choose what action you want to carry out with the 
investment you chose in the Investment field. The available activities are determined by 
what type of investment you chose. 

To open the activity list, click the arrow to the right of the Activity field, or press ALT+ 
DOWN ARROW. Then choose the activity you want from the list.

The activities you choose will later be reflected in your investment reports.
________________
See also

Entering Purchases and Sales
Entering Interest Received, Dividends, or Capital Gains Distributions
Investment Reports
Changing the Categories Assigned to Investment Activities



The Activity Field List (Investment Details)

You must choose from the list of investment activities. These activities are determined by 
the type of investment chosen in the Investment field.

Click the activity you want, or use the DOWN ARROW key to highlight the name. Then 
press TAB to move to the next field.



The Quantity Field (Investment Details)

The Quantity field is where you enter the number of shares you are buying or selling. 
Microsoft Money multiplies this by the Price and adds the Commission to get the Total for 
the transaction.

Type the quantity of shares you are buying or selling.
Note    For the Quantity, Price, Comm, and Total fields, you can enter figures for any three, 
and Money will calculate the fourth when you enter the transaction.
________________
See also

Entering Purchases and Sales
Entering Interest Received, Dividends, or Capital Gains Distributions



The Price Field

What you should enter in the Price field depends on the investment type.

Investment 
Type

Enter

Mutual Fund The price 
per share

Money 
Market

$1

CD Doesn't 
apply

Stock The price 
per share

Bond See The 
Bond Price 
Field

Discounted 
Bond

The price 
per bond

Note    For the Quantity, Price, Comm, and Total fields, you can enter figures for any three, 
and Money will calculate the fourth when you enter the transaction.
________________
See also

Entering Purchases and Sales
Entering Interest Received, Dividends, or Capital Gains Distributions



The Commission Field

Amounts you enter in the Commission field are not treated as an expense, and are not 
included in categorized reports or in your budget. Microsoft Money adjusts for commission 
amounts when calculating capital gains or losses, and commission payments are treated as
part of the cost basis for the purchase, reducing the total gain.

Enter the commission you paid your broker for the transaction. The commission price 
is then added to the Total for this transaction.
Note    For the Quantity, Price, Comm, and Total fields, you can enter figures for any three, 
and Money will calculate the fourth when you enter the transaction.
________________
See also

Entering Purchases and Sales
Entering Interest Received, Dividends, or Capital Gains Distributions



The Total Field (Investment Details)

The Total field displays the Quantity, times the Price, plus the Commission for the 
transaction. 
Note    For the Quantity, Price, Comm, and Total fields, you can enter figures for any three, 
and Money will calculate the fourth when you enter the transaction.
________________
See also

Entering Purchases and Sales
Entering Interest Received, Dividends, or Capital Gains Distributions



The Investment Field List (Investment Details)

You can choose from the list of previously entered investments, or type a new one in the 
field.

Click the investment you want, or use the DOWN ARROW key to highlight the name. 
Then press TAB to move to the next field.

If you type a new investment name and enter the transaction, Microsoft Money will 
prompt you to create the new investment.
________________
See also

Renaming an Item on a List
Deleting an Item from the List



The Investment Account Field (Investment Details)

Since you are displaying more than one Investment Account, you need to choose which one
this transaction relates to. You can choose from a list of previously entered accounts or type
a new one. If you type a new one, Microsoft Money will prompt you to set up the new 
Investment Account. 

To open the Inv Acct (Investment Account) list, click the arrow to the right of the Inv 
Acct field, or press ALT+ DOWN ARROW. Then choose the Investment Account you want from the
list.

If you set up a new Investment Account, it will be added automatically to your 
Investment account list.
________________
See also

Introduction to Investments
Setting Up an Investment Account
Deleting an Item from the List



The Investment Account Field List (Investment Details)

You can choose from the list of previously entered Investment Accounts, or type a new one 
in the field.

Click the name you want, or use the DOWN ARROW key to highlight the name. Then 
press TAB to move to the next field.

If you type a new Investment Account name and press TAB, Money will prompt you to 
set up the new Investment Account.
________________
See also

Renaming an Item on a List
Deleting an Item from the List



The Bond Price Field (Investment Details)

Most newspapers and brokers quote bond prices as percentages of their par value.
By default, Money expects you to enter the price as a percentage of par value. For 
example, if the bond was issued with a $1,000 par value, and you purchased it for $1,050, 
you will enter 105 in the Price field. Money will then use the percentage of par value to 
calculate the Total in dollars. 
You can generally find the purchase price in most newspapers or on the confirmation 
statement sent by your broker. 
You can change the setting to display your bond prices as dollar amounts instead of 
percentage of par value by choosing Options from the Tools menu. Then choose Investment
and change the option. You can then enter all bond activities in dollar amounts and your 
bond prices will be displayed as dollar amounts.
Note    For the Quantity, Price, Comm, and Total fields, you can enter figures for any three, 
and Money will calculate the fourth when you enter the transaction.
________________
See also

Displaying Bond Prices as Dollar Amounts
Entering Purchases and Sales
Entering Interest Received, Dividends, or Capital Gains Distributions



The Transfer From/To Field (Investment Details)

The Transfer From/To field is where you specify which account you want investment 
proceeds or expenses to go to or come from. For accurate record keeping, Microsoft Money 
recommends that when an investment transaction requires or produces cash, you transfer 
the cash from or to another Money account. This transfer account is commonly the 
Associated Cash Account, which is set up to handle these sorts of transfers. Its name will 
already be in the Transfer field.
________________
See also

Getting a Warning When the Transfer Field is Left Blank
Viewing Transactions in the Associated Cash Account
Enabling or Disabling the Associated Cash Account



The Transfer From/To List (Investment Details)

You can choose from the list of transfer accounts, or type a new one in the field.
Click the account you want, or use the DOWN ARROW key to highlight the account. Then

press TAB to move to the next field.
If you type a new account name and enter the transaction, Microsoft Money will 

prompt you to create the new account.
________________
See also

Getting a Warning When the Transfer Field is Left Blank





Managing Money Files

Introduction

Introduction to Money File Basics

Creating Files

Creating a New File

Opening Files

Changing the Drive or Directory When Opening a File
Opening a File
Opening Previous Versions of Money
Restoring a Backup File

Saving Files

Archiving Your Records
Backing Up Your File
Quitting and Backing Up Your File
Saving Your Work

Changing the File Name

Renaming a File



Introduction to Money File Basics

When you first start Microsoft Money, a file with the name MSMONEY.MNY is automatically 
created for you. Every time you enter a transaction, create a new account, or make any 
other changes, your work is automatically saved -- so you don't have to save when quitting.
Most of the time you'll work with a single file. However, you may want to create an 
additional file if you are maintaining two different sets of accounts, such as one for home 
and one for a charity. However, Money doesn't share information between files. If you use 
more than one file, the reports and charts you create will contain information only from the 
file that is currently open.

Backing Up a File

Whether your work is stored in one file or several, you should make frequent backup 
copies. Then, if you somehow lose or destroy the original, you will have a backup.

Archiving Transactions

When you archive your file, Microsoft Money backs up the complete file for archival 
reference, and then removes the old transactions you want removed from your current file 
to keep it to a manageable size.
________________
See also

Creating a New File
Backing Up a File
Archiving Your Records



Saving Your Work

Every time you enter a transaction, create a new account, or make any other changes, your
work is automatically saved -- so you don't have to save while working or when quitting 
Microsoft Money.
Even though saving to disk is automatic, it's still a good idea to back up your file to a 
different file name on a floppy disk. Unless you've changed the Backup setting, you'll be 
prompted to back up your file whenever you quit Money.
________________
See also

Backing Up a File



Creating a New File

You may want to create a new file if you are working with unrelated accounts, such as one 
for your home and another for a charity.
When you create a new file, you can set up a new set of accounts, a new list of categories, 
and new classifications. When a new file is created, Microsoft Money closes the open file, 
saving all changes.
Money doesn't share information between files. If you use more than one file, the reports 
and charts you create will only contain information from the file currently open.

To create a new file
1 From the File menu, choose New.
2 In the File Name box, type a name for the new file. The file name must be eight 

characters or less.
The file name extension, MNY, will be added automatically.

3 Choose the desired directory or drive.
4 Choose the OK button.

Money displays the Backup dialog box for the file currently open. You can choose whether
or not you want to back up the existing file before it is closed.

5 In the Set Up Category List dialog box, under Start With, choose whether you want to 
start with Money's Standard Categories. You can modify the category lists later.

6 Choose the OK button.
7 In the Account Name box, accept the proposed name or type the name for the first 

account in your file.
8 Choose the option for the type of account you want, and then choose the OK button.
9 In the Opening Balance dialog box, enter the starting balance for your first account, and 

then choose the OK button.
Money opens your new file and displays the new account you just created.

________________
See also
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Opening a File

When you start each work session, the last file you worked with is automatically opened. If 
you open a different file, you don't have to worry about saving your work because Microsoft
Money always saves your changes as you make them. However, it's a good idea to back up 
your file regularly.

To open a file
1 From the File menu, choose Open.
2 In the File Name box, type a name, or choose one from the list of files.

If the file is not listed in the current directory or drive, either type the directory name in 
front of the file name, or choose the correct directory or drive in the Directories box or 
the Drives box.

3 Choose the OK button.
________________
See also

Backing Up Your File
Starting Microsoft Money from the Command Prompt
Opening Previous Versions of Money



Changing the Drive or Directory When Opening a File

To change the drive or directory
1 From the File menu, choose Open.
2 To change the drive, in the Drives box, choose a drive from the list.

To change the directory, in the Directories box, choose a directory from the list.
3 Choose the OK button.



Renaming a File

In order to rename a Microsoft Money file, you will need to use the Windows File Manager.
Note    Do not rename a file while the file is open. First, quit Money, and then open the 
Windows File Manager.

To rename a file in the Windows File Manager
1 In File Manager, highlight the file you want to rename.

You can choose directories from either the Directory Tree or a directory window. You can 
choose files from a directory window only.

2 From the File menu, choose Rename.
3 In the To box, type the new name.
4 Choose the OK button.
Note    Money always remembers the name of the last file you used. If you rename your 
file, the next time you start Money an error message will be displayed saying Money cannot
locate or open the file. You'll need to specify the name of the file you want to open.



Backing Up Your File

Even though Microsoft Money automatically saves changes to your files, it's a good idea to 
make frequent backup copies. It's also best to back up your file onto a separate floppy disk 
and keep it in a safe place. That way, if your main disk drive crashes and you lose data, 
you'll have a good backup copy.
A backup file is saved with a .BAK extension. For example, if your file is named 
CHARITY.MNY, the proposed backup file will be CHARITY.BAK.
Money will remind you to make a backup every time you exit Money or open a different 
Money file -- unless you turn the backup reminder off.

To back up your file
1 From the File menu, choose Backup.
2 In the Backup File To box, accept the proposed drive and name, or type the drive you 

want to use, followed by a name for the file. For example, type: A:\MSMONEY.BAK to 
back up to a floppy disk in drive A.
If you already made a backup copy on the disk in that drive, a confirmation message is 
displayed asking you if you want to overwrite this file.

3 If you want the new backup file to overwrite the old one, choose the Yes button. If you 
don't want to overwrite the old backup, choose the No button. Then give the new backup
a different name and choose the OK button.

To restore a backup file
You can open BAK files like any other file.

1 From the File menu, choose Open.
2 In the List Files of Type box, choose Backup Files (*.BAK).

If the file is not listed in the current directory, either type the directory name in front of 
the file name in the File Name box, or choose the directory in the Directories box.

3 Choose the OK button.
Money displays a dialog box to remind you to back up the open file before restoring the 
BAK file.
Choose the Yes button if you want to make a backup copy of the open file. Choose the No
button if you don't want to back up the open file.

Note    If you plan to use a backup as a working file, and want to change the extension to 
MNY, you can do it in Windows File Manager.
________________
See also

Archiving Your Records
Renaming a File
Changing the Backup Option
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Archiving Your Records

When you archive your file, Microsoft Money backs up the complete file, and then removes 
old transactions from your file to keep it to a manageable size.
It's a good idea to archive as of the first of the year. That way it's easier to keep your yearly
records separate.

To archive your transactions
1 From the File menu, choose Archive.
2 In the Archive dialog box, accept the proposed date, or type the date up to which you 

want transactions removed from the current file.
3 Choose the OK button.
4 In the File Name box, accept the proposed name or type a name for the archive file.

At this point, you are making decisions about archiving (backing up) your current file. 
Later, you'll indicate which transactions you want removed from your current file. 

5 In the Directories box, choose the directory where you want the archive file.
6 In the Drives box, choose the drive where you want to keep the archive file.
7 Choose the OK button.
8 In the Archive (Account name) dialog box, choose which kind of old transactions you 

want removed from your current file.
You'll be asked to do this for each account and loan in the current file.

9 Choose the OK button to completely back up the current file for archival reference, and 
at the same time, remove the old transactions from the current file.

________________
See also

Backing up Your File
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Quitting and Backing Up Your File

You don't need to save your work before quitting Microsoft Money. Your work is 
automatically saved when you enter a transaction, close a dialog box, or make other 
changes. However, it's always a good idea to make backup copies of your working file onto 
a floppy disk. Keep the backup copy in a safe place away from your computer.
You'll get a reminder to back up your file when you quit Money -- unless you've changed the
setting for Remind to Back Up on Close. 

To quit Microsoft Money
1 From the File menu, choose Exit.
2 If the backup reminder is on, in the Back Up File To box, accept the proposed file name, 

or type a new file name, and choose the Yes button.
Note    If the backup reminder is off, you can turn it on by choosing Options from the Tools 
menu, and then choosing General. In the General Options dialog box, choose Remind To 
Back Up On Close.
________________
See also

Archiving Your Records
Backing up Your File
Turning the Confirmation Messages On or Off



Opening Previous Versions of Money

When you open a file created with an earlier version of Microsoft Money, Money will convert
it to a new file format for Money 3.0. You'll have an option to save a backup copy of the old 
file with an MNx extension. This is the recommended method, in case you ever need to 
reopen the file with the earlier version's formatting.

To convert an earlier version's file to version 3.0
1 From the File menu, choose Open.
2 If necessary, choose the drive or directory where the file you want is stored.
3 In the File Name box, choose the file you want.

If you have a Money 3.0 file open, the Backup Reminder dialog box may be displayed. 
Choose the Yes button to back up the file currently open, or the No button to not make a 
backup copy.

4 Before the earlier version's Money file is opened, a Confirmation message asks if you 
want to keep a copy of the file in the earlier version's format with an MNx extension. 
It is recommended that you choose Yes.





Introduction to Future Transactions

Setting up a Future Transaction for regularly scheduled bills and paychecks can save time 
and help you keep accurate records.
If you have a transaction that occurs regularly, such as a monthly utility bill, it's best to 
enter it as a Future Transaction. That way, you enter the information only once. When it's 
due, you'll get a reminder and an easy way to enter it.
You can use Future Transactions for paychecks, as well as payments. You might also want to
use a Future Transaction to remind you of a single important transaction, such as the 
maturity date for a certificate of deposit (CD).
When you schedule a Future Transaction, you have a wide range of choices for how often 
you want to enter the transaction, and you can always make changes later.
You can also set up a loan payment with a Future Transaction. It's best to set this up when 
you set up your loan in Microsoft Money.
If you want to enter any scheduled transactions ahead of time (before you get a reminder 
message from Money), choose Enter Due Transactions from the Tools menu.
________________
See also

Setting Up Future Transactions
Setting Up a Future Transaction for a Loan
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Setting Up Future Transactions

Once you've set up a Future Transaction, the next time the transaction is due, you'll get a 
reminder and an easy way to enter the transaction. You'll have a chance to make changes if
you want.

There are two ways to set up a Future Transaction:
You can set up a Future Transaction based on an existing transaction. If you've 

already entered a transaction that you know you're going to enter again, you can schedule it
as a Future Transaction.

You can enter the transaction information directly into the Future Transactions 
window. This is also how you'd modify an existing Future Transaction.

To set up a Future Transaction based on an existing transaction
1 In either the Account Book or Account Forms, select the transaction on which you want to

base the Future Transaction.
2 Click the Remind When Due button, or choose Remind When Due from the Tools menu.
3 In the Frequency list box, accept monthly or choose the amount of time that will elapse 

before the transaction is due again. 
Leave the box blank if the transaction will occur in the future but not regularly.
Choose Only Once if the transaction will only occur one time in the future.

4 In the Next Date box, accept the proposed date or type the next date the transaction is 
due. If you don't know the exact date, make an estimate.

5 Choose the OK button.
To enter a transaction directly into the Future Transactions window

1 Switch to the Future Transactions window.
2 In the Date field, enter the date you want to enter the transaction in the Account Book.

You'll get a reminder one or more days ahead of this date. The initial setting is five days 
in advance. To change this setting, choose Options from the Tools menu, and then choose
General. The Settings dialog box appears. Enter the number of days in advance you want
Microsoft Money to remind you of due transactions.

3 In the Frequency field, choose how often you want the transaction to be entered.
4 In the Account field, choose the account for the transaction.
5 In the Number field, enter Print if you're going to print a check. Otherwise, leave the field

blank.
6 In the remaining fields, enter the information as you would for any other transaction.
________________
See also

Entering a Transaction in the Account Book
Entering a Transaction in Account Forms
Entering Future Transactions That are Due
Changing When the Pay Bills Reminder Is Displayed
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Entering Future Transactions That are Due

If you have the Remind When Transactions Due reminder turned on, you will be reminded 
when a Future Transaction is due. When you're reminded, you can enter the scheduled 
transactions, or postpone them.
You can also enter one or more scheduled transactions at any time. You don't have to wait 
for a reminder.

To enter multiple Future Transactions
1 When you're reminded, in the Reminder dialog box, choose the Yes button.

-Or-
If you want to enter a transaction before you get the reminder, from the Tools menu, 
choose Enter Due Transactions.

2 In the Record Due Transactions dialog box, accept the proposed date, or type the date up
to which you want to enter Future Transactions.

3 Choose the OK button.
4 If you want to change the amount, or any other field, you can make the changes in the 

Enter Due Transactions dialog box. These changes will affect only this transaction.
If you want to make changes to transactions that are not yet due, switch to the Future 
Transactions window and make the changes there.

5 In the Number field, if the transaction is for a check, type the check number. If you want 
Money to enter the next check number in sequence, press the QUOTATION MARK (") key.
If you're going to print a check, type Print.
If the transaction is a split transaction and you want to modify any of the parts of the 
split, choose the Split button, make the changes, and choose the Done button.

6 Choose the Enter button to enter the transaction in the Account Book.
If you have entered a frequency for the Future Transaction, the transaction will be 
rescheduled to the next due date.
If you want to defer entering the displayed transaction, or if you're not going to make 
this payment, choose the Don't Enter button.
If you have already manually entered this transaction (for example, if you paid a bill 
ahead of time, but you want to be reminded next time), choose the Reschedule button.

7 If you are entering more than one transaction at a time, repeat steps 4, 5, and 6. When 
all the transactions, up to the date you specified, have been entered, postponed, or 
rescheduled, the dialog box will close automatically.

To enter a single Future Transaction in the Account Book
1 Switch to the Future Transactions window.
2 Select the transaction you want to enter.
3 From the Tools menu, choose Enter Selected Transaction.

To complete the transaction entry, follow steps 4 through 6 (above).
________________
See also

Changing When the Pay Bills Reminder is Displayed
Setting Up Future Transactions
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Switching to the Future Transactions Window

To switch to the Future Transactions window
Double-click the Future Transactions icon, or from the Window menu, choose Future 

Transactions.





Introduction to On-Line Services

On-Line Services allows you to do common banking and bill-paying tasks from your 
computer. Once you're set up with On-Line Services, you simply create a list of instructions 
for your bank or financial institution, and make the phone call to send the instructions 
electronically.
You can sign up for any or all of the services; each works on its own and has separate fees.

Types of On-Line Services:
Pay On-Line(sm)    Lets you pay bills electronically to nearly any business or 

individual in the U.S.
Bank On-Line(sm)    Lets you electronically update your bank and credit card records,

transfer funds between accounts, check your account balances, send inquiries, and order 
new checks -- just like working with a bank teller.

Quotes On-Line(sm)    Lets you electronically download the most recent closing 
prices for stocks and mutual funds.

Requirements:
A Hayes-compatible modem with a transfer speed of 1200 to 14400 bps.
A checking account at any bank or financial institution in the U.S. (for Pay On-Line 

and Quotes On-Line only).
An account at a participating bank or credit card issuer (for Bank On-Line only).

For information on On-Line Services' free trial period or to find On-Line Services standard 
rates, call (800) 200-7622.

To get started, see:
Applying for On-Line Services
Setting Up On-Line Services
Enabling Accounts for Pay On-Line or Bank On-Line
Creating a List of Instructions for On-Line Services

________________
See also:
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Applying for On-Line Services

To participate in Pay On-Line(sm) or Quotes On-Line(sm) all you need is a checking account. 
To participate in Bank On-Line(sm), you must have a bank or credit card account with a 
participating bank or financial institution. You can apply for any or all of the services by 
completing and mailing an application form. Each service works on its own and has 
separate fees.
Here's what you can do with each service:

Pay On-Line    Pay bills electronically to nearly any business or individual in the U.S.
Bank On-Line    Electronically update your bank or credit card records, transfer funds

between accounts, check your account balances, send inquiries, and order new checks -- 
just like working with a bank teller.

Quotes On-Line    Electronically download the most recent closing prices for stocks 
and mutual funds.

To apply for On-Line Services
Using the application form that came in the Money box:
1 Complete the application that came in the Microsoft Money box.
2 Mail the application in the envelope that came with your Money package.

Using the online application form:
1 Switch to the Program Manager window.
2 In the Microsoft Money group window, choose the On-Line Sign-Up Form icon.
3 Using the Write application that comes with Microsoft Windows, complete the application 

form that's displayed.
4 Make sure your printer is turned on and ready to print; then choose Print from the File 

menu in Write.
For information on On-Line Services' free trial period or to find On-Line Services standard 
rates, call (800) 200-7622.
________________
See next:

Setting Up On-Line Services
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Setting Up On-Line Services

Note    If you haven't yet applied for On-Line Services and received your start-up kit, see 
Applying for On-Line Services.

When On-Line Services receives your application, they process it and receive approval from
your bank or financial institution. This usually takes 5 to 10 days. They will then send you a 
start-up kit. This kit will include a confirmation of the accounts that have been approved for
use with On-Line Services and instructions for enabling them. It will also include your 
Personal Identification Number (PIN) and the local phone number you need to access the 
service.
You need your start-up kit in order to complete this procedure.

To set up On-Line Services
1 From the On-Line menu, choose Set Up Services.

Choose the Preview button if you want to learn more about On-Line Services.
2 In the Set Up On-Line Services dialog box, choose the Continue button.
3 In the Personal Information dialog box, fill in all relevant fields. 

If this is a joint account, enter the same information about the account's co-owner under 
Co-applicant for On-Line Services. When you are done, choose the Continue button.

4 In the Modem Options dialog box, complete the information and type the local telephone 
number you'll use to access On-Line Services in the On-Line Access Phone # box. This 
number can be found in your start-up kit.

________________
See next:

Enabling Accounts for Pay On-Line or Bank On-Line
Downloading Market Prices with Quotes On-Line
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Paying Bills Electronically

Pay On-Line(sm) lets you pay bills from your computer to nearly any business or individual in
the U.S. You simply enter the transaction in Microsoft Money, and it becomes a payment 
instruction that is sent by modem to Pay On-Line. If you send the payment to an On-Line 
Payee, the payee will generally receive the payment in one day. Otherwise, the payment 
will be completed in two to four business days. Either way, the payee receives the payment
by the date specified in the Account Book.
Tip    Any time after you've made your first connection to Pay On-Line, you can start using 
On-Line Payees to save payment delivery time. To download the On-Line Payees in your 
area, choose Payee List from the Lists menu, and then choose the Pay On-Line Info button. 
Then choose the Add On-Line Payees button and choose any payees you might send 
payments to in the future. Choose the Add button when you're done.

To pay bills electronically
1 Switch to the Account Book or Account Forms window.
2 In the Number field, type Epay.

"Epay" stands for electronic payment and tells Money you want to send this transaction 
to Pay On-Line for processing. Make sure the account has been enabled for Pay On-Line.

3 In the Date field, enter the date you want the bill to be paid.
Usually, this is the bill's due date. Money will reject or accept this date depending on how
many days Pay On-Line needs to pay this business or individual. Some payees can be 
paid in one day, but others will take up to four business days. You'll receive a message if 
Money can't process this transaction by the date you specify, requiring you to enter a 
different date.

4 In the Payee field, enter the payee name.
5 In the Payment field, enter the amount to be paid.

You can only send payments, not deposits.
6 You may also enter information in the Category, Subcategory, and Memo fields for your 

records, but it will not be transferred with your payment.
7 When you finish, press ENTER.
8 If Money doesn't have either an account number or an address for this payee, it will 

prompt you for this information when you enter the transaction.
The account number is the number of your account with the payee. You can usually find 
it on bills you receive from the payee. If the payee is a friend or family member instead 
of a business, type your name instead of an account number to help the payee identify 
your payment.
When you enter the transaction, Money displays a lightning bolt in the Number field. The 
lightning bolt indicates this is a pending instruction that will be sent during your next 
connection to Pay On-Line. After the instruction has been sent, the lightning bolt no 
longer appears.

9 Repeat steps 2 through 6 for each payment. When finished, you can send all payments 
at once.

10From the On-Line menu, choose Pay On-Line.
11In the Pay On-Line dialog box, verify the information in the instruction list.

All instructions will initially have an "X" in the box to the left. If you do not want one of 
the instructions to be sent, clear its check box. You can choose or clear instructions by 
clicking the instruction or highlighting it with an ARROW key and then pressing the 
SPACEBAR key.



12When all your instructions are ready, choose the Call button to send them.
For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.

Note    After the payment instructions are sent, "Epay" is replaced by a check number 
preceded by the letter "E." This reminds you that this payment was sent using Pay On-Line.
Tip    If you subscribe to "call waiting" service through your phone company, you may want 
to disable this feature temporarily while using the modem, so that it doesn't disrupt your 
modem connection while transferring information. For information on disabling this feature,
contact your telephone company.
________________
See also

Enabling Accounts for Pay On-Line or Bank On-Line
Using Automatic Payments
Canceling Electronic Payments
Reviewing and Sending Instructions to On-Line Services
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Using Automatic Payments

Automatic Payments can be used to pay bills that have a fixed frequency and a fixed 
amount, such as monthly car, rent, and mortgage payments. You only need to set up 
Automatic Payments once. Afterward, Pay On-Line(sm) will automatically make all payments
and enter a record of them in your Account Book.
Important    Once you set up Automatic Payments, Pay On-Line automatically withdraws 
the necessary funds from your account and pays the bills when they are due, whether or 
not you connect to Pay On-Line. It's important that you keep enough money in your account
to cover these automatic deductions.

To set up Automatic Payments
1 Switch to the Future Transactions window.
2 In the Number field, type Apay.

"Apay" stands for Automatic Payments.
3 In the Date field, enter the next date you want the bill to be paid.

Usually, this is the bill's due date. Money will accept or reject this date depending on how
many days Pay On-Line needs to pay this business or individual. On-Line Payees can be 
paid in one day; others will take up to four business days. You'll be prompted to enter a 
different date if Money needs more time to process the transaction.

4 In the Frequency field, enter the frequency of the Automatic Payment.
5 In the Payee field, enter the payee name.
6 In the Payment field, enter the amount of the fixed payment. This amount will not vary.

You can only send payments, not deposits.
7 In the Account field, choose the account from which you want this Automatic Payment to 

be made. Make sure the account is enabled for Pay On-Line.
8 You may also enter information in the Category, Subcategory, and Memo fields for your 

records. These will not be transferred with your payments.
9 When you finish, press ENTER. Money then displays the Set Up Automatic Payment dialog 

box.
10Review the information displayed and enter the number of payments or the date of final 

payment. If you want the payment to be made each time it's due until you send an 
instruction to cancel it, leave both boxes blank. Choose the OK button.

11If Money doesn't have either an account number or an address for this payee, it will 
prompt you for this information when you enter the transaction.
The account number is the number of your account with the payee. You can usually find 
it on bills you receive from the payee. If the payee is a friend or family member instead 
of a business, type your name instead of an account number to help the payee identify 
your payment.
When you enter the transaction, Money displays a lightning bolt in the Number field. The 
lightning bolt indicates this is a pending instruction that will be sent during your next 
connection to Pay On-Line. After the instruction has been sent, the lightning bolt no 
longer appears.

12From the On-Line menu, choose Pay On-Line.
13In the Pay On-Line dialog box, verify the information in the instruction list.

All instructions will initially have an "X" in the box to the left. If you do not want one of 
the instructions to be sent, clear its check box. You can choose or clear instructions by 
clicking the instruction or highlighting it with an ARROW key and then pressing the 
SPACEBAR key.



14When all your instructions are ready, choose the Call button to send them.
For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.

Note    The next time you connect to Pay On-Line, all Automatic Payments due within the 
next 30 days will automatically be entered into your Account Book with a check number 
preceded by the letter "A" in the Number field. This gives you the chance to cancel the 
payment before it's made and reminds you to have funds available. It's a good idea to 
connect to Pay On-Line at least once every 30 days. Automatic Payments will still be paid 
on the scheduled day, even if you don't connect to Pay On-Line.

To permanently cancel Automatic Payments
1 In the Future Transactions window, choose the recurring payment you want to cancel.
2 From the Edit menu, choose Void Transaction.

Money displays **VOID** and a lightning bolt indicating this is a pending instruction to 
cancel the Automatic Payment. This will cancel all future payments to this merchant. Be 
sure to send this instruction to Pay On-Line before exiting Money.
Note    This will NOT cancel any individual automatic payments that have already been 
scheduled in your Account Book. To cancel these, see the following procedure.

To cancel an individual Automatic Payment that has already been scheduled
1 In the Account Book, select the transaction you want to cancel. You can identify a 

scheduled Automatic Payment in the Account Book by the letter "A" preceding the check 
number in the Number field.

2 From the Edit menu, choose Void Transaction. Money displays **VOID** and a lightning 
bolt indicating that this is a pending instruction to cancel this scheduled Automatic 
Payment. Be sure to send this instruction to Pay On-Line before exiting Money.
Note    This will cancel only this payment. Other automatic payments will continue to be 
paid unless you permanently cancel them by following the previous procedure.

________________
See also

Paying Bills Electronically
Canceling Electronic Payments
Reviewing and Sending Instructions to On-Line Services
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Canceling Electronic Payments

You can cancel payment instructions even after they have been sent to Pay On-Line(sm), as 
long as Pay On-Line has not yet sent the payment to the payee.

To cancel a payment
1 In the Account Book, select the transaction you want to cancel. You can identify a 

scheduled electronic payment in the Account Book by the letter "E" preceding the check 
number in the Number field.

2 From the Edit menu, choose Void Transaction.
Money displays **VOID** in the Balance field and a lightning bolt in the Number field to 
indicate this is a pending instruction to cancel this scheduled payment. Be sure to send 
this instruction before exiting Money.

Tip    If you haven't sent the transaction to Pay On-Line (it still says "Epay" in the Number 
field) you can delete it by selecting it in the Account Book and pressing the DEL key.
Note    To cancel or stop a payment that Pay On-Line has already sent, contact your local 
financial institution for a Stop Payment order.
________________
See also
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Enabling Accounts for Pay On-Line or Bank On-Line

Note    If you haven't yet set up Microsoft Money to use On-Line Services, see Setting Up 
On-Line Services.
You should enable your accounts after you receive your start-up kit. The start-up kit will list 
the accounts that have been approved for On-Line Services.
Note    It's a good idea to set up a password now to keep your Money records private. For 
more information, see Assigning, Changing, or Deleting a Password.

To enable your account(s) for Pay On-Line or Bank On-Line
1 From the Lists menu, choose Account List.
2 In the Account List dialog box, highlight an account you want to enable, and choose the 

Money On-Line Services button.
3 In the Money On-Line Services dialog box, choose Pay On-Line(sm), Bank On-Line(sm), or 

both.
If you're enabling the account for Pay On-Line, type an account number in the Account 
Number box and choose the Pay On-Line check box.
If you're enabling the account for Bank On-Line, choose the Bank On-Line check box, 
choose a financial institution and enter information in the Account Number, Account 
Designation, and Bank Routing Number fields.

4 Repeat steps 2 and 3 for each account approved for On-Line Services.
Money will display a lightning bolt next to each account that has been enabled for On-
Line Services.

5 Choose the Close button.
Note:    To use Bank On-Line, you must have a bank or credit card account at a 
participating bank or financial institution.
________________
See next:

Creating a List of Instructions for On-Line Services
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Updating Your Account Records

With Bank On-Line(sm), you can electronically download your transaction records and 
automatically compare your bank's or financial institution's records with your Money 
records.
Important    To get transaction details for an account, you must first enable the account for
Bank On-Line.

To update your records with Bank On-Line
1 From the On-Line menu, choose Bank On-Line.
2 In the Bank On-Line dialog box, choose the Get Transaction Detail option for each 

account for which you want to get transaction details by choosing the check box to the 
left. You can clear the check box by choosing it again.

3 When all your instructions are ready, choose the Call button to send them.
For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.

4 In the Personal Identification Number (PIN) dialog box, type your four-character PIN, and 
choose the OK button.
Your instructions are then transmitted to Bank On-Line and the transaction details you 
requested are downloaded into Money.

5 In the Call Summary dialog box, choose the Continue button to get your bank or financial
institution's transaction details entered into your Account Book. Money will prompt you to
confirm each transaction.

Note    If you have already entered your transactions in the Account Book, Money matches 
your transactions with the bank's or financial institution's and prompts you before entering 
them. For all transactions that match your records, the bank or financial institution's 
transaction descriptions are entered in the Memo field and a "C" is entered in the Cleared 
field. If no match is found, Money enters the bank or financial institution transaction, and 
enters a "C" in the Cleared field.
Tip    If you want to change when Money prompts you to confirm that a transaction 
matches, choose Options from the Bank On-Line dialog box and then choose a different 
confirmation option.
________________
See also

Changing Your Bank On-Line Options
Reviewing and Sending Instructions to On-Line Services
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Sending Letters to Bank On-Line

You can send letters electronically to Bank On-Line(sm) to order new checks, get copies of 
processed checks, inquire about transactions, or send general purpose questions. Bank On-
Line will generally respond within two business days. (Remember that you will later have to
initiate another phone call in order to receive the response.)

To send a letter to Bank On-Line
1 From the On-Line menu, choose Bank On-Line.
2 In the Bank On-Line dialog box, choose the Inquiry button.
3 In the Letter dialog box, choose one of the letter options at the top.
4 In the Att'n field, type the name of the person or department to whom you want to direct 

your letter, or just type Customer Service.
5 In the Subject field, type the subject of your letter.
6 Type a brief description of your problem or question, and choose the OK button. Your 

letter will be added to the list of instructions in the Bank On-Line dialog box.
7 When all your instructions are ready, choose the Call button to send them.

For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.

Tip    If you want to review or change the letter before it's sent, choose the letter instruction
in the Bank On-Line dialog box, and then choose the Inquiry button.
________________
See also

Reviewing and Sending Instructions to On-Line Services
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Sending Letters to Pay On-Line

You can send letters electronically to Pay On-Line(sm) to investigate payments or make 
general purpose inquiries. Pay On-Line will generally respond within two business days. 
(Remember that you will later have to initiate another phone call in order to receive the 
response.)
Note    Payment Investigation Letters should be used, for example, if a payment you sent 
hasn't been debited from your account. Before sending Payment Investigation Letters and 
for simple and immediate payment status inquiries, see Getting a Quick Status of a 
Payment.

To send a letter to Pay On-Line
1 From the On-Line menu, choose Pay On-Line.
2 In the Pay On-Line dialog box, choose the Inquiry button.
3 In the Inquiry dialog box, choose the Write a Letter option, and then choose the Continue

button.
4 In the Letter dialog box, choose one of the letter options at the top.
5 In the Att'n field, you can type the name of the person or department to whom you want 

to direct your letter, or just type Customer Service.
6 In the Subject field, type the subject of your letter.
7 In the Dear Pay On-Line Service box, type a brief description of your problem or question,

and choose the OK button. Your letter will be added to the list of instructions in the Pay 
On-Line dialog box.

8 When all your instructions are ready, choose the Call button to send them.
For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.

Tip    If you want to review or change the letter before it's sent, choose the letter instruction
in the Pay On-Line dialog box, and then choose the Inquiry button.
________________
See also

Getting a Quick Status of a Payment
Reviewing and Sending Instructions to On-Line Services
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Getting a Balance and Status for Your Accounts

With Bank On-Line(sm) you can receive account information, such as the balance of all your 
accounts, available balances for credit card and credit line accounts, payment due dates, 
and interest payment totals. Available information varies by bank or credit card issuer.

To get the balance and status for your accounts
1 From the On-Line menu, choose Bank On-Line.
2 In the Bank On-Line dialog box, choose the Get Status/Balance for All Accounts check box

in the list of Instructions. You can clear this check box by choosing it again.
3 Once you have completed all your instructions for Bank On-Line, choose the Call button 

to send the instructions.
For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.

________________
See also

Reviewing and Sending Instructions to On-Line Services
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Transferring Money Electronically Between Accounts

Bank On-Line(sm) can be used to send instructions to transfer Money between your 
accounts, if both accounts are enabled for Bank On-Line. With transfers, you can update 
both accounts by entering a single transaction. You can use this, for example, to request a 
transfer from savings to checking or from checking to a credit card account.

To enter an electronic transfer request
1 Switch to the Account Book or Account Forms window.
2 From the Account box on the toolbar, choose the account you want to transfer money 

from.
3 In the Number field, type Xfer. to mark the transaction as an electronic transfer.
4 In the Date field, type today's date.
5 Enter the amount of the transfer in the column that will decrease the account balance 

(the Payment or Charge column).
6 In the Category field, type Transfer, or choose it from the list.
7 In the Subcategory field, enter the account you are transferring to, or choose it from the 

list.
The account you transfer money to must be with the same bank as the account you are 
transferring from and must also be enabled for Bank On-Line.

8 You can also enter information in the Memo and Payee fields, but it won't be sent with 
your instructions.

9 To complete the transfer, press ENTER.
The word "Transfer" will change to "Transfer To," and the transaction will also be entered 
in the account you transferred money to. A lightning bolt will appear in the Number field 
next to the word "Xfer" to remind you that this transaction still needs to be sent to Bank 
On-Line.

10From the On-Line menu, choose Bank On-Line. The transfers will be listed in the list of 
instructions.

11When all your instructions are ready, choose the Call button to send them.
For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.

Note    To ensure your transfers take place the day you send the instruction, see the start-
up kit supplied by your bank. These should list cut-off times. You can also call your bank or 
financial institution.
________________
See also

Reviewing and Sending Instructions to On-Line Services
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Getting a Quick Status of a Payment

You can use Quick Status to get immediate feedback about any Electronic Payments made 
within the last 60 days. You can use this to find out, for example, if a payment has been 
made or the date a payment will be made.

To get a Quick Status of a payment
1 From the On-Line menu, choose Pay On-Line(sm).
2 In the Pay On-Line dialog box, choose the Inquiry button.
3 In the Inquiry dialog box, choose Get Quick Status of a Specific Payment. Then choose 

the Continue button.
4 In the Get Status dialog box, Microsoft Money displays all Electronic Payments scheduled 

by Pay On-Line within the last 60 days. From this list, choose the payments for which you
want a Quick Status.

5 Choose the OK button.
Get Status instructions are added to your list of instructions for Pay On-Line.

6 When all your instructions are ready, choose the Call button to send them.
For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.
You will receive information in the Call Summary dialog box as soon as you complete the 
call.

________________
See also

Sending Letters to Pay On-Line
Reviewing and Sending Instructions to On-Line Services
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Changing Your Bank On-Line Options

To change your Bank On-Line Options
1 From the Tools menu, choose Options; then choose Bank On-Line(sm).
2 In the Bank On-Line Options dialog box, choose when you want Microsoft Money to 

confirm that transaction details downloaded from Bank On-Line match your Money 
transactions. Then specify how you want Money to merge the bank or financial 
institution's records with your money transactions.

3 Choose the OK button.
Note    You can also change your Bank On-Line options by choosing the Options button from
the Bank On-Line dialog box.
________________
See also
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Creating a List of Instructions for On-Line Services

To use On-Line Services, you first need to prepare a list of instructions. For more 
information on creating the specific instructions, see the corresponding Help topic for the 
task you want to perform:
Paying Bills Electronically
Using Automatic Payments
Updating Your Account Records
Canceling Electronic Payments
Getting a Balance and Status for Your Accounts
Transferring Money Electronically Between Accounts
Getting a Quick Status of a Payment
Sending Letters to Pay On-Line
Sending Letters to Bank On-Line

The instructions are always listed in the Pay On-Line(sm), Bank On-Line(sm) and Quotes On-
Line(sm) dialog boxes, which can all be reached from the On-Line menu. All instructions 
have a check box to the left. Only those with an "X" in the box will be sent when you call 
On-Line Services. You can choose or clear instructions by clicking the instruction or 
highlighting it with an ARROW key and then pressing the SPACEBAR key.
________________
See next:

Reviewing and Sending Instructions to On-Line Services
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Reviewing and Sending Instructions to On-Line Services

The steps for reviewing and sending instructions to Bank On-Line(sm), Pay On-Line(sm), and 
Quotes On-Line(sm) are the same.

To review and send instructions to On-Line Services
1 From the On-Line menu, choose Pay On-Line, Bank On-Line, or Quotes On-Line.
2 Review the list of instructions, making sure those you want to send have been chosen. 

(Chosen instructions will have an "X" in the check box to the left of the instruction.)
Choose or clear instructions by clicking the instruction or highlighting it with an arrow 
key and then pressing the SPACEBAR key.

3 When all your instructions are ready, choose the Call button to send them.
For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.

4 In the Personal Identification Number (PIN) dialog box, enter your four-character PIN 
code, and then choose the OK button. Microsoft Money will then dial, connect, and 
transmit your instructions.
Upon completing the phone connection, Money displays a Call Summary dialog box. This 
summary includes acknowledgment of all instructions sent during this call and 
information about any errors that might have occurred.
The Call Summary will also include any informational notes from On-Line Services or 
information you've requested, such as transaction details or responses to previously sent
letters.
If you want to save this summary for your records, choose the Save As button. When you
are done, choose the OK button.

________________
See also
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Downloading Market Prices with Quotes On-Line

In order to download market prices for a stock or mutual fund, you must first make sure the
market-approved symbol for the investment is entered in the Investment List. To check this,
choose Investment List from the Lists menu. Then highlight a stock or mutual fund in the 
Investment List and -- if you need to -- type a new symbol in the Symbol box.
The price Microsoft Money downloads will be the most recent closing price.

To download market prices
1 From the On-Line menu, choose Quotes On-Line(sm).

All your stock and mutual fund investments for which you have specified a symbol are 
listed in the Instructions For Quotes On-Line.

2 Review the list of instructions, making sure those you want to send have been chosen. 
(Chosen instructions will have an "X" in the check box to the left of the instruction.)
Choose or clear instructions by clicking the instruction or highlighting it with an ARROW 
key and then pressing the SPACEBAR key.

3 When all your instructions are ready, choose the Call button to send them.
For questions about connecting to On-Line Services, call On-Line Services Customer 
Support at (708) 852-7650.

4 In the Personal Identification Number (PIN) dialog box, enter your four-character PIN 
code, and then choose the OK button. Microsoft Money will then dial, connect, and 
transmit your instructions.
Upon completing the phone connection, Money displays a Call Summary dialog box that 
lists the most recent closing prices for your investments. 
Money will automatically make a record of this date and closing price in the Update Price 
dialog box, which you can view by choosing Update Price from the Investment List dialog 
box. It will also update the value of your investments in the Investment Summary 
window.

5 If you also want to save the Call Summary text for your records, choose the Save As 
button.

________________
See also

User's Guide
Chapter 28





Importing Information from a Quicken(TM) File

Before you import Quicken accounts, be sure to do the following:
Verify you are using Quicken for DOS version 3.0 or higher or Quicken for Windows.
While in Quicken, export your accounts, giving the exported accounts a descriptive 

file name with a QIF extension. QIF stands for Quicken Interchange Format.
For example, if you have a Checking account, a Savings account, and a Credit Card 
account in Quicken, you'll export each account into its own file, such as: CHECKING.QIF, 
SAVINGS.QIF, and CREDIT.QIF. Each of these files can be imported into a single Microsoft 
Money file. Make sure to choose the correct date range when exporting in Quicken, so 
that all the transactions are exported.

If you use class groups in your Quicken file, it's best to create classifications in Money
before importing.
Money will automatically create all the payees, categories, and classification items it finds 
in the Quicken file. 
Note    Money will import most of your data from Quicken, except the memorized 
transaction list, budget information, or loans. You can re-create some of this information 
after you've imported your accounts.

To import a Quicken file
1 From the File menu, choose Import.
2 From the File Name box, choose the Quicken files you want to import. 

You can select all of them by choosing the Select All button, or select none by choosing 
the Select None button. In the Directories box, be sure to specify where you have the QIF
files.

3 Choose the OK button.
4 In the Select Import Account dialog box, choose the Money account you want the 

imported transactions added to. If you want to create a new Money account for the 
Quicken records, choose the Create button and follow the instructions Money displays.
If you are importing investment accounts, Money will display the Select Import 
Investment dialog box, where you can choose the Money investment accounts you want 
the imported transactions added to. Money will also automatically create an Associated 
Cash Account for each Investment Account you import.

5 Choose the OK button to continue to the next account.
If an imported file contains a transfer to an account that does not exist, Money will 
prompt you to create a new one or choose an existing one in the Assign Import Account 
dialog box.

6 Money will display a message when the import is complete.
Transactions are copied from the Quicken account into the Money account, and the 
opening balance of the account is automatically updated if you entered the entire date 
range when exporting from Quicken. You can enter new transactions into the newly 
imported Money accounts at any time.

Note    If you import a transaction that uses a Microsoft Money term, an exclamation mark 
is appended to the name. For example, a category named "Income" in Quicken will be 
named "Income!". After importing, you can change the names.
________________
See also

Resolving Ending Balance Differences After Importing from Quicken
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Exporting an Account

Microsoft Money has an account export feature that allows you to export your information 
to a file interchange format known as QIF.

To export an account
1 Switch to the Account Book or Investment Details window.
2 From the Account box on the toolbar, choose the account you want to export.
3 From the File menu, choose Export.
4 Choose which format you want your exported file to have.

Choose the Loose QIF option if you are exporting this account for use in Money.
Choose the Strict QIF option if you are exporting this account for use with another 
program. This will result in your category names being shortened to 13 characters for 
compatibility.

5 In the next dialog box, choose the accounts you want to export.
In the File Name box, type a name for the file using a QIF extension, and then choose the
directory and drive where you want to export the file.

6 Choose the type of account you want to export.
7 In the Select Export Account dialog box, choose the account you want to export.
8 Choose the Continue button.

Money will confirm when the export is complete.
Note    When you export an account, you cannot export information such as shortcuts and 
comments.
For information on how to import a QIF file into other programs, consult the program's 
directions.
________________
See also

Combining or Dividing Files
Importing Information from a Quicken File



Resolving Ending Balance Differences After Importing from 
Quicken(TM)

If you've imported your account from Quicken and some of your ending balances don't 
match those in Quicken, you will want to:

Make sure the date range you chose while exporting the transactions in Quicken's 
Export screen included all the transactions in the register.

Make sure the account you exported from Quicken is the same type as the account 
you imported into Money. For example, if you exported an asset account in Quicken, make 
sure you didn't accidentally import it into a Liability Account in Money.
________________
See also

Importing Information from a Quicken File
Exporting an Account
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First Steps to Organizing Your Finances

By now you've probably created a Microsoft Money account. If you haven't already entered 
your records into a checking or savings account, that's the next recommended step.
When you first begin entering transactions, it's a good idea to use the Transaction Cue 
Cards. You'll get some useful tips as you enter your first few transactions, and you'll be sure
you've entered them correctly.
Once you've mastered the basics of working with a single account, you might want to 
launch the Money Preview from the Help menu and explore Money's features. Then, decide 
what you want to accomplish. For example, you might want to:

Add more accounts.
Set up a Money Loan to keep track of loan payments.
Plan a budget.
Pay bills.
Set up Future Transactions.
Set up Investment Accounts to keep track of your investments.
Plan ahead for tax time.
Set up a password to ensure privacy.
Protect your records by creating backup files.

Important    Remember, categories are the key to getting organized. Categories and 
subcategories enable you to keep track of income and expenses, create budgets, create 
reports and charts, and organize your tax records. 
________________
See also

Getting Help
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Getting Help

When you need information or instructions on how to get what you want from Microsoft 
Money:

Choose the Transaction Cue Cards from the Help Menu for assistance in entering your
first transactions.

Choose Money Preview from the Help Menu for an overview of Money's features.
Look in the Microsoft Money User's Guide for introductions, specific examples, and 

complete instructions on how to accomplish tasks.
For on-screen Help while working in Money, press the F1 key. Help will provide step-

by-step instructions on how to accomplish tasks, definitions, descriptions of commands, and 
information about options in dialog boxes.
Tip    You can keep the Help window visible while you work by choosing the On Top button 
that is at the top of all Help windows. This is especially useful when going through 
procedures in the Help topics.
________________
See also

Product Support Within the United States and Canada



How Money Stores Your Records

You'll enter the details of your financial records (for example, the details about your checks 
or deposits) into fields in Microsoft Money. A transaction, such as a check or deposit, is 
made up of several fields.
When you enter a transaction in Money, it's automatically saved on your disk. That's why 
there's no File Save command; you don't need one. 
You'll enter transactions into accounts, such as Bank, Credit Card, Cash, Asset, Investment, 
or Liability Accounts. Transfer transactions between two Money accounts are listed in both 
accounts. The Loans window will show any loan payments you've entered.
All your transactions and accounts are stored in a single file, MSMONEY.MNY. If you want, 
you can rename the file and make backups.
Even though Money automatically saves your records, it's a good idea to make frequent 
backups and store your backup disk safely away from your working copy.
________________
See also

Introduction to Money File Basics





Introduction to Investments

Before using Microsoft Money's investment tracking feature, it's important to understand 
the difference between Investment Accounts and investments:

Investment Accounts provide a place to store your investments. Your first step will 
be to set up an Investment Account for each brokerage statement you receive. For more 
information, see Setting Up an Investment Account.

Investments are added to Investment Accounts. You can have multiple investments 
in one Investment Account.
In Money, Investment Accounts differ from Asset Accounts in that Investment Accounts are 
tailored for tracking investments that have fluctuating market value. Whereas, Asset 
Accounts are better for keeping records for real estate, valuable collections, and personal 
property.

Use Investment Accounts for:
 Stocks  T-Bonds, T-Notes, and T-Bills
 Bonds  Money Market funds
 CDs  Keoghs, IRAs, 401(k)s, RRSPs and SEPs
 Mutual 

Funds
After entering your investment transactions in Money, you can study price histories, 
analyze the market value of your holdings, track for tax purposes, and see how much 
you've gained or lost on any investment.
______________
See also

Setting Up an Investment Account
Setting Up an Asset Account
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Setting Up an Investment Account

Create an Investment Account for each brokerage or institution in which you have 
investments. If you receive more than one statement from a financial institution, create an 
Investment Account for each statement. This way you can more accurately compare your 
investment records with your statements.
Retirement accounts, such as 401(k)s, Keoghs, SEPs, Canadian RRSPs, and IRAs should 
each have their own Investment Account. Investments you hold personally (rather than 
through a broker) should also be grouped in a single Investment Account.

To set up an Investment Account
1 From the Lists menu, choose Investment Account List.
2 In the Investment Account List dialog box, choose the New button.
3 In the New Investment Account dialog box, enter the information about your broker or 

bank. This can be helpful when making a trade.
If you choose Tax Deferred, transactions made in this account aren't included in your tax 
reports.

4 Choose the Continue button.
5 Choose whether you want to enable the Associated Cash Account for this account.
6 If you chose Yes, enter the opening balance in the Opening Cash Account Balance dialog 

box, and choose the OK button.
7 Choose the Close button.

Now you can record your current investment holdings. To see the steps for this, choose 
the topic below.

________________
See also

Recording Your Current Investment Holdings
Introduction to Investments
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Recording Your Current Investment Holdings

Before entering your investments, you must have an Investment Account in which to record
them. If you have not yet set up an Investment Account, see Setting Up an Investment 
Account.
All investments listed on a single statement should be recorded in the Investment Account 
you set up for that statement.
To ensure accurate record keeping, be sure to enter a separate purchase transaction for 
each lot. For example, if you purchased 100 shares of XYZ stock in January and 200 shares 
of the same stock in March, you should enter two investment transactions. Similarly, create
separate investments for bonds and CDs that have separate issue dates, interest rates, or 
par values.

To add an investment to an Investment Account
1 Switch to the Investment Details window.
2 In the Date field, enter the date you actually purchased the investment. This may not be 

the same date you record or initiate the purchase.
3 In the Investment field, enter the name of the investment.

If this is a new investment, Money will prompt you to enter the investment name, type, 
and other details.

4 In the Activity field, enter Buy.
5 In the Quantity field, enter the number of shares you bought.
6 In the Price field, enter the price per share.

To enter a fractional price, such as 35 7/8, type a space between the whole amount and 
the fraction. Or, type it in decimal form: 35.875.

7 If you are viewing multiple accounts, enter the account this investment belongs to in the 
Inv Acct (Investment Account) field.
If this is a new Investment Account, Money will prompt you for more details and set up 
the new account. For more information, see Setting Up an Investment Account.

8 In the Comm (commission) field, enter the commission you paid your broker for this 
purchase.

9 In the Transfer From field, enter the account the purchase money came from. If you don't 
want any of your other accounts to be debited for this purchase, leave this field blank.

Any investments you enter in the Investment Details window will be reflected in the 
Investment Summary window. For more information, see Using the Investment Summary 
Window.
Note    For the Quantity, Price, Comm, and Total fields, you can enter figures for any three, 
and Money will calculate the fourth when you enter the transaction.
________________
See also

Entering Purchases and Sales
Entering Interest Received, Dividends, or Capital Gains Distributions
Introduction to Investments
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Viewing Transactions in the Associated Cash Account

The Associated Cash Account is the cash portion of a brokerage account. The balance of 
the account is displayed at the bottom of the Investment Details window in the Cash 
Balance field.

To see the Associated Cash Account's transactions
1 Switch to the Investment Details window.
2 In the Inv Acct box on the toolbar, choose the Investment Account linked to the 

Associated Cash Account you want to see.
3 Choose the Cash Account button at the bottom.

The Account Book then displays transactions in the Associated Cash Account.
4 Once in the Account Book, you can return to the Investment Details window by choosing 

the Investment Account button.
Tip    Whenever the Account Book window is active, you can also display the Associated 
Cash Account by choosing it from the list in the Account box on the toolbar.
________________
See also

Enabling or Disabling the Associated Cash Account
Introduction to Investments
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Enabling or Disabling the Associated Cash Account

You initially enable or disable the Associated Cash Account while setting up your 
Investment Account; however, you can still change its status after setup.

To enable or disable the Associated Cash Account
1 From the Lists menu, choose Investment Account List.
2 Choose the account you want to change.
3 In the Investment Account List dialog box, choose the Modify button.
4 In the Modify Investment Account dialog box, choose the Cash Account Enabled box.

If there's a check in the box, the Associated Cash Account is already enabled.
5 Choose the OK button.
6 If you enabled the Associated Cash Account, enter its opening balance in the Opening 

Cash Account Balance dialog box.
7 Choose the OK button.

If you disabled the Associated Cash Account, you're presented with a confirmation 
message. Make your selection, or choose the Help button for more information.

Note    If you disable the Associated Cash Account, the Transfer field for all transfers to or 
from it will be blank. If you enable it, an Associated Cash Account is created, but past 
transactions won't be automatically transferred to or from it.
________________
See also

Introduction to Investments
Viewing Transactions in the Associated Cash Account
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Investment Reports

Report Types
Investment Transaction Report

Gives a detailed listing of your investment activities over a given period of time. This is 
useful when you want a summary of the price, quantity, commission, and total for your 
investment transactions.

Capital Gains Report
Shows realized gains and losses on investments. Use the grand total to determine if 
you've gained more than you've lost on investments you've sold. This can also be helpful
during tax time.

Market Value Report
Shows the current value of your investments (and Associated Cash Accounts). It's like a 
Net Worth Report focused only on your investments.

Performance Report
Shows the calculated annual return for your investments. You can compare this return 
with those of other investment opportunities, such as bank accounts or real estate.

Price History Report
Shows the historical prices for your investments. It's useful to create a line chart from 
this showing upward or downward trends.

________________
See also

Creating Charts from Reports

User's Guide
Chapter 30



Investment Transaction History Report

To display and customize an investment Transaction History Report
1 From the Reports menu, choose Investments; then choose Transaction History Report.
2 In the Transaction History Report dialog box, choose the Customize button.
3 Choose the options you want, as explained in the table below.
4 Choose the View button.

To Do this
Change 
the title

In the Title box, type a 
name.

Group 
your 
transacti
ons

In the Group by box, 
choose the item you want.

Include 
new 
columns

Under Include Fields, 
choose the information 
you want displayed in the 
report. 

Specify 
a time 
period

In the Dates box, choose 
the period you want the 
report to cover, or type the
dates in the From and To 
boxes.

Include 
only 
certain 
account
s

Under Include 
Transactions, in the From 
Account box, choose the 
accounts you want.

Include 
all 
transacti
ons

Choose the All 
Transactions option.

Include 
only 
certain 
transacti
ons

Choose the Select 
Transactions option. In the 
Select Transactions dialog 
box, choose the options 
you want.

Change 
column 
widths

Choose the Widths button.

Change 
the size 
or style 
of 
typeface

Choose the Fonts button.

________________
See also

Investment Reports



Exporting Reports
Printing Reports
Saving Reports
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Capital Gains Report

To display and customize a Capital Gains Report
1 From the Reports menu, choose Investment Reports; then choose Capital Gains Report.
2 In the Capital Gains Report dialog box, choose the Customize button.
3 Choose the options you want, as explained in the table below.
4 Choose the View button.

To Do this
Change the 
title

In the Title box, type a 
name.

Group your 
transactions

In the Subtotal By box, 
choose the item you want.

Specify a 
time period

In the Dates box, choose the
period you want the report 
to cover, or type the dates 
in the From and To boxes.

Include all 
Investment 
Accounts

Under Include Investment 
Accounts, choose the All 
option.

Include only
certain 
Investment 
Accounts

Under Include Investment 
Accounts, choose the Select 
option.

Include all 
investments

Choose the All option under 
Include Investments.

Include only
one 
investment

Choose the An Investment 
option under Include 
Investments.

Change 
column 
widths

Choose the Widths button.

Change the 
size or style
of typeface

Choose the Fonts button.

________________
See also

Investment Reports
Exporting Reports
Printing Reports
Saving Reports
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Market Value Report

To display and customize a Market Value Report
1 From the Reports menu, choose Investment Reports; then choose Market Value Report.
2 In the Market Value Report dialog box, choose the Customize button.
3 Choose the options you want, as explained in the table below.
4 Choose the View button.

To Do this
Change the 
title

In the Title box, type a 
name.

Change 
what is 
displayed in
each row 

In the Subtotal By box, 
choose another item. 
These will be listed down 
the left side of your 
report.

See the 
market 
value of 
your 
investments
on a prior 
date

In the Show Value As Of 
box, type a prior date. 
Otherwise, the report will 
display your investment's
market value as of today.

Combine 
small 
amounts

Enter a number in the 
Combine All Values Under
X % Of Total box.

Sort from 
largest to 
smallest

Choose the Sort By 
Amount check box.

Include all 
Investment 
Accounts

Choose the All option 
under Include Investment
Accounts.

Include only
certain 
Investment 
Accounts

Choose the Select option 
under Include Investment
Accounts. Then choose 
the accounts you want. 
Otherwise, the report is 
based on the Investment 
Account displayed in the 
Investment Summary 
window.

Include all 
investments

Choose the All option 
under Include 
Investments.

Include only
one 
investment

Choose the An 
Investment option under 
Include Investments. 
Then choose the 
investment you want. 

Change Choose the Widths 



column 
widths

button.

Change the 
size or style
of typeface

Choose the Fonts button.

________________
See also

Creating a Chart
Investment Reports
Exporting Reports
Printing Reports
Saving Reports
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Performance Report

To display and customize a Performance Report
1 From the Reports menu, choose Investment Reports; then choose Performance Report.
2 In the Performance Report dialog box, choose the Customize button.
3 Choose the options you want, as explained in the table below.
4 Choose the View button.

To Do this
Change 
the title

In the Title box, type a 
name.

Change 
what is 
displayed 
in each 
row 

In the Subtotal By box, 
choose another item. 
These will be listed 
down the left side of 
your report.

Specify a 
time 
period

In the Dates box, 
choose the period you 
want the report to 
cover, or type the dates
in the From and To 
boxes.

Display 
only the 
investmen
t name 
and 
annualize
d % return

Clear the Show 
Calculation Details 
check box. This will 
simplify your report.

Make sure
the report
reflects a 
sufficient 
amount of
data

In Do Not Show 
Performance Based On 
Data Of Less Than X 
Days, enter the number 
of days it takes to 
report valid annualized 
returns for your 
investment.

Include all
Investmen
t Accounts

Choose the All option 
under Include 
Investment Accounts.

Include 
only 
certain 
Investmen
t Accounts

Choose the Select 
option under Include 
Investment Accounts. 
Then choose the 
accounts you want. 
Otherwise, the report is 
based on the 
Investment Account 
displayed in the 
Investment Summary 
window.



Include all
investmen
ts

Choose the All option 
under Include 
Investments.

Include 
only 
certain 
investmen
ts

Choose the An 
Investment option 
under Include 
Investments, then 
choose the investments
you want. Otherwise, 
the report is based on 
the investments in your 
current view.

Change 
column 
widths

Choose the Widths 
button.

Change 
the size or
style of 
typeface

Choose the Fonts 
button.

________________
See also

Creating a Chart
Investment Reports
Exporting Reports
Printing Reports
Saving Reports
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Chapter 30



Price History Report

To display and customize a Price History Report
1 From the Reports menu, choose Investment Reports; then choose Price History Report.
2 In the Price History Report dialog box, choose the Customize button.
3 Choose the options you want, as explained in the table below.
4 Choose the View button.

To Do this
Change the 
title

In the Title box, type a name.

Specify a time 
period

In the Dates box, choose the 
period you want the report to 
cover, or type the dates in the 
From and To boxes.

Include all 
investments

Choose the All option under 
Include Investments.

Include only 
certain 
investments

Choose the An Investment 
option under Include 
Investments, then choose the 
investments you want. 
Otherwise, the report is based 
on the investments in your 
current view.

Delete the 
Source column 
from the report

Clear the Source check box 
under Include Fields. It is 
turned on by default and is 
displayed based on custom 
investment settings.

Change column
widths

Choose the Widths button.

Change the 
size or style of 
typeface

Choose the Fonts button.

________________
See also

Creating a Chart
Investment Reports
Exporting Reports
Printing Reports
Saving Reports

User's Guide
Chapter 30



Entering Interest Received, Dividends, or Capital Gains 
Distributions

Microsoft Money considers interest received, dividends and capital gains to be investment 
income. This income can be taken as a profit or reinvested. If you want to record 
transactions for purchases or sales of investments, see Entering Purchases and Sales.

To enter investment income
1 Switch to the Investment Details window.
2 In the Date field, enter the date you actually received the income. This may not be the 

same date you record the transaction.
3 In the Investment field, enter the name of the investment.
4 In the Activity field, enter the activity, as appropriate.
5 In the Total field, enter the amount of the income.
6 If you're displaying multiple accounts, in the Inv Acct. (Investment Account) field, enter 

the account this investment belongs to.
7 In the Transfer To field, enter the account the profits are going to.

To enter reinvested investment income
1 Switch to the Investment Details window.
2 In the Date field, enter the date you actually received the income. This may not be the 

same date you record or initiate the transaction.
3 In the Investment field, enter the name of the investment.
4 In the Activity field, choose the reinvestment activity, such as Reinvested Interest.
5 In the Quantity field, enter the number of shares purchased.
6 In the Price field, enter the price per share.

To enter a fractional price, such as 35 7/8, type a space between the whole amount and 
the fraction. Or, type it in decimal form: 35.875.

7 If you're displaying multiple accounts, in the Inv Acct. (Investment Account) field, enter 
the account this investment belongs to.

8 In the Comm (commission) field, enter the commission you paid for this reinvestment.
Note    For the Quantity, Price, Comm, and Total fields, you can enter figures for any three, 
and Money will calculate the fourth when you enter the transaction.
________________
See also

Introduction to Investments
Setting Up an Investment Account
Recording Your Current Investment Holdings
Using the Investment Details Window

User's Guide
Chapters 27, 28, & 29



Entering Purchases and Sales

If you want to record transactions for investment income or reinvested investment income, 
see Entering Interest Received, Dividends, or Capital Gains Distributions.

To enter purchases and sales
1 Switch to the Investment Details window.
2 In the Date field, enter the date you actually purchased or sold the investment. This may 

not be the same date you record or initiate the transaction.
3 In the Investment field, enter the name of the investment.

If this is a new investment, Money will prompt you for more details and set up the new 
investment.

4 In the Activity field, enter Buy or Sell, as appropriate.
5 In the Quantity field, enter the number of shares you're buying or selling.
6 In the Price field, enter the price per share at which you bought or sold the investment.

To enter a fractional price, such as 35 7/8, type a space between the whole amount and 
the fraction. Or, type it in decimal form: 35.875.

7 If you're displaying multiple accounts, in the Inv Acct. (Investment Account) field, enter 
the account to which this investment belongs.
If this is a new Investment Account, Money will prompt you for more details and set up 
the new account.

8 In the Comm (commission) field, enter the commission you paid your broker for this 
purchase or sale.

9 In the Transfer From/To field, enter the account the money is going to or coming from.
Note    For the Quantity, Price, Comm, and Total fields, you can enter figures for any three, 

and Money will calculate the fourth when you enter the transaction.
________________
See also

Introduction to Investments
Setting Up an Investment Account
Recording Your Current Investment Holdings
Using the Investment Details Window
Keeping Records for 401(k)s and Other Investments Made Through Paycheck Deductions

User's Guide
Chapters 27, 28, & 29



Making Changes to an Investment Transaction

You can modify your investment transactions any time in the Investment Details window. All
changes will be reflected in your reports and in the Investment Summary window.

To make a change to an investment transaction
1 Switch to the Investment Details window.
2 Select the transaction you want to change.
3 Press TAB or click in the field you want to change.
4 Make the change.
5 Press ENTER to enter the change.
________________
See also

Introduction to Investments
Using the Investment Details Window

User's Guide
Chapters 27, 28, & 29



Using the Investment Summary Window

The Investment Summary window shows a summary of your current investment holdings 
and their values. Any investments you enter in the Investment Details window are reflected
in the Investment Summary window. Switching to this window is the quickest way to see 
where your investments stand. You can also update the market prices of your investments 
in this window by choosing the Update Price button.

To switch to the Investment Summary window
Double-click the Investment Summary icon.

If the Investment Summary window is already open, click anywhere in the window to 
switch to it.
--Or--
From the Window menu, choose Investment Summary.

________________
See also

Entering Purchases and Sales
Entering Interest Received, Dividends, or Capital Gains Distributions
Updating Market Prices
Using the Investment Details Window



Using the Investment Details Window

The Investment Details window is where you enter investment transactions. It also provides
a detailed view of individual transactions.

To switch to the Investment Details window
Double-click the Investment Details icon.

If the Investment Details window is already open, click anywhere in the window to switch 
to it.
--Or--
From the Window menu, choose Investment Details.

________________
See also

Using the Investment Summary Window
Entering Purchases and Sales
Entering Interest Received, Dividends, or Capital Gains Distributions
Updating Market Prices

User's Guide
Chapter 27



Keeping Records of Investments Made Through Paycheck 
Deductions

For 401(k)s, employee stock purchase plans, and other investments you purchase through 
paycheck deductions, it's best to enter each purchase in the Account Book as part of your 
paycheck's split transaction. Purchases you enter this way are automatically added to your 
Investment Account records.
Note    If you don't want to enter the details of each contribution, such as purchase price 
and quantity, you may want to manage these investments in an Asset Account rather than 
an Investment Account. However, if you use Asset Accounts, you won't be able to use 
Money's investment reports, and your tax reports won't be complete.

To enter investment purchases made from your paycheck
1 Switch to the Account Book.
2 Enter your payment information, as usual.
3 In the Category field, choose Split.
4 Enter your non-investment paycheck information, such as the gross pay, taxes, and 

insurance, as explained in Itemizing a Paycheck Deposit.
5 In the Split Transaction dialog box, subtract your paycheck deduction amount from your 

gross pay amount (the first line in the split transaction).
6 Enter a new item and choose Wages & Salary in the Category field. In the Subcategory 

field, type Deferred Income. Press TAB to continue.
7 In the Create New Subcategory dialog box, clear the Include On Tax Reports check box, 

and then choose the OK button. 
8 In the Amount field, type your investment contribution amount (the same amount you 

subtracted from your Gross Pay).
9 Enter another new item and choose Buy Investment in the Category field. Press TAB to 

continue.
10In the Buy Investment dialog box, enter information about the investment purchase.

If you don't know the Number Of Shares and the Price Per Share, enter an estimate. You 
can update this information when you get your statement.

11Choose the OK button.
12If you're contributing to more than one investment, repeat steps 9 through 11.
13If your employer makes "matching contributions" to your retirement plan, add an item 

and choose the category Wages & Salary. Then add a non tax-related subcategory called 
Employer Matching. In the Amount field, type the employer's matching amount as a 
negative number.

14Repeat steps 9 through 11 for each investment purchased with your employer's 
contributions.

15Choose the Done button, and then press ENTER to enter this transaction.
Money enters corresponding Buy transactions in the Investment Details window and 
updates your investment price history records. You can quickly display the corresponding 
Buy transaction by choosing Go To from the Edit menu, and then choosing the OK button.
________________
See also

Introduction to Investments
Setting Up an Investment Account
Setting Up Future Transactions



Setting Up an Asset Account
Itemizing a Paycheck Deposit

User's Guide
Chapter 28



Tracking Stock Splits

To record a stock split
1 From the Lists menu, choose Investment List.
2 In the Investment List dialog box, choose the stock for which you want to record a split.
3 Choose the Stock Split button.
4 In the Stock Split dialog box, type the date and ratio for the split, and choose the OK 

button.
5 If the split results in any fractional shares, choose how you want Microsoft Money to 

handle these in the Fractional Shares dialog box. If you choose to convert your fractional 
shares to cash, Money will display the Price After Split dialog box, where you can specify 
the share price after the split.
When you're done, Money will adjust the price and quantity amounts to reflect the split. 
These changes will also be reflected in the Investment Summary and Details windows 
and the Update Price dialog box. 

To delete a stock split
1 Switch to the Investment Summary window.
2 Choose the stock for which you want to delete a split.
3 Choose the Update Price button. 
4 In the Update Price dialog box, choose the stock split entry from the list at the bottom.
5 Choose the Delete button.
6 Choose the Close button.

Money will remove the record of the split from the Update Price dialog box and adjust the
prices to their pre-split amounts.

________________
See also

User's Guide
Chapter 28



Getting a Warning When the Transfer Field is Left Blank

Microsoft Money recommends that when an investment transaction requires or produces 
cash, you transfer the cash from or to another Money account. You can choose if you want 
Money to give you a warning when the Transfer field is left blank.

To get a warning when the Transfer field is left blank
1 From the Tools menu, choose Options; then choose Investment.
2 Choose or clear the Require Transfer Account In Each Transaction box.

If there's a check in the box, it's turned on. If it's blank, it's turned off.
________________
See also

User's Guide
Chapter 28



Displaying Bond Prices as Dollar Amounts

Money can display bond prices either as dollar amounts or percentages of their par value. 
Bond prices are commonly quoted as percentages.

To display and enter bond prices as dollar amounts
1 From the Tools menu, choose Options; then choose Investment.
2 Clear the Treat Bond Prices As Percentage Of Par Value box.

If there's a check in the box, it's turned on. If it's blank, it's turned off.
________________
See also

User's Guide
Chapter 28



Defining When a Capital Gain or Loss is Considered Long Term

You can change the criteria Microsoft Money uses to categorize investment gains or losses 
as short or long term.

To change when a capital gain or loss is categorized as long term
1 From the Tools menu, choose Options; then choose Investment.
2 In the Categorizing Short Term and Long Term Capital Gains box, enter the number of 

days, months, or years the investment needs to be held until it's categorized as long 
term.

________________
See also

Changing the Categories Assigned to Investment Activities

User's Guide
Chapter 28



Changing the Categories Assigned to Investment Activities

When entering investment transactions, such as buying or selling stock, a category will be 
assigned to those transactions based on the activity. 

To change the default category and subcategory for investment activities
1 From the Lists menu, choose Category List.
2 In the Category List dialog box, choose the Investments button to the right.
3 In the Investment Categories dialog box, enter the new categories or subcategories for 

the investment activities.
4 Choose the OK button.
________________
See also

User's Guide
Chapter 28



Verifying Investment Records with a Statement

You can verify your records whenever you receive a statement from your broker or financial
institution by comparing the transactions in Money with those on the statement.

To reconcile an Investment Account
1 Switch to the Investment Details window.
2 Select a transaction that matches what's shown on the statement, and then press 

SHIFT+CTRL+M to mark it as reconciled. You'll see an "R" in the Cleared field. Repeat this 
for each transaction on the statement.
If you find a discrepancy, change your investment transaction, or call your financial 
institution.

Note    Money's regular balance feature is not available for investments. The reconciled 
mark is for your reference only.
Important    It's best to reconcile your account each time you receive a statement. This 
way you know your records are accurate.
________________
See also

User's Guide
Chapter 28



Updating Market Prices

You can update the market price of your investments any time you want to make your 
records more current.

To update the market price for an investment
1 Switch to the Investment Summary window.
2 Choose the Update Price button.
3 In the Update Price dialog box, choose the investment you want from the Investment 

box. Then, under Update Market Price, type the new date and price.
4 Choose the Update button. A record of the update is then entered in the price history 

table.
5 Choose the Close button.

The changes will be reflected in the Investment Summary window.
________________
See also

Downloading Market Prices with Quotes On-Line

User's Guide
Chapter 28



Investment Options

Changing the Categories Assigned to Investment Activities
Defining When a Capital Gain or Loss is Considered Long Term
Displaying Bond Prices as Dollar Amounts



Microsoft Money Decimal Place Rounding Rules

Here are some of the standards Money uses in rounding your fractional investment figures.

Fiel
d

Rounding Rule

Qua
ntity

When entering the quantity,
Money rounds to the 
nearest .000001, and also 
stores six digits internally. 
All six decimals are 
displayed in the Investment 
Details window. In summary
views such as the 
Investment Summary 
window and in Price History 
and Market Value Reports, 
quantities are shown 
rounded to the nearest .01. 
In the Investment Details 
window, exact integers are 
displayed without decimals.

Price When entering the price, 
Money rounds to the 
nearest .000001, and also 
stores six digits internally. 
All six decimals are 
displayed in the Investment 
Details window. In summary
views such as the 
Investment Summary 
window and in Price History 
Reports, prices are shown 
rounded to the 
nearest .001. In the 
Investment Details window, 
exact integers are displayed
without decimals.

Total Money rounds all dollar 
amounts to the number of 
decimal digits specified in 
your Windows Control Panel 
under Currency Format in 
the International dialog box.





Managing Lists

Introduction

Introduction to Managing Lists

Managing Lists

Creating Multiple Payees with the Same Name
Renaming an Item on a List
Deleting an Item from the List
Printing a List
Using Shortcuts



Deleting an Item from a List

Deleting items:
You can remove a payee or foreign currency from its list without affecting your 

current transactions.
You can delete a category assigned to a transaction, but will be asked which other 

category you want to assign the transaction to. If you do not choose an existing category, 
the Category field will be left blank.

You can delete an account, loan, or Investment Account if you no longer want to track
it, but all the transactions entered in that account or loan will also be deleted.

You can only delete an investment if its quantity is zero. To do this you must sell the 
investment.
Important  Be sure this is what you want to do before making the deletion. It's good to 
back up your file before deleting a list item.

To delete an item from the list
1 From the Lists menu, choose the list you want to delete from. For example, if you want to

delete a category, choose Category List.
2 In the list box, choose the item you want to delete.
3 Choose the Delete button.

If you are deleting accounts or loans, you will be asked to confirm the deletion. To 
proceed with deleting the account or loan, choose the OK button.
If you are deleting a category with subcategories, you will be asked to confirm the 
deletion of its subcategories. To proceed with deleting the category and its 
subcategories, choose the OK button.

4 Choose the Close button.
________________
See also

Renaming an Item on a List
Printing a List



Renaming an Item On a List

When you rename a category, subcategory, or payee, the name will be changed in all the 
transactions that use it. If you change the name for an account, loan, or Investment 
Account, the new name replaces the old in every transaction assigned to it. Renaming a 
currency item only changes the name that displays in the Currency List and Currency 
Converter. Renaming an investment only changes the name for that investment.

To rename a list item
1 From the Lists menu, choose the list that contains the item you want to rename. For 

example, if you want to rename a category, choose Category List.
2 In the list box, choose the item you want to rename.
3 For a payee, loan, or currency item, choose the Rename button. When renaming an 

account or category, choose the Modify button.
4 In the New Name box, type the new name.
5 Choose the OK button.
6 Choose the Close button.
________________
See also

Deleting an Item from a List
Printing a List



Creating Multiple Payees with the Same Name

If you have more than one payee with the same name, you can have different addresses for
each. Whenever you enter that payee name in a transaction, you will be prompted to 
choose one.

To create a second payee with the same name as another payee
1 From the Lists menu, choose Payee List.
2 Choose the New button.
3 In the Name box, type the name of the payee.
4 Choose the OK button.
5 Choose the Yes button to confirm that you want to create a new payee with the same 

name as an existing payee.
Note    So that you can distinguish between the two payees later, enter further details, 
such as an address or shortcut name for each payee in the box to the right of the Payee 
List.



Changing an Account's Type

To change an account's type
1 From the Lists menu, choose Account List.
2 In the Account List box, choose the account you want.
3 Choose the Modify button.
4 In the Modify Account dialog box, under Type, choose the type of account you want to 

change it to.
For example, if you chose Liability Account when setting up your account and want it to 
be a Credit Card Account, choose the Credit Card Account option.

5 Choose the OK button.
6 Choose the Close button.



Printing a List

You can customize and print an alphabetic list of your accounts, payees, categories, 
subcategories, loans, Investment Accounts, investments, or currencies.

To print a list
1 From the Lists menu, choose the list you want to print.
2 Choose the Report button.
3 If you want to change what's included in the list, choose the Customize button and make 

changes; then choose the View button.
4 Choose the Print button.
5 Choose the OK button.



Introduction to Managing Lists

To make entering transactions easier and less time consuming, you may want to optimize 
your lists. You can do this by renaming, printing, or deleting list items. To get a 
comprehensive record of what's in your lists, you can print a list report for:

Accounts
Payees
Categories
Loans
Investment Accounts
Investments
Currencies

________________
See also

User's Guide
Chapters 12, 14, & 24





Loan Reports

You can create and print a variety of loan reports depending on what you want to use the 
report for.

Loan Transaction Reports
Lists all transactions in the Loans window.

Loan List Reports
A summary of all your loans and their terms. You can customize the report to include 
additional information, such as the loan number, shortcut, payment splits, and loan type.

Loan Amortization Schedules
Used to see how future loan payments will be broken into principal and interest. It's 
based on loan information you supply, not on loan payments you've made.

Loan Payment Reports
A payment schedule for the life of the loan. It includes the payments you've already 
made and those you haven't yet paid that are listed in the Loan Amortization Schedule. 
You can customize the report to list the payments you've made, those you haven't made,
or both.

________________
See also

User's Guide
Chapter 25



Loan Amortization Schedules

To create a Loan Amortization Schedule
1 From the Tools menu, choose Financial Wizards; then choose Loan Calculator.
2 Enter the terms for the loan in the Loan Calculator, and calculate the unknown value if 

there is one.
3 Choose the Report button.
4 You can choose from the buttons at the top of the Loan Amortization Schedule window to 

Customize, Remember, Print, Export, or Close the window.
________________
See also

Setting up a Loan
Customizing and Remembering a Report

User's Guide
Chapters 24 & 25



Loan Payment Reports

To create a Loan Report
1 Switch to the Loans window.
2 From the Loan box on the toolbar, choose the loan for which you want to create a report.
3 From the Reports menu, choose Loan Payment Report. The report is displayed in its own 

window.
4 You can choose from the buttons at the top of the Loan Report window to Customize, 

Remember, Print, Export, or Close the window.
________________
See also

Setting up a Loan
Customizing and Remembering a Report

User's Guide
Chapter 25



Introduction to Loans

In the Microsoft Money Loans window, you can: 
Keep track of money you borrow or lend.
Get reminders to enter your loan payments.
See how many payments you've made or received, how many are left, and how much

interest, principal, and other fees you've paid.
Prepare for taxes by tracking the interest portion of your payments.
View your loan payments and create reports. 

Tip    If you borrow money, and your loan is for an asset that adds to your net worth, it's a 
good idea to set up an Asset Account and enter a transaction equal to the value of the 
asset. 
When you set up a loan, have your loan documents available for reference.

Where to Keep Track of Different Kinds of Loans

Type of Loan Type of 
Money 
Account

Loans that have 
a regular 
payment 
schedule or an 
amortization 
table.

Loans

Money you owe 
that does not 
have an 
amortization 
schedule or 
regular payment
schedule, such 
as a debt to a 
friend or 
relative.

Liability 
Account

Money owed to 
you that does 
not have an 
amortization 
schedule or 
regular payment
schedule, such 
as a loan to a 
friend or 
relative.

Asset 
Account

credit card 
advances and 
credit card 
transactions.

Credit Card 
Account

________________



See also

Setting Up a Loan

User's Guide
Chapter 24



Using The Loan Calculator

With the loan calculator, you can:
Compare the terms of two loans.
See how much you could save in interest by making extra payments.
Calculate an unknown value, such as interest, if you know the other values for the 

loan.
Create and print a Loan Amortization Schedule (a payment schedule showing 

principal and interest) for your records, for loans you make to others, or to show to a loan 
officer.
Note    The Loan Calculator only lets you calculate terms of a loan. To actually set up a loan 
in Money, see Setting Up a Loan.

To use the Loan Calculator
1 From the Tools menu, choose Financial Wizards; then choose Loan Calculator.
2 Accept or change the frequency for the loan. For example, if you make payments every 

Month, choose Monthly.
3 Enter values in all but one of the boxes. Leave the box blank for which you want 

Microsoft Money to calculate a value. 
If there are already values in all of the boxes, accept or change them, and delete the 
existing value in the box that you want to calculate.
You can also import the terms of an existing loan by choosing the Import button.

4 Choose the Calculate button.
If you then want to compare the terms with those of a different loan, choose the 
Compare Loans button. For more information, see Comparing Two Loans.
If you want to see how much you would save in interest by making extra payments, 
choose the Extra Payments button. For more information, see Calculating Savings from 
Extra Payments.

Note    If you want to see a report of the loan amortization schedule based on the terms 
you just entered, choose the Report button. You can then print the report by choosing the 
Print button.
________________
See also

Setting Up a Loan
Changing Loan Information
Using Financial Wizards
Setting Up a Future Transaction for a Loan

User's Guide
Chapter 26



Setting Up a Loan

You can quickly and automatically create a loan-payment record, or amortization schedule. 
Have your loan documents handy so you can easily find and enter accurate information. For
each loan you set up, Microsoft Money automatically calculates the principal and interest 
breakdown of each payment and keeps track of the balance due.

To set up a loan
1 Switch to the Loans window.
2 From the Loan box on the toolbar, choose Create Loan. 
3 Read the text on screen and choose the Next button.
4 At each step in the process of setting up a loan, you'll enter information in a Set Up Loan 

dialog box, and then choose the Next button to continue.
For additional information, you can use PopUp Help any time you see a question mark in 
a box on the screen. To use it, simply click the Question Mark (?).
If you don't want to go to the next dialog box, choose one of the other buttons at the 
bottom: Cancel to quit loan setup; Back to move back one dialog box; Restart to go back 
to the beginning of loan setup.

Note    When setting up a Loan, you can omit one value in the calculation section and have 
Microsoft Money calculate it for you. For example, if you don't know how much the Principal
+ Interest is, leave it blank. Based on the other numbers you enter, Money will calculate it 
for you.
________________
See also

Introduction to Loans
Changing Loan Information
Entering Loan Payments
Setting Up a Future Transaction for a Loan

User's Guide
Chapter 24



Changing Loan Information

You may need to change information about your loan payment due to changes in the:
Payment amount.
Interest rate.
Other fees associated with loan payments, such as property taxes or insurance.
Payee (who you make payments to).
To change a single payment
Make the change directly to the transaction when you enter it in Loans or the Account

Book.
To permanently change the loan information for all remaining payments

1 From the Lists menu, choose Loan List.
2 In the Loan list, highlight the loan you want to change.

If you want to change the loan name, choose the Rename button, type the new name, 
and then choose the OK button. If you want to change other information, continue with 
step 3.

3 Choose the Change Loan Information button.
4 Read the text on screen and choose the Next button.
5 Choose which part of the loan you want to change (Other Fees, Interest Rate, Loan 

Balance, or Other Information).
6 Follow the instructions on screen.

For additional information, you can use PopUp Help any time you see a question mark in 
a box on the screen. To use it, simply click the Question Mark (?).
Choose the Next button (or press ENTER) to move forward through the Change Loan 
Information dialog boxes.
If you don't want to go to the next dialog box, choose one of the other buttons at the 
bottom: Cancel to quit without making any changes; Back to move back one dialog box; 
Restart to go back to the beginning.

7 Make the changes you want in each Change Loan Information dialog box until the 
summary dialog box is displayed.

8 If the information is correct, choose the Done button. Otherwise, choose the Back button 
to make further changes.

________________
See also

Setting Up a Future Transaction for a Loan
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Balancing a Loan

If you want to reconcile any differences between your records in Microsoft Money and the 
interest, principal, and any other fees shown on your loan statement, you'll need to balance
your loan when you receive a loan statement from your lender.
Note    Because lenders may use different interest rate calculations, it's common to have 
small differences.

To balance a loan
1 Switch to the Loans window.
2 In the Loan box on the toolbar, choose the loan you want to balance.
3 With the mouse, click the Balance Loan button, or from the Tools menu, choose Balance 

Loan.
4 In the Statement Ending Date box, type the date of the loan statement. Then choose the 

Continue button.
You can also change the Statement Starting Date.

5 Compare the Principal Paid and Interest Paid amounts against your statement.
If the numbers don't match, you might want to make an adjustment.

6  Choose the Other Fees button. 
7 In the Balance Other Fees dialog box, compare what you've entered in Money against the

fees listed on your loan statement.
If there are no Other Fees associated with your loan, choose the Done button and go to 
step 8.
If the Other Fees in Money do not match those on your statement, adjust the amounts in 
Money to match the statement, then choose the Done button.

8 Choose the OK button. An adjustment transaction is automatically entered in Loans.
Most adjustments are due to minor discrepancies in interest rate calculation.

Note    If you commonly make large adjustments when balancing, some loan information 
may be incorrect. You may want to permanently change your loan information.
________________
See also

Changing Loan Information
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Setting Up Future Transactions for a Loan

Because making loan payments on time is so important, it's a good idea to set up a Future 
Transaction for each of your loans. That way, you'll get a reminder when a payment is due, 
and entering the transaction is nearly automatic.

To include Future Transaction reminders when setting up a loan
1 Begin setting up the loan as you would any other loan.
2 When you get to the Set Up Loan dialog box for Future Transactions, choose Yes, I Want 

To Be Reminded.
3 If you're unsure of what to enter, choose the PopUp Help button (the question mark in 

the box on the screen).
To add Future Transaction reminders to a loan you've already set up

1 In Account Book, Account Forms, or Loans highlight a loan payment.
2 With the mouse, click the Remind When Due button on the toolbar, or from the Tools 

menu, choose Remind When Due.
3 In the Frequency box, specify how often the transaction will recur, and in the Next Date 

box specify the next date it will be due.
4 Choose the OK button.

The transaction is entered in the Future Transactions window with the date and frequency
you specified.

________________
See also

Changing Loan Information
Setting Up Future Transactions
Setting Up a Loan
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Making Extra Payments

You can calculate how much you would save in interest by making extra payments on a 
loan by choosing the Extra Payments button from the Loan Calculator. For more 
information, see Calculating Savings from Extra Payments.

To increase a scheduled payment or make an extra payment
1 Begin entering the extra payment transaction in the Bank Account you usually make 

payments from (typically a checking account).
2 Enter the Number, Date, and Payee you normally enter when making a loan payment.
3 In the Payment field -- if you are increasing your regular payment by $50 -- type the 

amount plus $50.
If you are making an additional payment of $50, type 50 in the Payment field.

4 Press ENTER to enter the transaction.
5 If the Adjust Loan Payment Amount dialog box displays and you're increasing the amount

of your regular payment, choose the option: Apply All of the Unassigned Amount to 
Principal. If you're making an extra payment, choose the option: Apply the Entire Loan 
Payment to Principal. 
If the Adjust Loan Payment Amount dialog box does not display, you have entered an 
amount that matches the usual loan payment. However, since you don't want the 
payment split between other fees, choose Split Transaction from the Edit menu, and then
delete all but the Principal part of the split. Choose the Done button, and, when 
prompted, choose the option: Apply all of Unassigned Amount to Principal. Choose the 
OK button.

6 Choose the Done button.
7 Press ENTER to enter the transaction.
________________
See also

Changing Loan Information
Setting Up a Future Transaction for a Loan
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Figuring Loans into Your Net Worth

If you have any loans for assets that increase your net worth, such as a house, a vacation 
property, a rental property, a car, a boat, or other real assets, it's a good idea to include 
these in your Net Worth Reports. This will offset the negative impact of the loan.

To figure loans into your net worth
1 Create a separate Asset Account for each asset or group of assets. Enter zero for the 

opening balance.
2 In the Asset Account, enter a deposit for the original cost of the asset.

This amount should equal the total cost of the asset at the time of purchase. It might 
include the down payment plus the loan amount plus any other costs.

3 If the current value of the asset is more or less than your cost, enter a transaction in your
Asset Account to adjust for the difference.
Now your Net Worth Reports will more accurately reflect your finances. The remaining 
balance on your loan will be offset by the amount entered in your Asset Account.

________________
See also

Changing Loan Information
Net Worth Reports
Setting Up an Asset Account



Entering Loan Payments

Before you can enter loan payments, you must set up a loan. For more information, see 
Setting Up a Loan.
Once your loan is set up, you can use a Future Transaction to help you enter loan 
payments, or you can manually enter payments in the account from which you usually 
make payments.

The best way is to use a Future Transaction 
With a Future Transaction, entering loan payments is nearly automatic -- just like 

entering any other scheduled transaction. For more information, see Entering Future 
Transactions That are Due.

If you did not set up your loan with a Future Transaction, and you want to add one, 
see Setting Up a Future Transaction for a Loan.

To enter a loan payment from the Account Book
1 Switch to the Account Book, and in the Account box on the toolbar, choose the account 

you want to make the payment from.
2 Move to the blank transaction at the bottom of the register, and press TAB to begin 

entering information.
3 In the Number field, if you want, enter a check number or the word "Print," if you're going

to print a check. Press TAB to move to the next field.
4 In the Date field, accept or change the date.
5 In the Payee field, enter the name of the loan.

If you've entered a payment transaction for this loan before, the rest of the information is
filled in for you. Press ENTER to finish entering the transaction, and then refer to the Note 
following step 10.
If you're entering your first payment for this loan, continue with step 6. You'll need to 
enter more information before you press ENTER.

6 In the Payment field, type the amount of your payment.
If it's a regular loan payment, leave it blank and it will be filled in when you finish 
entering the other transaction information.

7 In the Memo field, type a memo if there's something unusual about this payment you 
want to remember.

8 In the Category field, enter Loan Payment.
9 In the Subcategory field, enter the name of the loan.

If the loan name was filled in for you after you entered the payee name, and you have 
more than one loan with the same payee, be sure to enter the correct loan name for this 
transaction.

10Press ENTER to enter the payment transaction.
If you entered a payment that matches your regular payment, you're done.
Note    If you entered an amount different from your regular payment, Microsoft Money 
will ask you how you want to adjust for the difference. Here are two common examples:

If you mistakenly entered the wrong amount and want to make a regular payment, 
choose the option Cancel Changes, Revert to the Regular Loan Payment and Split Amounts. 
Then choose the OK button.

If you want to enter an extra principal payment that does not equal the regular 
payment amount, choose the option: Apply the Entire Loan Payment to Principal.

To have Money enter most of the payment information for you



1 In the account you make payments from, move to the Category field in the blank 
transaction at the bottom of the register, and choose Loan Payment.

2 Move to the Subcategory field; choose the name of the loan and press ENTER.
The remainder of the loan payment information is filled in for you.

3 Press ENTER to complete the transaction entry.
________________
See also

Changing Loan Information
Entering Future Transactions That Are Due
Making Extra Payments
Paying Late Fees
Setting Up a Future Transaction for a Loan
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Paying Late Fees

Late fees generally don't affect the principal and interest portion of your payment; they're 
simply added to your payment at some point. If your payment is higher than normal 
because of a late fee, you can enter it as you would any other fee.

To add a late fee to a payment
1 Begin entering the payment.
2 In the Amount field, enter the greater-than-normal amount.
3 Enter the rest of the payment information, and press ENTER.

Because the payment amount is different than normal, the Adjust Loan Payment Amount 
dialog box will be displayed.

4 In the Adjust Loan Payment Amount dialog box, choose the option Manually Change the 
Split Amounts in the Split Dialog Box. Then choose the OK button.

5 In the Loan Payment dialog box, press TAB to begin entering information.
The Category list will open and the extra amount of the payment will be entered in the 
Amount field.

6 In the Category field, enter Bank Charges.
7 In the Subcategory field, enter Late Fees.

You will be prompted to create a new subcategory for Late Fees. Accept the new 
subcategory by choosing the OK button.

8 In the Description field, enter any details you might want to remember later.
9 In the Amount field, accept or change the amount. This value should be equal to your 

late fee.
10Press ENTER to complete that line of the Loan Payment dialog box.
11If the unassigned amount at the bottom of the Loan Payment dialog box is zero, choose 

the Done button. 
If there is a remaining unassigned amount, check for a mistake in the total amount of the
payment, and check to see that all parts of the payment are entered correctly. Then 
adjust either the parts of the loan payment or the total amount of the payment.
Note    The principal and interest portions of the payment should not be changed unless 
your lender has notified you. If that's the case, you might want to permanently change 
the loan information.

________________
See also

Entering Future Transactions That are Due
Entering Loan Payments
Setting Up a Future Transaction for a Loan
Changing Loan Information
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Deleting a Loan

Before deleting a loan, it's a good idea to first:
Back up the file.
Create and print a Loan Report for your records.
To delete a loan from Microsoft Money

1 From the Lists menu, choose Loan List.
2 In the Loan List, highlight the loan you want to delete.
3 Choose the Delete button.

If the loan had a Future Transaction, Money will ask if you want to delete it.
________________
See also
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Calculating Savings from Extra Payments

By using the Extra Payment feature of the Loan Calculator, you can do hypothetical 
calculations to see how your interest and loan period are affected by extra payments on 
your loans.
For more information on the Loan Calculator, see Using the Loan Calculator.

With the Extra Payment feature you can, for example:
See how much interest you would save during the life of a loan by making periodic or 

one-time additional payments.
See how the final payment date would change with additional periodic or one-time 

payments.
Note    The Extra Payment feature only lets you calculate hypothetical figures. To actually 
enter additional payments, see Making Extra Payments.

To use the Extra Payments feature
1 From the Tools menu, choose Financial Wizards; then choose Loan Calculator.
2 Do your initial calculation by filling in all but one of the boxes and choosing the Calculate 

button.
-Or-
Choose the Import button if you would like to do a calculation with the terms of an 
existing loan. Then choose the loan you want from the Import a Loan dialog box, and 
choose the Import button. This won't affect your existing loan records.

3 Choose the Extra Payments button.
4 In the Extra Payment box, type the amount of each additional payment.
5 In the Frequency box, enter how often the extra payment would be made.
6 Choose the Calculate button.

The results will be displayed below the Calculate button.
To actually enter this extra payment in your loan payment records, see Making Extra 
Payments.

________________
See also
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Comparing Two Loans

By using the Compare Loans feature of the Loan Calculator, you can compare two loan 
terms to see which is best for you.
For more information on the Loan Calculator, see Using the Loan Calculator.

With the Compare Loans feature you can, for example:
Compare the monthly payment amount of a 20-year loan compared to a 30-year 

loan. 
See how much interest you would save over the life of the loan by making larger 

payments or having a lower interest rate. 
See how the last payment date would change with larger monthly payments.
To use the Compare Loans feature

1 From the Tools menu, choose Financial Wizards; then choose Loan Calculator.
2 Do your initial calculation by filling in all but one of the boxes and choosing the Calculate 

button.
-Or-
Choose the Import button if you would like to do loan comparison calculations with the 
terms of an existing loan. Then choose the loan you want from the Import a Loan dialog 
box, and choose the Import button. This won't affect your existing loan records.

3 Choose the Compare Loans button.
4 In the second calculator, clear the box for the value you want to calculate, change one or

more of the other terms, and choose the Calculate button. 
You can then compare the results within the calculators and the amounts for total 
interest and last payment date, which are displayed below each calculator.

5 Repeat step 4 for each comparison you want to try.
________________
See also

Setting up a Loan
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File Menu Commands

New
Creates a new file. For more information, see New File.
Open
Opens and displays an existing file. For more information, see Open.
Import
Combines a QIF file with the current Microsoft Money account. For more information, see 
Import.
Export
Saves the selected account to a QIF file. Typically, you should use this command to move 
your account information to another program, not for regular file saving. For more 
information, see Export.
Password
Assigns a new password, changes the old password, or removes the password for the 
current file. For more information, see Password.
Backup
Makes a backup copy of the file on a disk. The file is saved with a BAK extension. For 
example, if your file is named CHARITY.MNY, it can be backed up as CHARITY.BAK. For more
information, see Backup.
Archive
Backs up the complete file for reference, and then removes old transactions from your 
current file to keep it to a manageable size. For more information, see Archive.
Print Checks
Prints transactions for which "Print" appears in the Number field. For more information, see
Print Checks.
Printer Setup
Displays current settings for report, chart, and check printing; you can change these 
settings. For more information, see Print Setup.
Exit
Closes Microsoft Money. Your work is automatically saved.



Edit Menu Commands

Undo
Reverses previous changes to the current field in the transaction.
Cut
Removes the highlighted text from a field and places it onto the Clipboard.
Copy
Copies the highlighted text from a field and places it onto the Clipboard.
Paste
Pastes text from the Clipboard into the highlighted transaction.
Delete Transaction
Deletes the selected transaction. You will be asked to confirm the deletion.
Void Transaction/Unvoid Transaction
Marks the selected transaction as void and does not include the amount in the running 
balance. If the transaction is already void, choosing the command reinstates the 
transaction. This command is not available in the Future Transactions window.
Split Transaction
Divides the amount of a transaction into two or more parts. You can assign a different 
amount, category, classification item, or memo (description) to each part. For more 
information, see Split Transaction.
Mark As Cleared/Uncleared/Reconciled/Unreconciled
Marks a transaction that has appeared on a bank statement as cleared, uncleared, 
reconciled, or unreconciled
Mark Range As Cleared
When reconciling, marks all transactions within a specified range as cleared.
Find
Searches for and selects transactions containing specified text or numbers. For more 
information, see Find.
Go To/Go To Last Edited
If you are in the Account Book or Account Forms, you can go to the last transaction 
changed, the other side of a transfer, or the main transaction for a split.



Lists Menu Commands

Account List
Displays account number, bank name, opening balance, minimum balance/credit limit, 
shortcut, and comments for each of your accounts. Here you can create, delete, and 
rename accounts, and enter and change other account information. For more information, 
see Account List.
Payee List
Displays shortcut, address, phone number, account number, and comments for each 
payee. Here you can add, delete, and rename payees, and enter and change other payee 
information. For more information, see Payee List.
Category List
Displays the shortcut, whether transactions assigned to this category should be included 
on tax reports, which tax form and line is assigned to each tax-related category or 
subcategory, and any comments for each category and subcategory. Here you can add, 
delete, and rename categories or subcategories, and enter and change other category and
subcategory information. For more information, see Category List.
Loan List
Displays loan number, shortcut, comments, and a brief summary of your loan terms for 
each loan. Here you can create, delete, and rename loans, and enter and change other 
loan information.
Currency List
Displays all the foreign currencies and the exchange rates you entered. Here you can add 
to the standard set of built-in foreign currencies, change a currency name, modify a 
currency's last exchange rate, delete unneeded currencies, or print a list of all currencies 
and their exchange rates.
Investment List
Displays investment type, symbol, tax-exempt status, and any comments you've entered 
for each investment. Here you can create, delete, or rename investments and enter and 
change other investment information.
Investment Account List
Displays the market value, shortcut, tax-deferred status, account number, institution, 
contact, phone number, and fax number for each Investment Account you've set up. From 
here you can create, delete, or modify Investment Accounts and enter and change other 
Investment Account information.
Other Classification
Creates a new classification, which you can use to track other information about 
transactions besides the type of income or expense. For more information, see Other 
Classification.
[Your Classification Name] List
Displays all the classification items and sub-items you create for your classification. Here 
you can add, delete, and rename an item or sub-item and enter and change item and sub-
item information. This command is available only after you set up a classification. For more
information, see Classification Item List.



Reports Menu Commands

You can view a report in the Report dialog box, print it, or export it to a text file. You can 
also create charts from your reports and print them.

Transaction Report
Displays the contents of the current window. For more information, see Customize 
Transaction Report.
Income And Expense
Totals transactions by income and expense (what you earned and what you spent) and 
compares the difference. For more information, see Customize Income and Expense.
Summary Report
Summarizes transactions by account, payee, category, subcategory, classification item, 
sub-item, week, or month. For more information, see Customize Summary Report.
Budget Report
Compares actual amounts spent in each category with budgeted amounts. For more 
information, see Customize Budget Report.
Net Worth Report
Shows the balances of all accounts and overall net worth. For more information, see 
Customize Net Worth Report.
Loan Payment Report
Shows the payment schedule for the life of the loan. This includes the transactions you've 
already paid listed in the Loans window, and those you haven't yet paid listed in the 
amortization schedule. For more information, see Customize Loan Report.
Tax Report
Generates information useful for tax purposes. It includes transactions or totals for 
categories marked as being included on tax reports. For more information, see Customize 
Tax Report.
Tax Form Report
Displays tax-related transactions for last year subtotaled by line number within each tax 
form. For more information, see Customize Tax Form Report.
Investment Transaction Report
Gives a detailed listing of your investment activities over a given period. This is useful 
when you want a summary of the price, quantity, commission, and amount for your 
investment transactions.
Capital Gains Report
Shows realized gains and losses on the investments you've sold. Use the grand total to 
determine if you've gained more than you've lost on investments you've sold.
Market Value Report
Shows the current value of your investments. It compares the cost basis of your 
investments against their current market value to calculate unrealized gain or loss.
Performance Report
Shows the average annual return for your investments. Money uses a standard method to 
calculate the annualized return, so you can compare your investment's return with that of 
other investment opportunities, such as bank accounts or real estate.
Price History Report
Lists your investments' market price history. It's most useful to create a line chart from this
showing upward or downward trends.
Remembered Reports



If you remembered a custom report, you would display it by choosing Remembered 
Reports. You can also rename or delete your remembered reports. If this option is 
unavailable, you have not remembered any reports.



Tools Menu Commands

Balance Loan
Begins reconciling your loan register against your loan statement. Because lenders use 
different methods to calculate interest, the actual interest that Microsoft Money calculates 
may vary slightly from the interest calculated by your lender.
Balance Account/Finish Balancing
Begins reconciling your Account Book against your statement. While balancing, the 
Balance Account command changes to Finish Balancing. For more information, see Balance
Account.
Budget
Displays a list of all the categories and subcategories and their assigned budget amounts. 
You can manually specify budget amounts or have Money do it for you by using the 
AutoBudget feature.
Calculator
Displays the calculator from Microsoft Windows, or the calculator you specified in the 
MSMONEY.INI file.
Financial Wizards
Displays a submenu of these wizards:

Loan Calculator
Lets you explore different loan terms. This also lets you compare two loan alternatives 
and explore how much you can save in interest by making extra payments on your 
loans. See Using the Loan Calculator.
Mortgage Planner
Compares two mortgages to see which is best for you, depending on how much you 
want to pay initially, how much you want to pay in monthly payments, and how long you
plan to own the home or land. See Using the Mortgage Planner. 
Savings Calculator
Calculates how much you need to save to reach a savings goal, or calculates how much 
you can expect to have saved by a certain date, given your current savings rates. See 
Using the Savings Calculator. 
Retirement Planner
Calculates how much you need to save to have the amount you want at retirement, or 
calculates how much you can expect to have for retirement, given your current savings 
rates. See Using the Retirement Planner. 
Interest Estimator
Calculates interest received from or paid to a Bank or Credit Card Account over a 
specified period. See Using the Interest Estimator. 

Top Line View
Displays only the top line of each transaction. In this view you can see more transactions 
on the screen at one time, allowing you to scroll through them faster.
Entire Transaction View
Displays all the lines of information for each transaction (memo, account, category, and 
classification).
Enter Due Transactions/Postpone Balance
Begins entering transactions from Future Transactions into the Account Book or Loans. 
While balancing, this command changes to Postpone Balance. For more information, see 
Enter Due Transactions.
Remind When Due



Places a copy of the transaction into the Future Transactions window, so it will be 
scheduled as a Future Transaction. This command is only available from Account Book, 
Account Forms, and Loans.
Options
You can change program settings, or options, to customize the way Money displays 
information or refine the way Money prompts you as you work. The options are divided into
General, Investment, Bank On-Line, and Modem.

General
Lets you change Money's display, confirmations, and other settings. For more 
information, see Options.
Investment
Lets you change preferences dealing with investment entry and short- and long-term 
capital gain requirements.
Bank On-Line
Lets you change when Money prompts you for confirmation when downloading 
transaction data from your bank. Also lets you specify what to do with bank and credit 
card information.
Modem
Lets you change your specifications for serial port, modem speed, phone number for 
On-Line Services, and your tone/pulse phone specification.



On-Line Services Menu Commands

Pay On-Line
Displays the Pay On-Line instructions that are ready to be sent. From here you can send 
the instructions, create a Quick Status instruction, or write a letter to Pay On-Line.
Bank On-Line
Displays the Bank On-Line instructions that are ready to be sent. From here you can send 
the instructions, create a general-purpose letter, order new checks, or request a copy of a 
processed check.
Quotes On-Line
Displays the Quotes On-Line instructions that are ready to be sent. From here you can also 
send the instructions.
Set Up Services
Once you have received your On-Line Services start-up kit, you can use this to enter your 
personal and modem information. You can then get started using Pay On-Line, Bank On-
Line, and Quotes On-Line.



Window Menu Commands

Cascade
Arranges all open windows in an overlapping pattern so that the title bar of each is visible.
Account Book
Switches to the Account Book window and brings it to the front.
Account Forms
Switches to the Account Forms window and brings it to the front.
Future Transactions
Switches to the Future Transactions window and brings it to the front.
Loans
Switches to the Loans window and brings it to the front.
Investment Details
Switches to the Investment Details window and brings it to the front.
Investment Summary
Switches to the Investment Summary window and brings it to the front.



Help Menu Commands

Contents
Provides a list of the information contained in Help along with procedures for 
accomplishing the most common tasks.
Keyboard Shortcuts
Provides a reference for keyboard shortcuts.
Search
Lets you search for individual Help topics.
How To Use Help
Displays introductory information about how to access and use Help.
Money Preview
Provides previews of Money's general features, an introduction to On-Line Services, and an
introduction to using Money's investment tracking features.
Transaction Cue Cards
Provides step-by-step instructions for entering your account information.
Ordering Checks
Allows you to order checks printed by Deluxe Business Systems. These numbered, 
personalized checks include your account number, name, address, and other information 
you specify. For more information on ordering checks, see the order form in the Microsoft 
Money package.
About Microsoft Money
Displays the product version number, copyright notice, and serial number.



Account Box

In the Account box, you can change which account is displayed, create a new account, or 
display more than one account at a time.

[Your Account Names]
Microsoft Money will display the transactions in the account you choose. The list of 
accounts will grow as you create new ones.
All Accounts
Displays the transactions from all the accounts you have created.
Multiple Accounts
Choose the accounts you want to display. For more information, see Select Multiple 
Accounts.
Create Account
Creates and displays a new account.



View Box

In the View box, you can choose which transactions are displayed and in what order. The 
Ending Balance, or Total, changes depending on which transactions are displayed.

All (By Date)
Displays all transactions in the selected account or accounts in date order.
All (By Number)
Displays all transactions in the selected account or accounts in numerical order. 
Transactions without numbers will be displayed before those with numbers.
All (By Entry Order)
Displays all transactions in the selected account or accounts in the order you entered 
them.
Unprinted Checks
Displays all transactions from the selected accounts that say "Print" in the Number field.
Unreconciled (By Date)
Displays all unreconciled transactions in the selected accounts in date order.
Unreconciled (By Number)
Displays all unreconciled transactions in the selected accounts in numerical order. Those 
without numbers will be displayed above those with numbers.
A Payee
Displays only transactions assigned to the payee you choose. For more information, see 
Select Payee.
A Category
Displays only transactions assigned to the category you choose. For more information, see 
Select Category or Select Classification Item.
A Classification Item
Displays only transactions assigned to the item you choose. This command only appears in
the list if you have set up a custom classification. For more information, see Select 
Category or Select Classification Item.
Other
You can create a custom view by choosing certain payees, categories, items, transaction 
numbers, dates, amounts, and sort order. For more information, see Other View.



Loan Box

In the Loan box, you can change which loan is displayed or create a new loan.

[Your Loan Names]
Microsoft Money will display the payments from the loans you choose. The list of loans will 
grow as you create new ones.
Create Loan
Creates and displays a new loan.





Moving Around

Finding a Specific Transaction
Keyboard Shortcuts
Moving Between Transactions
Moving Within a Transaction
Switching Between the Account Book and Account Forms
Using the Mouse and the Scroll Bar



Moving Between Transactions

Press To
UP ARROW Move up one 

transaction
DOWN ARROW Move down 

one 
transaction

PAGE UP Move up one 
screen

PAGE DOWN Move down 
one screen

HOME Move to the 
first 
transaction

END Move to the 
last 
transaction

CTRL+G Use the Go 
To command 
to move to a 
specific 
transaction

Note    When you use the keyboard to move around, the selected transaction changes. If 
you want to look at other transactions without closing the transaction you're working on, 
use the mouse and the scroll bar.
________________
See also

Finding a Specific Transaction
Using the Mouse and the Scroll Bar



Moving Within a Transaction

When changing a transaction you can:

Press To
TAB or ENTER Move into 

the Number
field to 
start 
entering or 
changing 
transaction 
information

TAB Move 
ahead one 
field

SHIFT+TAB Move back 
one field

UP ARROW Move up 
one field

DOWN ARROW Move down
one field

HOME Move to the
beginning 
of a field

END Move to the
end of a 
field

ENTER or 
CTRL+ENTER

Enter the 
transaction 
and move 
to the next 
transaction 

ESC Cancel 
changes

Notes    When a list in a field is open, ENTER does not move to the next transaction, it closes 
the list.
If you want to use the ENTER key instead of TAB  to move from field to field, make sure the 
setting Use Enter Key to Move in Register is chosen.
________________
See also

Introduction to Option Settings



Switching Between the Account Book and Account Forms

You can enter transactions in either the Account Book or Account Forms. Both display the 
same data.

To switch from the Account Book to Account Forms
If the window is open:

Click the Account Forms window, or from the Window menu, choose Account Forms.
If the window is iconized:

Double-click the Account Forms icon, or from the Window menu, choose Account 
Forms.

To switch from Account Forms to the Account Book
If the window is open:

Click the Account Book window, or from the Window menu, choose Account Book.
If the window is iconized:

Double-click the Account Book icon, or from the Window menu, choose Account Book.
Note    You can use the same general methods described above to switch between any of 
the Microsoft Money windows: Account Book, Account Forms, Loans, Future Transactions, 
Investment Details, and Investment Summary.
________________
See also

Choosing a Check or Other Form
Entering a Transaction in Account Forms
Introduction to Entering Transactions



Choosing a Check or Other Form

In Account Forms, different forms are available depending on the types of accounts you are 
viewing.

Account Forms
Bank Check, 

Deposit, 
Payment, 
and 
Transfer

Credit Card Charge, 
Credit, and
Transfer

Cash Receive, 
Spend, and
Transfer

Asset or 
Liability

Increase, 
Decrease, 
and 
Transfer

Multiple 
Accounts

Check, 
Receive, 
Spend, and
Transfer

To choose a form
Click the form name, or press ALT and the underlined letter.

The transaction you are entering, or changing, will be entered and a blank form will be 
displayed.

________________
See also

Displaying Multiple Accounts
Entering a Transaction in Account Forms



Using the Mouse and the Scroll Bar

Using the mouse on the scroll bar to move around has two advantages over using the 
keyboard. You can:

Scroll to view other transactions without closing the transaction you're working on. 
See the top line of each transaction in the message bar as you drag the scroll box.
Using the mouse

Click To Move
One of the
scroll 
arrows

Up or down 
one 
transaction

The scroll 
bar

Up or down 
one screen

A scroll 
arrow

Up or down 
one 
transaction

Continuou
sly on a 
scroll 
arrow

Continuously 
up or down 
through the 
transactions

And drag 
the scroll 
box

Up or down 
through the 
transactions 
until the one 
you want is 
displayed in 
the message 
bar. When 
you release 
the mouse 
button, the 
display 
changes to 
the new 
position. 

________________
See also

Displaying the Message Bar
Finding a Specific Transaction





Using Pen Windows

If you're using a pen with Microsoft Money, you might want to:
Choose the setting for a larger font size to get more space.
Use Account Forms if you have trouble using the pen in the Account Book.
Use shortcut names for payees, accounts, categories, classifications, and loans to 

minimize the number of characters you have to write.
Set the e-circle to ESC in the gesture manager. Then you can cancel editing a 

transaction or close a dialog box without using the keyboard.
________________
See also

User's Guide
Chapter 2





Printing Reports and Charts

Setting Up

Setting Up to Print Checks or Reports

Customizing

Changing the Font Used in a Report

Printing

Printing Charts
Printing Reports



Printing Reports

To print a report
1 If you haven't created the report you want to print, choose the type of report from the 

Reports menu.
Before printing, you can make changes to your report by first choosing the Customize 
button in the Report dialog box. You can make further changes to your report by 
choosing the Widths and Fonts buttons in the Customize Report dialog box.

2 Once you've made the customizations to the report, choose the View button in the 
Customize Report dialog box to display the report.

3 In the Report dialog box, choose the Print button.
4 Under Print Range, choose All to print every page, or choose Pages and type a page 

range to print.
5 In the Print Quality box, specify the print quality of the report. The print quality is either 

described in dots per inch (dpi) or as High, Medium, or Low. The more dots per inch, the 
higher the print quality.

6 In the Copy box, specify the number of copies of the report you want to print.
7 If you want several copies to be printed in sequence, choose the Collate Copies check 

box.
8 If you want to change your printer settings, choose the Setup button.
9 Choose the OK button.
Note    Some of the print options above are not available for certain printers. This is 
controlled by the printer driver (a file that describes your printer to the Microsoft Windows 
operating system), not Microsoft Money.
Important  If you have difficulty printing, make sure the printer is turned on and ready to 
print. If you are using a printer on a network, you must first make a connection. For 
information on how to connect to a network printer, see your Microsoft Windows 
documentation.
________________
See also

Creating a Chart
Setting Up to Print Checks and Reports
Choosing a Report Type
Adjusting the Report Column Width

User's Guide
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Printing Charts

To print a chart
1 Before printing a chart, customize your report by choosing Customize in the Report 

dialog box.
2 Once you've made the customizations, choose the View button in the Customize Report 

dialog box to display the report.
3 In the Report dialog box, choose the Chart button.
4 Once the chart is displayed, make any changes to its content and layout by choosing the 

Format button. 
5 At the top of the chart, choose the Print button.
6 In the Print Quality box, specify the resolution of the chart. The print quality is either 

described in dots per inch (dpi) or as High, Medium, or Low. The more dots per inch, the 
higher the print quality.

7 In the Copies box, specify the number of copies you want to print.
8 If you want to change your printer settings, choose the Setup button.
9 Choose the OK button.
Important  If you have difficulty printing, make sure the printer is turned on and ready to 
print. If you are using a printer on a network, you must first make a connection. For 
information on how to connect to a network printer, see your Microsoft Windows 
documentation.
________________
See also

Copying a Chart
Creating a Chart
Formatting a Chart
Customizing and Remembering a Report

User's Guide
Chapter 10





Introduction to Printing Checks

Using Microsoft Money to print checks can save you time when paying bills -- especially if 
you print multiple checks at once. Money prints the check information on special blank 
checks that you purchase.
If you don't already have blank checks, your first step is to decide which type of checks you
want. You can choose from six types, depending on your printer.
________________
See also

Ordering Checks
Printing Checks
Setting Up to Print Checks or Reports

User's Guide
Chapter 9



Setting Up to Print Checks or Reports

Before you print, you need to choose the appropriate settings, which Microsoft Money will 
remember, so you don't have to specify them again. Changing the printer settings in Money
does not change your basic Windows setup for the printer. Before you start printing checks,
make sure you have typed "Print" in the Number field of the transactions you are printing 
checks for.
Note    Money can only print checks from Bank Accounts.

To set up for printing checks and reports
1 From the File menu, choose Print Setup.
2 In the Setup For box, choose either the Report and Chart Printing or Check Printing 

option.
3 In the Printer box, choose the Default printer you are connected to, or choose a printer 

from the Specific Printer list.
If your printer is not in the list, you need to install it in Windows. See your Windows 
documentation for instructions.

4 Make sure your printer settings are correct by choosing the options you want from the 
table below.

5 If you want to modify additional printer settings, choose the Options button.
This allows you to make additional printing adjustments to take full advantage of the 
printer you are using.

6 Choose the OK button.
Note    The Options button may be unavailable, depending on the default printer selected 
in the Microsoft Windows Control Panel. These options are specific to your printer driver (a 
file that describes your printer to the Microsoft Windows operating system), and they're 
available only if you install new or updated printer drivers. Most newer printer drivers 
support the Options button.
If the Options button is unavailable, you can adjust your printer settings in the Control 
Panel in Microsoft Windows.

To Choos
e

Print the 
report 
vertically

Portrait
(Report
s)

Print the 
report 
horizontal
ly

Landsc
ape 
(Report
s)

Change 
the paper
size

Paper 
Size 
(Report
s)

Choose 
where to 
load the 
paper in 
the 
printer

Paper 
Source 
(Report
s)



Choose 
the type 
of check 
you want 
to print

Check 
Type 
(Check
s)

________________
See also

Printing Checks
Printing Charts
Printing Reports
Loading Blank Checks in the Printer

User's Guide
Chapters 9 & 10



Printing a Sample Check

Whenever you reload checks, you may want to print a sample check to make sure the 
checks are properly aligned.
Note    Make sure your printer is turned on and ready to print. If you are using a printer on 
a network, you must first make a connection to the printer. For information on how to 
connect to a network printer, see your Microsoft Windows documentation.

To print a sample check
1 Make sure you've loaded blank checks in the printer and the printer is ready.
2 From the File menu, choose Print Checks.

If the Select Account dialog box is displayed, select the Bank Account you want to print 
from and choose the OK button. You can only print from Bank Accounts.

3 Choose the Print Test button.
Microsoft Money will print sample information in the first blank check. For continuous-
feed checks, you may want to adjust your printer after seeing the sample.

4 After adjusting your printer, repeat steps 2 and 3 to double-check the alignment.
Tip    If you are using continuous-feed checks, and are satisfied with the way the test check 
prints, you may want to make a mark -- or place a piece of tape -- on your printer's case to 
help you align checks the next time. 
Note    If you're using single-sheet checks, you can change the print location by making a 
change to the MSMONEY.INI file.
________________
See also

Setting Up to Print Checks or Reports
Printing Checks
Loading Blank Checks in the Printer
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Printing Checks

Microsoft Money can only print checks from Bank Accounts, and will only print checks for 
transactions that have "Print" in the Number field.

To print a check
1 From the File menu, choose Print Checks.

If the Select Account dialog box is displayed, select the Bank Account you want to print 
from and choose the OK button.

2 In the Print Range box, choose Print All or choose Select Checks if you want to print 
specific checks.
If you choose Select Checks, choose the checks you want to print, then choose the OK 
button.

3 Follow the instructions at the bottom of the Print Checks dialog box.
4 Choose the OK button.

After the checks are printed, you're asked to confirm the printout. You can complete your 
printing by choosing Continue, or reprint the check(s) by choosing Reprint.

Note    If you want to print a sample check to confirm alignment, choose the Print Test 
button before choosing the OK button.
Important  If you have difficulty printing, make sure the printer is turned on and ready to 
print. If you are using a printer on a network, you must first make a connection. For 
information on how to connect to a network printer, see your Microsoft Windows 
documentation.
________________
See also

Setting Up to Print Checks and Reports
Printing a Sample Check
Ordering Checks
Loading Blank Checks in the Printer

User's Guide
Chapter 9



Ordering Checks

You can order checks that are compatible with Microsoft Money from Deluxe Business 
Systems. The check styles, formats, and sizes are approved by U.S. and Canadian banking 
institutions.

Deluxe Business Systems checks are available in:
Business or personal sizes.
Various colors.
Continuous-feed or single-sheet paper.

You can also order customized checks. For example, you may want to include your business
logo or a background design. 

You can order Deluxe Business Systems checks through any of three methods:
By mail
Complete and mail one of the order forms in your Money package.
By fax
Complete and fax one of the order forms from your Money package. The fax number 

in the U.S. and Canada is 1-800-531-1931.
By phone
Call Deluxe Business Systems toll free. The number in the U.S. and Canada is 1-800-

432-1285.
Have this information ready when calling Deluxe Business Systems to place your order:
1 This keycode number: T08264
2 The product number of the check type you want.

Laser Wallet Check # 080935
Laser Standard Check # 080974
Laser Voucher Check # 080971
Wallet Check # 090970
Standard Check # 091064
Voucher Check # 091186

3 Your Bank Account number, bank name and address, and the check number you want 
the Deluxe checks to begin with.
You can find this information on a check from your bank.

________________
See also

User's Guide
Chapter 9



Using Laser Standard and Laser Wallet Checks

Laser Standard and Laser Wallet checks were both designed to be used with a Laser printer.
Laser Standard checks are standard size checks (8.5" x 3.5") and Laser Wallet checks are 
smaller, wallet-size checks.

To specify the correct check type for Laser Standard and Laser Wallet 
checks
1 From the File menu, choose Print Setup.
2 In Setup For, choose Check Printing.
3 Under Check, from the Type list, choose either Laser Standard or Laser Wallet.

Important    Standard checks and Wallet checks are not the same as Laser Standard and
Laser Wallet checks, so please make sure you have chosen the appropriate check type.

________________
See also

Setting Up to Print Checks and Reports
Printing a Sample Check
Printing Checks
What's in Your MSMONEY.INI File
Loading Blank Checks in the Printer
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Loading Blank Checks in the Printer

To load continuous-feed Wallet, Standard, or Voucher checks
Load checks the same way you load plain paper.
To load single-sheet Laser Voucher checks
Load checks the same way you load plain paper. Load each sheet so that the check, 

not the voucher, enters the printer first.
To load single-sheet Laser Standard or Laser Wallet checks
You can load checks in two ways:

For a full sheet    If the next check to print is on a full sheet (with three blank checks), 
load it as you would normally load stationary or preprinted forms -- so information will 
print on the correct side of the checks. Your printer's documentation should explain how 
to load preprinted forms.
For a partial sheet    If you are starting with a partial sheet (with only one or two 
checks), load it sideways into the printer's manual-feed slot. Be sure to leave the strip of 
blank paper attached to the final check on the partial sheet.

________________
See also

User's Guide
Chapter 9





When You Have a Question

If you have a question about Microsoft Money, first look in the User's Guide or consult 
online Help. You can also find late-breaking updates and technical information in the 
README file that came with your Microsoft Money disks. If you cannot find the answer, 
contact the Microsoft Support Network.
Outside the United States, contact Microsoft Product Support Services at the Microsoft 
subsidiary office that serves your area. For information about Microsoft subsidiary offices, 
see Product Support Worldwide.

The Microsoft Support Network

The Microsoft Support Network offers you a wide range of choices and access to high-
quality, responsive technical support. Microsoft recognizes that support needs vary from 
user to user; the Microsoft Support Network allows you to choose the type of support that 
best meets your needs, with options ranging from electronic bulletin boards to annual 
support programs. For information about support services in the United States and Canada,
see Product Support Within the United States and Canada.
Services vary outside the United States and Canada. In other locations, contact a local 
Microsoft subsidiary for information. The Microsoft Support Network is subject to Microsoft's
then-current prices, terms, and conditions, and is subject to change without notice.



Product Support Within the United States and Canada

In the United States and Canada, the following support services are available through the 
Microsoft Support Network:
Electronic Services
Standard Support
Priority Support
Text Telephone
Other Support Options
Product Training and Consultation
________________
See also

Product Support Worldwide



Electronic Services

These services are available 24 hours a day, 7 days a week, including holidays.

Microsoft FastTips

(800) 936-4100 on a touch-tone telephone. Receive automated answers to common 
questions, and access a library of technical notes, all delivered by recording or fax. You can 
use the following keys on your touch-tone telephone after you reach FastTips:

To Press
Advance to the next message *
Repeat the current message 7
Return to the beginning of 
FastTips

#

CompuServe

Interact with other users and Microsoft support engineers, or access the Microsoft 
Knowledge Base to get product information. At any ! prompt, type go microsoft to access 
Microsoft forums, or type go mskb to access the Microsoft Knowledge Base. For an 
introductory CompuServe membership kit, call (800) 848-8199, operator 519.

Microsoft Download Service

Access, via modem, the Driver Library and the most current technical notes (1200, 2400, or
9600 baud; no parity; 8 data bits; 1 stop bit). In the United States, call (206) 936-6735. In 
Canada, call (905) 507-3022.

Internet

Access the Driver Library and the Microsoft Knowledge Base. The Microsoft Internet FTP 
archive host, ftp.microsoft.com, supports anonymous login. When logging in as anonymous,
you should type your complete electronic mail name as your password.
________________
See also

Standard Support
Priority Support
Text Telephone
Other Support Options
Product Training and Consultation



Standard Support

In the United States, no-charge support from Microsoft support engineers is available via a 
toll call between 6:00 A.M. and 6:00 P.M. Pacific time, Monday through Friday, excluding 
holidays. 

For technical support for Microsoft Money for Windows, call (206) 635-7131.
In Canada, support engineers are available via a toll call between 8:00 A.M. and 8:00 P.M. 
Eastern time, Monday through Friday, excluding holidays. Call (905) 568-3503.
When you call, you should be at your computer and have the appropriate product 
documentation at hand. Be prepared to give the following information:

The version number of Microsoft Money that you are using
The type of hardware that you are using
The exact wording of any messages that appeared on your screen
A description of what happened and what you were doing when the problem occurred
A description of how you tried to solve the problem

________________
See also

Electronic Services
Priority Support
Text Telephone
Other Support Options
Product Training and Consultation



Priority Support

The Microsoft Support Network offers priority telephone access to Microsoft support 
engineers 24 hours a day, 7 days a week, except holidays.

In the United States, call (900) 555-2000; $2 (U.S.) per minute, $25 (U.S.) maximum. 
Charges appear on your telephone bill. Not available in Canada.

In the United States, call (800) 936-5700; $25 (U.S.) per incident, billed to your VISA 
card, MasterCard, or American Express card. In Canada, call (800) 668-7975; $30 per 
incident, billed to your VISA card, MasterCard, or American Express card. 
________________
See also

Electronic Services
Standard Support
Text Telephone
Other Support Options
Product Training and Consultation



Text Telephone

Microsoft text telephone (TT/TDD) services are available for the deaf or hard-of-hearing. In 
the United States, using a TT/TDD modem, dial (206) 635-4948 between 6:00 A.M. and 6:00
P.M. Pacific time, Monday through Friday, excluding holidays. In Canada, using a TT/TDD 
modem, dial (905) 568-9641 between 8:00 A.M. and 8:00 P.M. Eastern time, Monday 
through Friday, excluding holidays.
________________
See also

Electronic Services
Standard Support
Priority Support
Other Support Options
Product Training and Consultation



Other Support Options

The Microsoft Support Network offers annual support plans. For information, in the United 
States, contact the Microsoft Support Network Sales and Information group at (800) 936-
3500 between 6:00 A.M. and 6:00 P.M. Pacific time, Monday through Friday, excluding 
holidays. In Canada, call (800) 668-7975 between 8:00 A.M. and 8:00 P.M. Eastern time, 
Monday through Friday, excluding holidays.
________________
See also

Electronic Services
Standard Support
Priority Support
Text Telephone
Product Training and Consultation



Product Training and Consultation

Microsoft Solution Providers are independent organizations that provide consulting, 
integration, customization, development, technical support and training, and other services
for Microsoft products. These companies are called Solution Providers because they apply 
technology and provide services to help solve real-world problems.
In the United States, for more information about the Microsoft Solution Providers program 
or the Microsoft Solution Provider nearest to you, please call (800) 426-9400 between 6:30 
A.M. and 5:30 P.M. Pacific time, Monday through Friday, excluding holidays. In Canada, call 
(800) 668-7975 between 8:00 A.M. and 8:00 P.M. Eastern time, Monday through Friday, 
excluding holidays.
________________
See also

Electronic Services
Standard Support
Priority Support
Text Telephone
Other Support Options



Answers to Common Questions About Microsoft Money

Following are some of the most common questions about Microsoft Money. Before you call 
Microsoft Product Support Services, scan this list for answers.

How Do I Restore a Backup File?
How Do I Change My Opening Balance for an Account?
What Is the Difference Between a File and an Account?
What Should I Choose in the Account Box on the Toolbar?
What Should the Starting and Ending Balances Be When Balancing My Bank Account?
How Do I convert my Money 2.0 Asset Accounts into Money 3.0 Investment Accounts?
How Do I Split a Transaction?
How Do I Use the Future Transactions Window?
How Do I Set Up a Checking Account?
How Do I Split My Paycheck?

________________
See also

Getting Help
Product Support Within the United States and Canada
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How Do I Restore a Backup File?

To use a backup file in place of a lost or damaged file
1 Quit Microsoft Money by choosing Exit from the File menu.
2 Switch to the Microsoft Windows File Manager.
3 In File Manager, display the directory listing for the disk that contains your backup file.
4 Highlight the name of your backup file.
5 From the File menu in File Manager, choose the Copy command.
6 In the To box, type the name of the drive and directory where you typically store your 

Money files; then type the backup file's name, with the extension .MNY.
For example, if you store your Money files in the \MSMONEY directory on the c: drive and 
your backup file is named MYBACKUP.BAK, you would type this:
C:\MSMONEY\MYBACKUP.MNY

7 Choose the OK button.
You now have a copy of your backup file named as a regular Money file, and stored on 
your hard disk.

8 Start Microsoft Money.
Money will open your backup file from the floppy disk again (unless it wasn't the last file 
you had open).

9 From the File menu in Money, choose Open.
10Use the Open dialog box to open your newly renamed backup file.

You may be prompted to backup your current file before opening the new file. You'll 
probably want to choose the No button.

11Once the file opens, you can begin working with it.
Your next step should be to enter any transactions or other information you've entered 
since you created the backup file. After that, you can work with the file as usual. 

________________
See also

Backing Up a File
Changing the Backup Option
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How Do I Change My Opening Balance for an Account?

1 From the Lists menu choose Account List.
2 Highlight the account you want to change.
3 In the Opening Balance box to the right of the Account List, type the new amount.



What Is the Difference Between a File and an Account?

Money uses a single file (usually MSMONEY.MNY) to store all your Money data. An account is
only one part of this Money data file. You can store 63 accounts in one file. Aside from 
Loans and Investment Accounts, Money has five basic account types: Bank, Credit Card, 
Cash, Asset, and Liability -- all of which are part of the Money file.
You will find a more detailed description of the different account types in the Create New 
Account dialog box that appears when you create a new account.
________________
See also

Creating a New File
Introduction to Money Accounts



What Should I Choose in the Account Box on the Toolbar?

What you choose in the Account (or Inv Acct) box on the toolbar determines what 
transactions are displayed in the active window. (This doesn't apply to the Loans or Future 
Transactions windows.) 
There are three basic options in the Account/Inv Acct box:

Choose This To Display
All Accounts
-Or-
All 
Investment 
Accounts

Transactions 
from all your 
accounts. 
This enables 
you to see 
the 
combined 
value of the 
accounts at 
the bottom 
of the 
window.

Multiple 
Accounts
-Or-
Multiple 
Investment 
Accounts

Transactions 
from a 
combination 
of different 
accounts. 
This enables 
you to see 
the 
combined 
value of a 
select 
number of 
your 
accounts at 
the bottom 
of the 
window.

individual 
accounts

Transactions 
from a single
account. This
is the most-
used option.

Note    Choose Create Account, Create Investment Account, or Create Loan from the 
Account box to create a new account or loan.



What Should the Starting and Ending Balances Be When Balancing 
My Bank Account?

The starting balance is the amount that was in your Bank Account at the beginning of your 
bank statement period. The ending balance is the amount in your account on the last day 
of the bank statement period. Both figures should be taken from your bank statement to 
ensure your records agree with the bank's.
________________
See also

Marking a Transaction as Cleared or Reconciled
Resolving Starting Balance Problems
Changing the Account Opening Balance
Resolving Ending Balance Differences



How Do I Convert My Microsoft Money 2.0 Asset Accounts into 
Money 3.0 Investment Accounts?

1 Set up the Investment Account.
For more information, see Setting Up an Investment Account.

2 In the Investment Account, enter all the purchases, sales, and other transactions you've 
entered in the Asset Account. For more information, see Recording Your Current 
Investment Holdings. 

3 Then, to avoid duplicate records, make a backup copy of your Money file and delete the 
Asset Account. 
For safety, put the backup file on a different disk than you usually use for backups, or 
give it a different name.

________________
See also
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How Do I Split a Transaction?

Use splits to divide transactions into two or more parts according to category or 
classification or to give each part its own description. Then, when you create reports and 
charts, each part of the transaction is included under the appropriate category and 
subcategory.

To split a transaction
1 In the Account Book or Account Forms, enter your transaction as usual, with the full 

amount in the amount field.
2 Choose Split in the Category field or click the Split Transaction button on the toolbar. 

Money will then display the Split Transaction dialog box.
3 Type a category, subcategory, description, and amount for each item. For more 

information, see Splitting a Transaction.
4 Choose the Done button.



How Do I use the Future Transactions Window?

Setting up a Future Transaction for regularly scheduled bills and paychecks can save time 
and help you keep accurate records.
If you have a transaction that occurs regularly, such as a monthly utility bill, it's best to 
enter it as a Future Transaction. That way, you enter the information only once. When it's 
due, you'll get a reminder, and an easy way to enter it -- which is especially helpful when 
handling split transactions.
For more information on scheduling Future Transactions, see Setting Up Future 
Transactions.



How Do I Set Up a Checking Account?

1 In the Account Book or Account Forms window, choose Create Account from the Account 
box on the toolbar.

2 Type an account name, and choose Bank as the account type. 
3 Type the closing balance from your most recent statement. 
4 Enter all outstanding transactions (ones that have not yet appeared on a statement).



How Do I Split My Paycheck?

When you deposit a paycheck into your account, you can keep track of the deductions from
your gross income, for example, FICA, Federal Income Tax, and health insurance premiums.

To itemize a paycheck deposit
1 Enter the date and payee information as you would for a typical deposit.
2 In the Deposit field, type the amount of your net pay (how much the check is actually 

for).
3 Choose the Split Transaction button, or from the Edit menu, choose Split Transaction.
4 In the Split Transaction dialog box, choose Wages & Salary in the Category field, and type

Gross Pay in the Subcategory field.
5 In the Amount field, type the amount of your gross pay.
6 Press TAB to move to the next line.
7 In the second line, choose Taxes in the Category field, and type FICA (Social Security 

Tax) in the Subcategory field.
8 In the Amount field, type the amount withheld from your paycheck for FICA as a negative

number. For example, type -100.00.
9 In the third line, choose Taxes in the Category field, and type IRS (Federal Income Tax) in 

the Subcategory field.
10In the Amount field, type the amount withheld from your paycheck for IRS taxes as a 

negative number.
11Continue entering other deductions as parts of the split transaction as negative amounts 

until the unassigned amount is zero.
12Choose the Done button.
13Press ENTER to enter the transaction.
________________
See also

Keeping Records for 401(k)s and Other Investments Made Through Paycheck Deductions
Splitting a Transaction
Transferring Money Between Accounts



Product Support Worldwide

Area Telephone Numbers
Argentina Microsoft de Argentina S.A.

Phone: (54) (1) 814-5105
(54) (1) 814-4807
(54) (1) 814-4808
(54) (1) 814-7199
Fax: (54) (1) 814-0372

Australia Microsoft Pty Ltd.
FAX (61) (02) 805-1108
Connect, Bulletin Board Service 
(61) (02) 878-5200
Standard, Setup/Installation 
Technical Support (61) (02) 870-
2870
Other Technical Support (61) (02) 
870-2131
Sales Information Centre (61) (02) 
870-2100

Austria Microsoft Ges.m.b.H.
Phone: 0222 - 68 76 07
Fax: 0222 - 68 16 2710
Information: 0660 - 6520

Prices, updates, etc.: 0660 - 
6520
CompuServe: GO MSEURO 
(Microsoft Central Europe)
Technical support: 0660 - 6738

Belgium Microsoft NV
Phone: 02-7303911
Customer Service: 02-7303922
CompuServe: 02-2150530 (GO 
MSBEN)
Bulletin Board Service: 02-
7350045 (1200/2400/9600 baud, 8
bits, no parity, 1 stop bit, ANSI 
terminal emulation)
Technical Support:
(Dutch speaking): 02-5133274
(English speaking): 02-5023432
(French speaking): 02-5132268

Bolivia See Argentina
Brazil Microsoft Informatica Ltda.

Phone: (55) (11) 530-4455
Fax: (55) (11) 240-2205
Technical Support Phone: (55) (11)
533-2922
Technical Support Fax: (55) (11) 
241-1157



Technical Support Bulletin Board 
Service: (55) (11) 65-8564 

Canada Microsoft Canada Inc.
Phone: 1 (905) 568-0434
Technical Support Phone: 1 (905) 
568-3503
Technical Support Bulletin Board 
Service: 1 (905) 507-3022 
Text Telephone (TT/TDD) 1 (905) 
568-9641

Chile Microsoft Chile S.A.
Tel: 56 2 218 5771, 56 2 218 5711,
56 2 218 7524
Fax: 56 2 218 5747

Colombia Microsoft Colombia
Tel: (571) 618 2245 Soporte 
Tecnico: (571) 618 2255
Fax:(571) 618 2269

Denmark Microsoft Denmark AS
Phone: (45) (44) 89 01 00

Dubai Microsoft Middle East
Phone: (971) 4 513 888
Fax: (971) 4 527 444

England Microsoft Limited
Phone: (44) (734) 270000
Fax: (44) (734) 270002
Upgrades: (44) (81) 614 8000
Technical Support:

Main Line (All Products): (44)
(734) 271000

Database Direct Support 
Line: (44) (734) 271126

MS-DOS    Warranty Support: 
(44) (734) 271900

MS-DOS    Fee Support Line: 
(44) (891) 315500

Bulletin Board Service: (44) 
(734) 270065 (2400 Baud) 

Fax Information Service: (44)
(734) 270080

Finland Microsoft OY
Phone: (358) (0) 525 501

France Microsoft France
Phone: (33) (1) 69-86-46-46
Telex: MSPARIS 604322F
Fax: (33) (1) 64-46-06-60
Technical Support Phone: (33) (1) 
69-86-10-20
Technical Support Fax: (33) (1) 69-
28-00-28

French 
Polynesia

See France



Germany Microsoft GmbH
Phone: 089 - 3176-0
Telex: (17) 89 83 28 MS GMBH D
Fax: 089 - 3176-1000
Information: 089 - 3176 1199

Prices, updates, etc.: 089 - 
3176 1199
Bulletin board, device drivers, tech
notes : Btx: microsoft# or 
*610808000# 

CompuServe: GO MSEURO 
(Microsoft Central Europe)
Technical support: 089 - 3176 - 
1170

Greece Microsoft Hellas, S.A.
Phone: (30) (1) 6893 635
Fax: (30) (1) 6893 636

Hong Kong Microsoft Hong Kong Limited
Technical Support: (852) 804-4222
Fax: (852) 560-2217

Ireland See England
Israel Microsoft Israel    Ltd.

Phone: 972-3-575-7034
Fax: 972-3-575-7065

Italy Microsoft SpA
Phone: (39) (2) 269121
Telex: 340321 I
Fax: (39) (2) 21072020
Customer Service (Prices, new 
product info, product literature): 
(39) (2) 26901359
Bulletin Board: (39) (2) 21072051

Japan Microsoft Company Ltd.
Tokyo Japan
Phone: (81) (3) 5454-8000
Fax: (81) (3) 5454-7972
PSS Technical Support Fax: (81) (3)
5454-7955
Customer Service Phone (Version 
upgrade/Registration)
Phone: (81) (3) 5454 2305 Fax: 
(81) (3) 5454-7952
Channel Marketing (Pre-sales 
Product Support) Information 
Center Phone: (81) (3) 5454-2300
Fax: (81) (3) 5454 7951

Korea Microsoft CH
Phone: (82) (2) 552-9505
Fax: (82) (2) 555-1724
Technical Support: (82) (2) 563-
9230
Technical Support Fax : (82) (2) 
563-5194



Technical Support Bulletin Board 
Service : (82) (2) 538-3256

Liechtenstei
n

See Switzerland (German 
speaking)

Luxembourg Microsoft NV
Phone: (32) 2-7303911
Customer Service: (32) 2-7303922
CompuServe: (32) 2-2150530 (GO 
MSBEN)
Bulletin Board Service: (32) 2-
7350045 (1200/2400/9600 baud, 8
bits, No parity, 1 stop bit, ANSI 
terminal emulation)
Technical Support: 
(Dutch speaking): (32) 2-5133274
(English speaking): (32) 2-
5023432
(French speaking): (32) 2-5132268

México Microsoft México, S.A. de C.V.
Phone: (52) (5) 325-0910
Customer Service: (52) (5) 325-
0911
Bulletin Board Service: (52) (5) 
590-5988 (1200/2400 baud, 8 bits,
No parity, 1 stop bit, ANSI terminal
emulation)
Desktop & OS: (52) (5) 325-0912
Fax: (52) (5) 280-7940
Technical Support: (52) (5) 325-
0912
Developers & Advanced Systems: 
(52) (5) 237-4800

Netherlands Microsoft BV
Phone: 02503-89189
Customer Service: 02503-77700
CompuServe: 020-6880085 (GO 
MSBEN)
Bulletin Board Service: 02503-
34221 (1200/2400/9600 baud, 8 
bits, No parity, 1 stop bit, ANSI 
terminal emulation)
Technical Support:
(Dutch speaking) Technical 
Support: 02503-77877
(English speaking) Technical 
Support: 02503-77853

New Zealand Technology Link Centre
Phone: 64 (9) 358-3724
Fax: 64 (9) 358-3726
Technical Support Applications: 64 
(9) 357-5575

Northern 
Ireland

See England



Norway Microsoft Norway AS
Phone: (47) (22) 18 35 00
Technical Support: (47) (22) 02 25 
50    

Papua New 
Guinea

See Australia

Paraguay See Argentina
Portugal MSFT, Lda.

Phone: (351) 1 4412205
Fax: (351) 1 4412101

Republic of 
China

Microsoft Taiwan Corp.
Phone: (886) (2) 504-3122
Fax: (886) (2) 504-3121
Technical Support : (886) (2) 508-
9501

Republic of 
Ireland

See England

Scotland See England
South Africa

Spain

Phone: (27) 11 444 0520
Fax: (27) 11 444 0536
Microsoft Iberica SRL
Phone: (34) (1) 804-0000
Fax: (34) (1) 803-8310
Technical Support: (34) (1) 803-
9960

Sweden Microsoft AB
Phone: (46) (8) 752 56 00
Technical Support:

Applications: (46) (8) 752 68
50

Development and Network 
products: (46) (8) 752 60 50

MS-DOS: (46) (071) 21 05 15
(SEK 4.55/min)
Sales Support: (46) (8) 752 56 30
Bulletin Board Service: (46) (8) 
750 47 42
Fax Information Service: (46) (8) 
752 29 00

Switzerland Microsoft AG
Phone: 01 - 839 61 11
Fax: 01 - 831 08 69
Documentation: Phone: 155 59 00 
Fax: 064 - 224294, Microsoft Info-
Service, Postfach, 8099 Zürich
Prices, updates, etc.: 01/839 61 11
CompuServe: GO 
MSEURO(Microsoft Central Europe)
Technical support: (German 
speaking): 01 - 342 - 0322
Technical support: (French 
speaking): 022 - 738 96 88



Uruguay See Argentina
Venezuela Corporation MS 90 de Venezuela 

S.A.
Technical Support: 58.2.910046, 
58.2.910510
Other information: 58.2.910008, 
58.2.914739, 58.2.913342
Fax: 58.2.923835

Wales See England



Managing Rental Properties

Getting Started Managing Rental Properties
Setting Up a Rental Property Classification



Getting Started Managing Rental Properties

You can track rental property income and expenses using a combination of categories, a 
classification, separate accounts, or even a separate file. You probably don't need to create 
a separate file unless your business is managing rental properties, and you want to keep 
that information separate from your other financial information.
If you have more than one rental property and you want to view and report income and 
expenses by property or apartment, it's best to use a separate classification.
________________
See also

Setting up a Rental Property Classification



Setting up a Rental Property Classification

If you organize rental property income and expenses with a rental property classification, 
you can create reports on various aspects of your rental property transactions. 

To set up a classification for rental property
1 From the Lists menu, choose Other Classification to create a new classification.
2 Choose one of the New buttons.
3 Under Type, choose Property or enter an appropriate name. Singular names work best.

If you want to use sub-items to add more information to the classification, choose the 
Allow Sub-items check box.

4 Choose the OK button.
5 In the Property List dialog box, under Property List, choose the New button.
6 In the Create New Property dialog box, type a name for the property.
7 Choose the OK button.
8 If you've chosen the Allow Sub-Items check box, under Sub-Property List, choose the New

button to create any sub-items you want for each property name. You can have more 
than one sub-item for each property name.

9 Choose the Close button.
Your new classification is now added to the Lists menu.

Examples
For a single-family building:
Classification item: 1000 High Street.
For a multiple-unit building:
Classification item: Sunset Apartments

Sub-item: Apt1
Sub-item: Apt2
Sub-item: Apt3
Sub-item: Apt4

________________
See also

Getting Started Managing Rental Properties
Classifying a Transaction





Creating List Reports (Index)

Account List Reports
Budget List Reports
Category List Reports
Classification List Reports
Currency List Reports
Loan List Reports
Payee List Reports



Transaction Reports

Account Book Transaction Reports
Future Transactions Reports
Loan Reports
Investment Transaction Reports



Introduction to Reports

Reports are a useful way to look at your financial status, to see trends, summarize 
information, and provide others with information. You can:

Create a variety of types of reports to display on-screen or print on paper.
Customize reports by changing what they contain and how they look (the layout).
Save (Remember) reports. 
Create charts from reports.

________________
See also

Choosing a Report Type
Creating a Chart

User's Guide
Chapter 6



Choosing a Report Type

Microsoft Money provides various types of reports. You can print and customize any of them
to meet your needs.

Transaction Reports
Transaction Reports reflect all transactions from the Account Book, Future Transactions, 
or Loans -- whichever you have open at the time.

Income And Expense Reports
Summarizes where your money comes from and where it goes. Totals by type, category, 
or subcategory.

Summary Reports
Summary Reports are especially useful when you want a detailed breakdown of your 
account activity, such as a report with a row for each category and a column for each 
account.

Budget Reports
Compares the budget you assigned to each category to the actual amount you spent or 
received and calculates the difference.

Net Worth Reports
Summarizes what you own and what you owe and calculates the difference between the 
two.

Loan Reports
Displays a list of all your loans, all the loan payments you've made, or your payment 
schedule for the life of the loan.

Tax Reports
Summarizes or lists the year's tax-related transactions. Totals by category or 
subcategory all transactions assigned to tax-related categories.

Tax Form Reports
Summarizes or lists the amounts you've assigned to specific lines on tax forms.

Investment Reports
You can study stock price histories, analyze the market value of your holdings, and see 
how much you've gained or lost on any investment.

List Reports
Shows the contents of your Account, Payee, Category, Loan, Currency, Budget, or 
Classification Lists. Customize these reports to get the most out of them.

________________
See also

Creating a Chart

User's Guide
Chapter 6



Summary Reports

To display and customize a Summary Report
1 From the Reports menu, choose Summary Report.
2 In the Summary Report dialog box, choose the Customize button.
3 Choose the options you want from the table below.
4 Choose the View button.

To Do this
Chang
e the 
title

In the Title box, 
type a name.

Chang
e what
is 
display
ed in 
each 
row 

In the Rows box, 
choose another 
item. These will be
listed down the 
left side of your 
report

Choos
e 
colum
n 
headin
gs

In the Columns 
box, choose an 
item. These will be
listed across the 
top of your report.

Combi
ne 
small 
amoun
ts 

Enter a number in 
the Combine All 
Values Under X % 
Of Total box.

Sort 
from 
largest
to 
smalle
st 

Choose the Sort 
By Amount check 
box.

Displa
y 
shortc
uts

Choose the 
Include Shortcuts 
check box. This 
only affects 
categories and 
subcategories.

Specify
a time 
period

In the Dates box, 
choose the period 
you want the 
report to cover, or 
type the dates in 
the From and To 
boxes.

Include In the From 



only 
specifi
c 
accoun
ts

Account and From 
Investment 
Account boxes 
under Include 
Transactions, 
choose the 
accounts you 
want.

Include
all 
transa
ctions

Choose the All 
Transactions 
option.

Include
only 
certain
transa
ctions

Choose the Select 
Transactions 
option. In the 
Select 
Transactions 
dialog box, choose
the options you 
want.

Chang
e 
colum
n 
widths

Choose the Widths
button.

Chang
e the 
size or 
style 
of 
typefa
ce

Choose the Fonts 
button.

________________
See also

Creating a Chart
Exporting Reports
Printing Reports
Saving Reports

User's Guide
Chapter 6



Income and Expense Reports

Depending on how you want to handle transfers between accounts, you can choose one of 
three options for the Income and Expense Reports:

Income Statement
Similar to an accountant's income statement; transfers are not included.

Expenditures
This is the best report for viewing household finances because money spent on assets 
and liabilities is included in a separate section.

Cash Flow
Shows cash inflows and outflows, including transfers to or from any accounts not 
included in the report during the period you specify.

To display and customize an Income and Expense Report
1 From the Reports menu, choose Income And Expense.
2 In the Income And Expense Report dialog box, choose the Customize button.
3 Choose the options you want from the table below.
4 Choose the View button.

To Do this
Chan
ge 
the 
title

In the Title box, 
type a name.

Chan
ge 
what 
is 
displ
ayed 
in 
each 
row

In the Rows box, 
choose another 
item. These will 
be listed down the
left side of your 
report.

Choo
se 
colu
mn 
headi
ngs

In the Columns 
box, choose an 
item. These will 
be listed across 
the top of your 
report.

Com
bine 
small
amou
nts

Enter a number in 
the Combine All 
Values Under X % 
Of Total box.

Sort 
from 
large
st to 
small
est

Choose the Sort 
By Amount check 
box.

Speci In the Dates box, 



fy a 
time 
perio
d

choose the period 
you want the 
report to cover, or
type the dates in 
the From and To 
boxes.

Inclu
de 
only 
certai
n 
acco
unts

Under Include 
Transactions, in 
the From Account 
and From 
Investment 
Account boxes, 
choose the 
accounts you 
want.

Inclu
de all
trans
actio
ns

Choose the All 
Transactions 
option.

Inclu
de 
only 
certai
n 
trans
actio
ns

Choose the Select 
Transactions 
option. In the 
Select 
Transactions 
dialog box, choose
the options you 
want.

Chan
ge 
how 
trans
fers 
are 
repor
ted

In the Report 
Transfers By box, 
choose the option 
you want.

Chan
ge 
colu
mn 
width
s

Choose the 
Widths button.

Chan
ge 
the 
size 
or 
style 
of 
typef
ace

Choose the Fonts 
button.

________________
See also



Creating a Chart
Exporting Reports
Printing Reports
Saving Reports

User's Guide
Chapter 6



Tax Reports

This report totals all transactions assigned to tax-related categories by category or 
subcategory. You can choose to display each transaction or just the totals.

To display and customize a Tax Report
1 From the Reports menu, choose Tax Report.
2 In the Tax Report dialog box, choose the Customize button.
3 Choose the options you want from the table below.
4 Choose the View button.

To Do this
Chang
e the 
title

In the Title box, 
type a name.

Display
individ
ual 
transac
tions

Choose the Tax 
Transactions option.

Display
a 
summa
ry of 
your 
transac
tions

Choose the Tax 
Summary option.

Chang
e what 
is 
display
ed in 
each 
row 
(for Tax
Summ
ary 
only)

In the Rows box, 
choose another 
item. These will be 
listed down the left 
side of your report.

Choose
column
headin
gs (for 
Tax 
Summ
ary 
only)

In the Columns box,
choose an item. 
These will be listed 
across the top of 
your report.

To 
group 
your 
transac
tions 

In the Subtotal By 
box, choose the 
item you want.



(for Tax
Transa
ctions 
only)
Display
shortcu
ts ( for 
Tax 
Summ
ary 
only)

Choose the Include 
Shortcuts check 
box.

Specify
a time 
period

In the Dates box, 
choose the period 
you want the report
to cover, or type 
the dates in the 
From and To boxes.

Include
only 
certain
accoun
ts

In the From Account
and From 
Investment Account
boxes, choose the 
accounts you want 
included in the 
report.

Include
all 
transac
tions

Choose the All 
Transactions option.

Include
only 
certain
transac
tions

Choose the Select 
Transactions option.
In the Select 
Transactions dialog 
box, choose the 
options you want.

Chang
e 
column
widths

Choose the Widths 
button.

Chang
e the 
size or 
style of
typefac
e

Choose the Fonts 
button.

________________
See also

Creating a Chart
Exporting Reports
Printing Reports
Saving Reports
Tax Form Reports



Using Categories to Track Tax Information

User's Guide
Chapter 36



Budget Reports

This report shows budgeted amounts vs. actual amounts for each category or subcategory 
and the difference between the two.

To display and customize a Budget Report
1 From the Reports menu, choose Budget Report.
2 In the Budget Report dialog box, choose the Customize button.
3 Choose the options you want from the table below.
4 Choose the View button.

To Do this
Chan
ge 
the 
title

In the Title box, 
type a name.

Chan
ge 
what 
is 
displa
yed 
in 
each 
row 

In the Rows box, 
choose another 
item. These will 
be listed down 
the left side of 
your report.

Choo
se 
colu
mn 
headi
ngs 

In the Columns 
box, choose an 
item. These will 
be listed across 
the top of your 
report.

Comb
ine 
small
amou
nts

Enter a number 
in the Combine 
All Values Under 
X % Of Total box.

Displ
ay 
budg
ets 
that 
have 
no 
trans
actio
ns

Choose the Show
Empty 
Categories check
box.

Sort 
the 
trans
actio
ns

Choose the Sort 
By Amount check
box. In the Sort 
Amount option 
group, choose 



from Actual, 
Budget, or 
Difference. 

Speci
fy a 
time 
perio
d

In the Dates box,
choose the 
period you want 
the report to 
cover, or type 
the dates in the 
From and To 
boxes.

Inclu
de 
only 
certai
n 
accou
nts

In the From 
Account and 
From Investment 
Account box, 
choose the 
accounts you 
want included in 
the report.

Inclu
de all
trans
actio
ns

Choose the All 
Transactions 
option.

Inclu
de 
only 
selec
t 
trans
actio
ns

Choose the 
Select 
Transactions 
option. In the 
Select 
Transactions 
dialog box, 
choose the 
options you 
want.

Chan
ge 
colu
mn 
width
s

Choose the 
Widths button.

Chan
ge 
the 
size 
or 
style 
of 
typef
ace

Choose the Fonts
button.

________________
See also

Creating a Budget



Creating a Chart
Exporting Reports
Printing Reports
Saving Reports
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Net Worth Reports

This report shows the net value of the accounts you choose on a date you specify. Your net 
worth is determined by subtracting liabilities from assets.

To display and customize a Net Worth Report
1 From the Reports menu, choose Net Worth.
2 In the Net Worth Report dialog box, choose the Customize button.
3 In the Show Balances As Of box, type a date.
4 Choose the options you want from the table below.
5 Choose the View button.

To Do this
Chan
ge 
the 
title

In the Title box, 
type a name.

Set 
date 
of 
net 
worth

Type the date in
the Show 
Balances As Of 
box.

Inclu
de 
only 
certai
n 
acco
unts

Under Accounts,
choose those 
you want 
included in the 
report.

Inclu
de 
only 
certai
n 
loans

Under Loans, 
choose those 
you want 
included in the 
report.

Inclu
de 
only 
certai
n 
Inves
tmen
t 
Acco
unts

Under 
Investment 
Accounts, 
choose those 
you want 
included in the 
report.

Com
bine 
small
amou
nts

Enter a number 
in the Combine 
All Values Under
X % Of Total 
box.



Sort 
from 
large
st to 
small
est

Choose the Sort
By Amount 
check box. 

Choo
se 
the 
level 
of 
detail
in 
your 
repor
t

Under Level of 
Detail, choose 
the option you 
want. 

Chan
ge 
colu
mn 
width
s

Choose the 
Widths button.

Chan
ge 
the 
size 
or 
style 
of 
typef
ace

Choose the 
Fonts button.

________________
See also

Creating a Chart
Exporting Reports
Printing Reports
Saving Reports

User's Guide
Chapter 6 & 35



Classification Reports

If you have set up a custom classification, you can use this report to show income and 
expenses for each classification item. For example, if you have a client classification, you 
can break down the totals by client. If you prefer to see the transactions assigned to each 
item, you can create a report that shows the transactions.

To create and customize a classification report without seeing individual 
transactions
1 From the Reports menu, choose Summary Report.
2 In the Summary Report dialog box, choose the Customize button.
3 In the Rows box, choose your classification.
4 Choose the options you want from the table below.
5 Choose the View button.

To Do this
Chan
ge 
the 
title

In the Title box, 
type a name.

Choo
se 
colu
mn 
headi
ngs 

In the Columns 
box, choose an 
item. These will 
be listed across 
the top of your 
report.

Sort 
from 
large
st to 
small
est

Choose the Sort 
By Amount 
check box.

Speci
fy a 
time 
perio
d

Under Date 
Range, in the 
Dates box, 
choose the 
period you want 
the report to 
cover, or type 
the dates in the 
From and To 
boxes.

Inclu
de 
only 
certai
n 
acco
unts

In the From 
Account and 
From Investment
Account boxes, 
choose the 
accounts you 
want included.

Inclu
de all

Choose the All 
Transactions 



trans
actio
ns

option.

Inclu
de 
only 
selec
t 
trans
actio
ns

Choose the 
Select 
Transactions 
option. In the 
Select 
Transactions 
dialog box, 
choose the 
options you 
want.

Chan
ge 
colu
mn 
width
s

Choose the 
Widths button.

Chan
ge 
the 
size 
or 
style 
of 
typef
ace

Choose the Fonts
button.

To create and customize a classification report showing the transactions
1 While in the Account Book, choose Transaction Report from the Reports menu.
2 In the Transaction Report dialog box, choose the Customize button.
3 Under Include Fields, choose the fields you want.
4 In the Subtotal By box, choose your classification.
5 Choose the options you want from the table below.
6 Choose the View button.

To Do this
Chan
ge 
the 
title

In the Title box, 
type a name.

Speci
fy a 
time 
perio
d

Under Date 
Range, in the 
Dates box, choose
the period you 
want the report to
cover, or type the
dates in the From 
and To boxes.

Inclu
de 

In the From 
Account box, 



only 
certai
n 
acco
unts

choose the 
accounts you 
want included in 
the report.

Inclu
de all
trans
actio
ns

Choose the All 
Transactions 
option.

Inclu
de 
only 
selec
t 
trans
actio
ns

Choose the Select
Transactions 
option. In the 
Select 
Transactions 
dialog box, 
choose the 
options you want.

Inclu
de 
split 
trans
actio
n 
detail
s

Choose the Show 
Splits check box.

Displ
ay 
and 
custo
mize 
a 
runni
ng 
balan
ce

Choose the 
Display a Running
Balance/Total 
Starting with 
option, and then 
specify the 
running balance 
starting point.

Chan
ge 
colu
mn 
width
s

Choose the 
Widths button.

Chan
ge 
the 
size 
or 
style 
of 
typef
ace

Choose the Fonts 
button.

________________
See also



Creating a Chart
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Account Book Transaction Reports

Account Book Transaction Reports reflect all transactions in the Account Book.
To create and customize a Transaction Report

1 Switch to the Account book.
2 From the Reports menu, choose Transaction Report.
3 In the Transaction Report dialog box, choose the Customize button.
4 Under Include Fields, choose the check boxes for other fields you want to include, or 

clear the check boxes for fields you want to exclude.
5 Choose the other options you want from the table below.
6 Choose the View button.

To Do this
Chan
ge 
the 
title

In the Title box, 
type a name.

Grou
p 
trans
actio
ns

In the Subtotal 
By box, choose 
from the list.

Speci
fy a 
time 
perio
d

Under Date 
Range, in the 
Dates box, 
choose the 
period you want 
the report to 
cover, or type the
dates in the From
and To boxes.

Inclu
de 
split 
trans
actio
n 
detail
s

Choose the Show 
Splits check box.

Displ
ay 
and 
custo
mize 
a 
runni
ng 
balan
ce

Choose the 
Display a 
Running 
Balance/Total 
Starting with 
option, and then 
specify the 
running balance 
starting point.



Inclu
de 
only 
certai
n 
acco
unts

In the From 
Account box, 
choose the 
accounts you 
want included in 
the report.

Inclu
de all
trans
actio
ns

Choose the All 
Transactions 
option.

Inclu
de 
only 
selec
t 
trans
actio
ns

Choose the 
Select 
Transactions 
option. In the 
Select 
Transactions 
dialog box, select
the criteria for 
the transactions 
you want 
included.

Chan
ge 
colu
mn 
width
s

Choose the 
Widths button.

Chan
ge 
the 
size 
or 
style 
of 
typef
ace

Choose the Fonts 
button.

________________
See also

Exporting Reports
Printing Reports
Saving Reports

User's Guide
Chapter 6



Investment Transaction Reports

Investment Transaction Reports reflect all transactions in the Investment Details window.
To create and customize an Investment Transaction Report

1 Switch to the Investment Details window.
2 From the Reports menu, choose Investment Reports; then choose Transaction Report.
3 In the Investment Transaction Report, choose the Customize button.
4 Under Include Fields, choose the check boxes for other fields you want to include, or 

clear the check boxes for fields you want to exclude.
5 Choose the other options you want from the table below.
6 Choose the View button.

To Do this
Chan
ge 
the 
title

In the Title box, 
type a name.

Grou
p 
trans
actio
ns

In the Group By 
box, choose from
the list.

Speci
fy a 
time 
perio
d

Under Date 
Range, in the 
Dates box, 
choose the 
period you want 
the report to 
cover, or type 
the dates in the 
From and To 
boxes.

Inclu
de 
only 
certai
n 
acco
unts

In the From 
Account box, 
choose the 
accounts you 
want included in 
the report.

Inclu
de all
trans
actio
ns

Choose the All 
Transactions 
option.

Inclu
de 
only 
selec
t 

Choose the 
Select 
Transactions 
option. In the 
Select 



trans
actio
ns

Transactions 
dialog box, select
the criteria for 
the transactions 
you want 
included.

Chan
ge 
colu
mn 
width
s

Choose the 
Widths button.

Chan
ge 
the 
size 
or 
style 
of 
typef
ace

Choose the Fonts
button.

________________
See also

Exporting Reports
Printing Reports
Saving Reports
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Future Transactions Reports

Future Transactions Reports reflect all transactions in the Future Transactions window.
To create and customize a Future Transactions Report

1 Switch to the Future Transactions window.
2 From the Reports menu, choose Transaction Report.
3 In the Future Transactions Report, choose the Customize button.
4 Under Include Fields, choose the check boxes for the fields you want to include, or clear 

the check boxes for fields you want to exclude.
5 Choose the options you want from the table below.
6 Choose the View button.

To Do this
Cha
nge 
the 
title

In the Title box, 
type a name.

Spe
cify 
a 
time
peri
od

Under Date 
Range, in the 
Dates box, 
choose the 
period you want 
the report to 
cover, or type the
dates in the From
and To boxes.

Inclu
de 
split
tran
sacti
on 
deta
ils

Choose the Show 
Splits check box.

Inclu
de 
only
cert
ain 
tran
sacti
ons

Under Include 
Transactions, 
choose from All, 
Payments Only, 
or Deposits Only.

Cha
nge 
colu
mn 
widt
hs

Choose the 
Widths button.

Cha Choose the Fonts 



nge 
the 
size 
or 
style
of 
type
face

button.

________________
See also

Exporting Reports
Printing Reports
Saving Reports

User's Guide
Chapter 11



Loan Transaction Reports

Loan Reports reflect all transactions in the Loans window.
To create and customize a Loans Report

1 Switch to the Loans window.
2 From the Reports menu, choose Transaction Report.
3 In the Loan Report, choose the Customize button.
4 Under Include Fields, choose the check boxes for the fields you want to include, or clear 

the check boxes for fields you want to exclude.
5 Choose the options you want from the table below.
6 Choose the View button.

To Do this
Cha
nge
the 
title

In the Title box, 
type a name.

To 
gro
up 
you
r 
tran
sac
tion
s

In the Subtotal 
By box, choose 
the item you 
want.

Incl
ude
the 
ope
nin
g 
bal
anc
e

Choose the Show
Opening Balance
check box.

Spe
cify
a 
tim
e 
peri
od

Under Date 
Range, in the 
Dates box, 
choose the 
period you want 
the report to 
cover, or type 
the dates in the 
From and To 
boxes.

Incl
ude
spli
t 
tran

Choose the Show
Splits check box.



sac
tion
det
ails
Incl
ude
onl
y 
cert
ain 
tran
sac
tion
s

Under Include 
Transactions, 
choose the 
option you want.

Cha
nge
col
um
n 
wid
ths

Choose the 
Widths button.

Cha
nge
the 
size
or 
styl
e of
typ
efa
ce

Choose the Fonts
button.

________________
See also

Exporting Reports
Printing Reports
Saving Reports

User's Guide
Chapter 25



Category List Reports

To create, customize, and print your Category List Report
1 From the Lists menu, choose Category List.
2 Choose the Report button.
3 In the Category List Report, choose the Customize button.
4 In the Title box, type a name for the report.
5 Under Include, choose the information you want in the report.
6 If you want to change the column widths or the typeface, choose the Widths or the Fonts 

button.
7 Choose the View button.
8 In the Category List Report, choose the Print button.
9 In the Print Report dialog box, choose the OK button.
________________
See also

Exporting Reports
Saving Reports

User's Guide
Chapter 12



Payee List Reports

To create, customize and print your Payee List Report
1 From the Lists menu, choose Payee List.
2 Choose the Report button.
3 In the Payee List Report, choose the Customize button.
4 In the Title box, type a name for the report.
5 Under Include, choose the information you want in the report.
6 If you want to change the column widths or the typeface, choose the Widths or the Fonts 

button.
7 Choose the View button.
8 In the Payee List Report, choose the Print button.
9 In the Print Report dialog box, choose the OK button.
________________
See also

Exporting Reports
Saving Reports

User's Guide
Chapter 14



Account List Reports

To create, customize, and print your Account List Report
1 From the Lists menu, choose Account List.
2 Choose the Report button.
3 In the Account List Report dialog box, choose the Customize button.
4 In the Title box, type a name for the report.
5 Under Include, choose the information you want in the report.
6 If you want to change the column widths or the typeface, choose the Widths or the Fonts 

button.
7 Choose the View button.
8 In the Account List Report dialog box, choose the Print button.
9 In the Print Report dialog box, choose the OK button.
________________
See also

Exporting Reports
Saving Reports

User's Guide
Chapter 17



Classification List Reports

To create, customize, and print your Classification List Report
1 From the Lists menu, choose the name of your classification.
2 Choose the Report button.
3 In the List Report dialog box, choose the Customize button.
4 In the Title box, type a name for the report.
5 If you want to include shortcuts, choose the Include Shortcut check box.
6 If you want to change the column widths or the typeface, choose the Widths or the Fonts 

button.
7 Choose the View button.
8 In the List Report dialog box, choose the Print button.
9 In the Print Report dialog box, choose the OK button.
________________
See also

Exporting Reports
Saving Reports

User's Guide
Chapter 13



Exporting Reports

Once you have set up a report, you can save it, or export it to a file. You can then open this 
file in a word processor, spreadsheet, or tax-preparation program.

To export a report to a spreadsheet or word processor
1 In the Report dialog box, choose the Export button.
2 In the Directories box, choose the directory you want the file exported to.
3 In the File Name box, type a name for the file.
4 Choose the OK button.
Note    In a word processor application, the report will have a tab character between the 
columns of data in each row, and a paragraph mark at the end of each row. In a 
spreadsheet application, the data will be organized into columns and rows.

To export a Tax Form Report to a tax-preparation program
1 Create and display -- but don't print -- a Tax Form Report.
2 Choose the Customize button.
3 Choose the Tax Summary option button.

If you want to include more than tax summary information, choose from the other dialog 
box options. For most tax preparation programs all you need is the summary information.

4 Choose the View button to display the customized report.
5 Choose the Export button while the report is displayed.
6 In the Create File Of Type box, choose Tax Exchange Format.
7 If you want, change the file name, directory, or drive that's proposed for the exported 

file.
8 Choose the OK button.

The information from your report is ready for use with your tax preparation program. Your
next steps are to start the tax preparation program, and then import the file you just 
created. For more information on importing, see the documentation for your tax 
preparation program.

________________
See also

Saving Reports
Tax Reports
Tax Form Reports
Using Categories to Track Tax Information

User's Guide
Chapter 6



Adjusting the Report Column Width

To adjust the report column width
1 From the Reports menu, choose the type of report you want.
2 Choose the Customize button.
3 In the Customize Report dialog box, choose the Widths button.
4 Choose the option button for the width you want.

The Automatic option will size the columns to fit the information in each column.
5 Choose the OK button.
6 Choose the View button to see the result.
________________
See also

Printing Reports
Saving Reports

User's Guide
Chapter 6



Changing the Font Used in a Report

To change the font type used in a report
1 From the Reports menu, choose the type of report you want.
2 Choose the Customize button.
3 In the Customize Report dialog box, choose the Fonts button.
4 In the Font box, choose the font you want.
5 In the Size box, choose the size you want.

In the Sample box, you can see your choices.
6 Choose the OK button.
7 Choose the View button to see the results.
________________
See also

Printing Reports
Saving Reports

User's Guide
Chapter 6



Customizing and Remembering a Report

After you've created a report, you can customize it by changing:
The information it contains

For example, you can include transactions between a range of dates, from specific 
accounts, relating to certain payees, etc.

The layout
You can change the width of the columns, the size or type of font, and how you want to 
sort the information.

Important    You can also save, or remember, your report customizations for future use. 
When you remember a report, only the report structure is saved, not the information in the 
report. The information is updated each time you display or print the remembered report.

To customize a report
1 First create the report.
2 From the buttons at the top of the report, choose Customize.
3 Choose the options for what you want to include in the report.
4 If you want to change the column widths, choose the Widths button. You can set report 

column widths to Automatic, Narrow, Standard, Wide, or Extra Wide.
5 If you want to change the style and size of the letters and numbers, choose the Fonts 

button. The available choices depend on which fonts you have installed on your 
computer.
A sample of the font is displayed in the Select Font dialog box.

6 When you've chosen all the options and settings you want, choose the View button.
To remember a report

1 From the buttons at the top of the report, choose the Remember button after 
customizing.

2 In the Remember dialog box, accept or change the proposed name.
3 Choose the OK button.

The report is added to the list of Remembered Reports available on the Reports menu.
To display a remembered report

1 From the Reports menu, choose Remembered Reports.
2 Highlight the report you want to view or print.
3 Choose the View button.

The report displays up-to-date information in the remembered report format.
________________
See also

Adjusting the Report Column Width
Changing the Font Used in a Report
Changing the Layout of a Report in a Word Processor or Spreadsheet
Deleting or Renaming a Remembered Report

User's Guide
Chapter 6



Loan List Reports

To create, customize, and print your Loan List Report
1 From the Lists menu, choose Loan List.
2 Choose the Report button.
3 In the Loan List Report dialog box, choose the Customize button.
4 In the Title box, type a name for the report.
5 Under Include, choose the information you want in the report.
6 Choose the View button.
7 In the Loan List Report dialog box, choose the Print button.
8 In the Print Report dialog box, choose the OK button.
________________
See also

Exporting Reports
Printing Reports
Saving Reports

User's Guide
Chapter 24



Tax Form Reports

Once you've assigned a tax form and line to each tax-related category or subcategory, you 
can create a Tax Form Report and export it for use with your tax preparation program. 
Tax Form Reports are similar to Tax Reports, except Tax Form Reports are always subtotaled
by tax form line number.

To create, customize, and print a Tax Form Report
1 From the Reports menu, choose Tax Form Report.
2 In the Tax Form Report dialog box, choose the Customize button.
3 To include only particular transactions in the report, choose the Select Transactions 

option button; then make your changes, and choose the OK button.
4 Choose the View button to display the report again.
5 To print the report, choose the Print button.
6 To save the report for future use, choose the Remember button.

To export a Tax Form Report to a tax preparation program
1 Create and display -- but don't print -- a Tax Form Report.
2 In the Tax Form Report dialog box, choose the Customize button.
3 Choose the Tax Summary button.

If you want to include more than tax summary information, choose from the other 
options. For most tax preparation programs, all you need is summary information.

4 Choose the View button to display the customized report.
5 Choose the Export button.
6 In the Create File Of Type box, choose Tax Exchange Format.
7 If you want, change the file name, directory, or drive that's proposed for the exported 

file.
8 Choose the OK button.

The information from your report is now ready for use with your tax preparation program.
Your next step is to start the tax preparation program, and import the file you just 
created. For more information on importing, see the documentation for your tax 
program.

________________
See also

Printing Reports
Saving Reports
Tax Reports

User's Guide
Chapter 36



Currency List Reports

To create, customize, and print your Currency List Report
1 From the Lists menu, choose Currency List.
2 Choose the Report button.
3 In the Currency List Report dialog box, choose the Customize button.
4 In the Title box, type a name for the report.
5 Choose which exchange rate(s) you want to print.
6 Choose the View button.
7 In the Currency Exchange Rate Report dialog box, choose the Print button.
8 In the Print Report dialog box, choose the OK button.
________________
See also

User's Guide
Chapter 16



Budget List Reports

To create, customize, and print your Budget List Report
1 From the Tools menu, choose Budget.
2 From the Budget dialog box, choose the Report button.
3 In the Budget List Report dialog box, choose the Customize button.
4 In the Title box, type a name for the report.
5 Under Include, choose Summary or Budget Details.

Summary displays a single column titled Annual Budget. Budget Details displays a 
column for each month.

6 Choose the Subcategory Budgets check box if you want to include subcategories in your 
report.

7 Choose the View button.
8 In the Budget List Report dialog box, choose the Print button.
9 In the Print Report dialog box, choose the OK button.
________________
See also

Exporting Reports
Printing Reports
Saving Reports



Deleting or Renaming a Remembered Report

You can remember up to 50 reports in Microsoft Money. However, you may want to delete 
or rename old reports long before you reach that limit. 

To delete a remembered report
1 From the Reports menu, choose Remembered Reports.
2 In the list of reports Money displays, choose the report you want.
3 Choose the Delete button.
4 When Money asks you to confirm the deletion, choose the Yes button.

To rename a remembered report
1 From the Reports menu, choose Remembered Reports.
2 In the list of reports Money displays, choose the report you want.
3 Choose the Rename button.
4 In the New Name box, type the report name you want.
5 Choose the OK button.
________________
See also

Printing Reports
Saving Reports



Saving Reports

In Microsoft Money, you can save a report as a remembered report. Money remembers the 
report structure, but doesn't save the information in the report. You can have up to 50 
remembered reports.
When you view a remembered report, it will contain up-to-date information, not necessarily
the same information it contained when you last viewed the report.

To remember a report
1 First create the report you want.

If you want, customize the report.
2 From the buttons at the top of the report, choose the Remember button.
3 In the Remember [Report Name] dialog box, accept or change the proposed name.
4 Choose the OK button. The report name is added to the list of Remembered Reports, 

under the Reports menu.
To display a remembered report

1 From the Reports menu, choose Remembered Reports.
2 Highlight the report you want to view or print.
3 Choose the View button.
The report displays up-to-date information in the remembered report format.
________________
See also

Deleting or Renaming a Remembered Report
Exporting Reports
Printing Reports

________________
See also

User's Guide
Chapter 6





General Options

Confirmation Options

Changing the Backup Option
Requiring Categories in Each Transaction
Turning the Confirmation Messages On or Off
Turning the Beep on Transaction Entry Setting On or Off

Display Options

Automatically Inserting the Decimal Point
Changing the Color
Changing the Size of Text and Numbers on Your Screen
Displaying the Message Bar
Displaying Scenic Checks

Entry Options

Automatically Displaying or Not Displaying Lists
Automatically Inserting the Decimal Point

Future Transaction Options

Changing When the Pay Bills Reminder is Displayed



Modem Options

Choosing a Modem Port
Choosing a Default Phone Number for Money Express
Choosing a Modem Speed
Choosing Pulse or Tone Dialing



Assigning, Changing, or Deleting a Password

You can assign a password to any open file. You can also change the password for any open
file if you know its current password.

To assign or change a password
1 From the File menu, choose Password.
2 If a password was previously assigned to the file, type the current password in the 

Password box, and then choose the OK button.
3 If there was no previous password assigned, in the New Password box, type a new 

password, and then choose the OK button.
4 In the New Password box, type the new password again, and then choose the OK button.

To delete an existing password
1 From the File menu, choose Password.
2 In the Password box, type your current password and then choose the OK button.
3 In the New Password box, choose the OK button instead of typing a new password.
4 In the New Password box, choose the OK button again.

You will no longer be prompted to enter a password when you open this file.



Turning the Confirmation Messages On or Off

If you're concerned about accidentally entering transactions before they're complete, you 
can choose to see a confirmation message before you enter each transaction.

To turn confirmation messages on or off
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Confirmation, choose or clear the Confirm Transaction Changes check box.
3 Choose the OK button.
________________
See also

User's Guide
Chapter 15



Turning the Beep on Transaction Entry Setting On or Off

To turn the beep on or off
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Confirmation, choose or clear the Beep On Transaction Entry check box.
3 Choose the OK button.
________________
See also

User's Guide
Chapter 15



Automatically Displaying or Not Displaying Lists

You can change a setting so the lists of categories, classification items, accounts, and 
frequencies don't automatically drop the lists as you move to those fields.

To turn automatically dropped lists on or off
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Entry, choose or clear the Automatically Drop Lists check box.
3 Choose the OK button.
Note    You can use the F4 key or ALT + DOWN ARROW while in the field if you want to 
display a list.
________________
See also

User's Guide
Chapter 15



Displaying the Message Bar

The message bar is the area at the bottom of the screen that displays information to help 
you use Microsoft Money. It is recommended that you use it. However, you can turn it off if 
you want to gain a little more room on your screen.

To turn the message bar on or off
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Display, choose or clear the Message Bar check box.
3 Choose the OK button.
________________
See also

User's Guide
Chapter 15



Displaying Scenic Checks

Microsoft Money has six scenic checks you can display in your Account Forms window. The 
scenic background will not print on your checks. They only appear on the screen.

To turn scenic checks on or off
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Display, choose or clear the Scenic Checks check box.
3 Choose the OK button.
________________
See also

User's Guide
Chapter 15



Automatically Inserting the Decimal Point

Microsoft Money is preset so that you must type a decimal point to enter an amount in 
cents. You can change this setting so that when you type an amount in a transaction, a 
decimal point is entered for you. When you move to the next field, the decimal point is 
inserted two digits from the right.

To turn auto decimal points on or off
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Entry, choose the Auto Decimal Point in Amounts check box.
3 Choose the OK button.
Note    If you want to type the amounts in dollars, you'll need to type two zeros whenever 
you enter a whole dollar amount or enter a decimal point manually.
________________
See also

User's Guide
Chapter 15



Changing the Backup Option

Microsoft Money is preset so that when you exit or open a different file, you are reminded 
to make a backup of your file.

To turn the backup reminder on or off
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Confirmation, choose or clear the Remind to Back Up on Close check box.
3 Choose the OK button.
Note  A backup is an extra copy of your work. Your work is automatically saved every time 
you exit Money. Creating a backup file is an extra precaution against data loss.
________________
See also

Backing Up Your File

User's Guide
Chapter 15



Changing When the Pay Bills Reminder is Displayed

Microsoft Money is preset to remind you of Future Transactions five days before they're due.
You can change the number of days of advance notice, or turn off these reminder 
messages.

To turn reminder messages on or off
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Future Transactions, choose or clear the Remind When Transactions Due check 

box.
3 Choose the OK button.

To change the number of days of advance notice
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Future Transactions, in the Days In Advance To Remind box, type the number of 

days of advance notice you want to receive.
3 Choose the OK button.

To have reminder messages based only on business days
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box appears.
2 Under Future Transactions, choose or clear Count Only Business Days.
3 Choose the OK button.
Note    Business days are considered all weekdays except federal bank holidays.
________________
See also

Setting Up Future Transactions

User's Guide
Chapter 15



Changing the Size of Text and Numbers on Your Screen

You can change the type size displayed on your screen, but this will not affect the size of 
text that prints on checks and reports.

To change the size of text and numbers on your screen
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Font Size, choose the Large option to increase the size, or choose the Standard 

option to return to the smaller, standard size.
3 Choose the OK button.
________________
See also

Changing the Font Used in a Report

User's Guide
Chapter 15



Changing the Color

You can change the background color of the Account Book, Account Forms, Future 
Transactions, and Loans windows.

To change the color
1 From the Tools menu, choose Options; then choose General. The General Options dialog 

box is displayed.
2 Under Display, in the Background Color box, choose a color from the list.
3 Choose the OK button.
Note    Some color options may make text difficult to read on monochrome screens.
________________
See also

User's Guide
Chapter 15



Requiring Categories in Each Transaction

You can choose to be alerted if you try to enter a transaction without a category.
To require categories in each transaction

1 From the Tools menu, choose Options; then choose General. The General Options dialog 
box is displayed.

2 Under Confirmation, choose or clear the Require Category in Each Transaction check box.
3 Choose the OK button.
________________
See also

Creating a New Category or Subcategory
Assigning Categories to Transactions

User's Guide
Chapter 15



Restoring a Backup File

To restore a backup file
1 Quit Microsoft Money by choosing Exit from the File menu.
2 Switch to the Microsoft Windows File Manager.
3 In File Manager, display the directory listing for the disk that contains your backup file.
4 Highlight the name of your backup file.
5 From the File menu in File Manager, choose the Copy command.
6 In the To box, type the name of the drive and directory where you typically store your 

Money files; then type the backup files name, with the extension MNY.
For example, if you store your Money files in the \MSMONEY directory on the c: drive and 
your backup file is named MYBACKUP.BAK, you would type this:
C:\MSMONEY\MYBACK.MNY

7 Choose the OK button.
You now have a copy of your backup file named as a regular Money file, and stored on 
your hard disk.

8 Start Microsoft Money.
Money will open your backup file from the floppy disk again (unless it wasnt the last file 
you had open).

9 From the File menu in Money, choose Open.
10Use the Open dialog box to open your newly-renamed backup file.

You may be prompted to backup your current file before opening the new file. Youll 
probably want to choose the No button.

11Once the file opens, you can begin working with it.
Your next step should be to enter any transactions or other information youd entered 
since you created the backup file. After that, you can work with the file as usual. 

________________
See also

Backing Up a File
Changing the Backup Option

User's Guide
Chapter 37



Deleting an Account

When you delete an account, all its transactions are permanently deleted. Before deleting 
an account, you may want to backup the file. You can open a backup file at any time.

To delete an account
1 From the Lists menu, choose Account List.
2 In the Account List box, choose the account you want to delete.
3 Choose the Delete button.
4 If the account contains transactions, you will be prompted to confirm the deletion.
5 Choose the Close button.
________________
See also

Backing Up a File
Archiving Your Records

User's Guide
Chapter 17



What's in Your MSMONEY.INI File

There is a file in your MSMONEY directory called MSMONEY.INI that contains information 
about your option settings. If this file is accidentally deleted, Microsoft Money will return to 
the default settings. You can view this file in Windows Notepad.

The file may contain the following information:
Location and name of last file used.

For example, CurrentFile=C:\MSMONEY\MSMONEY.MNY gives the directory path and
file name for the last data file you were using.

Status for each window. Shows the status, position, and size for the Application 
(Main), Account Book, Loans, Account Forms, Future Transactions, Investment Details, and 
Investment Summary windows.

For example, the numbers in the line AccountWindow=1 30 78 595 304 0 show that 
the Account Book window is open (0 is closed, 1 is open), the position in the application 
window is 30 pixels from the left and 78 from the top, the window size is 595 pixels wide 
and 304 pixels tall, and Top Line view is being displayed (0 if Top Line, 1 if Entire). The 
first number following MainWindow indicates whether the application window is 
minimized, normal size, or maximized (0 minimized, 1 normal, 2 maximized).

Reminders and confirmation messages on or off.
For example, BeepOnEntry, BackupOnClose, RemindOnOpen, SmartFill, 
ConfirmChanges, etc. will be followed by a 0 or 1 (0 is off and 1 is on).

Other display and reminder information.
For example, FrontWindow shows which window is currently displayed on top (0 for 
Account Book, 1 for Future Transactions, 2 for Account Forms, 3 for Loans, 4 for 
Investment Details, 5 for Investment Summary), ReminderDays shows how many 
Reminder Days you have set for Future Transactions, FontSize shows small or large font 
size (0 is small, 1 is large), and ColorScheme shows what color you are using. The color 
scheme numbers are: blue 0; grey 1; green 2; monochrome 3; yellow 4.

Adding Printer Options to your MSMONEY.INI file.
If you've installed your printer correctly, chosen the correct settings in the Print Setup 
dialog box, and you're feeding checks correctly into your printer, your checks are 
probably printing the way you want. However, if you're still having problems getting 
check information to print in the exact location you want, you can add one or both of the 
following lines to your MSMONEY.INI file:

    PrintOffset=yF xF yP xP
Adding this line allows you to make small adjustments to where information prints on 
Laser Standard, Laser Wallet, or Laser Voucher checks. Changing the value of the 
numbers yF xF yP and xP changes the print position. (y and x represent vertical and 
horizontal position. F and P stand for Full sheets in Portrait mode and Partial sheets in 
Landscape mode). The numbers are in 16ths of an inch, and can be positive or negative. 
If you type a positive number, do not use the plus (+) sign. Numbers without a sign are 
assumed to be positive.

    The first number (yF) controls vertical positioning on full sheets in Portrait mode. A 
positive number causes information to print lower on the sheet. A negative number causes 
information to print higher.

    The second number (xF) controls horizontal positioning on full sheets in Portrait 
mode. A positive number causes information to print farther to the right. A negative number 
causes information to print farther to the left.

    The third number (yP) controls vertical positioning on partial sheets in Landscape 
mode. A positive number causes information to print lower on the page. A negative number 
causes information to print higher on the page.



    The fourth number (xP) controls horizontal positioning on partial sheets in Landscape 
mode. A positive number causes information to print farther to the right. A negative number 
causes information to print farther to the left.

    UseDefaultPrSetup=x
Adding this line allows you to specify which Print Setup dialog box controls your printer. 
When UseDefaultPrSetup=0, the Print Setup options in Money control your printer. When 
UseDefaultPrSetup=1, your printer is affected by how options are set in the Windows 
Control Panel Print Setup. Use this when you are having serious problems printing reports
or checks.

________________
See also

General Options



Introduction to Option Settings

You can change a variety of option settings for how Microsoft Money works using the same 
general methods.

To change an option
1 From the Tools menu, choose Options; then choose General, Investment, Bank On-Line, 

or Modem. The Options dialog box is displayed.
2 Find the setting you want to change.
3 Choose [ X ] or clear [      ] the box in front of the setting to activate or deactivate it.
________________
See also

Options



Choosing a Modem Port

Most PCs have two serial ports that can be used for printers, mouse connections, or 
modems. The MS-DOS operating system labels these ports COM1 and COM2. 

To select a port for your modem
1 From the Tools menu, choose Options; then choose Modem. 
2 Under Serial Port, select the correct modem port.
3 Choose the OK button.



Choosing a Phone Number for On-Line Services

To select a default phone number for Pay On-Line
1 From the Tools menu, choose Options; then choose Modem. 
2 Under On-Line Access Phone #, type the phone number you wish to use as the default 

number your modem will dial when calling On-Line Services. You can find this number in 
your On-Line Services start-up kit.

3 Choose the OK button.
________________
See also

User's Guide
Chapter 31



Choosing a Modem Speed

Check your owner's manual to determine how many bits per second, or bps, your modem 
can transmit and receive.

To select a modem speed
1 From the Tools menu, choose Options; then choose Modem. 
2 Under Modem Speed, choose the setting that corresponds to that of your modem.
3 Choose the OK button.



Choosing Pulse or Tone Dialing

To select pulse or tone dialing
1 From the Tools menu, choose Options; then choose Modem. 
2 Under Dialing, choose the setting that corresponds to the way your phone dials a 

telephone number.
3 Choose the OK button.



Options

You can change program settings, or options, to customize the way Microsoft Money 
displays information or refine the way Money prompts you as you work. The options are 
divided into General, Investment, Bank On-Line, and Modem.

General Options
 Change Font Size  Confirm Transaction 

Changes
 Change Background 

Color
 Beep On Transaction 

Entry
 Display Scenic Checks  Confirm New Payee 

Names
 Show Message Bar  Remind to Back Up 

When Closing
 Require A Category In

Each Transaction
 Protect Reconciled 

Transactions
 Require the Correct 

Category Type
 Remind When 

Transactions Are Due
 Require an Account 

for Investment Transactions
 Get Advance Warning 

on Reminders
 Count Only Business 

Days
 Use SmartFill

 Automatically Drop 
Lists

 Automatically Add 
Decimal Points In Amounts

 Use Enter Key to Move 
in Register

 Prompt if Checks Are 
Postdated

 Print Payee in Check 
Address

Investment Options
 Require Transfer 

Account In Each Transaction
 Treat Bond Prices as A

Percentage of Par Value
 Categorize Capital 

Gains or Losses as Long 
Term if The Investment Was 
Held More Than X Days, 
Months, Or Years

Bank On-Line Options
 Confirm That 

Downloaded Transactions 
Match Your Money Records

 Attach the Bank's 
Transaction Information to 
the Memo Field in Money

Modem Options
 Choose A Serial Port  Choose A Modem 

Speed
 Specify the Local On-

Line Services Phone 
Number

 Choose Whether Your 
Phone Service Uses Tone Or 
Pulse Dialing





Keyboard Shortcuts

For on-screen Help in Microsoft Money, press the F1 key at any time.

Moving Between Transactions
Moving Within a Transaction
Keyboard Shortcuts for Entering Transactions
Making Changes in a Field
Using Special Commands
Windows Keys
________________
See also

User's Guide
Outside back cover



Keyboard Shortcuts for Entering Transactions

Press To
F4 or 
ALT+DOWN 
ARROW

Open a list 
in a field 
that contains
an arrow.

F8 Convert an 
amount to a 
foreign 
currency 
(the 
insertion 
point must 
be in an 
amount 
field).

CTRL+D Insert the 
current date 
in a Date 
field.

CTRL+K Open the 
Windows 
Calculator, 
or the 
application 
you're using 
in place of 
the 
calculator.

CTRL+S Split a 
transaction.

PLUS SIGN (+) Increase the 
number or 
date by one.

MINUS SIGN (-) Decrease 
the number 
or date by 
one.

SHIFT+QUOTAT
ION MARK (") 

Copy field 
from 
previous 
transaction.

CTRL+M Mark 
transaction 
as cleared or
uncleared.

SHIFT+CTRL+
M

Mark 
transaction 
as 



reconciled or
unreconciled
.

ESC Cancel 
changes.

Important    Generally, you'll want to press F9 to balance your account, rather than using 
CTRL+M or SHIFT+CTRL+M to clear or reconcile transactions.



Making Changes in a Field (Keyboard Methods)

Press To
ALT+BACKSP
ACE or 
CTRL+Z

Undo last 
change to the
current field.

CTRL+X or 
SHIFT+DEL

Cut to 
Clipboard.

CTRL+C or 
CRTL+INS

Copy to 
Clipboard.

CTRL+V or 
SHIFT+INS

Paste from 
Clipboard.

DEL Delete 
selection.

SHIFT+ARRO
W KEYS

Extend 
selection.



Using Special Commands

Press To
F1 Get Help.
F2 Change the 

selected 
transaction.

F5 Add an 
unassigned 
amount to 
the last part
of the split. 
(Effective 
only when 
working in 
the Split 
window with
an 
unassigned 
amount.)

F6 Apportion 
an 
unassigned 
amount 
between 
parts of the 
split. 
(Effective 
only when 
working in 
the Split 
window with
an 
unassigned 
amount.)

F7 Repeat last 
Find (using 
information 
previously 
entered).

F8 Convert 
currency 
(effective 
when the 
insertion 
point is in 
any amount 
field).

F9 Balance or 
reconcile an 



account or 
Loan.

CTRL+DEL Delete a 
transaction 
without 
getting a 
confirmation
message. 
First select 
the 
transaction, 
then press 
CTRL+DEL.

CTRL+E Schedule a 
Future 
Transaction, 
or enter a 
scheduled 
transaction.

CTRL+F Find specific
information 
in fields of 
your choice.

CTRL+G Go To a 
specific 
transaction.

CTRL+K Display the 
Windows 
Calculator.

CTRL+O Create a 
custom 
view.

CTRL+P Pay 
scheduled 
bills (Open 
the Record 
Due 
Transactions
dialog box).

CTRL+R Use 
remembere
d reports.

CTRL+T Switch 
between Top
Line and 
Entire 
Transaction 
Views.

CTRL+W Cascade 
(arrange) all
Money 
windows 



that are 
open.



Microsoft Windows Keys

Press To
ALT or 
F10

Activate 
the 
menu 
bar.

ALT+F4 Exit 
Money.

ESC Cancel a
menu, a 
dialog 
box, or 
an error 
messag
e.





Starting Microsoft Money from the Command Prompt

You can start Microsoft Money from the MS-DOS(R) command prompt (C:\), instead of from 
Microsoft Windows(TM). Only do this if you are not currently running Windows.

To start Money from the command prompt
Change to the Money directory, and at the command prompt, type:
win msmoney

Then press ENTER. If you want to open a file other than the last one you were working 
with, you can also type a specific file name:

win msmoney charity.mny
Windows and Microsoft Money will start.

Important    The path in your AUTOEXEC.BAT file must include the directory you installed 
Money in: for example, path=c:\;c:\dos;c:\msmoney
Note    For information on changing directories within MS-DOS, see your MS-DOS 
documentation.



An Account Naming Strategy

Always try to name your accounts so the first few letters are different than any other 
account; that way SmartFill can complete the name for you after you type only a few 
letters.
For example, if you have a savings, checking, and credit card account with Anybank, 
instead of starting each account name with the word Anybank, name the accounts Savings 
Anybank, Checking Anybank, and Credit Card Anybank.
On the other hand, if you have several checking accounts in several different banks, you 
might want to have the account name begin with the bank name.



Quickly Deleting a Transaction

If you want to delete a transaction without getting a confirmation message, select the 
transaction, then press CTRL+DEL.



Speeding Up Date Entry

If you want to change the date Microsoft Money proposes, rather than entering the 
complete date, you can:

Enter the day, and press TAB, and Money will fill in the month and year for you.
Enter the day and month, and press TAB, and Money will fill in the year for you.

Note    You can increase or decrease the date by pressing the PLUS (+) or MINUS (-) sign keys 
while the date is highlighted.



Combining or Dividing Files

If you started off with separate files, you may want to eventually combine one or more 
accounts from those files. You can also split a file into two files, keeping your accounts 
separate.

To combine two files
1 In the Account box, choose the account you would like to move to another file.
2 Export the account, giving it a descriptive name you will remember with a .QIF file name 

extension.
3 Open or create the file you'd like to add the exported account to.
4 Import the account you've just exported.

If you get the Select Import Account dialog box, highlight the account you want to import
the data to, and choose the OK button.

5 Microsoft Money will confirm when the import is complete.
Delete the account from the first file.

To split a file into two files
1 Export each account you want to include in the new file.
2 Create a new file.
3 In the new file, create a new account for each account that you've exported.
4 Import each exported account into the new accounts you've created.
5 Delete the accounts in the first file that were exported.
Note    When you export an account, you cannot export information such as shortcuts and 
comments.
________________
See also

Exporting an Account
Creating a New File
Importing Information from a Quicken File



Setting Up Two Future Transactions for Paychecks

If you get paid twice a month, it's possible that the amount of the two paychecks will differ 
due to variations in your gross pay and taxes withheld. To speed up entering the deposits in
your account, you can set up two separate Future Transactions: one for the middle of the 
month, and one for the end of the month, 

To create two Future Transactions for a payroll check
1 Select a transaction you've entered for the first paycheck deposit of the month.
2 From the toolbar, click the Remind When Due Button, or from the Tools menu, choose 

Remind When Due.
3 In the Frequency box, choose Monthly.
4 In the Next Due Date box, accept the proposed date or type the date you will deposit 

your first paycheck of the next month.
5 Choose the OK button.
6 Select a transaction you've entered for the second paycheck deposit of the month.
7 Repeat steps 2 through 4, and in the Next Date box, accept the proposed date or type 

the date you'll deposit your second paycheck of the month.
8 Choose the OK button.



Entering Information You Don't Want Printed on Checks

To add information to a field that won't print on checks, type it between curly brackets {    }.
If you use curly brackets in the Payee field, you'll also get more information about the 
transaction when viewing the register in Top Line View.
For example, if you're writing a check to a brokerage firm called Acme Brokerage to buy 
stock XYZ, type: Acme Brokerage{XYZ Stock}. XYZ Stock will not print on your checks; 
however, the full name will be used on reports.
________________
See also

Switching Between Entire Transaction and Top Line Views



Changing the Layout of a Report in a Word Processor or 
Spreadsheet

You can use a word processor or spreadsheet application to create a different page layout, 
add character formatting, or make other changes to a Microsoft Money report.
First, export a report from Money; then load it into a word processor or spreadsheet 
application. The format of an exported file is tab-delimited text. When you open this file in a
word processor, the report will have a tab character between the columns of data in each 
row, and a paragraph mark at the end of each row. When you open the file in a spreadsheet
application, the data will be organized into columns and rows.
________________
See also

Exporting Reports



Itemizing a Paycheck Deposit

When you deposit a paycheck into your account, you can keep track of the deductions from
your gross income, for example, FICA, Federal Income Tax, and health insurance premiums.

To itemize a paycheck deposit
1 Enter the date and payee information as you would for a typical deposit.
2 In the Deposit field, type the amount of your net pay (how much the check is actually 

for).
3 Choose the Split Transaction button, or from the Edit menu, choose Split Transaction.
4 In the Split Transaction dialog box, choose Wages & Salary in the Category field, and type

Gross Pay in the Subcategory field.
5 In the Amount field, type the amount of your gross pay.
6 Press TAB to move to the next line.
7 In the second line, choose Taxes in the Category field, and type FICA (Social Security 

Tax) in the Subcategory field.
8 In the Amount field, type the amount withheld from your paycheck for FICA as a negative

number. For example, type -100.00.
9 In the third line, choose Taxes in the Category field, and type IRS (Federal Income Tax) in 

the Subcategory field.
10In the Amount field, type the amount withheld from your paycheck for IRS taxes as a 

negative number.
11Continue entering other deductions as parts of the split transaction as negative amounts 

until the unassigned amount is zero.
12Choose the Done button.
13Press ENTER to enter the transaction.
________________
See also

Keeping Records for 401(k)s and Other Investments Made Through Paycheck Deductions
Splitting a Transaction
Transferring Money Between Accounts



Keeping Track of Reimbursable Expenses

If you travel or make personal expenditures for the company you own or work for, you may 
incur expenses for which you need to be reimbursed.

To keep track of these expenses
1 Set up an Asset Account called "Expense Reports."
2 When you incur an expense, enter a transaction for it in the appropriate account 

(Checking, Credit Card, or Cash). Choose Transfer as the category and Expense Reports 
as the account.

3 When you receive reimbursement for the expense, enter a deposit for that amount in the
appropriate account (checking, Credit Card, or Cash) and choose Transfer in the Category
field and Expense Reports in the Account field.
Once you have received reimbursement for all your expenses, the balance of the 
Expense Reports account should be zero.

To get more detailed information about these expenses
1 When you turn in your expense report to your employer, mark the transactions in the 

Expense Report account as reconciled.
2 When you receive reimbursement for these expenses, mark the reimbursement 

transaction in the Expense Report account as reconciled.
You can create a view to see only reconciled or unreconciled business expense 
transactions. By viewing only unreconciled transactions, you can see how many business
expenses you've incurred which you haven't reported yet. By viewing only reconciled 
transactions, you can see your expense report balance (how many expenses you've 
reported but have not yet been reimbursed for).

To create a view of reconciled or unreconciled transactions
1 In the View box, choose Other.
2 In the Cleared box, choose Unreconciled Transactions or Reconciled Transactions.
3 Choose the OK button.



Recording Home Improvements

Records of the improvements you make to your home might be important for tax 
preparation, insurance planning, and figuring your net worth. Since your house is an asset, 
you'll start by setting up an Asset Account, with the purchase price of the home as the 
starting balance.

To record home improvements in your house Asset Account
In your checking account, enter the payment transaction for the improvement as a 

transfer to the house Asset Account.
Microsoft Money enters the payment as an increase in the house account.
If you own more than one piece of property, you may want to set up a property 
classification so you can track improvement expenses on each piece of property.

________________
See also

Transferring Money Between Accounts
Setting up a Rental Property Classification
Setting Up an Asset Account



Moving Transactions from One Account to Another

No matter what account you entered a transaction in, you can move it to the account you 
want. For example, If you enter a transaction in your Bank Account, but meant to enter it in
your Credit Card Account, you can move it.

To move transactions from one account to another
1 Switch to the Account Book window.
2 Select All Accounts from the Account box on the toolbar.
3 Highlight the transaction you want to change.
4 Move to the Account field. If that field is not visible, switch to Entire Transaction View by 

pressing CTRL+T. This field will only be visible if you have All Accounts or Multiple 
Accounts chosen from the Account list box on the toolbar.

5 In the Account field, choose the account you want to move the transaction to and press 
ENTER.
If the account doesn't appear in the list, create the account by typing its name in the 
Account field. Money will prompt you to enter the name, type, and opening balance of 
your new account.

6 If you want to move multiple transactions to another account, highlight the next 
transaction and press CTRL+QUOTATION MARK to repeat the account name. Repeat this step 
for each transaction you want to move.



Microsoft Money Limits

Here are some of the Microsoft Money limits. Use them to plan how you organize and enter 
your financial information.

You 
can 
hav
e up
to
63 Accounts per file.
63 Loans per file.
253 Categories and 

subcategories per file.
2 Classifications per file.
255 Items and sub-items for 

each classification.
50 Remembered reports per 

file.
To save more than 50 
reports in a file, use the 
Windows Recorder. See your
Windows documentation for 
instructions on using the 
Recorder.

9 Digits in the amount fields 
of all windows.
For example, you can enter 
a transaction amount for 
$9,999,999.99 but not 
$10,000,000.00. If you do 
have a transaction amount 
that exceeds this limit, you 
can divide it into two 
transactions.

44 Currency list items per file.
8,00
0

Payees per file.
The maximum number of 
payees that can display in a
drop-down list box is 8,000; 
however, you can enter 
more than 8,000 payees--
they just won't show in the 
drop-down or Payee List 
boxes.

516 On-Line Payees
32,7
65

Transactions (or 
investments) per file.
You would have to enter 100



transactions per month for 
27 years without archiving 
to reach this limit. Splits are
considered transactions in 
this calculation.

Money accepts dates between
January 1, 1948 - December 31, 
2075



Using Customized Sounds

If you have a sound board installed, you can customize the sound that can be heard when 
completing a transaction.
Any available sound file that shows up in the Sound section of your Windows Control Panel 
may be linked to Money.

To install a custom sound
1 From the Program Manager in Windows, choose the Control Panel.
2 Choose the Sound icon. This opens the Sound dialog box.
3 In the Events list box, highlight Money Transaction Entry.
4 In the Files list box, choose a sound file.
5 Choose the OK button.
________________
See also

Turning the Beep On Transaction Entry Setting On or Off






